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1 Introduction

1.1 Documentation Contents

This documentation covers the following topics:

What is New in ThinManager 5.0?
A Quick Start Checklist

Standard ThinManager Installation
ThinManager Licensing
Redundancy

The ThinManager Interface

The Menu items

Adding thin client hardware
Configuration Wizards

The Terminal Configuration Wizard
The PXE Server Configuration Wizard
Display Servers

Display Clients (formerly Terminal Server Groups and Application Groups)
Failover and Instant Failover
Modules

Citrix ICA

Hotkeys

MultiMonitor

Reports

WinTMC

Shadowing

ThinManager Security

TermSecure
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e TermMon ActiveX Control

e A ThinManager Troubleshooting Guide to aid in deployment

1.2 ACP ThinManager 5.0

ThinManager is a server-side configuration, management, and hardware enabling software for Terminal
Services based thin client systems.

ThinManager is a software program that allows thin clients to boot, receive a configuration, and connect to a
terminal server. ThinManager provides terminal configuration, session management, and session status
monitoring. ACP ThinManager provides quick replacement of terminals and an almost seamless switch from
terminal server to terminal server in case of terminal server failure.

A thin client is a device that connects to a server, logs onto a separate independent session, and runs its
applications on the server and not locally on the thin client. Thin Clients first connect to a ThinManager
Server where it receives its configuration. This configuration sends the terminal to a terminal server where it
logs in.

Note: The terms Thin Client and Terminal are used interchangeably in this document.

The keystrokes and mouse movements from the thin client are sent to the terminal server. The terminal
server session determines the response and sends the screen display back to the terminal. This simplifies
maintenance and management by eliminating the need to install and configure operating systems and
applications on the thin client. All configuration, management, installation and applications are on the server,
not the thin client.

Note: All trademarks, service marks, and copyrights belong to their respective companies.

Microsoft, Windows, Windows XP, Windows 2000, Windows 2000 Server, Windows 2003, Windows
2003, Server Windows 2008, and Windows 2008 Server are trademarks of the Microsoft Corporation,
Redmond, Washington.

Citrix, ICA, and Citrix Device Services are trademarks of Citrix Systems, Fort Lauderdale, Florida.
ESX and vCenter is a trademark of the VMware Company, Palo Alto, California.

ACP, ACP Enabled, AppLink, MultiSession, MultiMonitor, SmartSession, SessionTiling, TermSecure,
ThinManager, ThinManager Ready, and ThinServer, are trademarks of Automation Control Products,
Atlanta, Georgia.
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1.3 What is New in ThinManager 5.07?
New — PXE Support

ThinManager 5.0 now supports thin clients capable of network booting through PXE. This expands the
selection of thin client hardware that works with ThinManager.

See PXE Server Configuration Wizard for details.
New — Xli Licensing

ThinManager Xli licensing includes a MultiMonitor, WinTMC, and TermSecure license with every Terminal
Connection license. ThinManager Xli licensing is required for PXE boot of thin clients.

1.4 Evolution of ThinManager Terminology

ThinManager has evolved over the years leading to changes in terminology and function.

1.4.1 Essential ThinManager Functionality
The booting of a thin client is a two-step process:
e The thin client connects to ThinManager to receive its configuration.
e This configuration sends the thin client to a terminal server to login and run a session.

The ThinManager may be on the same physical computer as the terminal server or it may be on a different
computer.

1.4.2 The Client/Server Relationship in Terminal Services

This is how the client/server relationship works in terminal services:
e The client (fat or thin) connects to a terminal server, logs on, and starts a session.
e The client sends mouse and keystrokes to the terminal server for processing.

e The terminal server processes the input, generates the corresponding graphics, and sends the
graphics calls to the client for display.

e The client displays the graphics locally for the user.
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1.4.3 Hardware Configuration Tool
Early versions of ThinManager functioned as a tool for configuring the thin client hardware.

mThinManager ¥2.3.1 I [l

Edit Tools Wew Help

- Attribute | W alue -

M arme gerver2000_tmz2
Licenzes
Fromo n/5
FultiS eszion 245
Smart Seszion 275
AutoCreate YES
AutoCreate Mazk AutaTerm ]
R eplacement YES
TermCap DB Yersion 262

« | ;I_I

Far Help, press F1 =

ThinManager 2.3.1 Interface

The status of the terminal was limited to indicating if a terminal was on or off by use of green or red colors on
the terminal icons.
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1.4.4 Wizards

Configuration wizards were added in ThinManager 2.4.

ThinManager ¥Z2.4.1

Edit Tools ThinManagerServer Wiew Help

|_:_|---"-.f' ThinfManager Servers

| Walle -

* s Attribut
(SR o 5= er2000_tm2 e
: = M arne
E| Terminall
------ ﬁ Server2000_krnz Licenses
- 4f] serverzonz_TsEC Pramo
E| Terminalz FultiS eszion
...... g Server2003_TSEC Smart Session
4] serverzonn_tmz
=~ a Terminal Servers Autolreate
: AutoCreate Mask
- [ serverzono_tmz s reate As
i R eplacement
- [ serverzo03_tsenz
TermCap DB Yersion
1]

al | ]

Far Help, press F1

gereer 2000

0/5
0/5
0/5

YES
AutaTermn |
TES

262

s

Fiiiz

ThinManager 2.4 Interface

The tree was expanded to show what terminal servers the terminals were assigned to. Green and red
lightning bolts indicated whether a terminal had an active connection to the terminal server.
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1.4.5 Terminal Server Groups

ThinManager 2.5 introduced Terminal Server Groups. These were collections of terminal servers that a
terminal could connect to and run a session on.

Edit Tools ThinfManagerServer

Ed ThinManager v2.5 [_ O]

Wiew  Help

|_:_|---"-.f' ThinfManager Servers
E|‘..f server2000_tmZ

Eg Terminall
-l Hr
Reporks

Eg Terminalz

=g

E@ Reparks

- ﬁ Terminal Servers
I'_—'Ii Terminal Server Groups
- [ serverzooo_tmz
[ [ serverzona_sen:
El@ Reporks

- [ serverzo00_tmz

1 |

For Help, press F1

....... B Seryer2000_t
R B Server2003_

....... B Server2000_k
....... ﬂ Server2003_°

-

s

Configuration | Licensesl "Jersi-:unsl

Attribute

MHame

Require Pazsward for Unknown terminals
Allow Automatic Terminal Creation
Autoratic: Terminal Creation Mask

Al Off-line Replacement

SMTP Server

Thinkdanager Server Start/Stop
Termminal Server Data Connection
Teminal OnOff

Terminal Configuration Chanige
Install Firnware

Inztall TermCap

Install License

E-mail Addresses

Unknown Terminal Configuration

Event Configuration

-
1| | 3

e

ThinManager 2.5 Interface

The use of Terminal Server Groups increased the power of ThinManager through AppLink and MultiSession.

AppLink is the deployment of specific applications and MultiSession is the ability to run multiple sessions on a
terminal at the same time. In the example Terminal2 is using MultiSession to run two AppLink apps (HMI and

Reports).

Automation Control Products ThinManager 5.0 Help Manual

Introduction e 16



1.4.6 Application Groups

Terminal Server Groups were renamed Application Groups in ThinManager 3.2.

¥ ThinManager v3.2 | _ O] =]
Edt Manage [nskall Tools Wiew Remoteview Help
IGrEE:n LI Config I Server Hankl
El‘f Green Y Abtribute -
Terminals — Application Group Configuration
EI ﬁ Terminal Servers Group Mame
- [ BasesE4s Group Type
B Blue TerminalServers
B reen Enforce Primary Server
Ingtant Failower
[—]i Application Groups Allow duterlagin |

Back01

e

Graphics SmartSeszsion
HMI SmartSeszion

ICasppl
ICanpps

Protocal for connections in thiz group

Linked Application
Reparts Linked Application

3 ! Shadowdny Ll S | | 4

For Help, press F1 i

ThinManager3.2 Interface

Terminal Server Groups didn’t describe Terminal-to-Terminal shadowing accurately because that function
isn't coming from the terminal server but is coming from the shadowed terminal.
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1.4.7 Display Servers and Display Clients

ThinManager 4.0 added IP cameras, an additional source to display on the ThinManager Ready thin client
leading to a major change in terminology.

5% ThinManager v4.0 [_ O]

Edit Manage [nstall Tools Yiew RemoteYiew Help

IGrEEH - | Canfiguratian | Licensesl F'ru:upertiesl ‘Jersinnsl S_I,Inn:hrcunizatiunl Ewent 4 I *I
Elww A0 Attribute | walue -
Q Terminals M arme Green

E| ﬁ Display Servers

E‘ ﬁ Terminal Servers Unknown Terminal Configuration

j Black Require Password for Unknown terminals MO
j Blue Sllovs Avtomatic Terminal Creation YES
j Green Automatic: Terminal Creation Mask AutoTermn

= @& Cameras
----- @ CameraGroupl

- Tim_207 —
2 IE' Disolay Client Event Configuration
—- isplay Clients

SKTP Server

Allora Off-line Replacement YES

1

_l; Graphics Thintanager Server Start/Stop I
_l; HIMI Teminal Server Data Connection
; Reparts Termninal OnAOf
IZ—]@ Camera Terminal Configuration Change
@ Backil Inztall Firmnware
@ Frontol Iriztall TermCap
I'_—"IQ Termingl Shadow  — Install License
- shadowdny SMTP server -
Kl [ |—I d | _>I_I
For Help, press F1 | [

ThinManager 4.0 Interface

Important Definitions:

A server is defined as device, computer, or application that provides applications, files, or data for use by
other computers.

A client is defined as device, computer, or application that requests data, resources, or services from a
server or software program that shares data with the server.

Display Servers — ThinManager 4 uses Display Servers to denote devices that provide content that can be
displayed on the client. Examples include the traditional terminal server and IP cameras.

Display Clients - ThinManager 4 uses Display Clients to denote the graphic rendering of the output from a
Display Server. This could be a traditional Terminal Server session, IP Camera display, or a Terminal-to-
Terminal Shadow session.
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52 ThinManager v4.1 =] E3

Edit Manage Instal Tools View RemoteView Help

Iﬂ Training52 b
B (%) vcenter Servers

Dizplay Clients

ACP Datacente
= atacenter Show Dizplay Client Selector Menu

ICDhaIi j Configuratior I Schedulel Ewent Lngl Heportl
E;E,? Cobalt I I Attribute I Value
Q Bravo Mame Baker
Q. Charlie Wwindows Userame
=) ﬁ Displary Servers Windows D omain
E ﬁ Terminal Servers
g cosomu

E@ v _Eight Termminal Interface Options

ﬁ Trainings1
Auto-Hide Dizplay Client Selector Menu MO
@ Training52 )
=N I:l Display Clients Enable Screen-Edge Group Selection WO
. F Terminal Services Enable Tiling ND
Uze Terminal Hotkens MO
§ Inztant Failowver Haotkey Digabled
= 5 Workstation Group Hotkey - Mext ControlPage Down
El- ﬁ TermSecure Users Group Hotkey - Previous Control+Page Up
b n Adam Show Switch User Menu YES =
E| 2 Baker LI 4| | _’l_l
For Help, press F1 l_ &

ThinManager 4.1 Interface

ThinManager 4.1 adds vCenter server control and management to ThinManager.
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2 System Overview

2.1 Quick Start Checklist

Microsoft
O Build a terminal server with the Microsoft Windows 2003 or 2008 Server operating system. Enable
Terminal Services. See Non-ThinManager Components.

O Create a Microsoft Licensing Server and add a TS CAL (Terminal Server Client Access License) for
each thin client. They also require a normal CAL. See Microsoft Licenses.

O Create a Microsoft user profile for each terminal on the terminal server. Make sure that the user is a
member of the Remote Desktop Users Windows group. See Creating Microsoft User Profiles.

O Apply appropriate security to each user profile using the standard Microsoft techniques.
ThinManager
o Install ACP ThinManager software onto a computer to create a ThinManager Server. See Installation
of ThinManager.

O Create a Master ACP License and add enough Product Licenses for each thin client. See Adding a
Master License to ThinManager.

Hardware
O Establish the IP addressing scheme for the thin clients, Static IP or DHCP. See IP Address
Assignment.
If using DHCP, configure Option 066 to list the IP address of the ThinManager Server. See DHCP.
Attach the terminals to ThinManager by either:

0 Turning on the terminal and selecting the "Create New Terminal" option when the offline
terminals are listed.

0 Pre-creating the terminals in ThinManager and selecting the proper terminal name when the
terminal is turned on and offline terminals are listed.

Results

O Step 1: The clients will connect to the ThinManager Server and download the firmware and
configuration.

O Step 2: The configuration will send them to the terminal server to login and start a session.
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Note: It is a good idea to schedule an automatic backup of your configuration. See Scheduling for details.

2.2 Required Components

Thin Clients require a number of components to function properly. These include:
e Terminal Services from Microsoft
e Client Communication Protocol, either Microsoft RDP or Citrix ICA
e ACP ThinManager software
e ThinManager Ready or PXE Capable Thin Client Hardware
e Standard TCP/IP network infrastructure

2.2.1 Windows Terminal Server Operating System

The first component is the Terminal Server. This is a computer with a version of Microsoft's Windows 2003
or 2008 Server that has the Terminal Services functionality activated. The operating system allows multiple
users to log into the server and run independent, isolated sessions. The operating system controls the server,
provides security, controls user access, and runs the applications.

The terminal servers need a Microsoft Terminal Services Licensing Server with Terminal Services/Remote
Desktop Services Client Access Licenses (TS/RDS CALs) added.

See Microsoft Licenses for details.

2.2.2 Client Communication Protocol

The second component is the Client Communication Protocol. The Client Communication Protocol is the
protocol used for client-to-server communications in the Terminal Services Environment. The protocol
handles all video, information, and user input such as keyboard and mouse input. This can be either the
default RDP protocol that is installed by default with any Windows Terminal Server operating systems or an
ICA protocol available separately from Citrix.

The RDP (Remote Desktop Protocol) is the Client-Communication Protocol that is included with Microsoft
Terminal Services and can be used by Thin Clients to connect to Windows 2000/2003/2008 Terminal Servers.
The RDP connection to a Windows 2000 Terminal Server is limited to a 256-color depth (8-bit) while the
Windows 2003/2008 Server connection can be made at a higher color depth.

The ICA (Independent Computer Architecture) Protocol is available by installing and licensing a Citrix
component on the Terminal Servers.

2.2.3 ThinManager Administrative Software

The third component is ACP ThinManager software from Automation Control Products. ThinManager is
used to configure, manage, and control the ThinManager thin clients. Although ThinManager is treated as a
single entity, it really has two main components, the ThinManager interface and the ThinServer service.

e ThinServer is a service that is the engine of the program. It starts automatically, runs in the
background, and provides essential functions to control the thin clients. ThinServer is installed during
ThinManager installation if selected.

e ThinManager is the administrative software that facilitates the configuration and organization of the
thin clients. This is the visible component of the ThinManager software. ThinManager displays
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information generated by ThinServer. ThinManager can be installed on any computer on the network,
including the terminal server.

Note: ThinManager Server is used to describe a computer running ThinManager and ThinServer that
provides control and configuration to Thin Clients, even if the computer is a workstation.

One instance of ThinManager can provide client connection to several terminal servers. The thin clients would
boot from the ThinManager server but could be assigned to any of several terminal servers.

2.2.4 ThinManager Ready Thin Client Hardware

ACP ThinManager is designed to control and configure ACP Enabled Thin clients. These are ThinManager
Ready thin clients produced by a variety of manufacturing partners and displaying the ThinManager Ready
sticker. The ACP website (http://www.thinmanager.com) has links to the ACP Partners.

ThinManager

DGDDG

O

v

THINMAMNAGER READY

READY 0127833

ThinManager Ready Logos

ThinManager Enabled thin clients should display a ThinManager Ready Logo.
The
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2.3 Connection Overview

When a terminal is powered on:

e For ThinManager Ready thin clients:

e AnIP address is requested from a DHCP server by default. The DHCP server needs to have
Option 066 set to the ThinManager Server IP address and Option 067 set to
Firmware .acp to specify a ThinManager Server IP address. Units with the ACP
BootLoader 5.01 and later can use DHCP and have the ThinManager Server statically
assigned on the unit.
See DHCP Server Setup and Boot Process for details.

e Alternately, the terminal may be assigned a static IP address and the ThinManager Server IP
address.

e For PXE thin clients:

e AnIP address and boot file is requested from a DHCP server, or ThinManager if configured..
See PXE Server Configuration Wizard for details.

e The terminal connects to the ThinManager Server to download its configuration.

e The ThinManager configuration will tell the terminal which terminal server to connect and login to.

e The terminal will connect to that terminal server and display the Windows login dialog box or will
automatically login with help from the ThinManager configuration.

e The terminal will create a session on the terminal server, allowing applications to run.

The Thin client can be assigned to a single terminal server, or it can be assigned to multiple terminal servers
in case of terminal server failure. Display Clients are groups of terminal servers that have added functionality
for the thin client.

2.4 Failover Overview

Server failures in any network or system can disrupt productivity and data management. ACP ThinManager
(version 2.3 and later) has a failover capability built into it that allows terminals to connect to a secondary
terminal server if the terminal server that they are logged into fails. This will lessen the effect of server failures
on the terminal server network. The terminals can detect the server crash, drop the connection to it, and
connect to a secondary server in seconds.

To initiate ACP ThinManager Failover protection, four steps are needed:

Multiple Servers: The first step is to have multiple terminal servers, with appropriate applications
and licenses installed.

Terminal Server Addressing In ThinManager: When configuring the display clients to use
individual terminal servers, list the terminal servers, in the order of preferred connection, in
ThinManager. Upon boot, each terminal will try to connect to the first server in the list (the primary
server). If it is not available, it will try the next on the list (a secondary server) until a connection is
made.

When using a SmartSession Group the terminal will connect to the terminal server with the
lightest load.

Sufficient Memory: The third step is to have sufficient memory capacity on the servers to
accommodate the addition of terminals during failover. If you do not plan for the extra capacity,
the servers can be taxed with the addition of the new terminals.
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e User Permissions: Each terminal server needs the appropriate Windows 2000/2003/2008 user
profiles and permissions. The terminals will not log into a secondary session unless it has a user
profile on that server.

ACP ThinManager allows the use of several terminal servers, defined as the primary and as backups. If the
primary terminal server fails, the thin client will detect the server failure and will initiate a new session on a
backup server. This allows the operator to continue their work and minimize the effect of a server failure.

¥\Display Client Wizard |

Dizplay Client Members w
h-n‘

Select the Terminal Servers for thiz dizplay client.

Axallable Terminal Servers Selected Terminal Servers

Blue [192.168.1.36] Silwer [192.168.1.38]
i Al

Edit Server List

< Back I Hest > I Finizh Cancel Help

Failover Configured for Display Clients in the Display Client Wizard

Failover when using Display Clients is configured in the Display Client Wizard by adding multiple terminal
servers to the Display Client. See Display Client List for details.

Instant Failover is an advanced configuration of failover. The terminal will log into two terminal servers and
start a session on each one. The primary session will be displayed, with the secondary session cascaded
behind it. If the primary terminal server fails, the terminal will switch focus to the already initiated secondary
session and display the secondary session, saving the time needed to switch terminal servers and load
applications.

See Instant Failover for further details.
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2.5 MultiSession Overview

MultiSession is the ability for a Terminal to display several Display Clients at one time. Normally the Display

Clients are cascaded with only one active at a time. Tiling allows a thumbnail of each Display Client to be
displayed at the same time.

5%\ Terminal Configuration Wizard |
Display Client Selection m
Select the Dizplay Clients to uze on this kerminal } ‘
A
Aryailable Display Clients Selected Digplay Clients
Shadowdny Hkdl
Frant Backm
Reparts
Graphics F
— w

Edit Digplay Cligntz Overide |

¢ Back I Hest > I Finizh Cancel Help

Display Client Selection Page of Terminal Configuration Wizard

MultiSession is initiated by adding multiple Display Clients on the Display Client Selection page of the
Terminal Configuration Wizard.

See SessionTiling Options for details.
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2.6 MultiMonitor Overview

MultiMonitor is the ability of some thin clients to use up to five monitors on the thin client. These monitors can
be used to display single screen Display Clients or the monitors can be merged to form spanned windows of
two or more monitors.

The MultiMonitor function can be applied to the WinTMC client running on a Windows PC with multiple
monitors.

Note: MultiMonitor requires the usage of Display Clients instead of using individual terminal servers.

See MultiMonitor for more details.

2.7 TermSecure Overview

TermSecure is a new ThinManager feature that allows users to logon to a thin client and access user-specific
or terminal-specific Display Client. This does not replace the Windows logon but adds an additional layer of
security and control.

Terminals and Display Clients can be assigned Access Group permissions. A TermSecure User can use
those terminals and Display Clients only if the TermSecure User has been assigned to the same Access
Group Display Clients

TermSecure has two main attributes:

e SecureAccess: Manages user access to terminal servers and sessions through ThinManager
authentication and group permissions.

e SmartContext: Allows the movement of the display of a TermSecure User’s terminal server sessions
between multiple thin clients; initiated by either manual login or the use of an authentication device.
This allows a user to leave one terminal, logon to a different terminal, and reconnect to their session,
essentially having the session follow him from terminal to terminal.

TermSecure logins can be initiated by a manual login or by the use of an ID device like USB drives or
ProxCards for login.

See TermSecure User Configuration Wizard for details.

Note: TermSecure requires the usage of Display Clients instead of using individual terminal servers.

2.8 PXE Boot Overview

PXE (Preboot Execution Environment; sometimes pronounced "pixie") is an environment that allows a
computer to boot over a network. ThinManager provides a complete PXE boot environment that does not
require any additional software components. The ThinManager PXE Server conforms to version 2.1 of the
Intel PXE boot specification.

The Thin Client computer must be capable of PXE Booting. Most standard BIOS ROMS include a PXE Option
ROM. In order to PXE boot, the PXE Option ROM must be enabled in the BIOS. The PXE boot method (boot

from network) should be set to first in the boot order. Disabling the other boot devices in the BIOS will ensure

that the unit will only boot via PXE.

See PXE Server Configuration for more details.

Automation Control Products ThinManager 5.0 Help Manual System Overview e 27



3 Installation of ThinManager

3.1 Standard ThinManager Installation

3.1.1 Windows Server 2003

Note: The installation of the latest Microsoft .NET Framework may require a restart.

ThinManager can be installed on a Windows server or a workstation (NT 4.0 SP5 and later). On Microsoft
Windows 2003/ 2008 Servers, software needs to be added in the Install Mode through the Control Panel >
Add/Remove Programs. Failure to use the Install Mode can prevent an application from working properly.

Select Start > Settings > Control Panel > Add/Remove Programs to open the Add/Remove Programs
dialog box.
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% add or Remove Programs M=l E3

Add a program From CD-ROM or Floppy disk
— L. Toadd aprogram From a CO-ROM or floppy disk, click CD or Floppy Gl
G F

Add programs From Microsoft

% To add new Windows Features, device drivers, and system updates over the Internet, click o e |

Windows Update

Add/Remove Programs

Select the CD or Floppy button on the Add/Remove Programs Properties dialog box to open the
Installation wizard. The wizard will prompt for the insertion of the ThinManager CD. When the CD is inserted,
the wizard will ask for the path to the setup program.
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Docu

Desktop

Y

Terminal Monitor Ackives

iy Documents

™

ty Computer

“

File name:

Open

Filez of twpe: ISetup Frogramsz

=
El

Cancel |
p

Install CD File System

The ThinManager CD has 4 folders.

Terminal ActiveX — This folder contains the Terminal Monitor Acti
documentation. See TermMon ActiveX Control for details.

Browse to the setup.exe file in the ThinManager folder to install ThinManager.

Documentation — This folder contains a copy of this documentation in *.pdf format.

veX and companion

ThinManager— This folder contains the ThinManager setup program.

WinTMC - This folder contains the WinTMC setup program. See WinTMC Installation for details.

Automation Control Products ThinManager 5.0 Help Manual

Installation of ThinManager e 30



Run Installation Program |

If thiz iz the comect inztallation program, click Finish, To
gtart the autamatic search again, click Back. Ta manually
zearch far the inztallation program, click Browse.

Open:

"FAThintanager hzetup.exe"’ Browsze. . |

¢ Back

Cancel |

Run Installation Program Window

Once the ThinManager setup program is selected, select Next to continue the installation.
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ThinManager Setup E

Welcome to the ThinManager Install Wizard

rd will ingtall Thinkd anager on your computer. T

THINMANAGER

=

ThinManager Setup Wizard

The ThinManager Setup Wizard will lead the user through the installation process.

Select Next to continue.
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ThinManager Setup

License Agreement
Ple ead the following lic

Automation Control Products
End-Uzer Licenzse Agreement

THIS IS & COMTRACT. PLEASE READ IT CAREFULLY BEFORE COMPLETING THE
INSTALLATION PROCESS AMD USIMG THE SOFTWARE. IF¥0U DO NOT AGREE /ITH
THE TERMS AWD COMDITIONS OF THIS AGREEMENT, ¥OU %/ILL MOT BE ABLE TO
IUSE THE SOFTWARE. IFY0OU DO MOT ACCEFT THIS AGREEMEMT AND HAVE PROOF
OF PAYMENT, vOU MAY RETURN THE UMUSED SOFTWARE TO THE LOCATIOMN AT
WHICH Y'0U ACQUIRED IT WATHIM THIRTY [30) DAYS FOR A REFUMND OF THE
LICEMSE FEE.

1. Drefinitionz
THINMANAGER [a] "Mat For Resale [MFR] Yersion' means a version of the Automation Contral Products
[ACP] Product, =0 identified, to be used for review and evaluation purpozes, only.
[b] "ACP" means Automation Contral Productz, Ine. and its licensars, i any.
[c] "Software' means the programs supplied by ACP herewith, and any and all updates

End-User Licensing Agreement

Read the End-User Licensing Agreement (EULA). If you agree to the conditions, select Yes to continue.
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ThinManager Setup E

Applications

. ThinServer Install
Thinkd anager Utiltiez

tliniation Folder

uired on [: 0 k.

InskallShield

Application Selection

The installation wizard will display the components of the ThinManager installation. Although ThinManager
appears to be a seamless program, it has two major components and utilities.

e ThinManager is the graphic user interface. It is installed to view and control the program.

e ThinServer is the engine that drives the program. It is a vital component that needs to be
installed with ThinManager to allow thin clients to boot and be configured. ThinServer is the
component that requires licensing. It is separated from ThinManager in the installation to allow
additional instances of ThinManager to be installed for remote administration.

o ThinManager Utilities includes tools like the touch screen calibration program. These utilities
need to be installed on every terminal server that have clients with touch screens connected to
them.

Note: If touch screens are being used with thin clients, the ThinManager Utilities program needs installed on
every terminal server to provide the Calibrate Touch program for connected thin clients.

The Browse button will allow the user to change the path to the folder where ThinManager will be installed.

Check the desired components and select Next.

Automation Control Products ThinManager 5.0 Help Manual Installation of ThinManager o 34



ThinManager Setup

Inztall Wizard Complete

Thinkd anager Installation is complete

THINMANAGER

rmmemm——

Installation Wizard Completion

When the wizard has finished select the Finish button.
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After Installation

after installation, pleaze click Hext.

Cancel

After Installation Dialog

After the ThinManager Setup wizard has finished, one needs to complete the installation through the
Microsoft dialog boxes.

Select Next to continue.

Finish Admin Install

When the ingtallation has ended [zuccessfully or nat),
pleaze click the Finizh button ar the Cancel button, DO

MHOT CLICK. THE BUTTOMS BEFORE INSTALLATIOMN
HaS EMDED!

< Back Cancel

Finish Installation

Select Finish to complete the installation.

ThinManager now needs licenses installed. See Licensing ThinManager for details.
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3.1.2 Windows Server 2008

Note: The installation of the latest Microsoft .NET Framework may require a restart.

It is a common practice to install ThinManager on a terminal server but ThinManager is independent of
terminal services and doesn’t need to be installed on a terminal server.

Applications on terminal servers need to be installed in the Install Mode. Open the Control Panel and click on
the Install Application on Terminal Server icon to start the installation wizard.

)

»
Install
Application an
Terminal
Server

Figure 1 - Install Application on Terminal Server Icon

Once the wizard begins navigate to the ThinManager SETUp . €xe program and continue with the wizard as
described in Licensing ThinManager. ThinManager will install a 32-bit version on 32-bit operating systems
and a 64-bit version on 64-bit operating systems.

The Install Mode can also be entered by typing change user /Zinstall atacommand prompt. You
can then run the setup . exe to install ThinManager.

Type change user /execute when finished installing to leave the Install Mode.

See Allow Inbound Traffic to Firewall for details on configuring the 2008 server to allow connections.

3.2 WIinTMC Installation

The WIinTMC program is a terminal client that is installed on a PC. When the WinTMC client is run it connects
to a ThinManager Server, receives its configuration, and then connects to a terminal server and launches a
session. The session is then displayed in the WinTMC client as a window or as a full screen, bringing terminal
server computing to PCs.

Note: Do not install WinTMC on a ThinManager Server. The two programs will compete over the 2031 port.

The WIinTMC client needs to be installed on each PC that it is run on.

Note: Although PCs don’t have as strict a requirement as terminal servers; it is a good idea to install the
WInTMC client using the Add and Remove Programs feature.

The ThinManager Install CD contains the installation for the ThinManager program and the WinTMC client. To
install the WinTMC client on a PC select Start > Settings > Control Panel > Add/Remove Programs to
open the Add/Remove Programs dialog box.
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% add or Remove Programs M=l E3

Add a program From CD-ROM or Floppy disk
— L. Toadd aprogram From a CO-ROM or floppy disk, click CD or Floppy Gl
G F

Add programs From Microsoft

% To add new Windows Features, device drivers, and system updates over the Internet, click wWindaws Update |

Windows Update

Add/Remove Programs

Select the CD or Floppy button on the Add/Remove Programs Properties dialog box to open the
Installation wizard. The wizard will prompt for the insertion of the ThinManager CD. When the CD is inserted,
the wizard will ask for the path to the setup program.
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Lok jn: [ () winTMC l & F =B

Docurnentation

L Terminal Monitar Ackives
by B ThinManager
Doc

Desktop

o

ky Documents

File narne: I j Open
- Cancel |
= g

Filez of tpe: ISetup Frogramsz

Install CD File System

The ThinManager CD has 4 folders.
e Documentation — This folder contains a copy of this documentation in *.pdf format.

e Terminal ActiveX — This folder contains the Terminal Monitor ActiveX and companion
documentation. See TermMon ActiveX Control for details.

e ThinManager— This folder contains the ThinManager setup program.
e WIinTMC - This folder contains the WinTMC setup program.
Browse to the setup.exe file in the WinTMC folder to install the WinTMC client.
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Run Installation Program |

If thiz iz the comect inztallation program, click Mesxt. To start
the autoratic zearch again, click Back. Ta manually
zearch far the inztallation program, click Mest.

Open:

tandardsCD [nstallyi | EXE Browse. . |

¢ Back I Hest > I Cancel

Run Installation Program Window

Once the WIinTMC setup program is selected, click the Next button to continue with the install.
WinTMC Setup |

Welcome to the InstallShield Wizard for WinTMC

The InstallShield “Wizard will ingtall WinTkC an your
computer. To continue, click Mest.

% Back

Cancel |

WIinTMC Setup Wizard

The WinTMC Setup wizard will launch. Select Next to continue.
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WinTMC Setup |

License Agreement %«

Pleaze read the following license agreement carefully. l % -

Prezs the PAGE DO key to zee the rest of the agreement.

|!f1'-.ut|:|mati|:|n Control Products 3
End-Uzer Licenze Agreement

THIS IS A CONTRACT. FLEASE READ IT CAREFULLY BEFORE COMPLETIMNG THE
IMSTALLATION PROCESS AMD USING THE SOFTWARE. IF ¥'0U DO NOT AGREE
"WITH THE TERMS AND COMNDITIOMNS OF THIS AGREEMENT, wOU WALL MOT BE
ABLE TO USE THE SOFTWARE. IF v0OU DO NOT ACCEPT THIS AGREEMENT AND
HaWE PROOF OF PAYMENT, vOLU MAY RETURK THE UNUSED SOFTWARE TO
THE LOCATIOMN AT WHICH Y0U ACQUIRED IT WATHIM THIRTY [30] D&YS FOR A

REFUUMD OF THE LICEMSE FEE. ;I
Do pou accept all the terms of the preceding License Agreement™? [F pou Frint |
zelect Mo, the zetup will close. Taoinstal %inT MC, vou must accept this o
agreement,
| rigkalShield
< Back Yes Hao |

License Agreement

Read the End-User License Agreement (EULA). If you agree with the conditions select Yes to continue.

WinTMC Setup |
Choose Destination Location %
Select folder where setup will install files. I i TR

Setup will ingtall WinT T in the following folder.

T inztall to this folder, click Mest. Ta install ta a ditferent folder, click Browse and select

another folder.
Destination Faolder
|7D:'x..."-.-'1‘-.ut|:|matiu:un Caontral ProductzihfinT kM Browse... |
[rztallEhield

Cancel |

Choose Destination Location
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The Browse button will allow the user to change the path to the folder where the WinTMC client will be
installed.

Select Next to continue.

WinTMC Setup

Select Features
a™

Select the features you want ta install, and deselect the features vou do not warnt to inztall,

Select the features setup will inztall

inTkAC — Description
WinTMC Shadow Service 0k
Space Required on D 0K
Space Available on D 4717360 K
| retallShield
< Back Hest » | Cancel |

Feature Selection

The WinTMC installation program has two options.
e WIinTMC - This is the client application that needs to be installed to use the client.

e WIinTMC Shadow Service - This optional program allows the PC to be shadowed from within
ThinManager by authorized users.

Note: The WinTMC Shadow Service will function even when the WinTMC isn't active.

Select the Next button to continue with the WinTMC installation.
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WinTMC Setup |

Inztall5hield Wizard Complete

The InstallShield Wizard haz successfully installed WinT MC.
Click Finizh to esit the wizard.

Eancel |

WInTMC Installation Completion

When the wizard has finished select the Finish button.
After Installation |

After installation, pleaze click Mext.

¢ Back

Cancel |

After Installation Dialog

After the WinTMC setup wizard has finished, one needs to complete the installation through the Microsoft
dialog boxes.
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Select Next to continue.

Finish Admin Install |

When the installation has ended [zuccessfully or not),
pleaze click the Finizh button or the Cancel button. DO

MOT CLICK THE BUTTOMS BEFORE INSTALLATIOM
Ha5 EMDED!

< Back

Canicel |

Finish Installation

Select Finish to complete the installation.
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4Licensing ThinManager

4.1 ThinManager Licensing

ThinManager 5.0 introduced changes in licensing.

Master Licenses — Each ThinManager Server or synchronized pair of ThinManager Servers use a single
Master License to contain the product licenses. Product license codes of individual license components are
added to the master license. When the master license is activated the product licenses are included in the
activation and a single master license file is downloaded, containing the functionality of the member
component licenses.

The master license can be for a single ThinManager Server or for a Mirrored Redundant pair of ThinManager
Servers, or a fully redundant pair of ThinManager Servers, depending on the component licenses. See
Redundant ThinManager Servers for details on Stand Alone, Mirrored, and Fully Redundant systems.

4.1.1 Standard Licensing

Product Licenses — Product licenses are the licenses that are added to the Master License to provide the
needed functions. The Product Licenses are:

e Terminal Connection License — This is the main product license that allows a terminal to
receive its configuration. It is needed by every terminal.

e MultiMonitor — This product license, with a Terminal Connection License, allows a specialized
thin client to use up to five monitors on a single thin client. See MultiMonitor for details.

e WIinTMC - This product license, with a Terminal Connection License, allows ThinManager to
manage the RDP connection and terminal services experience of a PC. See WinTMC Fat Clients
for details.

e TermSecure — This product license enables additional security features for users. It can be used
to grant them special access to hidden applications or allows access to a user’s application from
any terminal in the system. See TermSecure for details.

TermSecure licensing is per-user licensing. Each instance of ThinManager will install with
licensing for five users of TermSecure included. Additional TermSecure product codes can be
purchased to increase the number of TermSecure users beyond the initial five users.

Components included in the ThinManager Terminal Connection Licenses include:
e MultiSession
e SmartSession

e Instant Failover
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¢ Redundant Ethernet

e Share Keyboard and Mouse

4.1.2 XLi Licensing

XLi Licenses are added to a master license the same way as standard licenses. XLi licenses include all
features from the standard licenses plus MultiMonitor, WinTMC, Term Secure, and PXE Boot.

4.1.3 Master License Advantages

The use of a Master License means that there is one license for the ThinManager Server. You only need to
activate and transfer one master license if you need to decommission an old ThinManager Server and build a
new one.

New license components get added to the master license and the master license is re-activated and re-
applied to the ThinManager Server.

4.2 License Activation

4.2.1.1 Installation

Install ThinManager on a computer, or on two computers if you have redundant or mirrored Terminal
Connection product licenses.

See Installation of ThinManager and Redundant ThinManager Servers for details.

4.2.1.2 Synchronization
Synchronize the ThinManager Servers if you are using redundancy or mirrored redundancy.
See Automatic Synchronization for details.
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4.2.1.3 Online Activation

Go to www.thinmanager.com and follow the links to the License Activation to activate the license.

@—\:-\ L |g https: //szcure, randombytes, com  TM40_License] j[_%_J "‘) | A | I-.l Google |2 .;:
J File Edit “iew Favorites Tools  Help J X %Convert = @Select
T & index page J {fﬁ - o

ThinManager Licensing

Not logged in ThinManager License Activation

Login

N‘;gw User Welcome! You may activate your ThinManager licenses from this site by logging in
with your ThinManager user name & password that was emailed to you from
licensesigacpthinclient com.

This system can be used to activate licenses for ThinManager version 4.0 and
newer. If you are running an older version of thinmanager, please visit
https:iisecure.randombytes.com/TM_License/ to activate your licenses

NOTE: Software must be registered to the END USER. If you are an integrator or
distributor, enter the company name and location where this license is being
activated.

Ifyou do not have a username & password click on Mew Userto create an
- account.

] If you have forgotten your user name or password click here to receive a Passcode
i via e-mail.

[T T T T T @ internet [73 = [#o0 ~

License Activation Site

Login with an existing account or use the New User link to create a new account.
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4.2.1.4 New Account

An account can be created on the license site by selecting the New User link.
{= New User Registration - Windows Internet Explorer
6@ - |g| https: | /secure randombytes com/TM40_LicenseMNewlser j\él |E] |E] I;’ Google |EE|
| Ele Edt view Favorites  Tools  Help | % @comvert - [ Select

'{i‘ @New User Reqgistration J '& X -

ThinManager Licensing

Not logged in Create a new User Account

Login Please enter your email address.
New User

Submit | Reset

ThinManager Home | ThinManager Original License Site | Licensing Tech MNotes

T T T T [@mteme [ - [®i100% - 4

New User Entry

Enter your e-mail address to start the creation process.
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(_ Mew User Registration - Windows Internet Explorer

@\:: - |g, https://secure randombytes.com/THM40_License/Mewl ser j ﬁ (¥4 % | ﬁ Google FElle
J File Edit Wiew Favorites Tools  Help J X lié-;‘g(jonw'ert - @Select

" »
& 3 @New User Registration J ‘& b

ThinManager Licensing

Mot logged in New User Information Form

Login
MNewr liser
New Uses Please take a moment to complete the registration form below. After your submit the completed form,
you'll automatically be emailed your user name along with an assigned password from
licenses@acpthinclignt.com.

Please enter User Information

User Hame paul@paulburns.com

First Hame |Pau|

Last Hame IBurnS

Company |ACP

Title IDirectorofEducatjon

| Address 1 |4IJBD MeGinnis Ferry Rd

Address 2 |Suite a01|

ritu |

Done |_|_|_|_|_|_|@ Internet [#3 - [®Roee - 4

New User Information Entry

Enter the required information and select the Submit button.

A password will be sent to the e-mail address that allows access to the site.
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4.2.1.5 Login to Site

Select the Login link to enter the site.

(_ Thinmanager License Login - Windows Internet Explorer

@_:_‘; b |g, https: | fsecure randombytes com/TM40_License,/Login jLﬂ ':"f-' A I-" Google
| Ele Edt view Favorites  Tools  Help | % @comvert - P Select

{ z »
50 & Thinmanager License Login J ‘& -

ThinManager Licensing

Not logged in ThinManager License Activation Login

Login

e e Enter your ThinManager user name & password that was

emailed to you from licenses@acpthinclient.com. Once you
log in, you may download your ACP Activation License file.

User Name /| Email

Address Iname@yourdomain.com

Password IIIII-I-I-I-I
Login |

Do you need help logging in? i
| 3m anew user.
| forgot my username or password.

T T T T T [@rmterme [a - [R100% - 4

Login

Enter the e-mail address used in the creation of the account. Enter the password that was sent to that
account to login to the site. Select the Login button.
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{= main - Windows Internet Explorer

@;: - Iii, https:/isecure randombytes.com/THM40_License/main j ﬂ ;_“' S X I_l Google

J File Edit Wiew Favaorites Tools Help J X l%Convert - @Select

'i',:? ‘_'émain J ‘& 2 o
B

ThinManager Licensing

Logged In: Thank you for logging in.
name@yourdomain.com
You may activate your ThinManager license by downloading your ACP License file
by clicking on Activate Master License. You may also change your accoeunt
information by clicking on Lanage Account. And you may view a history of your
account activity by clicking on History.

Logout

User

Manage Account

Create Master License
Manage Master Licenses
Activate Master License

History

I—l_,_,_|_|_|@ Internet [%a - | R 100%

License Site Main Screen

The ThinManager Licensing site has a sidebar with 6 functions:

e Logout — This will log you out of the site and end your session.

e Manage Account — This allows you to change the details of the account, like address and phone
number. It also has a link that allows you to change the password to one of your choosing.

e Create Master License — This creates the Master License that acts as a shell or container to
hold the individual license product codes.

e Manage Master License — This allows you to add the product license codes of the individual

license components to the master license.

Activate Master License — This allows the master license to be activated and downloaded for
installation.

History — This shows the history of actions taken by the user.
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4.2.1.6 Creating a Master License

Select the Create Master License link to initiate the creation of a master license.

f'l:reate a master license form - Windows Internet Explorer

I i 1
@\:‘»/ - |g, https:,l'll'secure.randombytes.u:-:rnll'TM4D_Liu:ense,l'MasterLi-:ensell'Creajl ﬂ |;""?-5 A I-" Google | 2=

J File Edit Wiew Favaorites Tools

Help

JX %Convert - @Select

S0 @create a master license Form

R mEmE mmow om o m m oy ——

Logged In:
name@yourdomain.com

Logout

User

Manage Account

Create Master License
Manage Master Licenses
Activate Master License
History

Server Name /
Server Description

Site Description
Company Name
Company Address
City

State

Zip/Postal Code

Country

License Redundancy (" Full Redundancy

e — gy

[View Licenses] [Create Hew] [Activate]

[acp

|4DBD McGinnis Ferry Rd Suite 801

|Alphareﬂa

[GA

{30005

jusA

¥ Hone )

" Mirrored Redundancy

Submit |

T T T T [@mtene [ - [®100% - 4

Create Master License

Enter a description of the license for your usage in the Server Name/Server Description field.

Select the redundancy level that matches the redundancy level of your Terminal Connection product license
and select the Submit button.
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(:“Ereate a master license form - Windows Internet Explorer

sy - - - [
@:_: - |g, https.,l',l'secure.randombytes.com,l'TM4D_L|cense,l'MasterLlcense,l’Creaj %

IT=] 3

| ﬁ Google

J File Edit Wiew Favorites Tools  Help

JX %Convert - @Select

0 & Create a master license Form

ThinManager Licensing

Logged In:
name@yourdomain.com

Logout

User

Manage Account

Create Master License
Manage Master Licenses
Activate Master License
History

[View Licenses] (L caie [ev] [Activate]

1111-2222-3333-ABCD
Production Servers

License Number
Description
ThinManager Title Bar Description
Company
Address

City

State

Zip/Postal Code
Country
Redundancy
Has Support

ACP

4080 McGinnis Ferry Rd Suite 801
Alpharetta

GA

30005

USA

none

Mo

Ll

it I_l_’_,—l—’_|eI I‘nter;'let- =

|v§. - | E

100% -

&

Master License Information

The site will create a master license and display the information for you. It is useful to print this page for your

records.
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4.2.1.7 Manage Master Licenses

Use the Manage Master License link to add product licenses to the Master License.

( ¥iew Master Licenses - Windows Internet Explorer

@?} - |;g, https:,l'll'secure.randombytes.u:-:mII'TMﬂrD_Liu:ense,l'MasterLicensell'Mastj ﬂ ""f PI

| Ele  Edt view Favorites  Tools  Help | % @comvert - [ Select

’ »
0 & view Master Licenses J ‘& =

ThinManager Licensing

Logged In: [View Licenses] [Create Hew] [Activate]
name@yourdomain.com
Logout View Master Licenses

User Master License i Creation
Humber Description Date
Manage Account

Create Master License Download Add Product Edit 111222 333.88CD | Spare 121032009

Manage Master Licenses |Fie License License
Activate Master License
History

Done [T T T [T [@unternet [%5 - [®ioee -

View Master License

Selecting the Manage Master License link will display the master licenses.

e Download File — This link will download the master license file once the product codes of the
component licenses are added. The Master License needs to be activated before downloading. If
this link is selected before activation it will prompt for activation.

See Download the Master License for details.

e Add Product License — This link will allow a product code of a license to be added to the master
license.
See Add Product License for details.

e Edit License — This link allows the descriptions of the master license to be edited.

e Master License Number — This link displays the master license details.
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4.2.1.8 Add Product License

The Master License needs the product license codes of the component licenses to be added to the master
license. This is done by selecting the Add Product License link of the Manage Master License page.

ﬁindeu_html - Windows Internet Explorer =
——
~

| r
@ o Ié, https:,l'll'secure.randombytes.u:-:rnll'TM4D_Liu:ense,l'MasterLi-:ensell'Mc-diji %J b [ 8 I-" Google
| Fle Edit wiew

Favorites  Tools Help

2=
JX %Convert - ESelect
i & index_html

ThinManager Licensing

Logged In: [View Licenses] [ roaie Hew [Activate]
name@yourdomain.com

Add License to Master License '1111-2222-3333-ABCD'
Logout

The License Number was provided with the ThinManager software. It should be on the

inside, left of the CD case. Ifitis missing, please contact your distributor. This number must
be typed in exactly as shown, with no spaces before or after it.

Activate Master
History

License Number |

Submit |

Daone

b
[T T T T @ meere

[“3 - [®me - 4

Add Product Code Window

Enter the product license code (license number) of the component license to the License Number field and
select the Submit button.
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{= Results - Windows Internet Explorer [_ Ol

G;@ - |g| https:,l',l'secure.randombytes.com,l'TM4D_License,l'MasterLicense,l’Modij 5 El |E| IEGDDQIB |F‘ bt
J File Edit Wiew Favorites Tools  Help J x %Convert - &Select
"I:E @Results J ‘& 2 i

ThinManager Licensing

Logged In: [View Licenses] [Creaie Hew! [Activate]
name@yourdomain.com

Logout Product License 4444-5555-6666-7777 added to Master
License 1111-2222-3333-ABCD

User

Manage Account

Create Master License
Manage Master Licenses
Activate Master License
History

I_l_,_|_|_|_|“ Internet [a - [R100% - 4

Add Product Code Result Window

When a product code of a license is successfully added to the master license the web site will show a
confirmation message.

Enter as many product codes as you have licenses to add to the master license.
The master license will need activation and downloading after each group of product licenses are added.

Automation Control Products ThinManager 5.0 Help Manual Licensing ThinManager e 56



4.2.1.9 Redundant Master License with Non-Redundant Product Licenses

If you have non-redundant Terminal Connection Licenses you can add them to a mirrored or fully redundant
master license. When you add the product license it will ask which ThinManager Server you want to apply the
license to. Apply half to the Primary and half to the Secondary.

ThinManager Licensing

Logged In: [View Licenses] [Create New] [Activate]

ul ulburns.com
pauigpa Select the target server for this product license
Logout
This master license is redundant or mirrared, and the product license is not. You must pick
User the server an which the product license will be installed
Manage Account
Create Master License
Add Product License

Master License Number ABCD-1234-ABCD-5678
‘ Besary. License Number 12345678-12345678
Target Server " Secondary
Supper
Tech Support

Stand-alone License on a Redundant ThinManager Server

Once the product licenses are assigned to the target server it can be activated and applied.
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ThinManager Licensing

Logged In: [View Licenses] [Create New] [Activate]
Pai@pauibims.com License Details
Logout
| License Number | 51BC-CA72-C4AAE167
=2 Server
Manage Account Description Demo_Redundundacy

Create Master License - —
Add Product License | Site Description
Activate Master License

Manage Master Licenses |{Zreated |':|‘”2':”2':I11
History |{2reated By | paul@paulburns.com
| | City/State | Alpharetta/GA
Support
| | Disabled NO
Tech Support i
Activate Limit |1
| Support | Mane
|Deacription | Demo_Redundundacy
| Redundancy | full

| [Edif] [Delete] [Remove Product License]

Product Licenses
| Product License | Type |{2crunt |Redundanc1,r | Primary | Secondary |‘u’ersion
| 12345678-12345673 |Termina| Connection License | 5 | nane | Walid | Invalid | 4.0
| 37634321-876343521 |Terminal Connection License | 5 | none | Invalid | Valid | 4.0

Stand-alone License on a Redundant ThinManager Server

Stand-alone Product Licenses applied to the Primary will show “Valid” for the Primary and “Invalid” for the
Secondary, and visa versa.
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42.1.10 Activate the Master License

The Master License needs activated and downloaded once the product license codes of the component
licenses have been added to the master license. This is done by selecting the Activate Master License link
of the Manage Master License page.

ff;'m:tivate Master License - Windows Internet Explorer

F ) - . .= bq |3 | [® o[-
6‘\_—: - Ié, https.,l',l'secure.randombytes.u:-:m,l'TM4D_L|u:ense,l'MasterLlcense,l’P.-:twJ % "f 3( I l Google P J
J File Edit Miew Favorites Tools  Help J x %Cnnvert - @Select

" »
o @nctivate IMaster License J % %

ThinManager Licensing

Logged In: [View Licenses] [Create New] [Activate]

paul@paulburns.com . .
Activate Master License
Logout

Enter a master license number or pick from the list

User

Master License Humber I
Manage Account

Create Master License
Manage Master Licenses Master License Number Creation Date

Activate Master License
History | 0E63-1630.7141.28AF | Spare | 1210312009

Submit |

| |_|_|_|_|_|_|@ Inkernet

Y 00% v

Activate Master License Page

Selecting the Activate Master License link will display the Activate Master License page with a list of all the
master licenses that are registered to the person logged in.

Select the master license from the table or enter the master license number into the Master License Number
field and select the Submit button.
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ﬁ' Activate Master License - Windows Internet Explorer

— .
@ y v IE https:,I',l'secure.randombytes.com,I'TM‘ID_License,I'MasterLicense,l'nctivateLicense?Iic_nljl % ] | % I-‘l Google

J File Edit ‘iew Favaorites Tools Help JX %Convert - @Select

Logged In: [View Licenses] (L ]

L“"’"?""””""’““ e Activate Master License 1111-2222-3333-ABCD
ogou

Enter the Installation Id for the Master License Activation

The Installation ID is the number from the bottomn of the Licensing dialog in ThinManager. Select Install-=Licenses to
display the Licensing dialog. This number must be typed in exactly as shown.

Primary
Installation
D

Secondary
Installation
D
Site I
Description

Company
e jacp

mg:g? 14080 McGinnis Ferry Rd Suite 801

Country  |USA

Submit |

city [Alpharetia state [GA e [ooos

-

Done [T T T T [ emntermne: [¥5 - [Rioow -~ 4

Activate Master License Page

Activation requires the entry of the Installation ID of the ThinManager Servers that the master license will be

installed on.
The Installation IDs will need to be added each time the Master License is activated or re-activated.
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censing

bl azter License Mumber I

Licengze Mumber | Dezcription | Location | Redundancy | E wpiration
J | H
— Installation Id
GREEN [primary] | BEEE-A L84 BEBE-1111-2222-3333
TSE4E I 4444 BREE-CCCC-DDDD-1111-2222

|nztall Licensze Delete License | Dretails Inztall Demo Code Show Old Licenses

ThinManager Licensing Window with Installation IDs

The Installation IDs are shown on the Licensing window that is launched by selecting Install > Licenses
from the ThinManager menu.

Enter the required installation IDs into the Primary Installation ID field (and the Secondary Installation ID
field if needed) on the Activate Master License page of the License Activation web site.

Select the Submit button to finish the activation.
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421.11 Download the Master License

Download the master license by selecting the Manage Master Licenses link from the main menu.

(_ ¥iew Master Licenses - Windows Internet Explorer

6@ - |g, https:,l'll'secure.randombytes.u:-:mII'TMﬂrD_Liu:ense,l'MasterLicensell'Mastj % |"__f| |E| I'!.' Google |P '|
| Ele Edt Wiew Favorites Tools  Help | % @& convert - [ Select
'i',:'? g‘v‘iew Master Licenses J '& % <

ThinManager Licensing

Logged In: [View Licenses] [Create Hew] [Activate]
name@yourdomain.com
Logout View Master Licenses

User Master License i Creation
Humber Description Date
Manage Account
Create Master License Download Add Product i

Manage Master Licenses | File License 111-222-333-ABCD | Spare 12/03/2009
Activate Master License
History

Done i [T T T [T [@unternet [%5 - [®ioee -

View Master License

Select the Download File link for the master license.
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f'duwnluad - Windows Internet Explorer [ [O] =}

@\‘_‘ * |g https:,l',l'secure.randombytes.com,l'TM4D_License,l'MasterLicense,l'.D.ctivat-j 2l X -‘l Gongle 2=

J File Edit “iew Favorites Tools  Help JX lEﬁ?:j(:on\-'ert - @:Select

95 & download

ThinManager Licensing

Logged In:
name@yourdomain.com

Click the link below to download the license file.
Logout

TM_License1111-2222-3333-ABCD.lic

Mote: Some web browsers will change the name ofthe file as itis saved to the disk
The filename must be kept the same as shown above. Otherwise, ThinManager may not recognize the
licensze file.

=]
[T T [@mteme %5 - [Hies -

Master License Download

Select the link on the page to start the download.
File Download |
Do you want to save this file. or find a program online to open
it?
Mame: Th_Licensel111-2222-3333-ABC0 lic

Type: Unknown File Tvpe, 1.68KE

From: secure.randombytes.com

Eind Save i LCancel

harm your computer, |f pou do not st the source, do not find a

I '?- | wWhile files from the Intermet can be uzeful, some files can potentially
L program ko open this file or zave thiz file. What's the nzk’y

File Download Window
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The download will begin and prompt you to save the file. Do not save it directly into the ThinManager folder
but save it to a folder that is accessible from ThinManager.

4.3 Adding a Master License to ThinManager

Licenses are added to ThinManager Servers by selecting Install>Licenses from the ThinManager Menu.
lcensing ]

bl azter License Mumber I

Licengze Mumber | Dezcription | Location | Redundancy | E wpiration

< | B

— Ingtallation Id

GREEN [primary) | BE66-4444-BBBE-1111-2222-3333

|nztall Licensze Delete License | Dretails Inztall Demo Code Show Old Licenses

Licensing Window — Single ThinManager Server

Single, unsynchronized ThinManager Servers will display the Installation ID for the local ThinManager Server.
lcensing |

bl azter License Mumber I

Licengze Mumber | Dezcription | Location | Redundancy | E wpiration
4| | B
— Installation Id
GREEN [primary] | BEEE-A L84 BEBE-1111-2222-3333
TSE4E I 4444 BREE-CCCC-DDDD-1111-2222

|nztall Licensze Delete License | Dretails Inztall Demo Code Show Old Licenses
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Licensing Window — Single ThinManager Server

Synchronized ThinManager Servers will show the Installation IDs for both redundant ThinManager Servers.
See Automatic Synchronization for details.

Select the Install License button to launch a file browse window.
Open K E3
Lok, in: I I 40_GreenLicenze j da £ Ef-

File name: ITMLicense_'I 111-2222-3333-4BCD lic dpen I
Files of bype: IThinManager Lizense Files j Cancel |

[~ Open az read-only

&

File Browser for License Files

Browse to the folder that the master license is saved in. Highlight the master license and select the Open
button to install the license.

censing

bl azter License Mumber |1111-2222-333-AEICD
Licengze Mumber | Dezcription | Location | Redundancy | E wpiration
4444-5555-5555-}'}'?? Terminal Connection Redundant License GREEM.TSE4E full Mewer
ARARA-BEEE-TTTT-2888 WinTMC Connection Redundant License GREEM.TSE4E full Mewer
1] | B
— Ingtallation Id
GREEN [primary] | BEEE-A L84 BEBE-1111-2222-3333
TSE4E I 4444 BREE-CCCC-DDDD-1111-2222
|nztall Licensze Delete License | Dretails Inztall Demo Code Show Old Licenses

Licensing Window with Licenses Installed
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The master license will be displayed in the Master License Number field. The product code of each
component license will be displayed in the license window.

4.3.1 Delete License
The Delete License button will delete the Master License.

Delete License

Are vou sure you wank to delete this master license?

Delete License Prompt

Selecting the Delete License button will open a Delete License window. Selecting Yes will delete the license
while selecting No will cancel the deletion and close the window.
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4.3.2 License Details

The License Details button will open the License Details window with information about the Master License.

License Details |
maszter license | [icense achivator I [icense owner I
Froduct Thinkd anager =
Yerzion 3
b aszter Licenze Mumber  1111-2222-3333-2BCD
Frimary Inztall 1D GEGG-A224 BEEBE-1111-2222-3333
Secondary [nstall 1D d444-p000 CCCC-DODD-1111-2222
lzzue Date 1240342009
Reazon
Company ACP |
Location Green/TSE4R
Address 4080 kMecGinnig Ferry Bd Suite 801
City Alpharetta
State G hd

Master License Details

The License Details window shows information about the master license, the activator of the license, and the
owner of the license on the Master License, License Activator, and License Owner tabs.

4.3.3 Install Demo Code

The Install Demo Code button will open the Install Demo Code window and allow a user to add a demo
code to give ThinManager temporary functionality.

Install Demo Code |

Wigit wivw thinmanager. com to receive a demo code. You
will need the installation id from T hinkd anager.

Cancel |

Enter the demao code from the Thinktdanager.com webzite

Install Demo Code Window

A Demo Code gives ThinManager temporary functionality, normally for 30 days.
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4.3.4 Show Old Licenses

The Show Old Licenses button will show ThinManager 3.X licenses in a Licenses Not Included in Master
License window.

Licenzez Mot Included in Maszter Licenze |

Lizenze Mumber | Description |
123456758-1 2345675 Enterprize Site Pluz Licenze
ABCDEFD-1 2345675 TemSecure License
11223344-2BCDEFD WinTHC Connection Licenze

Not Included in Master License Window

The Not Included in Master License window shows licenses installed in previous versions on ThinManager
before the upgrade to ThinManager 5.

4.4 WIinTMC Licenses

Each WIinTMC requires a Terminal Connection License and a WinTMC License. The product license code for
the WIinTMC is added to the master license like other product license codes as described in License
Activation.

4.5 TermSecure Licenses

TermSecure is licensed on a Per-User License. Each ThinManager Server installation comes with a 5-user
TermSecure license. This allows you to try and use TermSecure with ThinManager before buying.

Additional user licenses for TermSecure can be purchased and added to the master license as described in
License Activation.
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4.6 Upgrading to ThinManager 5 from Older
ThinManager versions

Start the activation process by going to https://secure.randombytes.com/TM40_License. See Online
Activation for details.

Login to the license site. Create an account as needed. See New Account for details.

Select the Create Master License link to create a new Master License. See Creating a Master License for
details.

Select the Manage Master License link to view the master license. Select the Add Product License link and
add each of your current Product License Numbers to the newly created Master License. See Add Product
License for details.

The ThinManager 3.X Product License Numbers can be found by selecting Install > Licenses > Show Old
Licenses in ThinManager. See Show Old Licenses for details.

Activate the Master License once all the product codes are added. Select the Activate Master License link to
activate the master license. See Activate the Master License for details.

Once the Master License is activated it need to be downloaded and installed in ThinManager. See Activate
the Master License; Download the Master License, and Adding a Master License to ThinManager for details.
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5Redundant ThinManager
Servers

5.1 Redundancy Overview

ACP uses the term Failover to describe having two or more terminal servers that the thin clients can
connect and run a session from.

ACP uses the term Redundancy to describe having two or more ThinManager Servers that the thin clients
can connect and receive a configuration from.

ThinManager can be installed in three modes:
e Single ThinManager Server
e Full Redundancy
e Mirrored Redundancy

Single ThinManager Server — No Redundancy: A system with a single ThinManager Server will have all the
terminals boot from that computer, receive their configuration, and then connect to the assigned terminal
servers. If the ThinManager Server fails the terminals will continue to function as designed because they hold
their configuration in memory. If the terminal reboots it will be unable to connect to the failed ThinManager
Server and will not receive their configuration or connect to a terminal server until the ThinManager Server
comes back online.

Full Redundancy — Two ThinManager Servers: A fully redundant system has two licensed ThinManager
Servers that are synchronized with the same configuration on each. The thin clients are configured to boot
from either ThinManager Server to receive their configuration. If the primary ThinManager Server fails the
terminals will continue to function as designed because they hold their configuration in memory. If the terminal
reboots it will be unable to connect to the failed primary ThinManager Server but will switch and boot from the
secondary ThinManager Server and will receive the configuration and connect to a terminal server.

Mirrored Redundancy — Two ThinManager Servers: This is a form of redundancy that is controlled with a
mirrored license. You use two synchronized ThinManager Servers that the terminals can boot from as in a
fully redundant system. The difference is that administrative functions like shadowing and configuration
changes are limited to the primary ThinManager Server.

Mirrored redundancy is a means to provide a redundant ThinManager Server at a lower cost. It provides a
backup ThinManager Server to keep production running until a replacement can be found for the primary
ThinManager Server.

Note: All Enterprise licenses include Full Redundancy.
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5.1.1 Redundancy Differences
No Redundancy - Single ThinManager Server

Least expensive.

If the ThinManager Server fails the thin clients continue to run from their configuration loaded
into RAM.

If the thin client reboots the thin clients cannot retrieve their configuration until the
ThinManager Server is restored.

The Master License is created with “None” for its redundancy.

Mirrored Redundancy- Two ThinManager Servers

Provides redundancy at a lower cost than full redundancy.

If the ThinManager Server fails the thin clients continue to run from their configuration loaded
into RAM.

Configuration changes can be made only on the primary ThinManager Server. If it fails the
thin clients are able to retrieve their configuration from the backup and run as configured.
Configuration changes must wait until the primary ThinManager is restored.

The Master License is created with “Mirrored Redundancy”. It uses Mirrored Terminal
Connection Product Licenses.

Full Redundancy - Two ThinManager Servers

If the ThinManager Server fails the thin clients continue to run from their configuration loaded
into RAM.

If a ThinManager Server fails, the other ThinManager Server will provide configuration.
The ThinManager configuration can be changed on either ThinManager Server at anytime.
Requires a duplicate set of licenses on the backup ThinManager Server.

The Master License is created with “Full Redundancy”. It uses Redundant Terminal
Connection Product Licenses.

5.2 Creating a Redundant Pair of ThinManager Servers

To create a redundant pair of ThinManager Servers:

1.
2.

Install ThinManager on two computers. See Standard ThinManager Installation.

Configure the thin clients on the primary ThinManager Server. See Terminal Configuration
Wizard.

Synchronize the two ThinManager Servers. See Synchronize Configuration[Help73].

Create a Master License with Full Redundancy and add a Redundant Terminal Connection
Product License or add two Terminal Connection Product Licenses and apply one to the
Primary ThinManager Server and one to the Secondary ThinManager Server. See
ThinManager Licensing for details.

Configure the thin clients to boot from two ThinManager Servers using the DHCP server or
static IP addressing. See DHCP Server Setup or Configuring New Hardware.

See Licensing ThinManager for details about Redundant License activation.
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5.3 Creating Mirrored Redundancy

Mirrored Redundancy provides redundancy at a reduced cost from full redundancy.

To set up Mirrored redundancy:

1.
2.
3.

Install ThinManager on two computers. See Standard ThinManager Installation.
Synchronize the two ThinManager Server. See Manual Synchronization.

Create a Master License with Mirrored Redundancy and add a Mirrored Terminal Connection
Product License to the Master License. See ThinManager Licensing for details

Configure the thin clients on the primary ThinManager Server. The configurations will be
transferred to the secondary ThinManager Server. See Terminal Configuration Wizard.

Configure the thin clients to boot from two ThinManager Server using the DHCP server or
static IP addressing. See DHCP Server Setup or Configuring New Hardware.

Administrative functions like changing configuration or shadowing can be only performed on the primary
ThinManager Server. If the primary fails the thin clients will continue running from their configuration stored in
memory. If they reboot they are able to retrieve their configuration from the backup and run as configured.
Configuration changes must wait until the primary ThinManager is restored.
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6 ThinManager Interface

6.1 Opening ThinManager

ThinManager is used for the configuration of Thin Clients in the ACP thin client environment.

ThinManager can be started using any of the traditional Windows methods, based on the administrator's
preference:

e Run from the Start Menu, Start > Programs > \Automation Control Products > ThinManager.

e Run from the Run line, Start > Run > C:\Program Files\Automation Control
Products\ThinManager\ThinManager.exe (default path).

e Run from a command prompt, C:\Program Files\Automation Control
Products\ThinManager\ThinManager.exe (default path).

e Run from a shortcut on the desktop.

e Run from a ThinManager icon in the system tray, if this option is selected in View > Options from
the menu bar.

e Run from Windows Explorer.

Note: ThinManager can be run on a terminal with full privileges if the user is an administrator or a member of
the ThinManager Administrator's group. See ThinManager Server Configuration wizard for details on
ThinManager User Groups.
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6.2 ThinManager Graphic User Interface
=10l |

Edt Manage Install Tools Yiew RemoteView Help Menu Bar

gy
W Configuration | Licensesl F'r-:upertiesl "v"ersi-:unsl S_I,Inu:hru:unizatinnl Ewvent Lu:ugl Report ITElhﬁ
(- 9 Termninals

ﬁ Display Servers
[ 5] vCenter Servers

|:| Display Clients
ﬂ Termsecure Lisars Unknown Terminal Configuration

FRequire Pazsword for Unknowe terminals

Attribute | " alue -

M ame TMEerver

&llows Autarnatic Terminal Creation YES
Autarnatic Terminal Creation Mask ButaT erm
Alloww OFf-line Aeplacement YES
Tree Pane —
SMTP Server
Think anager Server Start/Stop
Terminal Server Data Connection Detail Pane
Terninal On/Of b

Terminal Configuration Change
Irmztall Firnware

Imztall TermCap

Inztall License
SMTP server
E-mail Addresses MNone
Teminals o receive messages Mone _ILI
4| | v
Far Help, press F1 Status Bar Comm Indicator Bl 2

ACP ThinManager Graphic User Interface

The ThinManager administrative interface provides "at-a-glance management". The groups and terminals are
displayed in the tree pane. The configuration data is displayed in the detail panel. Color-coded icons in the
tree pane show the on-line status of terminals.

The sections of the ThinManager interface include:
e ATitle Bar with the standard Windows Minimize/Maximize/Close shortcut icons.
e A Menu Bar with commands.

o A Tree Pane with an expandable/collapsible tree showing the Terminals, Display Servers,
Display Clients, TermSecure Users on the ThinManager Server. Terminals that are on-line have a
green monitor icon, while stopped or rebooting terminals have a red monitor icon.

e A tabbed Details Pane with information about settings and configurations. The blue group icon
denotes a property that was obtained from the group. The details pane is tabbed for organization.
The tabs that are shown depend on the tree item that is highlighted.
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e A Status Bar that shows advice and tips.

e The Communication Indicator shows green when ThinManager is talking to a ThinManager
Server. ThinManager will wait until this communication is finished before processing additional

requests.

6.3 Tree Pane

The tree pane shows the members of the ACP Thin Client Network in an expandable tree.

2 ThinManager =] B

Edit Manage Install Tools \Wjew RemoteView Help

= '52( MServer
Q Terminals

Corfiguration |Licenses| F'n:upertiesl "v"ersicunsl Synchrunizatinnl Event L-:ugl Hepu:-rtl

Attribute

| b alue -

a Display Servers
[ (5] VCenter Servers
|:| Display Clients

------- ﬁ TermSecure Users

E

Unknown Terminal Configuration

TMServer

Fequire Pazsword far Unknown terminals MO

Allow Autornatic Terminal Creation YES
Automatic Terminal Creation Mazk AutoTerm
Allows OFff-line Replacement YES
Event Configuration

SMTF Server
Thintd anager Server Start/Stop =

Teminal Server Data Connection
Terminal OndOFF

Terminal Configuration Change
Install Firmware

Inztall TermCap

Install Licenze

SMTP server

For Help, press F1

ACP ThinManager With Tree

The Tree has five branches.

e Terminals — This lists terminal groups and terminals. Terminal groups can be expanded to show
member terminals and terminals can be expanded to show assigned display clients.

e Display Servers — This lists the display server types that can be used when configuring display
clients.

e VCenter Servers - This allows ThinManager to list and manage VMWare VCenter servers.
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e Display Clients — This lists the display client types that can be added to a terminal configuration.
They can be expanded to show the members of each display client type.

e TermSecure Users — This lists configured TermSecure Users and any created groups of
TermSecure users.

6.4 1cons

6.4.1 Tree Icons
Several of the menu tools and other features are dependent on what icon is highlighted in the tree.

The tree is divided into five branches, Terminals, Display Servers, VCenter Servers, Display Clients and

TermSecure Users.
59( TMServer
+- ™ Terminals
[+ i Display Servers
E [ﬂ_,:] YCenter Servers
}" W Display Clients
~+ ﬁ TermSecure Users

| SN

Five Tree Branches

Each of the branches, shown as a blue icon, can be expanded.
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=01 x|

Edit Manage

E|"'

T

Install Tools Wiew RemoteWiew Help

= ™ Terminals
Q Termiroupl
Q Terms
Q Terms3
ﬁ Display Servers
i Terminal Servers
- @ Cameras
[5) viCenter Servers
|J_..|7,a| DemawZenter
(=Ml Display Clisnts
F Terminal Services
5 Carneta
Q Terminal Shadow
E Workskation
- ﬂ Termaecure Users
m Term>ecurearoupl

For Help, press F1

Configuration |Licenses| F'r-:upertiesl "v’ersinnsl Synchronization | Event Lu:ugl Hepu:urtl

Attribute

| Yalue -

1

M ame

Unknown Terminal Configuration

Require Pazsword for Unknown terminals
Allo Aubornatic Terminal Creation
Autamatic Terminal Creation bMagk,

Al OFf-line Replacement

Event Configuration

SMTP Server

Thinkd anager Server Start/Stop
Terminal Server D ata Connection
Terminal OnOff

Terminal Configuration Change
Inztall Firrnware

[hztall TermCap

Inztall License

SMTP zerver

E-mail Addreszes

Terminals to receive meszages

TMEServer

KO

YES
AutaT erm
YES

Mone

Maone 7
| 3

| [ %

Expanded Tree Showing Icon Variety

Terminal Groups can be expanded to show the subgroups and terminals that are members of the group.

Terminals can be expanded to show the display clients assigned to it.

Display Clients can be expanded to show the members that are assigned to it.

TermSecure User Group can be expanded to show the TermSecure Users that are members of the group.

Each of the branches of the tree can be expanded.
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6.4.1.1 ThinManager Server Icons

s Pe,

\&¢ ThinManager Server - Connected

.? U{‘_
‘>?( ThinManager Server - Disconnected

ThinManager Server Icons

ThinManager can connect to several ThinManager Servers, but only one ThinManager Server tree can be
displayed at a time. The tree shows the local ThinManager Server by default. Other ThinManager Servers can
be added to the ThinManager Server drop-down box by selecting Edit > Add ThinManager Server from the

menu bar.

A Green ThinManager Server icon represents a ThinManager Server that has an active communication link
with the program. These can be collapsed or expanded to show the Group and Terminal icons that nest under

the ThinManager Server icons.

A Red ThinManager Server icon represents a ThinManager Server that is not communicating with the
program. Right clicking on a red ThinManager icon and selecting Reconnect will reinitiate communications to

the ThinManager Server.
6.4.1.2 Terminal Icons
The Terminals branch can be expanded to show Terminal Groups and terminals.

= '% Terminals branch
E‘l‘_F Terminal Group
[’ _

’ Off or Disconnected Terminal

Terminal leading firmware

Terminal waiting for Monitering connection
On and Connecled Terminal

Terminal with TermSacura User logged in

Locked Terminal

Disabled Terminal

5-5-5-5- 8- 3
[RS8 8 [ [ [

Group and Terminal Icons

A Group is represented by an icon of two monitors with a blue screen. Subgroups can be nested under
Groups.

A Terminal is represented by an icon of a single monitor.

e A Red terminal screen indicates that the Terminal is off or not communicating with the ThinManager
Server.
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A Purple terminal screen indicates that the Terminal is loading the firmware during the boot
process.

A Yellow terminal screen indicates that the Terminal has loaded firmware, received its configuration
and is in the process of establishing a monitor connection to the ThinManager Server.

A Green terminal screen indicates that the Terminal is on and communicating with the ThinManager
Server.

A Terminal with a Head icon indicates that a TermSecure User is logged onto the terminal. The
TermSecure User name will be displayed in parentheses.

A Terminal with a Lock or a locked group icon means that that terminal or group is being modified
and cannot be changed by another user. If the Group or Terminal remains locked after its
configuration wizard is closed, it can be unlocked by using Edit > Unlock from the menu bar.

A Terminal with a Red X indicated that an administrator has disabled the terminal.

Note: The purple and yellow screen will not be visible before the terminal has connected the first time and is
defined in ThinManager.

The purple and yellow screens are only visible during a reboot and not after a restart, as a restarted terminal
does not reload firmware.

The Terminal icon can be expanded to show the assignment of the terminal.

B | Terminal with individual terminal servers
| ? Active session on terminal server
“2Z Instant Failover hackup session

! f Mo session on terminal server

Terminal Assigned to Individual Terminal Servers

A terminal that is using individual terminal servers may expand to show a terminal server icon with three
connection states.

A green lightning bolt indicates an active connection to the terminal server.

A yellow lightning bolt indicates an active connection that is cascaded in the background while
using Instant Failover.

Ared lightning bolt indicates an inactive connection to the terminal server.
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“’ :...!..].; Term3 Active Terminal

L—_] E TSClient1 Terminal Services Display Client (foreground)
P ------ : §. T51 Terminal Server with active session

------ ’ T52 Terminal Server with no active session

------ é../ T53 Terminal Server with Instant Failover session
E| @ CamClientl Camera Display Client (background)

D @ Overlay_1 Active Camera Overlay

: ----- @ Came Active Camera

=l @ Overlay_2 Active Camera Overlay

@ Cam3 Active Camera

E| Q ShadowClient1 Terminal Shadow Display Client (hackground)

% Term?2 Shadowed terminal

Terminal using Display Clients

A terminal that is using Display Clients can be expanded to show the status of the Display Clients. The
Display Clients can be expanded to show the status of the Display Client members.

If a Group or Terminal is disabled using the Tools > Disable function, it will be displayed with a red X over
the terminal icon. An entire ThinManager Server or an entire Group can be disabled, but the ThinManager
Server icon and the Group icon will not show an X, just the terminal icons.

g Terminal Off and disabled

g Terminal On and disabled

Disabled Terminal Icons

A Red terminal screen with a Red X indicates that the Terminal is disabled and is either turned off or
rebooted and waiting to be enabled.

A Green terminal screen with a Red X indicates that the disabling has been applied to the terminal that is
turned on. The terminal has a disabling screen and is waiting for enabling.

If a Group or Terminal is disabled using the Tools > Disable function, it will be displayed with a red X over
the terminal icon. An entire ThinManager Server or an entire Group can be disabled, but the ThinManager
Server icon and the Group icon will not show an X, just the terminal icons.

Once a terminal is disabled, a disabling screen will appear on the terminal until the terminal has been
enabled.
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Terminal DESE. disabled by Sdmnestrator

Disabling Screen

If a terminal is active when it is disabled, it will display the Disable Screen with a message indicating the
disabled status in the upper left corner.

ThinManager Client w3.Z

Copyright 1999-F002 Automation Control Products

iz terminal has been disabled on serwer GREEN

Disabled Terminal

If a terminal is booted when disabled, the boot process will be halted until the terminal is enabled.
See Disable Terminals for details.
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6.4.1.3 Display Servers Branch

The Display Servers section of the tree is where display sources are defined and configured. These
definitions will be used when defining a Display Client. Examples of Display Servers are Terminal Servers and

IP Cameras.

- ﬁ Display Servers

E| i Terminal Servers

= TS

- Tz
M- T3

B Cameras

E]Eﬂ ZamiGroupl
- Cami

...... Cam?

...... Cam3

Display Servers Tree Branch

6.4.1.4 Terminal Server Connection Icons

The Display Servers Terminal Servers branch can be expanded to show the Terminal Servers that are
configured. The Terminal Servers can be expanded to show the member terminal servers. The member
terminal servers can be expanded to show the terminals connected to them. The monitor screen color and the
lightning bolt color indicate the terminal’s status on the Terminal Server.

,«;5 Terminal Off - No Connection
g Terminal On - No Connection

% Terminal On - Background Connection {Instant Failover)

% Terminal On - Active Connection

Terminal Server Connection Icons

The monitor screen color indicates the ThinManager Server connection status. The lightning bolt color
indicates the Terminal Server connection status.

e A Red monitor screen indicates that the terminal is off or unable to communicate to the ThinManager

Server.

e A Green monitor screen indicates that the terminal is on and able to communicate to the
ThinManager Server.

e ARed lightning bolt represents a lack of active connection to the terminal server.

e A Green lightning bolt represents a connection to the terminal server with an active session.

e AYellow lightning bolt represents a connection to the terminal server with a session that is the
backup session in Instant Failover mode.

Automation Control Products ThinManager 5.0 Help Manual

ThinManager Interface o 84



6.4.1.5 VCenter Server Icons
EI |f,J ViCenter Servers Tree Branch
|':"| (.2l Defined VCenter Server
]_'[ Imported Datacenter
------ ELI_I Stopped Virtual Machine

""" Iﬁl Suspended Virtual Machine
o @- Running Virtual Machine

VCenter Server Tree Icons

6.4.1.6 Display Clients Branch

The Display Clients section of the tree is where the usage of a Display Server is defined. Display Clients are
added to the terminal configuration. Examples of Display Clients are Terminal Services Display Clients, IP
Camera Display Clients, Terminal Shadow Display Clients, and Workstation Display Clients.

EI Bl Display Clients
EI ﬁ Terminal Services

...... ; Terminal Services Display Client Icon

I'él 5 Camera

@ Camera Display Client Icon

EI . Terminal Shadow

Iﬂ‘ Terminal Shadow Display Client Icon

EI E Workstation

------- Workstation Display Client Icon

Display Client Tree Branch
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6.4.1.7 TermSecure User Branch

The TermSecure Users branch can be expanded.
Elﬁ TermSecure Users

3 Tscient1
TermSecure User Tree

The TermSecure User branch expands to show TermSecure User Groups.

A Two-headed icon represents a TermSecure User Group. This can be expanded to show member
TermSecure Users.

A Single-headed icon represents a TermSecure User. This can be expanded to show any Display Clients
that are assigned to the TermSecure User.

A Single-head with Terminal icon represents a TermSecure User that is logged in on a terminal. The
terminal name is shown in parentheses. This can be expanded to show any Display Clients that are assigned
to the TermSecure User.

A TermSecure User that is not active or logged into a terminal server will show the normal Display Client icon.

A TermSecure User that is active and logged into a terminal will show an icon of the TermSecure User head
with the Display Client

6.5 Details Pane

The Details Pane has tabs to provide additional information. Highlighting different items in the tree will display
a different set of tabs and the corresponding set of information.

6.5.1 ThinManager Server Detail Tabs
Highlighting the green ThinManager Server will show:

e Configuration - These are the configuration parameters set in the ThinManager Server
Configuration Wizard and include the Event Messaging summary.

e Licenses - This displays the installed licenses, the quantity used and the quantity available.
ThinManager lists all the license files and identifies whether that are valid or invalid. This tab will
display licenses for both ThinManager Servers if the pair is auto-synchronized.

e Versions - This displays the version numbers of ThinManager, the firmware, and the TermCap
database.

e Synchronization — This will show the synchronization status of the ThinManager Server. See
Automatic Synchronization for details.
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e Event Log - This displays events for the ThinManager Server. The events and duration are
configurable in the ThinManager Server Configuration wizard. See Event Selection Page for

details.

e Report — This will display the selected report for the ThinManager Server. See Reports for

details.

JRT=TE

Edit Manage Install Tools Wiew RemobeYiew Help

Configuration |Licenses| Prnpertiesl \-"ersic-nsl Sunchronization | Ewent Logl Heportl

(=[] Display Clients

5 Camera SMTP Server

Q Terminal Shadow Thinkdanager Server Start/Stop

5 Workstation Terminal Server Data Connection
= ﬂ TermSecure sers Temingl On/Ok

m TermSecureGroupl Terminal Configuration Change

Install Firmware

Inztall TermCap

[;] Q Terminals -
Attribute | Walue -~
. Q, TermGroupl
- Termz N ame THMServer
Ct
Q Term3
=N ﬁ Display Servers Unknown Terminal Configuration
i Terminal Servars Require Password for Unknown terminals
Cameras Allow Sutamatic Terminal Creation YES
=5} ¥Center Servers Autarnatic Terminal Creation b azk AutaT erm
(% DemowCenter Allow Off-line Replacement vES

F Terminal Services Event Configuration

Inztall License
SMTP server
E-mail &ddresses Mane
Terminals to receive messages Maone _ILI
1| | 3
For Help, press F1 li l_ v

ThinManager Server Tabs
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6.5.2 Terminal Group Detail Tabs
Highlighting a Group will show:

Configuration - These are the configuration parameters set in the Group Configuration Wizard
and include Terminal Server assignments, video settings, and monitoring settings. See Terminal
Group Configuration Wizard for details.

Modules - This lists the assigned modules and parameters for the Group. See Modules for
details.

Schedule — This will display any events scheduled for the Group. See Terminal Schedule for
details.

Properties - This is blank for a Group.
Event Log - This is blank for a Group.
Shadow — This is blank for a Group

Report — This will display the selected report for the group. See Reports for details.

52 ThinManager 10l =l
Edit Manage Install Tools Wiew Remotewiew Help
e -
- onfiguration chedule | Properties | Ewent Log adow | Repor
[=-48¢ Thames Configuiation Modules | Schedule | Prapetties | Event Log | Shadow | Report
= Terminals -
Qf' | Attribute | Y alue
= @ TermGroupl
[ Installed Modules
Q, TermSubGrol
Module Screen Saver Module
f Q Termz2
Q Termd Download screensaver.mod
Display Servers Screen Saver BlarkSeraen
ﬁ Terminal Servers Wait Time in Minutes il
- §S) Cameras Uze Dizable Time Period MO
=[5 WCenter Servers Digable Start Hour [0-23) a
[ () DemovCenter Disable End Hour [0-23] 0
(=] (M| Display Clierks Farce Off wihen Start Hour Reached WO
F Terminal Services
5 Camera
Q Terminal Shadaw
=] ﬁ TermSecure Users
i m TermSecureroup
n Bob
n Fred
« [ Ll | i
For Help, press F1 i

Group Tabs — Modules
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6.5.3 Terminal Detail Tabs

Highlighting a Terminal will show:

Configuration - These are the configuration parameters set in the Terminal Configuration Wizard
and include Terminal Server assignments, video settings, and monitoring settings. See Terminal
Configuration Wizard for details.

Modules - This lists the assigned modules and parameters for the Terminal. See Modules for
details.

Schedule — This will display any events scheduled for the terminal. See Terminal Schedule for
details.

Properties - This shows the IP address, firmware version, make and model, CPU, memory
usage, Terminal Up Time, CPU load, and BootROM version of the Terminal.

Event Log - This shows the terminal events and terminal configuration events for that terminal, if
event logging is enabled in the ThinManager Configuration Wizard. See Event Selection Page for
details.

Shadow — This tab shows what the terminal is displaying on its monitor. Administrators can
interact with the session while ThinManager Power Users can view the session but not control it.
See ThinManager Security Groups for details.

Report — This will display the selected report for the terminal. See Reports for details.

il x]

Edit Manage Install Tools Wiew RemoteView Help

Eg;{ Thames .Configurationl Mu:u:lulesl Schedulel F'ru:upertiesl EventLog Shadow | Fleportl
- M Terminals .

@ TermGroupl

Q Termz

Q Term3

- ﬁ Display Servers

= Terminal Servers
E Cameras
B @ Yenter Servers
@ DemovCenter
(=1 [l Display Clients
i Terminal Services
E Camera
Q Terminal Shadow
B ﬂ TermSecure Users
m TermZecurearaup
n Bob
n Fred

,’.‘“'Startl |Zm & | =
‘ [ |2l | |
For Help, press F1 l_ v

Terminal Tabs — Shadow
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6.5.4 Terminal Server Detail Tabs

Highlighting the blue Terminal Server branch will show:

Status - This shows the status of the communication connection between the local ThinManager
Server and the defined Terminal Servers and ThinManager Servers. This shows whether the
local ThinManager Server is able to retrieve the updated resource information used in
determining the SmartSession Server Ranking. See Terminal Server Name Page for detalils.

Summary - This will report information on the terminal servers like available memory, uptime,
CPU utilization, and operating system.

Event Log - This shows the terminal events and terminal configuration events for that terminal
server, if event logging is enabled in the ThinManager Configuration Wizard. See Event Selection
Page for details.

The Connection Status of the Terminal Servers may have different messages:

OK indicates a good connection.
WTSAPI32.dll connection failed occurs when the terminal server is off or unreachable.

No login information supplied indicates that the Terminal Server didn’t have a username and
password added in the Terminal Server List Wizard.

User specified does not have permission to connect indicates that the Terminal Server had
an invalid username and password added in the Terminal Server List Wizard.

1o x]

Edit Manage Install Tools Wiew RemoteView Help

P
E'}ﬁ(‘ Thames Statuz | Summary | Event Log |
EIQ Terminals

Termiroupl
i % Termz T51 Mo login information supplied
=1}

Terminal Server | Statug

Q Terma TS Mo login information supplied

Display Servers T53 Ma login information supplied

-l -

+]- i Terminal Servers
- W8 Cameras
- (55} vCenter Servers
ﬂ DemovCenter
(=1 [l Display Clients
F Terminal Services
5 Camera
@ Terminal Shadow
B ﬁ TermSecure Users
m TermZecurearaup
2 Bob
2 Fred

]

« [ |l | I
For Help, press F1 l_ v

Terminal Servers Tabs — Status
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Highlighting an individual Terminal Server will show:

Configuration - This shows the installed Client Communication Protocols and the SmartSession
settings for the Terminal Server. See Terminal Server Capabilities Page for details.

Properties — This tab displays the server resource data like total memory, free memory, uptime,
and CPU speed.

Schedule — This will display any events scheduled for the Group. See Terminal Server Schedule
for details.

Users - This tab displays information from the Terminal Services Manager. It shows users that
are logged into the Terminal Server. Right clicking on a user will show options that allow the
session to be Reset (logged off), Disconnected, or have a message sent to it.

Sessions - This tab displays information from the Terminal Services Manager. It shows users
that are logged into the Terminal Server. Right clicking on a user will show options that allow the
session to be Reset (logged off), Disconnected, or have a message sent to it.

Processes - This tab displays information from the Terminal Services Manager. It shows the
processes running on the Terminal Server and can have them sorted by Session ID (users) or
Process Name. Right clicking on a process will give the option to kill the process.

Graph — This tab will display the CPU usage and memory usage of the terminal server as a
graph. This graph can contain one hour of historical data.

Event Log - This shows the terminal events and terminal configuration events for that terminal, if
event logging is enabled in the ThinManager Configuration Wizard. Event Selection Page for
details.

Connect — This tab will open a connection from ThinManager to the terminal server. This session
allows administrators to manage the terminal server from within ThinManager. See Connect
Options for details.

Report — This will display the selected report for the terminal server. See Reports for details.
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5= ThinManager

=0l x|

Edit Manage Install Tools Wiew RemobeMiew Help
Y-
E'}ﬁ(‘ Thames Canfig | F'roperliesl Schedulel Usgers I Sessinnsl F'rocessesl Graphl Event Loc 4 I 'I
- M Terminals -
: I Abtribute | W alue
@, TermGroupl - —
: Terminal Server ldentification
- Termz
: 5 M T51
5 Terms erver Mame
=B ﬁ Display Servers IP Address 99.98.57.99
E i Terminal Servers
: a Terminal Server Configuration
B Connection Types Supported Remote Deszkiop Protocol
SmartSession wES
Cameras
B @ WCenter Servers Data Collection Update Times
[H- [ DemavCenter SmartSession Update Time 8
E||:| Display Clients Process Infarmnation L pdate Time 5
F Terminal Services Session Information pdate Time 3
E Camera
Q Terminal shadow
B ﬂ Term3ecure sers
m TermZecurearaup
2 Eob
2 Fred
A [ o) Ll | 2
For Help, press F1 v

Terminal Server Tabs

6.5.5 Modifying a Terminal

Modifying a terminal allows you to reconfigure the terminal or change group settings such as touch screen

usage, video resolution, or to assign it to a terminal server.

To modify a terminal open the Terminal Configuration Wizard or the Terminal Properties by either:

Highlighting the terminal in the ThinManager tree pane by clicking on the terminal name or icon

and select Edit > Modify from the ThinManager menu bar.

Right-clicking on the terminal icon in the ThinManager tree pane and select Modify.

Double-clicking on a terminal icon in the ThinManager tree pane.

This will launch the Terminal Configuration Wizard, allowing changes to be made.

Note: The terminal will need to be restarted for the changes to take effect.
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6.5.6 Deleting a Terminal
A terminal can be deleted from the ThinManager by:

e Highlighting the terminal in the ThinManager tree pane and selecting Edit > Delete from the
ThinManager menu bar

e Right-clicking a terminal icon in the tree pane of ThinManager and selecting Delete Terminal.

6.5.7 Restarting a Terminal
A restart will reload any changes to a terminal configuration or firmware without a cycling of power.
A terminal or group can be restarted by:

e Selecting Tools>Restart Terminal from the ThinManager menu bar. This will restart all the
terminals on the server if the server is highlighted. If a group is highlighted, all members of the
group will be highlighted. If a terminal is highlighted, the terminal is restarted.

e Right-clicking a group icon in the tree pane of ThinManager and selecting Restart Terminals.
This will reboot all the terminals in the group.

e Right- clicking a terminal icon in the tree pane of ThinManager and selecting Restart Terminal.
This will restart only the highlighted terminal.

6.5.8 Rebooting a Terminal
A reboot will cycle power to the terminal, reloading firmware and configuration.
A terminal or group can be rebooted by:

e Selecting Tools>Reboot Terminals from the ThinManager menu bar. This will reboot all the
terminals on the server if the server is highlighted. If a group is highlighted, all members of the
group will be highlighted. If a terminal is highlighted, the terminal is rebooted.

e Right-clicking a group icon in the tree pane of ThinManager and selecting Reboot Terminals.
This will reboot all the terminals in the group.

e Right-clicking a terminal icon in the tree pane of ThinManager and selecting Reboot Terminal.
This will reboot only the highlighted terminal.

6.5.9 Renaming a Terminal
Terminals can be renamed by:
e Highlighting the Terminal and selecting Edit > Rename.

e Right-clicking the Terminal and selecting Rename.

Note: Renaming a terminal can be accomplished the same way that files or directories are renamed in
Windows Explorer. Single click twice on the terminal name; this will draw a box around the name and
highlight it. Type the new terminal name.
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5= ThinManager 10| =l
Edit Manage Install Tools Wiew RemoteView Help
pry- . .
E'}ﬁ(‘ Thames Cnnfigurationl Mu:u:lulesl Schedule  Properies | Event Lu:ngl Shadowl Fleportl
- M Terminals -
: I Abtribute | W alue
@, Terméroupl - -
Q. Terminal Information
i IP &dd 93,98.97.97
- = Terms _ ess
- ﬁ Display Servers Terminal [0 007143507 2354
i Termingl Servers Firrwsare Wersion »04.00.993
Cameras Hardware Model MTa-6020
- (55} vCenter Servers Hetwork, Boot Loader Werzion 52
@ DemovCenter
(=1 [l Display Clients
ﬁ Terminal Services
E Camera
Q Terminal Shadow
=- ﬂ TermSecure Users
m Term3ecurearoup
W 0 e
2 Fred
A [ o) Ll | 2
For Help, press F1 l_ v

Renaming a Terminal

The terminal name should be less than 15 characters because of limitations on the terminal server.

Tip on single clicking twice: Click once to highlight the name, move the mouse slightly and click again.
This will prevent Windows from confusing the two single clicks with a double click.
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/ Menu ltems

7.1 Edit

Edit contains commands for adding, deleting, and changing configurations. The functions listed are
dependent on what is highlighted in the tree.

7.1.1 Add Terminal

Edit > Add Terminal will launch the Terminal Creation Wizard to start the process of adding a new terminal.
This command will be displayed when the ThinManager Server, Terminals branch, or a Terminal Group is
highlighted.

See Terminal Configuration Wizard for details.

7.1.2 Add Terminal Group

Edit > Add Terminal Group will launch the Group Creation Wizard to start the process of adding a new
group of terminals. This command will be displayed when the ThinManager Server, Terminals branch, or a
Terminal Group is highlighted.

See Terminal Group Configuration Wizard for details.

7.1.3 Add ThinManager Server

Edit > Add ThinManager Server will allow the remote administration of multiple ThinManager Servers by
adding an additional ThinManager Server to the ThinManager Server drop-down box above the tree. A user
logged in with administrative rights can connect to multiple ThinManager servers for management.

Selecting Add ThinManager Server will launch a dialog box.
ThinManager |

Enter Thintdanager Server

Cancel |

Add ThinManager Server Dialog Box
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Enter computer name or the IP address of a ThinManager server. This adds the ThinManager Server to the
ThinManager Server drop-down box above the tree pane of the local ThinManager so that the configuration

can be displayed in the tree when needed.

Note: The ThinManager Server may need to be defined in the ThinManager Server List Wizard.

Edit Manage Install Tools View RemoteView Help

'Es_?-i_'Th inManager H =1 B

------ 23 VCenter Servers

SMTF Server

Thintdanager Server Start/Stop
Terminal Server Data Connection
Temminal On/0fF

Terminal Configuration Change
Irztall Firrmware

Inztall TermCap

Inztall License

SMTP zerver

ICuhaIt |E| Configuratian | Licenzes I Properties I Yersions I Sunchronization I Event Log I Fiepart I
; Attribute | Y alie -
RET Cobalt

|i| Alpha
= Tango Frequire Pazsword for Unknown terminalz MO
B uriform Allows Automatic Terminal Creation TES
Q Wictor Automatic Terminal Creation b ask AutoTerm

e~ [l Dislay servers Allow Off-line Replacement YES

- Display Clients - :
El E vent Configuration
------ ﬂ TermSecure Users

For Help, press F1

ThinManager Adding an Additional ThinManager Server

The new ThinManager Server will be added to the ThinManager Server drop-down box. Selecting the new
ThinManager Server in the drop-down will display the tree for that ThinManager Server.

Members of the Administrator group or the ThinManager Administrators group have full control of the remote
ThinManager Server and can make changes as needed. Members of the ThinManager Power Users group

can monitor the connection.

See ThinManager Security Groups for more details.

If ThinManager is installed on a Windows XP Pro workstation, it cannot be added to a ThinManager on a

Windows 2003 unless a security option is changed.

In Windows XP Pro select Start > Control Panel > Administrative Tools > Local Security Policy.
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£ Local Security Settings

File  Action  Wiew Help

P Security Settings Policy | Security Setting A
[0 Account Policies
=28 Local Palicies

+-8 Audit Policy

+ :@ IUser Rights Assignmen

8 securicy Options

+-_7] Public key Policies
+-[_7] Software Restriction Policie
+ g;, IP Security Policies on Loca

o |Metwork security: Minimum session secarity For MTLM 55P based (includi... Mo minimum
_,gﬂNetwcurk security: Minirum session security For MTLM 55P based (includi... Mo minimum
i Metwork security: LDAP client signing requirements Megatiate signing
_,éﬁNetwu:urk security: LAN Manager authentication level Send LM & NTLM - us
Hhetwork security: Force logaoff when logon hours expire Disabled
¥IMetwork security: Do not store LAN Manager hash value on next passw... Disabled

security model For local accounts Classic - local users :

o|Metwork access: Shares that can be accessed anonymousky COMCFG,DFSE
¥Inetwork access: Remoteky accessible reqistry paths SyskemiiCurrentCont
_gﬂNetwcurk access: Mamed Pipes that can be accessed ananymaously COMMAR, COMMODE
¢_; Metwork access; Let Everyone permissions apply to anonymous users Disabled

_,gf]Netwcurk access: Do not allow storage of credentials or JMET Passports .., Disabled

HMetwork access: Do not allow anonymous enumeration of SAM account,..  Disabled

_,éﬂr'-.letwu:urk access: Do not allow anonymous enumeration of SAM accounts Enabled

Blnetwork access: Allow anonymous SIDfkame translation Enabled
_,n_.:f]MicrusnFt network server: Disconnect clients when logon hours expire Enabled

¥IMicrosoft network server: Digitally sign communications (if client agreesy  Disabled

[R¥IMicrosoft network server: Digitally sian communications (ahaass) Disabled
£ s >

Windows XP Pro — Local Security Settings

Highlight the Security Options folder in the Local Security Settings program. Change the Network access:
Sharing and Security model for local accounts from the default Guest Only to Classic to match the
setting of the Windows 2003 terminal server.

7.1.4 Remove ThinManager Server

Edit > Remove ThinManager Server will delete a highlighted ThinManager Server from the tree.

7.1.5 Delete

Edit > Delete will launch a message box that will remove a highlighted ThinManager Server, group or
terminal. Deleting a remote ThinManager Server will remove it from the local list.

ThinManager |
Do ywou wank to delete the Terminals For Group Groupz as well?

MOTE: IF no, Group Members will be assigned ko Group MOME
Cancel |

Delete Group Message Box
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Deleting a group will give the option of deleting the group terminals or moving them under the server without a
group.

7.1.6 Modify
The function of Edit > Modify depends on what tree icon is highlighted when Modify is selected.

e Modify will launch the ThinManager Server Configuration Wizard for a highlighted
ThinManager Server. This allows the ThinManager Server to be configured as described in the
ThinManager Server Configuration Wizard.

e Modify will launch the Terminal Group Configuration Wizard for a highlighted group.
Modifications can be made as described in Terminal Group Configuration Wizard.

¢ Modify will launch the Terminal Configuration Wizard for a highlighted terminal. Modifications
can be made as described in Terminal Configuration Wizard.

e Modify will launch the appropriate Display Server Configuration Wizard for a highlighted
Display Server member.

¢ Modify will launch the appropriate VCenter Server Property Wizard for a highlighted VCenter
member.

e Modify will launch the appropriate Display Client Configuration Wizard for a highlighted
Display Client member.

e Modify will launch the TermSecure Configuration Wizard for a highlighted TermSecure user or
group.

7.1.7 Rename

Edit > Rename will allow a highlighted tree item to have its name changed.

Note: The terminal name should be less than 15 characters because of limitations of the terminal server.

7.1.8 Lock

When a tree member is opened for modification, the entry in the configuration is automatically locked to
prevent two people from making changes at one time.

Edit > Lock will manually lock the configuration of a tree member to prevent it from being changed. A lock
icon will designate the locked state.

,% Group
.% Terminal

Lock Icons

7.1.9 Unlock

Edit > Unlock will manually unlock a tree member that was locked while being modified. This is used if the
server was shut down while a tree member was locked, preventing the member from being unlocked
automatically when the modifications are complete.
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Using the Unlock function will display a warning to alert the user.

Manually Unlocking a Terminal that is being edited could carrupt the database,
Are You Sure?

Lock Warning Message

Unlocking a locked member can cause a loss of configuration data if another user is modifying it.

Note: This tool is to be used only when a tree member remains locked due to an unexpected server shut
down while a member is being configured. Using this tool while another is configuring that terminal can lead to
corruption of the database.

7.1.10  Find

Edit > Find launches a Find dialog that searches the tree for the item typed into the Find field.

Find |

Cancel |

Find ||

V' Search Mames

[T Search P Addresses
[T Search Teminal ldz

[T Search Teminal Models

[~ Exact Match Only

Find Dialog Box

The Find function has several checkboxes to enhance the search:

Search Names — this, when checked, will search for a name entered in the Find field.
Search IP Addresses - this, when checked, will search for an IP address entered in the Find field.

Search Terminal Ids - this, when checked, will search for a MAC address/Terminal ID entered in the
Find field.

Search Terminal Models — this, when checked, will search for a thin client model entered in the Find
field.

Exact Match Only - this, when checked, will limit searches to exact matches to the name entered in
the Find field.

CTRL+F is the short cut key to launch Find.
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7.1.11  Find Next

Edit > Find Next will continue searching the tree for the next instance of the text in the Find field of the Find
dialog box.

F3 is the shortcut key for this function.

7.2 Manage

7.2.1 ThinManager Server List

Manage > ThinManager Server List will launch the ThinManager List Wizard. See ThinManager Server
List for details.

7.2.2 TermSecure Access Groups

Selecting Manage > TermSecure Access Groups will launch the Access Groups window to create
Permission Groups for use with TermSecure.

See Permissions for more details.

Access Groups E |

Inrestricted
Al Uszerz

Edit

[=

Add

Delete

i

Access Groups Window

Select the OK button to accept the changes and close the window.

Select the Edit button to change the highlighted Access Group.

Select the Add button to add a new Access Group.

Select the Delete button to remove the highlighted Access Group.

If the Add button is selected, an Access Group Creation window will be displayed.

Automation Control Products ThinManager 5.0 Help Manual Menu Items e 100



Access Group

Enter Group Mame

\_H
=
(x|

|| Cancel

E dit kembers |

Access Group Creation Window

Enter a name for the new Access Group and select OK to create the group.

AcCcess Groups

X
IJrrestricted (] |
Al Uzers

E ngineering
IT_Stalf
Management
Operators

Contractors E dit

Delete |

TermSecure Access Groups Added

Defined Access Groups will be displayed in the Access Group window. See Permissions for more details.

7.2.3 DNS Configuration

Manage > DNS Configuration will launch the DNS Configuration Wizard. See DNS Configuration for
details.

7.2.4 PXE Server

Manage > PXE Server will launch the PXE Server Configuration Wizard. See PXE Server Configuration
Wizard for details.

7.2.5 Configure Default Terminal

Manage > Configure Default Terminal will launch the Terminal Properties for the “Default” terminal. This
default terminal is used as a template that terminals created during Auto-Create are based on. See Auto-
Creation of Terminals for details on Auto-Creation of terminals.
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7.2.6 Restore Configuration

Manage > Restore Configuration will allow a backed up ThinManager configuration to be applied to the
ThinManager Server. Select Restore Configuration to launch the desired ThinManager Configuration file in
the browse window and select Open. The backup copy will overwrite the existing configuration.

Laak. ir: I iy 33 Clgs LI - ﬁi -

Green_backup.db

File name: IEreen_I:uau:kup.dl:- Open I
Filez af bype: IThinManager Configuration LI Cancel |/
A

Restore ThinManager Configuration
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7.2.7 Backup Configuration

Manage > Backup Configuration allows the ThinManager Configuration to be saved. Select Backup
Configuration to launch a browse window and select the Save button to save a backup copy.

Save i I 33 Cigs LI - ﬁi -

File name: Green backup.db Save I
Save az twpe: | Thinkdanager Configuration LI Cancel |/
A

Backup ThinManager Configuration

7.2.8 Synchronize Configuration

Manage > Synchronize Configuration allows the configuration of multiple ThinManager Servers to be kept
identical so that a terminal will boot with the same configuration regardless of what ThinManager Server the
terminal connects to.

Note: ThinManager has an Automatic Synchronization feature that will keep two ThinManager Servers
synchronized without requiring a manual input. See ThinManager Server List Page for details.

Although Automatic Synchronization is the preferred method of synchronization, Manual Synchronization is
useful to synchronize the configurations on the primary and backup ThinManager Servers before turning on
the Automatic Synchronization.

Selecting Synchronize Configuration will launch the Synchronize ThinManager Server Configurations
Wizard. See Manual Synchronization for details.

7.2.9 Reconnect

This command will reinitiate the connection between the highlighted ThinManager Server and the ThinServer
service.

7.2.10 Disconnect

This command will disconnect the connection between the highlighted ThinManager Server and the
ThinServer service.
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7.3 Install

Install is a new menu item that contains the commands from Manage that involve installation.

7.3.1 Licenses

Install > License opens up the Licensing dialog box.

censing

bl azter License Mumber |1111-2222-333-AEICD

Licengze Mumber | Dezcription | Location | Redundancy | E wpiration
4444-5555-5555-}'}'?? Terminal Connection Redundant License GREEM.TSE4E full Mewer
ARARA-BEEE-TTTT-2888 WinTMC Connection Redundant License  GREEM.TSE4E full Mewer

< | B

— Ingtallation Id
GREEN [primary] | BEEE-A L84 BEBE-1111-2222-3333
TSE4E I 4444 BE66-CCCC-DDDD-1111-2222
|nztall Licensze Delete License | Dretails Inztall Demo Code Show Old Licenses

Licensing Window
The Master License Number field shows the number of the installed master license. See Creating a Master
License for details.
The Licensing window displays several columns.

e License Number — This displays the component product license numbers included in the installed
master license. A green monitor indicates a valid license while invalid licenses will display a red “X".

e Location — This lists the ThinManager Server(s) that the component product license applies to.
e Redundancy — This indicates whether the license type is redundant or mirrored.

e Description — This lists the license type.

e Expiration — This displays the license expiration date.

The Installation ID field displays the Installation ID humber that is used in the license activation process.
ThinManager Servers that are auto-synchronized will display the Install ID of both ThinManager Servers.

e Install License — This button launches a file browser that allows a license file to be added.
o Delete License — This button allows a highlighted license to be deleted.
o Details — This button displays the details of a highlighted license.

e Install Demo Code — This button allows a Demo Code to be added to give temporary functionality.
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e Show Old Licenses — This lists the previously installed ThinManager 3.x licenses on the
ThinManager Server.

e Done — This button closes the Licensing window.

See Licensing ThinManager for details.

7.3.2 Modules

Install > Modules open the Modules dialog box. This displays the modules that are available to the ACP
Enabled thin clients. See Module Overview for details.

Modules for Server Cobalt |

todule Type I.-“-‘-.II M odulesz j

Dezcription | "Yerzion | Licenze H. .. | -

AMD Geode Videa Driver 400 HOME

AMD Geode VideoZ Driver 400 HOME [
Add Serial Part 400 HOME

Advantech ARK.-1332 Sound Driver 4.00 HOME

Advantech ARFK.-3380 Sound Driver 400 HOME

Advantech PCM-5820 Sound Driver 400 HOME

Advantech PCM-3372 Sound Driver 400 MOME

Advantech UNO-1150 Sound Driver 4.00 HOME

Advantech UNO-1170 Sound Driver 400 HOME

Advantech UMO-2053E Sound Driver 400 HOME

Advantech UMO-2173 Sound Driver 400 MOME

Allen-Bradley Yersabiew 2008 Sound Driver 4.00 HOME

Anzta 5324-ACP Sound Driver 400 HOME

Arizta B324-ACP Sound Driver 400 HOME

Arizta FR2A-4TP S mond Driwer AnNn MIMMF ;I

[nztall b odule. .. | Femove Module fram &l Terminalz

Installed Modules Windows

The Module Type drop-down allows all modules to be displayed or allows the modules to be filtered by type.
The Modules for Server X window has three columns.
e Description — This lists the modules by name.

e Version — This is the version number of the module. This can be compared against the latest
versions from http://www.thinmanager.com/support/downloads.shtml#modules.

e License Reqd — This shows what license is required, if any, to use the module.
The Modules for Server X window has three buttons.

e Install Module — This button launches a file browser that allows a module file to be added or
updated.

e Remove Module form All Terminals — This button will remove a highlighted module from all
terminals. It doesn’'t remove the module from the system; it just removes it from the configurations.

e Done — This button closes the Modules window.

Selecting Install Module... will launch a dialog box that allows modules files to be selected.
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Open

71

Look, in; I ) Unreleazed

~| © B ot E-

elotouch.mod
gunze_tauch, mod
kbd_canfig.rmod
rnicrokaouch, mod
penmount. mod
ronics.mod

arista_touch.mod
carrollzouch.mad
contec.mod
core_viden, mod
DMCTouch, mod
dynapro.mod

kerm_shadow. mod
kouch_int, miod
kouchcontrol.mod
. usbkouch, mod
wideo_inkelZ,mod
wycom_kouch, mod

File narme: Iushtu:nun::h.mn:ld

Open

Files of type: II'-.-1|:u:|uIe Files

[T Open as read-only

| ooen |
;I Canizel |
4

Open Module File

A module can be added to the list of available modules by highlighting the desired module file and selecting
Open. . The window will close when the license is installed.

Note: The module files should not be saved directly into the ThinManager folder but should be saved to
another folder and be installed using ThinManager.

See Module Overview for details

7.3.3 Reports (Installation)

Install > Reports will launch a Reports window that allows additional reports to be added to ThinManager.
Each report has two components, an HTML template and a SQL query.

See Reports for information on reports.
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Reports |

i~ S0L Files i~ |mages, Finished Reports ete.
R eport Description | Fepart Type | Fepart Template
Terminal Login Settings Fpghem TeminaldutologinS ettingsT emplate. b
Terminal Configuration Chan...  terminal TerminalConfigChanges T emplate. html
Properties of All Terminals zWztem TeminalPropertiesT emplate. kil
Teminal Server Resource E... terminal server Teminal5erverResourceE ventzT emp
Termminal Seszion Events Log  terminal TerminalSezsionkE ventsT emplate. html
Termminal Shadow Events terminal TerminalShadowE vents T emplate. html
TemSecure LogindLogout E... uger |JzerloginE wentT emplate. html
Eent Log zpztem eventlogtemplate. html
Terminal Uptime Report Fpghem terminaluptimetemplate. html

[nztall Delete

Reports Window —Reports Templates
The Reports widow has radio buttons to display report templates, SQL files, and images, finished reports,
and assorted files.

Selecting the Report Template radio button will display installed report templates. ThinManager installs a
variety of templates. New templates can be downloaded from www.thinmanager.com.

Selecting the Install button will launch a file browser to install new templates. Selecting the Delete button will
delete a highlighted report.

Open E3

Loak, jr: I ' ReportTemplates ;I = ¥ ER-

) Partl ,f] TerminalZerverResourceEven
[_IPartz ,@ TerminalSessionEventsTempl:
,fj eventlogternplate, htmil ,ﬂ TerminalshadowEventsTempl.
,@ TerminalAukalaginSettingsTemplate, htrml ,@ kerminaluptimetemplake. Rkl

ﬁ TerminalC

.@ TerminalPropertiesTemplate, hkml
« | =

File name: ITerminalEanfigEhangesTemplate.html Open I
Files of type: | Report Templates | Cancel |

[T Open as read-only

onfigZhangesTemplate. hkml g—] IUserLoginEventTermplate. htm

Open File Window

Navigated to the desired template, highlight the file, and select Open. This will install the template and close
the file browser window.
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Reports

™ Report Templates

]|

i~ |mages, Finished Reports ete.

SOL Query File

eventlog.zgl
terminalautologingetting. sql
terminalconfigchanges. zql
terminalzerverresouncesyent. .
terminalzeszions. aql
terminalzhadowewvents. zql
terminaluptime. zql

termprops. gl

uzerloging. sql

[nztall Delete

Reports Window

Selecting the SQL Files radio button will display installed

— SQL Files

SQL queries. ThinManager installs a variety of SQL

gueries as companions to the report templates. New SQL queries for new reports can be downloaded from

www.thinmanager.com.

Selecting the Install button will launch a file browser to install new SQL queries. Selecting the Delete button

will delete a highlighted SQL query.

Reports Ed |

" Feport Templates " SOL Files ¥ |mages, Finished Feports ete.
Filenarne | File Type | -
eventlog_2008_04 20 17_00. kel Firefow Docurment
logod 50«50, jpg JPEG Image
logo1 50«50_TH.jpg JPEG Image
logo150x50_phz.jpg JPEG Image
terminaluptime_2007_07_27_21_00 ktrl Firefow Docurment
terminaluptime_2007_03_10_21_00.htrl Firefor Document

terminaluptime_2007_03_17_21_00.htrol
terminaluptime_2007_08_24_21_00 ktrl
terminaluptime_2007_08_31_21_00 ktrl
terminaluptime_2007_09_07_21_00.htrl
terminaluptime_2007_03_14_21_00.htrol
terminaluptime_2007_09_21_21_00 ktrl
terminaluptime 2007 11 02 21 00, kol

terminaluptime_2007 1109 20_00.htrl

[rztall Delete

Firefax Docurment
Firefow Docurment
Firefow Docurment
Firefor Document
Firefax Docurment
Firefow Docurment
Firefow Docurment
Firefor Document

Reports Window — Images,

Finished Reports, etc.
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Selecting the Images, Finished Reports, etc. radio button will display installed images and reports.

Selecting the Install button will launch a file browser to install new images. Selecting the Delete button will
delete a highlighted image, report, or file. This is a handy way do delete older copies of backed up reports and
configurations that were saved using the Scheduler. See System Schedule for details.

Selecting the OK button will close the Reports window.

7.3.4 Eirmware

ThinManager allows the firmware for the thin client to be upgraded with the latest version from the
ThinManager web site (www.thinmanager.com).

Select Install > Firmware to launch a file browser.
Open H
Laak, jr: ; 3 firmware _ﬂ - ITF -

firmware.acp.vDS.D'l A
firmware.acp.vDS.DE.E
firmware.acp.vﬂd.ﬂﬂﬂ
firmware.acp.vﬂd.DD.E

firrrare. acp v04.01.0

File: narne: J firrmweare. acpv04.01.0 Open I
Filez of bype: JFirmware j Cancel l

I” Open az read-only

Z

Install New Firmware

Select the new version of the firmware.acp and select Open. This will install the new version of the firmware.

The thin clients will download the new version of firmware the next time they are rebooted.

7.3.5 TermCap Database

ThinManager has a Terminal Capability Database (termcap - db) that provides ThinManager with the
configuration parameters for each thin client model. At each terminal connection, the TermCap database is
checked and an integrity check is performed. If the configuration does not match the terminal specifications,
ThinManager may reconfigure the terminal to acceptable parameters.

ThinManager Integrity Check

The following changes were made :
Terminal Prod_LinelA - Invalid Yideo Mode, was 1024x768 70Hz 256 Colors, changed to 800x600 72Hz 256 Colors
Terminal Prod_Lineld - Module Elographics Touch Screen Driver - Property "PORT" Invalid, was "COM1", changed to "COM4"

Terminal Capabilities Integrity Check

The Terminal Capability database can be updated with the current release from the ThinManager web site
(www.thinmanager.com).
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To update the Terminal Capabilities Database, select Install > TermCap Database.
Open HE
Laak: jr: ! 3 firmware ﬂ & ITF -

terr‘ncap.db.-’-l.l:l.E
m termecap.db.4.1.1

File: narme: jtermcap.db.4.1.1 Open I
Files of type: JTermEap Database ;I Cancel |

[” Open az read-only
: 57

Install New TermCap Database

An Open dialog box will be launched.

Select the new version of the termcap.db and select the Open button. This will install the new version.
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7.3.6 PXE Boot Loader

ThinManager uses a initially boots PXE thin clients from a boot file (acpboot.bin).
To install the PXE Boot Loader, select Install > PXE Boot Loader.

open B
Loak in: |@' Desktop j 4 = E-

My Docurments

-j My Computer
jMy Metwork Places
[TIPXE
acpboat-1.0.bin

b;i

My i
Diocu

File name: | Open

i

Filez of type: IF‘XE Boot Loader Cancel

[ Open az read-only

An Open dialog box will be launched.
Select the acpboot.bin file and select the Open button. This will install the file.

7.4Tools

Tools contain commands that affect the terminals.

7.4.1 Restart Terminals

Tools > Restart Terminals will perform an intelligent restart of a terminal. It will load any changes to the
configuration, modules, firmware, and reconnect them to the terminal server without cycling power to the
terminal, unless it is needed to reload the firmware.

Note: Restarting a terminal does not close the session on the terminal server nor does it unlock a frozen
session. It reloads changes independent of the session on the terminal server. It will reconnect to the same
session without changing the session.

¢ Highlight a terminal in the ThinManager tree pane and select this command to restart a terminal.
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¢ Highlight a group in the ThinManager tree pane and select this command to restart all the
terminals of the group.

e Highlight a ThinManager Server in the ThinManager tree pane and select this command to
restart all the terminals on the ThinManager Server.

7.4.2 Reboot Terminals

Tools > Reboot Terminals will cycle the power to the terminal, reloading the firmware and configuration, and
reconnect it to the terminal server. The function of this command has been largely replaced by the Restart
Terminal command.

Note: Rebooting a terminal does not close the session on the terminal server nor does it unlock a frozen
session. It reboots and reloads the firmware and configuration independent of the session on the terminal
server. It will reconnect to the same session without changing the session.

e Highlight a terminal in the ThinManager tree pane and select this command to reboot a terminal.

e Highlight a group in the ThinManager tree pane and select this command to reboot all the
terminals of the group.

e Highlight a ThinManager Server in the ThinManager tree pane and select this command to
reboot all the terminals on the ThinManager Server.

7.4.3 Reboot Terminal Server
Tools > Reboot Terminal Server will send a command to restart the highlighted terminal server.

e Highlight a terminal server in the ThinManager tree pane and select this command to restart a
terminal server.

Caution: Reboot Terminal Server will restart the terminal server and log off all sessions without giving users
a chance to save their data. Use wisely.

7.4.4 Disable Terminals

The Disable Terminal command will disable any highlighted Group or Terminal by displaying a lockout
screen. The terminal will wait until it is enabled with the Tools > Enable Terminal function to be functional
again. This allows terminals to be locked down for security reasons, or to prevent the terminals from
accessing the terminal servers.

Highlighting a Terminal Server, or Group in the ThinManager tree and selecting Tools > Disable Terminal
will disable every terminal assigned to it.

élﬂ Terminal Off and disabled

E‘;I_. Terminal On and disabled

Disabled Terminal Icons

If a Group or Terminal is disabled using the Tools > Disable function, it will be displayed with a red X over
the terminal icon. An entire ThinManager Server or an entire Group can be disabled, but only the terminal
icons will show the X, not the ThinManager Server icon or the Group icons.
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Once a terminal is disabled, a disabling screen will appear on the terminal until the terminal has been
enabled.

Disabled Terminal Screen — Logged On

A logged on terminal will display a screen indicating that the terminal is disabled.

heen disabled on server GREEN

Disabled Boot Screen

Terminals that are booted while disabled will halt on a blue screen indicating that the terminal is disabled.
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7.4.5 Enable Terminals

The Enable Terminal command will remove the disabling from a highlighted Group or terminal and allow it to
continue functioning or resume the boot process.

7.4.6 Disable Terminal Server

The Disable Terminal Server command will disable all connections from the selected terminal server to all
thin clients logged onto that server. The sessions will be disconnected but not reset.

Elﬁ Display Servers
; EI ﬁ Terminal Servers
- @-% 1=
TSz

Disabled Terminal Servers

This is useful in updating terminal servers. Clients can be disconnected and have their sessions logged off,
allowing the server can be updated. Once it is updated in can be enabled to allow client to connect to it again.

7.4.7 Enable Terminal Server

The Enable Terminal Server command will enable a disabled terminal server to allow connections from thin
clients.

7.4.8 Calibrate Touch Screen

ThinManager has a touch screen configuration utility that can calibrate a thin client touch screen. The utility
can be started three ways:

e On the thin client, select Start > Program Files > Automation Control Products > Calibrate
Touch Screen (or Start > Program Files > Acp > CalTouchScreen). This is useful because it
allows the operator to calibrate the touch screen without administrative support.

¢ On the ThinManager Server, highlight the desired terminal in ThinManager and select Tools >
Calibrate Touch Screen from the menu bar. This will launch the calibration on the selected
terminal.

e The Calibration Touch Down Time (seconds) setting on the touch screen module will allow the
calibration to be triggered by holding a finger on the touch screen for the amount of time set in the
parameter. See Touch Screen Modules for details.

e The TermMon ActiveX can be configured to launch the calibration program. See TermMon
ActiveX Control for details.
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Touch Screen Calibration
Touch Crosses as they Appear

Monitor 1

Touch Screen Calibration Screen

A new touch screen calibration program was released with ThinManager 2.6 and is included in the 2.6 and

later touch screen modules. When the calibration is run, a “+” appears in the lower left. Touch the center of

the + and then touch the center of the other four +s as they appear. This provides touch screen mapping for
the terminal.

Note: The touch screen module must first be added through the Module page in the Terminal Configuration
wizard.

To launch the calibration program from the Start menu from within the session requires that the ThinManager
Utilities be installed on each terminal server. See Standard ThinManager Installation in Windows for details.

7.4.9 Send Message

Send Message will send a message to a highlighted terminal.

Send Terminal Message

Message Title IMessage Fram Thinkd anager

ﬂ Cancel |
[

Meszzage

Send Message Window

Enter the message into the Message text box. The Message Title can be changed, if desired.
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Select the OK button to send or the Cancel button to cancel.

Send Message Window

When a message is sent, an ACP splash screen will be displayed with the message until the message is
acknowledged.

7.4.10 Clear Event Log

Selecting Clear Event Log will clear the event log. The event log is configured the ThinManager Server
Configuration Wizard that is launched by double-clicking on the ThinManager in the tree or highlighting the
ThinManager and selecting Edit > Modify from the menu.

7.5 View

7.5.1 Status Bar

The Status Bar shows advice and comments on the bottom of the ThinManager window. When the Status
Bar command is checked, the Status Bar text is visible. When the Status Bar command is unchecked, the
Status Bar text is invisible.

7.5.2 Show Connected Only

View > Show Connected Only, if checked, will simplify the tree by removing unconnected terminals, terminal
servers and terminal server groups.
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7.5.3 Reports (Selection)

View > Reports will open the Select Reports window.

celect Reports | x| |

Cancel |
=]

System Feport IF'r-:uperties af Al Terminalz
Termninal Report ITerminaI Configuration Changes ;I
Terminal 5erver Feport ITerminaI Server Resource Event;l

TemSecure User Report ITermSecure Login/Logot Evenl;l

Select Reports Window

The Select Reports window allows the selection of the default report that will display when the Report tab is
selected for a ThinManager Server, terminal, terminal server, or TermSecure user.

The default reports can be changed by selecting a different report in the drop-down boxes.

See Reports for detalils.
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7.5.4 Print
View > Print will print the highlighted tab of the Details pane..
—1o) x|

Edit Manage Install Tools Wiew Remoteview Help

22T, E
E'}E{ TM3erver I:::unfiguraticunl Mu:u:lulesl Schedulel F"ru:upertiesl Ewent Lu:ugl Shadow Report |
= W Terminals =]
: . " .
Fil- @, TermGroupt | Terminal Configurati
o e L T
Q Terms3 Geteral Iupml
=l ﬁ Display Servers
|é| i il [ Select Prnter
B TErmlna E P HP Laserlet 5000 Series PCL e Macromedia FlashPaper |
H- ] Tat EXHP LaserJek P100S i3 Micrasoft PS5 Document We |
a T52 = KONICA MINCILTA magicoks S4300L |
E e ﬂ 153 | i
G1-@8 Cameras || giyuse  Ready I~ Pinttofie Preferences | |
[+ [l Display Clisnts Location: T E
Py Find Printes... I |
- ﬂ TermSecure Us |
—Page Ranga
Al Number of copies: m
) Selechor €0 Gurent Page
[ Fw [1 | ]:"“ [Tollate 4
Enter either a single page number or & single 1 £ L |
page range. For example, 512
[P | Caest | tery |
FETTTITTAT Ly U Ao L a3 .ﬂ.dmmlﬁtratﬂr
Changed 14:27:49 -
4 | _’l_l
For Help, press F1 | o

Print Reports

A Print dialog box will appear to allow the selection of the printer and the desired number of copies.
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7.5.5 Options

Selecting Options will launch the Options dialog box.
opions [

— aeneral Optiohs

¥ Display "Create New Teminal* dialog for unknown terminals.

¥ Display "Create Mew User' dislog for unknown uzers.

— lzon Optiong

[ Minimize ta the Sypstem Tray.

— License Ophions

warn if license will expire within I1 0 da(z].

A walue of 0 dizables warning.

Caricel |

Options

The Display “Create New Terminal” dialog for unknown terminals check box, if selected, will launch the
Terminal Configuration Wizard on the ThinManager Server when a new terminal is added.

The Display “Create New User” dialog for unknown users check box, if selected, will launch the
TermSecure User Configuration Wizard on the ThinManager Server when an unknown ID device (USB key
or ID card) is read by a terminal.

Note: Checking the Display “Create New User” dialog for unknown users check box is useful for
assigning ID cards to TermSecure Users. See Card and Badge Configuration for a TermSecure User for
details.

The Minimize to the System Tray checkbox will send the ThinManager icon in the system tray when
ThinManager is minimized.

Warn if license will expire within __ day(s) will set the warning period before license expiration. This is
useful for time-limited demonstration and Trialware licenses.

7.6 RemoteView

7.6.1 Interactive Shadow

Interactive Shadow, if checked, allows Administrators and members of the ThinManager Security Groups
that have interactive shadow permissions to interact and control a shadowed terminal session. If this value is
unchecked the sessions will be viewable, but observers cannot take control of the session.
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7.6.2 Scaled to Window

Scaled to Windows, if checked, will scale the shadowed terminal session to fit the Details pane of
ThinManager. If this value is unchecked the session will be viewed regular-sized, requiring the use of scroll
bars to view portions of the screen.

7.6.3 Go FullScreen

This allows the connection from the Connect tab on ThinManager to the terminal server to be displayed full
screen instead of in a window in ThinManager.

This session can be switched to full-screen by selecting RemoteView > Go FullScreen in the menu. This
changes the appearance from running from within a window to running as a desktop.

The full screen session will have a tool tab at the top of the screen with controls that allow the window to be
switched back to the window or to close the connection.

[+ Blue - 0 X

Remote Session Tool Bar

The standard Minimize, Maximize, and Close icons on the Remote Session Tool Bar allow control over the
session.

The hot keys of CTL+ALT+BREAK will allow you to switch to full screen mode or to exit full screen mode.

7.6.4 Connect Options

Selecting RemoteView > Connect Options will launch the Terminal Server Connect Options window that
allows the terminal server Remote View connection to be configured.

Terminal Server Connect Options E |

—%ideo Settings

Yideo Mode I'“:'E*h"?EE LI Cancel |
Widthl 1024 Height 768

Calar Depth | 256 Colors -

—Access Options

[ allow Auto-Login
[T allow sccess to Local Drives

[T Cornect To Conzole

Terminal Server Connect Options

The Video Settings include:

o Video Mode — This allows the connection to be displayed at a specific resolution or as full
screen.
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e Width — This allows the connection to be displayed at a specific width if the Video Mode is set to
Custom.

e Height — This allows the connection to be displayed at a specific height if the Video Mode is set
to Custom.

e Color Depth - This allows the connection to be displayed at a specific color depth. Windows
2003 is required for high-color.

The Access Options include:

e Allow Auto-Login — This allows the connection to login without prompting when checked. It will
use the login information that is entered on the Terminal Server Name page of the Terminal
Server Wizard.

e Allow Access to Local Drives — This allows the user to access the hard drive on the remote
computer from the remote connection.

e Connect To Console — This allows the ThinManager user to capture the console session for
display through ThinManager instead of starting a new session on the terminal server.

7.6.5 Send Key

Send Key allows the sending of key commands to the shadowed session that are normally saved for the local
machine and don't function in shadowing. These include:

e CTLL+ALT+DEL

e CTL+ESC

e ALT+Tab

e ALT+Shift+Tab
e ALT+ESC

e ALT+Space.

Select RemoteView > Send Key and the desired key combination to send the key command to the
shadowed session.

Note: The Key Block module will block this command if it is used on the terminal. See Key Block Module for
details.

7.7 Help

7.7.1 Help Topics

Selecting Help Topics will launch the ThinManager Help file. This file can also be launched by selecting F1
while using ThinManager.

7.7.2 About ThinManager

Selecting About ThinManager will display a dialog box with ThinManager version information, copyright
information, and contact information for ThinManager.
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7.8 Right Click Menus in the Tree Pane

7.8.1 Right Click on the ThinManager Server Icon

e Reconnect - This causes the ThinServer service to try to reconnect to the highlighted
ThinManager Server.

¢ Modify - This launches the ThinManager Server Configuration Wizard to configure the
highlighted ThinManager Server.

e Remove - This removes the highlighted ThinManager Server from the tree. It does not remove
any configuration or uninstall the program.

See Add ThinManager Server for details.

7.8.2 Right Click on the Terminals Branch Icon
e Add Terminal - This launches the Terminal Configuration Wizard to create a terminal.
e Add Group - This launches the Terminal Group Configuration Wizard to create a group.

e Restart Terminals - This sends a signal to all the terminals to reload any changes to its
configuration, modules, or firmware. It will only do a full reboot if needed.

7.8.3 Right Click on a Terminal Group Icon

e Add Terminal - This launches the Terminal Configuration Wizard to create a terminal in the
group.

e Add Group - This launches the Terminal Group Configuration Wizard to create a group.

e Restart Terminals - This sends a signal to all the terminals under the highlighted icon to reload
any changes to its configuration, modules, or firmware. It will only do a full reboot if needed.

e Modify - This launches the Terminal Group Configuration Wizard to configure the highlighted
group.

e Rename - This allows the Group to be renamed.

o Delete - This removes the Group from the ThinManager configuration. Member terminals can be
deleted with the group, or moved out of the group, depending on the choice in the confirmation
window.

ThinManager |
Do wou wank to delete the Terminals For Group Group3 as well?

MOTE: IF no, Group Members will be assigned to the parent group
Cancel |

Delete Group confirmation Window

Selecting Yes will delete the Group and all member terminals.

Selecting No will delete only the group. The member terminals will be moved out of the group and retain their
configuration as individuals.
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Selecting Cancel will stop the process and allow the group to remain as it is.

7.8.4 Right Click on a Terminal Icon
e Modify - This launches the Terminal Configuration Wizard to configure the highlighted terminal.
e Rename - This allows the terminal to be renamed.
e Delete - This removes the terminal from the ThinManager configuration.

e Go to TermSecure User - This changes the focus of the tree to the TermSecure User that is
logged into the terminal.

e Restart Terminal - This sends a signal to the terminal to reload any changes to the configuration,
modules, or firmware. It will only do a full reboot if needed.

7.8.5 Right Click on the Display Servers Terminal Servers Branch Icon

e Add Terminal Server - This launches the Terminal Server Wizard to create and configure a
new terminal server.

e Edit Terminal Server - This launches the Terminal Server List Wizard to allow the
configuration of an existing terminal server.

See Terminal Services Display Servers for details

7.8.6 Right Click on a Terminal Server Icon

e Modify - This launches the Terminal Server Configuration Wizard to allow changes to the
configuration of the highlighted terminal server.

e Rename - This allows the terminal server to be renamed.
e Delete - This removes the terminal server from the ThinManager configuration.
ThinManager

Delete Terminal Server Cream, Are You Sure?

Terminal Server Deletion Confirmation

ThinManager will prompt for confirmation before deletion.

ThinManager E3

This server is used in at least one Terminal Configuration of a Server Group, Femowe From all Terminal configurations and Server Groups before atkempting bo
delete,

Terminal Server Deletion Error

A terminal server cannot be deleted from a configuration if it still has terminals assigned to it.

e Restart Terminals - This sends a signal to the terminal to reload any changes to all terminals
connected to the terminal server. It will only do a full reboot if needed.

Automation Control Products ThinManager 5.0 Help Manual Menu Items e 123



7.8.7 Right Click on the VCenter Servers Branch Icon
The branches of the VCenter Server tree have various right-click menus:
e VCenter Servers:

0 Add vCenter Server — Launches the VCenter Server Property Wizard to allow a VCenter
Server to be defined.

o Defined VCenter Servers:
0 Remove — Removes the defined VCenter Server.
e Imported Datacenter:
0 Rename — Allows you to rename the datacenter.
o0 Delete — Allows you to delete the datacenter.
e Virtual Machine:
o0 Power Operations:
= Power On — Turns on a stopped or suspended virtual machine.
= Power Off — Turns off a stopped or suspended virtual machine.
= Suspend — Suspends a running virtual machine and stores the state.
= Reset — Cycles power to the virtual machine to restart the virtual machine.
0 Snapshot:
= Take Snapshot — Captures and stores the state of the virtual machine.

= Revert to Current Snapshot — Reapplies the stored state of a previously saved
virtual machine.

= Snapshot Manager — Launches the Snapshot management tool.
0 Rename - Allows the virtual machine to be renamed.

o Remove from Inventory — Removes the virtual machine from the tree without deleting the
files.

0 Delete — Removes the virtual machine from the tree AND deletes the file system.

7.8.8 Right Click on the Display Client Branch Icon

e Add Display Client- This launches the Display Client Wizard to create and configure a new
Display Client.

o Edit Display Client- This launches the Display Client List to allow the configuration of an
existing Display Client.

See Display Client List for details.

7.8.9 Right Click on a Display Client Member Icon

e Modify - This launches the Display Client Configuration Wizard to allow changes to the
configuration of the highlighted Display Client.

e Rename - This allows the Display Client to be renamed.

e Delete - This removes the Display Client from the ThinManager configuration.
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Edit Manage Insktall Tools Wew RemoteWiew Help

Eg;( TM3erver Config | Server Hankl
Q Termz Cliernt Tupe Terminal Services
Q Term TerminalServers T51
=~ a Display Servers S
E| i Termingl Servers Enforce Primary Server MO
i a 51 Instant Failower TS
o g = s
» j To3 ROFP
- g Cameras Delete Display Client TSClentl, Are You Sure?
|:—:||:| Display Clients _
[':l F Terminal Services Mo KO
E2RE kT Clienit 1
e {0 Tl
[=]- E Camera Linked Application
- ggl CamClient1

E CamClient2 Display Client Dptions
EIQ Terminal Shadow Always maintain a session
------ Shadowlient

: Start a zezzion at boot-up YES
e ShadowiZlient

Disconnect sezsion when chent iz in the background MO

- 8 TermSscure Users Allows client ta be Tiled YES _I;I
4| | o] | | b

Far Help, press F1 | [ 4

[l

Terminal Services Display Client Deletion Confirmation

ThinManager will prompt for confirmation before deletion.

ThinManager x|

This Display Client is used in at least one Terminal or User Configuration,
Remove from all Terminal and User configurations before atbempting to
delete,

Display Client Deletion Error

A Display Client cannot be deleted from a configuration if it still has terminals assigned to it.
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7.8.10

7.8.11

Right Click on the TermSecure Users Branch

Add TermSecure User — This launches the TermSecure User Configuration Wizard to allow a
TermSecure User to be defined.

Add TermSecure User Group — This launches the TermSecure User Group Configuration
Wizard to allow a TermSecure User Group to be defined.

Right Click on a TermSecure Users Group Icon

Add TermSecure User — This launches the TermSecure User Configuration Wizard to allow a
TermSecure User to be defined.

Add TermSecure User Group — This launches the TermSecure User Group Configuration
Wizard to allow a TermSecure User Group to be defined.

Modify - This launches the TermSecure User Group Configuration Wizard to allow changes to
the configuration of the highlighted TermSecure User Group.

Rename - This allows the TermSecure User Group to be renamed.

Delete - This will remove the TermSecure User Group from the ThinManager configuration.
Members can be deleted with the group or moved out of the group, depending on the choice in
the confirmation window.

ThinManager |
Do wou wank ko delete the Users For Graup Admins as well?

MOTE: IF no, Group Members will be assigned ko the parent group
Cancel |

Delete Group confirmation Window

Selecting Yes will delete the Group and all members.

Selecting No will delete only the group. The members will be moved out of the group and retain their
configuration as individuals.

Selecting Cancel will stop the process and allow the group to remain as it is.

7.8.12

Right Click on a TermSecure Users Icon

Modify - This launches the TermSecure User Configuration Wizard to allow changes to the
configuration of the highlighted TermSecure User.

Rename - This allows the TermSecure User to be renamed.
Delete - This removes the TermSecure User from the ThinManager configuration.
Logoff User — This logs the TermSecure User out the terminal that it is currently logged into.

Go to Terminal - This changes the focus of the tree to the terminal that the TermSecure User is
logged into.
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8 Adding Thin Client Hardware

8.1 The Boot Process

There are two methods that an ACP Enabled thin client can use to boot. The standard method is to connect to
a ThinManager Server and download the firmware and its configuration across the network. This allows for an
easy update of the firmware and ensures that all the terminals share the same firmware. Embedded
ThinManager Ready thin clients have the firmware embedded in them on a compact flash or disk-on-chip and
boot locally then connect to a ThinManager Server to download its configuration. See Firmware Update (Disk
On Chip / Compact Flash) Update Module for details.

A ThinManager Ready thin client goes through a number of steps from the initial power on to the complete
connection to a terminal server. Understanding this process will aid in terminal configuration and
troubleshooting.

The steps are:

1.

POST: Once a ThinManager Ready thin client is turned on it begins the Power On Self-Test to
examine the hardware and to test the memory.

IP Address Assignment: The terminal needs an IP address to connect to the network. By default, it
receives an IP Address from a DHCP server, but this can be changed to use an assigned static IP.
See IP Address Assignment for details.

ThinManager Server Connection: After receiving an IP address the terminal will connect to the
ThinManager Server. This is the Boot Server Host as defined in the DHCP scope Option 066 or the
Primary ThinManager Server defined in the static IP address configuration.

Firmware Loading: Next the terminal will download the firmware from the ThinManager Server.

Terminal Configuration Download: Established terminals will receive their configuration and
proceed. New terminals will need to be defined on the ThinManager Server, either through the
Terminal Configuration Wizard or the Create New Terminal method.

ACP ThinManager Logo Screen: After the terminal receives its configuration, it will display an ACP
splash screen with the ThinManager logo.

Client Communication Connection: Next the terminal will launch its Client Communication protocol.

Terminal Server Connection: The thin client will connect to the terminal server(s) that it is assigned
to in its configuration.

Windows Login: Next the terminal will display the Windows Login dialog box, prompting for a valid
username and password. If these have been entered into the username and password fields on the
Terminal Configuration Wizard of ThinManager, the terminal will login automatically and display the
Windows desktop or a defined initial program.
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Note: Windows 2000 prevents auto-login with RDP by default. To allow auto-login see RDP-tcp Login

Settings for details.

Windows Session: The terminal logs onto a session on terminal server. The terminal will pass mouse clicks
and keystrokes to the session on the terminal server. The terminal server will process the data and send the
graphics back to the terminal for display, giving a full Windows experience to the user.

8.2 IP Address Assignment

ThinManager Ready thin clients are set by default to automatically receive an IP address from a DHCP
server. Most ThinManager Ready thin clients may use a manually assigned Static IP address instead.

Note: The ThinAdapter and ThinAdapter Plus require DHCP.

8.2.1 DHCP

ThinManager Ready thin clients are set to use DHCP (Dynamic Host Configuration Protocol) by default. The
DHCP Server needs two options configured for ThinManager Ready thin clients.

Server Options

General | Advanced I

HE|

Available Options

| Descriptinnd

[ 064 MIS+ Damnain Mame
[ 085 MIS+ Servers
0BG Boot Server Host Mame

Q&7 Bootfile Mame

J

The name ¢
A st af IP 2
TFTF boaot

Bootfile Har =
3

— Data entry

String walue;

192168321 192.168.2.24

o]

Cancel

Apply

DHCP Options
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Option 066 - Boot Server Host Name must be set to the IP address of the ThinManager Server. If redundant
ThinManager Servers are being used, the IP addresses of multiple ThinManager Servers can be entered,
separated with a space.

Option 067 - Bootfile Name must be set to Firmware .acp.

Details are at DHCP Server Setup for details.

ThinManager Ready thin clients use DHCP (Dynamic Host Configuration Protocol) by default. If they have
been set to use a static IP they can be reset to DHCP from static IP by pressing any key when prompted
during the boot sequence to open the IP Configuration Menu.

{
Enter new Terminal
Enter 'D' for DHCP o

IP Configuration Menu - DHCP

Press the A key to allow a change to DHCP and enter D key to set the configuration to DHCP. Press the
Enter key to return to main menu.

Press the S key to save the configuration and continue with the boot process.

Download Pro gr

Boot Process - Firmware Download

The terminal will connect to the ThinManager Server and download the firmware.
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The download bar will be purple if the terminal is using Multicast during the download. See MultiCast
Configuration Page for details.

8.2.2 Static IP

Most models of ThinManager Ready thin clients allow the usage of static IPs. These are set by interrupting
the boot process to launch the IP Configuration Menu and adding the static IPs.

Boot Process - Press Any Key Prompt

To set the terminal to use a static IP, press any key at the appropriate moment of the boot sequence.

(A) g = DHCP
(F) Password Status = Disabled
(H)

()

(8)
Enter Mew Terminal Addrass
‘D' for DHCP or

IP Configuration Menu — Static IP

Press the A to allow the client IP to change from DHCP.

Type in the static IP address for the client, including the separating periods and press the Enter key.
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n Control Products

IP Configuration Menu - Options

Once the Terminal has a static IP assigned, the IP Configuration Menu will be shown to allow the setting of
other values.

(A) Terminal IP Address - This should be a unique address for the terminal.

(B) Primary ThinManager Server IP Address - This should be the unique address for your main
ThinManager Server.

(C) Secondary ThinManager Server IP Address - The Secondary ThinManager field allows the
terminal to use two ThinManager Servers. If the terminal cannot connect to the Primary
ThinManager Server, it will connect to the Secondary ThinManager Server to receive its
configuration. If you are not using a Secondary ThinManager Server, set the IP address to
0.0.0.0.

(D) Router IP Address - Fill in the IP address of the router or gateway if one is being used. If not
this should be set to 0.0.0.0.

(E) Subnet Mask - Set this to your subnet mask. 255.255.255.0. is a standard setting.

(F) Password Status - Allows a password to be set to prevent unauthorized people from
changing the configuration.

(H) Help - Will launch a Help to explain the IP Configuration Menu.

(Q) Abort Changes and Exit - This will cancel any setting changes and let the terminal continue
to boot with the old settings.

(S) Save Changes and EXxit - This will apply any changes and allow the terminal to continue to
boot with the new settings.

Type the letter of the desired setting and type the IP address, with periods. Press the Enter key on the
keyboard to accept each change.

Once configured the terminal will connect to the ThinManager Server and download the firmware and
configuration.
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8.2.3 Hybrid IP Addressing

ThinManager Ready thin clients that have BootROM version 5.01 or later have the ability to use DHCP for the
client IP address and have the ThinManager Server IP addresses entered as static IPs to save having to
configure the DHCP server with Option 066.

Selecting any key when prompted during bootup opens the IP Configuration Menu.

ACP Hetwork Boot Loader vh.01
Copyright 199%9-2004 Automation Control Products

IP Configuration Menu

{A) Terminal IF Addresz = DHCP

{B) Primary ThinManager Server IP hddress = DHCP {(Option 66)
Secondary ThinManager Serwver IF hddress = DHCP {(DOption 66)
Pazz=word Status : Disahled
Load Default Values
Help

Abort Changes and Exit
{5) Save Changes amd Exit

Select Letter:

Boot Loader v5.01 Default Values

Typing the B key will allow the configuration of a static IP for the ThinManager Server. Type the numbers and
periods for the address.

ACPF Hetwork Boot Loader v5.01
Copyright 1999-2004 Automation Control Products

IF Configuration Menu

(A) Terminal IPF Address = DHCP

(B} Primary ThinManager Server IF Address = 192, 16%.3.11
{C}) Secondary ThinManager Server IP Address = 192.168.3.12
{(F) Passzword Status = Di=zabled

{6} Load Default Values

{(H) Help

{0) fbort Changes amd Exdt
{5) S5ave Changes amd Exit

Select Letter:

DHCP with Static ThinManager Server
Once a ThinManager Server is assigned, typing C will allow a redundant secondary ThinManager Server to
be assigned.

Type S to save the changes and allow the connection to the ThinManager Server. The terminal will now boot
using DHCP.

Note: The Escape key will let you exit the entry field and return to the IP Configuration Menu.
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8.3 Configuring New Hardware

The configuration of terminals is done in ThinManager on the ThinManager Server and not on each individual
terminal. When a new, undefined ThinManager Ready Thin Client is first connected to a ThinManager Server
one of three things will happen:

e If the ThinManager Server has no terminals that are configured and offline, then the terminal will
go into the Create New Terminal Mode and launch the Terminal Configuration Wizard on the
ThinManager Server. Once the terminal is configured on the ThinManager Server it will
automatically download its configuration upon boot up.

o If the ThinManager Server has terminals that are created and offline, the terminal will go into
Replace or Create Mode and list the offline terminals that are available for selection. Once a
configuration is selected, the terminal will take that identity. During any following boot up the
terminal will automatically download its configuration.

e Athird scenario is to use the Auto-Create Terminal Mode to create an array of terminals.

8.4 Create New Terminal Mode

Turning on a terminal for the first time will initiate the Create New Terminal mode if:
e No terminals are defined in ThinManager, or
e All the defined terminals are currently connected, or

e All the defined terminals that are turned off have the Allow This Terminal To Be Replaced If Off
Line check box unselected.

ACP Hetwwork Boot Loader vh.01
Copyright 1999-2004 Auwtomation Control Products

Please Wait while Terminal i= defined on Serwver 192.168.3.11

Create New Terminal Mode Screen

When a terminal enters the Create New Terminal Mode, the terminal will launch the Terminal Configuration
Wizard on the ThinManager Server. The terminal will display a screen indicating that it will wait until the
configuration is finished before progressing further.
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8.5 Replace or Create New Terminal Mode

Turning on a terminal for the first time will initiate the Replace or Create New Terminal Mode if one or more
of the defined terminals are offline and they have the Allow This Terminal To Be Replaced If Off Line
check box selected.

Thi= Terminal is undefined on Serwver 192, 168.3.11
Choose the terminal to Replace or Action

Innexid Innex

Annex1B Annex
hnnex2C Innex
Boilerl Boilers
Boiler3 Boilers
Parts1l Parts
Shipping 2 Shipping
Create Hew Terminal

Replace or Create Mode

The screen will display all the offline terminals that the terminal can replace. Highlight the desired terminal
name using the keyboard and press the Enter button. The terminal will retrieve the selected configuration and
assume its identity.

8.6 Auto-Creation of Terminals
Auto-Create allows new terminals to be created and configured in an array, using the Default Terminal as a
template.

Turning on a terminal for the first time will initiate the Replace or Auto-Create Terminal mode if:

e The Auto-Create mode is enabled by the selection of the Enable AutoCreate check box on the
Unknown Terminal page of the ThinManager Server Configuration Wizard.
The ThinManager Server Configuration Wizard is launched by selecting Manage > Settings
from the ThinManager menu.

And

o The Default terminal is configured as a template for the new terminals.
This is done by selecting Manage > Configure Default Terminal on the ThinManager menu.

And

e The user selects Auto-Create from the Replace or Action Menu as the terminal boots and
connects. The user can do a replacement instead of an Auto-Create.

8.6.1 Enabling AutoCreate

Open the ThinManager Server Configuration Wizard by right clicking on the ThinManager Server in the
tree and selecting Modify, or select Manage > Settings from the menu.
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The terminal will be given the name of the Auto-Create Mask and a number, starting with “0”. The Auto-
Create Mask is configured on the Unknown Terminals page of the ThinManager Server Configuration

Wizard.

5= ThinManager Server Configuration Wizard

Unknown Terminals

Chooge whether unknown terminalz are to be allowed to connect to b ‘
A

thiz Thintd anager Server.

— Unknawn Terminalz
Allows unknown terminals to connect

Fiequire pazsword on unknown terminalz

Paszword I

aonfirm I

— Autamatic Terminal Creation

Enable AutoCreate v

AutoCreate Mask I.-’-‘-.utu:uT £

< Back I Mest » I Finizh

Help

Unknown Terminals

Check the Enable AutoCreate checkbox and enter an AutoCreate Mask name. This allows new terminals to
be added to the system and configured without additional input from the server.
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8.6.2 Configuring Default Terminal

The Default Terminal is created by selecting Manage > Configure Default Terminal. This will launch the
Terminal Configuration Wizard for a terminal pre-named “Default”.

52 Terminal Configuration Wizard 5[

Terminal Mame G

Enter the name for thiz terminal, select the terminal group to which b ‘
thiz terminal belongs, or chooze to copy the configuration from A
another terminal.

— Terminal Hame
Drefauilt

Thiz rmuszst be a unique name uzing letterz, numberz, hyphens [-],
and underscores [_] only.

— Terminal Group

— Copy Settings

[ Copy Settings from anather Terminal Copy Fram |

Permizsions |

< Black | Mest » | Finizh | Cancel Help

Default Terminal Configuration

Configure the terminal with the desired settings. The Default terminal can be added to a Group by selecting
the Change Group button.

Once the wizard is finished, the Default terminal will be displayed in the ThinManager Server tree.
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Edit Manage Insktall Tools Wew RemoteWiew Help

El';;‘ THMServer
=- Q Terminals

El@ TermiGroupl

- =

] Q Termz
- Q Terms3

Display Servers

(|

¥

i Terminal Servers
H- [ 181
B [ 1s2
H- [ 153

[+ B8 Cameras

!

[l Display Clients

[L]ﬁ Terminal Services
-l TsClientt
-l T5Chent2

E CamiClient1

EQ Terminal Shadow

For Help, press F1

@ Term3ubGroupl

- TsClient1
5 T5Clentz

e

[ |

Configuratian | Mndulesl Schedulel F'ru:upertiesl Ewent Lu:ugl Shaduwl Hepu:urtl

Attribute
Terminal |dentification

Terminal Mame

tadel Mumber
bl anufacturer
Yideo Controller

TouchScreen Tupe

Login zemame

Login Diamain

R eplaceable

Allow Shadowing

Allowy |nteractive Shadowing
Terminal Effects

Show Statuz Messages

l@ IJze Dizplay Clients
Dizplay Chents

1|

Terminal Properties

W alue -

Drefault

DC-30-100
ACP
CyberPro2010
M/

YES
YES
YES
YES
YES
YES
T5Client?

T5Clients il
| 5

ThinManager Tree with Default Terminal

Once the Enable AutoCreate check box on the Server Properties window is checked and the Default
Terminal is created and configured, any new terminal connected to the ThinManager Server will have

AutoCreate Terminal as an option.
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AhutoCreate Terminal

Replace or Action Menu

The user needs to scroll to AutoCreate Terminal and press the Enter key to automatically create and
configure the terminal.

The new terminal will be given the AutoCreate Mask and a number, starting at 0, for its name. This name will

also be entered in the Username field of the Log In Information page of the Terminal Configuration
Wizard.
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9 Configuration Wizards

9.1 Introduction to Wizards

ACP ThinManager uses wizards for configuration. Wizards take two forms.

List Wizards associate Terminal Servers and ThinManager Servers with their IP addresses or

assign server functions to groups of Terminal Servers.

Configuration Wizards set the parameters and options for individual terminals, groups of
terminals, Display Servers, Display Clients, TermSecure Users, and TermSecure Server Groups.
This is where the terminals and TermSecure Users have their settings defined.

This help will list the wizards in the following order:

ThinManager Server List

ThinManager Server Configuration Wizard
DNS Configuration

PXE Server Configuration Wizard
Terminal Configuration Wizard

Terminal Group Configuration Wizard
Display Server Configuration Wizards

e Terminal Services Display Servers

e Camera Configuration Wizard
VCenter Server Configuration Wizard
Display Client Configuration Wizards

e Terminal Services Display Clients

e Camera Display Clients

e Terminal Shadow Display Clients
TermSecure Configuration

e TermSecure User Configuration Wizard

e TermSecure Users Group Configuration Wizard
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9.1.1 List Wizards

The List Wizards are:

Terminal Server List — Used to show defined Terminal Servers, or Terminal Services Display Servers. The
Terminal Server Configuration Wizard can be launched from here. Launched by:

o Expanding the Display Server branch, right clicking on the Terminal Servers icon, and selecting
Edit Terminal Server List.

See Terminal Services Display Servers for details.

Display Client List — Used to show defined Display Clients. The Display Client Configuration Wizard can
be launched from here. Launched by:

¢ Right clicking on the Display Client icon, and selecting Edit Display Client List.
See Display Client List for details

ThinManager Server List — Used to define ThinManager Servers and setup Automatic Synchronization.
Launch by:

e Selecting Manage > ThinManager Server List.

See ThinManager Server List for details.

9.1.2 Configuration Wizards
The Configuration Wizards are:
Domain Name Server Wizard — Used to configure DNS, if needed. Launched by:
e Selecting Manage > DNS Configuration.
See DNS Configuration for details.

PXE Server Configuration Wizard — Used to configure ThinManager for use with PXE thin clients.
Launched by:

e Selecting Manage > PXE Server.
See PXE Server Configuration Wizard for details.

ThinManager Server Configuration Wizard — Used to configure global ThinManager properties like
scheduling, e-mail notification, and user access. Launched by:

¢ Double clicking on the ThinMan icon.

e Right clicking on the ThinMan icon and selecting Modify.

e Highlighting the ThinMan icon and selecting Edit > Modify.
See ThinManager Server Configuration Wizard for details

Terminal Configuration Wizard — Used to configure Terminals, both thin clients and PCs with WinTMC
installed. Launched by:

e Selecting Edit > Add Terminal in the menu.
e Right clicking on the Terminals branch icon and selecting Add Terminal.
¢ Double clicking on an existing terminal icon.

See Terminal Configuration Wizard for details.
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Terminal Group Configuration Wizard — Used to configure groups of Terminals, both thin clients and PCs
with WinTMC installed. Launched by:

e Selecting Edit > Add Terminal Group in the menu.
e Right clicking on the Terminals branch icon and selecting Add Group.
e Double clicking on an existing terminal group icon.
See Terminal Group Configuration Wizard for details.
Terminal Server Wizard — Used to define and configure Terminal Servers. Launch by:

e Expand the Display Server branch, right click on the Terminal Servers icon and select Add
Terminal Server

e Double clicking on an existing Terminal Server icon.
Camera Configuration Wizard - — Used to define and configure IP cameras as Display Servers. Launch by:
e Expand the Display Server branch, right click on the Cameras icon and select Add Camera.
e Double clicking on an existing Cameras icon.
See Camera Configuration Wizard for details

VCenter Server Wizard - Used to create and configure VCenter Servers. These are virtual machines
managed by VMWare’'s vCenter Server. Launch by:

e Highlighting the VCenter Server branch, right clicking, and selecting Add VCenter Server.

Display Client Wizards - Used to create and configure Display Clients. These include the Terminal Services,
Camera, Terminal Shadow, and Workstation Display Clients. Launch by:

e Highlighting the Display Clients branch, right clicking, and selecting Add Display Client.

¢ Expanding the Display Clients branch, highlighting Terminal Services, right clicking, and
selecting Add Display Client.

e Expanding the Display Clients branch, highlighting Camera, right clicking, and selecting Add
Display Client.

e Expanding the Display Clients branch, highlighting Workstation, right clicking, and selecting
Add Display Client.

e Expanding the Display Clients branch, highlighting Terminal Shadow, right clicking, and
selecting Add Display Client.

e Double clicking on an existing Display Client icon.
See Display Client Configuration Wizard for details
TermSecure User Configuration Wizard — Used to define and configure TermSecure Users. Launch by:
e Highlighting the TermSecure User branch, right clicking, and selecting Add TermSecure User.
e Double clicking on an existing TermSecure User icon.
See TermSecure User Configuration Wizard for details.

TermSecure User Group Configuration Wizard — Used to define and configure TermSecure User Groups.
Launch by:

e Highlighting the TermSecure User branch, right clicking, and selecting Add TermSecure User
Group.

e Double clicking on an existing TermSecure User Group icon.

See TermSecure Users Group Configuration Wizard for details.
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9.2 ThinManager Server List

Selecting Manage > ThinManager Server List will launch the ThinManager Server List Wizard to allow the
definition of ThinManager Servers. The definition of ThinManager Servers allows the connection to remote
ThinManager Servers and allows the synchronization of ThinManager Server configurations.

Multiple ThinManager Servers should be synchronized so that a terminal will receive the same configuration
regardless of the ThinManager Server that it boots from.

Automatic Synchronization will connect all of the configuration databases on the ThinManager Servers in
this list and keep them synchronized so that a change on one is a change on all. See Automatic
Synchronization for details.

Manual Synchronization requires a user to synchronize the configurations after each configuration change.
See Synchronize Configuration for details.

x4
ThinManager Server List Wizard W
}-.‘

[ ntroduction

The Thinkdanager Server ‘wWizard defines the Thinkdanager Servers on pour
network. Thesze are the servers to which the thinclients can make monitor
connechions.

The Thinkdanager Server name muzt be the name Windows uses to identify
your computer an the netwaorl.

[ pou are uzing a DS server pou will only enter the server name.

[f you are not wzing a DS zerver you will enter a zerver name and IP address.
The zerver name will be for reference anly.

¢ Back Finizh Cancel Help

ThinManager Server List Wizard - Introduction

Importance of Page: This displays introductory information

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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9.2.1.1 Auto-Synchronization Selection Page

5 ThinManager Server List Wizard 5[
Auto-synchromzation selection m
(=

Check Autornatic Synchronization to autamatically synchronize the
configuratian of twa Thinkdanager servers.

Check the box if you want ko use Autamatic Synchranization bebween bwo
Thintdanager servers. Leave the box unchecked if you want to uze manual

gpnchronization.

[f wou have mirrored licenses, then you must uge Automatic Synchronization.

[ isutomatic Synchronization

< Back I Hest > I Finizh Cancel Help

Auto-synchronization Selection

Importance of Page: Enables Auto-synchronization.
Settings:
e Automatic Synchronization — Check this to initiate auto-synchronization.

Why Change from Default Settings: Auto-synchronization is required for Mirrored licenses and Redundant
Licenses. It also makes sure that redundant ThinManager Servers have the same configuration.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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9.2.2 Automatic Synchronization

Multiple ThinManager Servers should be synchronized so that a terminal will receive the same configuration
regardless of the ThinManager Server that it boots from.

Automatic synchronization is required for Mirrored licenses, Redundant licenses, and Enterprise Server

licenses
x|
Auto-synchromization selection m
=y

Check Autormatic Synchronization to automatically synchronize the
configuration of twa Thinkd anager servers.

Check the box if you want ko use Autamatic Synchranization bebween bwo
Thintdanager servers. Leave the box unchecked if you want to uze manual
gpnchronization.

[f wou have mirrored licenses, then you must uge Automatic Synchronization.

v isutomatic Synchronization

< Back I Hest > I Finizh Cancel Help

Auto-synchronization Selection

Select the Automatic Synchronization checkbox and select the Next button to configure Auto-
synchronization.

Automation Control Products ThinManager 5.0 Help Manual Configuration Wizards e 144



9.2.2.1 Automatic Synchronization Configuration

5 ThinManager Server List Wizard 5[
Auto-spynchromzation Configuration m
(=

Define the primany and zecondamy Think anaager servers. These
zervers will be synchronized.

— Prirmary Thintanager Server

Edit |

M arne |

IP Addrass |

— Secondary Thinkdanager Server

E dit |

M ame |

IP Address |

< Back [ [ Cancel Help

Auto-synchronization Configuration

Importance of Page: Defines and displays the Primary and Secondary ThinManager Servers. This allows a
terminal to boot from a backup if the primary fails.

Fields:

e Name (Primary ThinManager Server) — This field is for the NetBios name of the Primary
ThinManager Server. Use its real name and not a shortcut or nickname. The name is entered by
using the Edit button.

o IP Address (Primary ThinManager Server) — This field is for the IP address of the Primary
ThinManager Server. It is entered by using the Edit button.

e Name (Secondary ThinManager Server) — This field is for the NetBios name of the Secondary
ThinManager Server. . Use its real name and not a shortcut or nickname. The name is entered by
using the Edit button.

e |P Address (Secondary ThinManager Server) — This field is for the IP address of the Secondary
ThinManager Server. It is entered by using the Edit button.

Buttons:

e Edit (Primary ThinManager Server) — This button launched the Enter The Primary ThinManager
Server Information Window that is used to define the primary ThinManager Server.
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e Edit (Secondary ThinManager Server) — This button launched the Enter The Secondary
ThinManager Server Information Window that is used to define the backup ThinManager Server.

Why Change from Default Settings: The Name and IP address of both ThinManager Servers need to be
defined for auto-synchronization to work.
9.2.2.2 Defining the ThinManager Servers

Select each Edit button on the Auto-synchronization Configuration page to launch the Enter ThinManager
Server Information Window for each ThinManager Server.

Enter the Primary ThinManager Server Information |

Thirtd anager Server Blue (] I

C I
Thinkd anager Server [P I [EENR L = anee

Digoowver |

Enter ThinManager Server Information Window

Enter the name of the ThinManager Server in the ThinManager Server field.
Enter the IP address of the ThinManager Server. The Discover button will enter the IP address for you.
Select the OK button to accept the settings or the Cancel button to close without saving.
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5 ThinManager Server List Wizard

Auto-spnchromzation Configuration

Define the prmary and secondary Thinkanager servers. These

zervers will be synchronized.

X

=

— Prirmary Thintanager Server

Edit |

M arme |Elue

IP Address 192188.1.3

— Secondary Thinkdanager Server

E dit |

Name |I3 reen

IF Address [152.168.1.34

< Back [ [

Cancel

Help

Auto-synchronization Configuration

When complete, the Auto-synchronization Configuration window will show the Primary and Secondary
ThinManager Servers. This will automatically synchronize their configuration so that a terminal will receive the
same configuration regardless of the ThinManager Server that it boots from.

Additionally, the status lights for the terminals will be displayed in the trees of both ThinManager Servers.
Select Finish to save and close, or Cancel to close without saving.
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9.2.3 Defining ThinManager Servers for Manual Synchronization

9.2.3.1 ThinManager Server List Page

5=\ ThinManager Server List Wizard |

Enter the ligt of Thinkdanager Servers an vaur netwark.

ThinManager Server List w
}-’

A
v |

Femove Server | Edit Server |

< Back | Hewt | Finizh | Cancel | Help |

ThinManager Server List - Blank

Importance of Page: This page allows ThinManager Servers to be defined.

The ThinManager Server List is the collection of ThinManager Servers on the network. These include
ThinManager Servers that the terminal will communicate with to keep the connection status lights in the
ThinManager tree updated. It also allows access to remote ThinManager Servers that allow network wide
monitoring, control, and management.

Fields:

e List Box (Unlabeled) — The list box will display a list of defined ThinManager Servers and their IP
addresses.

Buttons:
e Remove Server — This button will clear a highlighted ThinManager Server from the list.

e Add Server — This button will launch a window that allows the entry of a ThinManager Server name
and IP address.

e Edit Server — This button will launch a window that allows the change of a highlighted ThinManager
Server name and IP address.
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e Arrows — These buttons adjust the order of the ThinManager Servers. The computer on top is
considered the Primary ThinManager Server.

Why Change from Default Settings: The ThinManager Servers need to be defined and listed in the window
to be available for manual synchronization and remote access.

Select the Add Server button on the ThinManager Server List Page to launch the Enter the new
ThinManager Server Definition Window.

Enter the new ThinManager Server Definition |

Thintd anager Server IEH'-‘E

s

C I
Thintdanager Server [P I ™2 .18 . 1. 3 Anee

ThinManager Server Definition

Enter the name of the ThinManager Server in the ThinManager Server field.

Enter the IP address of the ThinManager Server in the ThinManager Server IP field. The Discover button will
enter the IP address for you.

Select the OK button to accept the settings or the Cancel button to close without saving.
Repeat until all ThinManager Servers are defined.
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5 ThinManager Server List Wizard

ThinManager Server List
Enter the list of Thinkanager Servers on pour nebwork.

Blue [192.168.1.36]
Green [192.168.1.34]

FRemove Server | Add Server I Edit Server |

< Back | [ [ | Finizh | Cancel |

Help |

ThinManager Server List - Filled

When all of the desired ThinManager Servers are added to the list, select Finish to close the ThinManager

Server List wizard.

9.2.4 Manual Synchronization

Redundant ThinManager Servers should be synchronized so that the same configuration is available to thin
clients regardless of where they boot. Auto-synchronization is the preferred method (see Automatic
Synchronization Configuration) but the ThinManager Servers can be manually synchronized.

Select Manage > Synchronize Configurations from the menu to initiate the manual synchronization. This

will launch the Synchronize ThinManager Server Configurations wizard.
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& synchronize ThinManager Server Configurations

ThinM anager Server Configuration Synchronization G
Select a Thinkdanager Server to be the zource of the configuration, and } ‘
zelect one or more Thinkd anager Servers bo receive the configuration.

Configuration Source Caonfiguration D'estination

|Ea$eTSE4E

< Back I Hewt > I Finizh Canicel Help

Synchronize ThinManager Server Configuration Wizard

Highlight the primary ThinManager Server as the Configuration Source ThinManager Server and the
secondary ThinManager Server as the Configuration Destination. Select Next to proceed. Although many
ThinManager Servers can be defined in the ThinManager Server List it is normal to have just a primary and a

backup ThinManager Server.
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& synchronize ThinManager Server Configurations

ThinM anager Server Conhguration Differences

These are the differences between the zource configuration and the target } ‘
configuratian A

Source Thinkd anager Server [Green
Destination T hinkd anager Server ; BazeTSE46
| Source Wersion I Deztination “ersion | Synchronized |
Firrmware Werzion 04.00.939 04.00.933 ez
Termcap Wersion 400 4010 Yes
Modules A M A ez
Terminal - 23 M A4, Mo
Configuration M M A Mo

< Back I Hewt > I Finizh Canicel Help

Synchronization Differences

The ThinManager Synchronization Wizard will list the files being updated, including the firmware, TermCap
database, modules, and the configuration. It synchronizes everything but the licenses.

Note: The Synchronization tool does not compare and contrast then make changes back and forth.
Synchronization will take the files and configuration from the source ThinManager Server and overwrite the
corresponding files on the destination ThinManager Server.

Select Next to continue.
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& synchronize ThinManager Server Configurations

ThinM anager Server Configuration Synchronization G
Select "Finizh'' to start the synchronization. } ‘
N
Source Think anager Server Destination T hint anager Servers
Ereen BazeTSE4E

< Back Hewt = | Finizh I Canicel Help

ThinManager Server Synchronization Confirmation

The ThinManager Server Configuration Wizard will prompt for a confirmation of the synchronization before
proceeding. Select Finish to finalize the synchronization.

Synchronizing ThinM anager Servers |

+# Load Firmware from Green

+# Load Terminal Capabilities Database from Green

«# Load Configuration Database from Green

«# Download Firmware to BaseTSEA46

«# Download Terminal Capabilities Database to BaseTSEA46
=¥ Synchronize Configuration Database with BaseTSE46
«# Synchronize Modules with BaseTSE46

Synchronization Progress Meter

ThinManager will display the progress of the synchronization as it updates the files.
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9.3 ThinManager Server Configuration Wizard

The ThinManager Server Configuration wizard allows the configuration of global ThinManager settings. It can
be launched by:

e Selecting Edit > Modify while the ThinMan icon is highlighted in the ThinManager tree, or
e Double-clicking on the ThinManager icon in the tree, or

¢ Right clicking the ThinMan icon and selecting Modify.

& ThinManager Server Configuration ¥Wizard El
ThinM anager Server Configuration Wizard m
Inbroduction } ‘
A

The Thinkd aniager Server Canfiguration *izard prezents the configuration
options for the Thinkdanager server. These opliohz defing how the

Think anager zerver reacts to undefined terminals and what actions are taken
when events ooour.

< Back Finizh Cancel Help

ThinManager Server Configuration Wizard

Importance of Page: This displays introductory information

Select Next to Configure the ThinManager Server settings.
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9.3.1.1 Unknown Terminals Page

52 ThinmManager Server Configuration Wizard x|

Unknown Terminals

Chooze whether unknown terminals are to be allowed to connect ta } ‘
thiz Thintdanager Server. A

— Unknawn Terminalz

Allovw unknown terminals to connect v
Require pazswaord on unknown terminalz I
Fazsword I
Canfirm I

— Automatic Terminal Creation

Enable AutalCreate v

AutaCreate tazk I.-“-‘-.utl:uT 2

< Back I Hest > I Finizh Cancel Help

Unknown Terminals
Importance of Page: Controls creation and replacement of terminals through use of passwords and auto-
creation.
Settings:

e Allow unknown terminals to connect - This checkbox, if selected, lets new terminals be added to
the ThinManager Server. Replacements and new terminals are prevented if this box is un-selected.

e Require password on unknown terminals - This checkbox, if selected, allows use of a password so
that only authorized personnel can add terminals to the ThinManager Server. If checked, the
password fields become active and allow the addition of a password.

e Enable AutoCreate - This checkbox, if selected, allows the auto-creation of an array of terminals as
described in Auto-Creation of Terminals.

e AutoCreate Mask - This field is the base name used in the array of terminals when using Auto-
Creation of Terminals.

Why Change from Default Settings: requiring a password can control who adds terminals. Using auto-
creation can be helpful is some large deployments.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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9.3.1.2 Terminal Replacement Page

52 ThinmManager Server Configuration Wizard x|

Select whether replacement of affline terminals is allowed an thiz
Thinkdanager Server.

Terminal Replacement m
}-’

— Replacement

Check the "Enable Replacement' box to allow new terminals to replace
offline terminalz

Enable Replacement v

< Back I Hest > I Finizh Cancel Help

Terminal Replacement

Importance of Page: Sets the global setting for enabling replacement of offline terminals.

Note: Terminals that are on cannot be replaced until they are turned off.

Settings:

e Enable Replacement — This checkbox gives global permission for terminals to be replaced. Un-
selecting this will prevent all terminals from showing up in the replacement list when a new terminal is
added, making Create New Terminal the only option. This feature is also available for the Group and
terminal level on the first page of the corresponding wizard. However, if this checkbox is unselected in
the ThinManager Server Configuration Wizard, checking it in a Terminal Configuration Wizard
will have no effect.

Why Change from Default Settings: Un-selecting this will prevent all terminals from showing up in the
replacement list when a new terminal is added, making Create New Terminal the only option.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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9.3.1.3 Historical Logging Page

52 ThinmManager Server Configuration Wizard x|

Histoncal Logging H

Select the items to log and haw long b maintain the logged
information, A

— Higtarical D ata

b aintain Higtoncal Log For I-I days

Clear Hiztary

—Ewvent Log
b aintain Event Log for I? dayz
Chooze events tolog

[T Temminal Server Events
¥ Temminal Events

¥ Teminal Configuration changes

[~ TemSecure User Configuration changes

Clear Event Lag |

< Back Finizh Cancel | Help |

Historical Logging

Importance of Page: Sets the duration that logs are maintained.
Settings:

e Maintain Historical Log for X days - This field determines the length of time that the terminal server
CPU and memory data from the Terminal Server Graph tab is stored. See Details Pane for an
example of the graph.

e Maintain Event Log for X days - This field determines how long the event log is kept.
e Choose events to log - These checkboxes determine what events are stored in the log.

e Terminal Server Events - This checkbox, when selected, records events of the terminal
servers.

e Terminal Events - This checkbox, when selected, records events of the terminal.

e Terminal Configuration Changes - This checkbox, when selected, records changes to the
terminal configuration.

e User Configuration Changes - This checkbox, when selected, records changes to the
TermSecure User configuration.

Buttons:

e Clear History - This button will erase the Historical log.
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e Clear Event Log - This button will erase the Event log.

Why Change from Default Settings: You can add Terminal Server events and TermSecure User events that
aren’t collected by default. You can change the duration of the logs.

Selecting the Event Log tab will show the events for the highlighted tree icon.

Edit Manage Install Tools View RemoteView Help
. Configuration I Licenzes I Froperties I Werziong I Synchronization  Event Log | ILI_’I
S Terminals
- Type | I ame | Ewent -
- L%H Groupi ; . . . .
: - terminal b Lalkibd omitar Terminal Configuration Changed
% Aipha terminal *ictar Terminal Deleted
IL%«II MultiMonitor 1 terminal Iniform Terminal Deleted
Q Sierra terminal Alpha Could Mot Start Seszsion on Server #P-2 fe
,Q, Tango terminal Alpha Could Mot Start Sezsion on Server TRAIN
- ﬁ Display Servers kermninal Alpha Received Configuration fram T hinkd anage
-5} VCenter Servers kermninal Alpha Monitar Connection Establizhed
=N El Display Clients terminal Alpha b anitor Connection Lost. Connection time
5 Terminal Services term!nal Alpha Reboot Terminal .
: terminal Alpha Could Mot Start Sezsion on Server #P-2 h
@ Camera . .
i terminal Alpha Could Mot Start Seszsion on Server P2 h
@ B terminal Alpha Could Mot Start Sezsion on Server TRAIN
[@ Workstation terminal Alpha Received Configuration from T hinkd anage
E ﬁ Termsecure Users terminal Alpha tanitor Connection E stablished
terminal Alpha Terminal Configuration Changed
terminal Alpha b anitor Connection Logt
terminal Alpha Restart Terminal
terminal Alpha Could Mot Start Sezsion on Server #P-2 h -
4 [v] | Led | LI_I
For Help, press F1 | s

Event Log Tab

Details of an event can be obtained by double-clicking on an event.
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Event Details

Date 041708
Time 15:14:05

Cancel |
Izer
Event Type Connection
Source Type terminalzerer
Source Green

— Event Descrption

D ata collection establizhed

Event Detail

The Event Details window shows details of the selected event. Select either the OK or Cancel button to
close.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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9.3.1.4 System Schedule

52 ThinmManager Server Configuration Wizard x|

System Schedule ﬂ

Edit the systern schedule
A

Syzstem Schedule

Edit Scheduls

< Back I Hest > I Finizh Cancel Help

System Schedule

Importance of Page: Allows schedules to be setup for ThinManager and the ThinManager system.

Buttons:

e Edit Schedule — This button launched the Event Schedule window.
See Scheduling for details.

Why Change from Default Settings: Automating backups, reports, and actions with the Scheduler saves
time.

Select Next to continue, Finish to save and close, or Cancel to close without saving.

9.3.1.5 ThinManager Security Groups

Access to ThinManager can be assigned to Windows User Groups on the ThinManager Security Groups
page.
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52 ThinmManager Server Configuration Wizard x|

ThinManager Secunty Groups

Agzign access to Thintanager functions for Windows User Groups. } ‘
A

Windows Lzer Graup Celete Group |
Adrinistrators j Add Group |

—%indows zer Group Permizsions

Available Allowed
Logaff TermSecure Users Connect
Calibrate Touchscreens Shadow
Restart Terminals Interactive Shadow

Reszet Sezzion:
Kill Proceszses
Feboot Terminal Servers

ﬂ
Connect ta Terminal Servers p
| | B

lzers are allowed to make BDF connection to terminal servers from
T hinkd anager

< Back I Hest > I Finizh Cancel Help

ThinManager Security Groups

Importance of Page: Normally administrators are the only people who have access to ThinManager

functions. This page allows access to be granted to people so they can perform specific jobs without being
elevated to the administrator role.

Settings:

e Windows User Group — This dropdown shows the group that is being configured.
Fields:

e Available — This list box shows the ThinManager functions that are available to the Windows group
displayed in the Windows User Group box. These functions can be added to the Allowed list by
double clicking.

e Allowed - This list box shows the ThinManager functions that are granted to the Windows group
displayed in the Windows User Group box. These functions can be removed form the Allowed list
by double clicking.

Buttons:
o Delete Group — This button will remove the highlighted group in the Windows User Group box.

e Add Group - This button launched the New Window Group window where a new Windows®© group
can be added to the configuration. See Add Windows Group for details.

Why Change from Default Settings: Creating a Windows Group and granting access to ThinManager
functions allows people to use ThinManager without being an administrator.
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ThinManager allows different levels of access and functionality based on standard Windows groups. By
default only members of the Windows Administrator group has the ability to connect to ThinManager and use
the application. The ThinManager Security Groups allows other Windows groups to be granted privileges in
ThinManager.

ThinManager comes with privileges pre-defined for six groups. Each of these groups (except Administrators)
needs to be created on the domain controller or in the Local Users and Groups on the Computer
Management console and members added before they can be used.

e Administrators - The Microsoft defined Administrator group is given all privileges by default in
ThinManager. This may be denied by unselecting the various allowed Windows User Group
Permissions.

e ThinManager Administrators have full permission to do anything within ThinManager including the
power to logoff sessions, kill processes, send messages, restart terminals, calibrate touch screens,
change terminal configurations, update firmware, update the TermCap, and restore configurations.
Administrators and members of ThinManager Administrators can shadow terminals and interactively
control the terminal session. These privileges may not be removed and will be grayed out.

e ThinManager Interactive Shadow Users - Members of this group may shadow a terminal
interactively.

e ThinManager Power Users can logoff sessions, kill processes, send messages, restart terminals,
and calibrate touch screens. They cannot change terminal configurations, update firmware, update
the TermCap, and restore configurations. ThinManager Power Users can shadow terminals from
within ThinManager but cannot interact with the session.

e ThinManager Shadow Users - Members of this group may shadow a terminal but not interactively.

e ThinManager Users can view only. They cannot logoff sessions, kill processes, send messages,
restart terminals, or calibrate touch screens. ThinManager Users cannot shadow a terminal.

Selecting the Add Group button to launch the New Windows Group window will allow the configuration of
additional Windows User Groups.

9.3.1.6 Add Windows Group

Mew Windows Group |

Enter Windows User Group Hame

IEDmputerT ech

cucs|

New Window User Group Window

Adding a Windows Group name in the Enter Windows User Group Name field of the New Window Group
window and selecting the OK button will add the Windows User Group to the drop-down list.

Note: This doesn'’t create the user group on any servers. This just adds the name of an existing group to the
list that ThinManager is maintaining.
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52 ThinmManager Server Configuration Wizard x|

ThinManager Secunty Groups

Agzign access to Thintanager functions for Windows User Groups. } ‘
A

Windows Lzer Graup Celete Group

ComputerTech j

i

Add Group

—%indows zer Group Permizsions

Available Allowed
Shadow . Connect
Reset Sessiong Interactive Shadow
Logoff TermSecure Uzers Kill Frocesses
Adrminister Thinkd anager Servers Rebaoat Terminal Servers
Create Uszers Connect to Temminal 5ervers

Create Terminalz

Create Termninal Servers -
Bl m Biles T omemniin =l
0l | »

< Back I Hest > I Finizh Cancel Help

ThinManager Security Groups Page

Select the group from the Windows Users Group drop-down. Choose the permissions you want to grant to
the group by double clicking on the function in the Available Windows User Group Permissions list.
Members of the Windows User Group will have the selected permissions the next time they login.

Although ThinManager has Windows User Groups pre-configured with privileges, these groups have not been
created on the terminal servers.

To create a Windows User Group, open the Computer Management Console by selecting Start > Settings
> Control Panel > Administrative Tools > Computer Management.
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Highlight Groups in the tree and select Action > New Group to launch the New Group window.

Created ThinManager Security Groups
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Microsoft New Group Windows

Enter the group name in the Group name field.

Add Users to the Windows User Group by selecting the Add button.

Select the Create button to finish the Windows User Group creation. Members of the Windows User Group

will have the selected permissions the next time they login.

Note: The ThinServer service may need to be stop and restarted to load the new ThinManager Security

Group settings.

Select Next to continue the ThinManager Server Configuration Wizard, Finish to save and close, or
Cancel to close without saving.
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9.3.1.7 Event Selection Page

52 ThinmManager Server Configuration Wizard x|

Event Selection m
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< Back I Hest > I Finizh Cancel Help

Event Selection

Importance of Page: ThinManager has event notification. E-mails or Windows messages can be sent by
ThinManager to identify changes in the setup, configuration or status.

Settings:

e Email — Checking the E-mail checkbox will send an e-mail message when that event occurs. The e-
mail needs to be set up on the next page of the wizard.

e Windows Messages — Checking the Windows Message checkbox will send an message to a
terminal when that event occurs. The terminal needs to be defined on the next page of the wizard.

Why Change from Default Settings: Information about these events can be useful. The event needs
checked to add the notification.

The ThinManager Server Stop/Start, Terminal Server Monitor Connection, and Terminal Monitor Connection
events may indicate the failure of the ThinManager Server, Terminal Server, or terminal.

Sharing information on configuration changes, firmware, TermCap, or license installation can be useful when
management is shared among a group. Sending an e-mail to all group members keeps them informed of all
changes.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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9.3.1.8 E-Mail or Windows Message Recipients Page

52 ThinmManager Server Configuration Wizard x|

E-mail or Windows Mezzage Recipients
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mainti@yoLrdaomain, com
Add
Delete |
—Mezzages
Terminals Tem:
Add

Delete

i

< Back Finizh Cancel Help

Email or Windows Messaging Recipients

Importance of Page: This page defines what users are notified of event changes from the Event Selection

page.
Fields:
e SMTP Server - Enter the SMTP (Simple Mail Transfer Protocol) server to be used by the
ThinManager Server in the field.
e E-Mail Return Addresses - Enter the return e-mail address to be used by the ThinManager Server in
the field
e E-Mail Addresses - ThinManager will send an e-mail message to the addresses in this text box when
an event selected on the Event Select page occurs.
e Terminals - ThinManager will send a message to the terminals in this text box when an event
selected on the Event Select page occurs.
Buttons:

Add (E-Mail Addresses) - Select this button to add e-mail addresses through the Enter the E-mail
address window.

Delete (E-Mail Addresses) - Select this button to delete a highlighted e-mail address from the E-mail
Addresses list.
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e Add (Terminals) - Select this button to add a terminal through the Select Terminal(s) window.

o Delete (Terminals)- Select this button to delete a highlighted terminal from the Terminals list.

Add (E-Mail Addresses) - Select this button to add e-mail addresses through the Enter the E-mail

address window.

Enter the E-mail address

Iphurns@thinmanager.cam

Cancel

i

Enter the E-mail Address Window

Enter the desired e-mail address in the entry form and select OK. Select the Cancel button to close the

window without making changes.

Add (Terminals) - Select this button to add a terminal through the Select Terminal(s) window.

Select Terminal | x| |

E|-- ..... minals
B G_rn:nup1
= SubGroupls

[y
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i SubGrouplB
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- Terminal_2_A
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L Terminalls,_2

[+ Graup3

- desk_5820

- Dezk_Uno_2053
- bultiton

- Unit02

- Unitd3

i TMC
& ApplGEroup
- Z_T5E

] I
Cancel |

Terminal Selection Window

The Select Terminal(s) windows will list the terminals configured on the ThinManager Server. Highlight the
desired terminal and select the OK button.

Why Change from Default Settings: You need to add recipients for event notification to work.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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9.3.1.9 Multicast Configuration Page

52 ThinmManager Server Configuration Wizard x|

Multicast Configuration m
}-’

Select the options for Multicast.

i aximum Packet Size I-I 432 Advanced |
™ bl icas Satto Detas |

¥ Enable Smart Multizast

< Back I Hest > I Finizh Cancel Help

Multicast Configuration Page

Importance of Page: Allows multicast to be configured for ThinManager Servers.
Fields:
e Maximum Packet Size — This allows the firmware download packet size to be changed, if needed.
Settings:
e Enable Multicast - This checkbox, if selected, enables Multicast.
¢ Enable Smart Multicast - This checkbox, if selected, enables Smart Multicast.
Buttons:
e Advanced - This button, if selected, displays the advanced settings.
e Set to Defaults - This button, if selected, sets the advanced settings back to the defaults.

Why Change from Default Settings: You may need to change the settings if there is a conflict with another
multicast server on the network.

Multicast provides the ability for an unlimited number of terminals to boot simultaneously from the same data
stream. This feature reduces the amount of network traffic and reduces the amount of load on the
ThinManager Server when multiple terminals are booting concurrently. This function is especially useful for
low bandwidth connections and highly utilized networks.
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Smart Multicast allows the terminal firmware to be sent directly to the terminal while a single terminal is
booting. If additional terminals request the terminal firmware during this time, the firmware will be multicast so
that all terminals can receive the firmware from a single data stream. If Smart Multicast is disabled, the
firmware will always be sent as a multicast transmission.

Multicast is only available on terminals with ACP Boot Loader Version 5.0 and later. No local terminal
configuration is needed to use Multicast.

Unicast — ThinManager has error checking that will switch a terminal’s firmware download to unicast if the
multicast download fails.

The thin client will continue to try to use multicast at each boot but will use unicast if multicast keeps failing.
Advanced Settings — Selecting the Advanced button will reveal advanced settings for multicast.
& ThinManager Server Configuration Wizard El

Multicast Configuration m
}-.‘

Select the options for Multicast.

M aximum Packet Size I-I 432 Advanced |
¥ Enable Multizast Set to Defaults |

W Enable Smart Multicast

— Multicast Settings
Address | 224 100 . 100 . 100

Port [ 7= (1-65535]

Time-to-Live [TTL] [1-255]

| B0
— |GMP Settingz
el | 2 nz
| 1

Time-to-Live [TTL]

[1-255]

¢ Back Hest > Cancel Help

Advanced Multicast Options
Importance of Page: This allows changing the multicast settings if there is a conflict with another multicast
server on the network.
Settings:
e Multicast Settings
0 Address — This is the IP address that will be used for Multicast transmissions.
o Port — This is the destination port that will be used for Multicast transmissions.

0 Time-to-Live (TTL) — This is the maximum number of router hops for Multicast packets.
Setting this value to 255 allows for unlimited hops.
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e |GMP Settings (Internet Group Management Protocol)
o0 Version — This sets the IGMP version for use with multicast capable routers.
0 Time-to-Live (TTL) — This sets the time-to-live value for IGMP packets.
Buttons:
e Advanced - This button displays the advanced settings.
e Set to Defaults - This button sets the advanced settings back to the defaults.

Why Change from Default Settings: Change these if a conflict develops.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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9.3.1.10 Shadow Configuration Page

ThinManager allows the port used for shadowing to be configured.

5% ThinManager Server Configuration ¥Wizard El

Shadow Configuration H

Select the shadow part
A

Shadow Optionz

Shadow Port

¢ Back [HEwt > | Finizh I Cancel Help

Shadow Configuration Port

Importance of Page: This allows the port that is used for shadowing to be changed.

Settings:

e Shadow Port — ThinManager uses port 5900 as the default port for shadowing. Entering a different
port number into the Shadow Port field will change the port used if it is in conflict with another
processes use of the port.

Why Change from Default Settings: ThinManager uses the save port as VNC. If VNC is installed on a
WinTMC PC then there could be a conflict between shadowing services. If this happens the port can be
changed in ThinManager.

Select Finish to accept changes or select Cancel to close without making changes.
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9.4 DNS Configuration

Selecting Manage > DNS Configuration will launch the Domain Name Server Wizard to allow the definition
of Domain Name Servers.

52\ Domain Name Server Wizard |
Domain Name Server Wizard W
Introduction } ‘
oy
The Domain Mame Server Wizard defines the Name Server settings for your
networl.
{*' System using a DNS server
™ System without 3 DMNS server
< Back Mend = Finish Cancel Help

Domain Name Service Wizard - Introduction

Importance of Page: This allows you to use a DNS server to identify terminal servers instead of relying on IP
addresses.

Settings:

e System without a DNS server - This is selected if you are not using a DNS server for computer
identification. No configuration is needed. Select the Finish button to close the wizard.

e System using a DNS server - This is selected if you are not using a DNS server for computer
identification.. Select the Next button to launch the Domain Name Service Configuration screen.

Why Change from Default Settings: Using a DNS server allows you to point to a server by name instead of
IP address as the DNS server will handle name resolution.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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9.4.1.1 Domain Name Server Configuration Page

52 Domain Name Server Wizard

Domain Name Server Configuration m
Erter the list of DMNS servers on your netwark and your domain } ‘
information. A

DMNS Servers

Add DNS Server Remove DMNS Server

Domain I
Search Domain I
Read DMS Setting from this computer |
< Back Hest > Cancel | Hep |

Domain Name Server Configuration

Importance of Page: This is the page where the DNS server is defined in ThinManager.

Fields:

e DNS Servers — The DNS Servers that ThinManager and the terminals will use need to be listed in
this list box. They are added with the Add DNS Server button. See DNS Server Entry Window for
details.

. Domain - This is a field for the DNS domain name.

Buttons:

Search Domain - This field will be added as a prefix to any DNS searches.

The Add DNS Server - This button will launch the DNS Server dialog box that allows a DNS
Server to be added to the list.

Remove DNS Server - This button will remove a highlighted DNS server from the list.

Arrows (Up/Down) - The arrow keys will change the order of DNS servers used. Highlight a
DNS server in the list and select the appropriate arrow.

Read DNS Setting from this computer - This button will transfer the DNS settings from the
current computer into ThinManager

Why Change from Default Settings: The default is blank. You need to add values for this to work.
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Select Finish to save and close, or Cancel to close without saving.

9.4.1.2 DNS Server Entry Window
DNS Server |

M ame Server

| JER . PEE . 255 . 255 Cancel |

Domain Name Server Configuration - Add DNS Server

Selecting the Add DNS Server button will launch a DNS Server dialog box that allows the IP address of the
DNS server to be entered.

Add the IP address of the DNS server into the DNS Server dialog and select OK. Additional IP addresses can
be listed by selecting the Add DNS Server button again.

Select the Finish button when the DNS configuration is done.
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10Terminal Configuration

10.1Terminal Configuration Wizard

The Terminal Configuration Wizard is used to configure terminals for use with ThinManager.

If a terminal is a member of a terminal group that has a group setting in use then the terminal will have that
setting grayed out and deactivated. The setting will need to be changed at the group level in the Group
Configuration Wizard and not the Terminal Configuration Wizard.

Launch the Terminal Creation Wizard by:

e Selecting the ThinManager Server in the ThinManager tree and selecting Edit > Add Terminal from
the menu bar, or

e Selecting the Terminals branch in the ThinManager tree, right-clicking on the Terminals icon, and
selecting the Add Terminal option, or

e Selecting a Group in the ThinManager tree, right-clicking on the Group icon, and selecting the Add
Terminal option. This puts the terminal in that group.
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10.1.1.1 Terminal Name Page

= Terminal Configuration Wizard x|

Terminal Hame m
(=<
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— Terminal Mame
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I Change Group
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— Copy Settings
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Terminal Configuration Wizard - Terminal Name

Importance of Page: Names the terminal and allows it to be added to a group.
Settings:
e Terminal Name — Required field for unique terminal name. Keep it under 15 characters.
e Terminal Group —Adds the terminal to a group of terminals by using the Change Group button.

e Copy Settings — Allows the terminal to be created quickly by copying configuration from an existing
terminal.

Buttons:

e Change Group — Launches tree to select group for the terminal to join. See Changing a Terminal's
Group for details.

e Copy From — Launches tree that allows an existing terminal configuration to be applied to the new
terminal. Only active when checkbox is selected.

e Permissions — Applies TermSecure permissions to the terminal. See Permissions for details.

Why Change from Default Settings:
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Terminal needs a unique name. It can have setting from another terminal applied to speed configuration.
Adding to a group will speed configuration and management.

10.1.1.2 Joining a Group

The Change group button launches the Select Group window to allow the terminal to join a group of terminals.

Select Terminal Group | x| |

BR [ =il K|
= Groupd
e SubGroupla Cancel |
----- SublGroupl1B
..... Group?2
..... Group3
Select Group Window

Expand the Terminals tree to show the created groups. Highlight the desired group and select OK to join. This
will close the window.

To remove a terminal from a group highlight Terminals and select the OK button.

Cancel will close without changes.

10.1.1.3 Copy Settings
Terminal configuration can be sped up by copying the settings from an established terminal.

Select the Copy Settings from another Terminal checkbox and then select the Copy From button: This will
launch the Select Terminal window that allows the terminal to copy settings from another terminal.
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Terminal_3_A
Terminal_3_B
& || it
- Unitd2

-~ Unitd3 ~|

Select Terminal Window

The Select Terminal window will show a tree of the configured Terminal Groups and terminals. Highlight the
terminal that you wish to copy and select the OK button to load the settings and return to the Terminal
Configuration Wizard.

The Cancel button will close the Select Terminal window without making changes.
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10.1.1.4 Terminal Hardware Page

%2 Terminal Configuration Wizard

Terminal Hardware b‘;"

Select the manufacturer and model of this terminal.

|Use this to configure the type of hardware for this teminal.

Make /OEM  |ACP

L] Ll

Model IDC-E[H 00

COEM Model DC-30-100
Video Chipset CyberPro2010

Clear |
Teminal 1D Mone

< Back Mext = Finish Cancel Help

Terminal Configuration Wizard - Hardware Configuration

Importance of Page: Defines the hardware used for the terminal.
Settings:
e Make/OEM: This dropdown allows the make of the hardware to be selected.
e Model: This dropdown allows the model of the hardware to be selected.
e OEM Model: This displays the actual model used once the terminal connects to ThinManager.
e Video Chipset: This displays the video chipset used once the terminal connects to ThinManager.

e Touch Type: This displays the touch screen controller used if the thin client has an integrated touch
screen.

e Terminal ID — This displays the MAC address of a connected terminal. We use it to identify the thin
client. On WinTMC c clients this will be the terminal name.

Buttons:

e Clear: This will remove the Terminal ID identifier from the configuration of an inactive terminal. The
MAC address of a terminal is used for the Terminal ID. Clearing the Terminal ID will free hardware
that has already been tied to a configuration and allow the terminal to be tied to a different
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configuration, without deleting its original configuration. It will also allow the make and model of the
hardware to be changed.

e Edit: Selecting this button will launch the Edit Terminal ID window that allows you to manually
change the MAC address of the configuration. This allows you do a replacement of an old terminal by
entering the MAC address of the replacement. Entering the new MAC address allows the new
terminal to boot and retrieve its configuration without selecting the terminal from the list.

Edit Terminal Id [ x|

Mew Terminal Id I

Cancel |

Edit Terminal ID Window

Why Change from Default Settings: Using the correct make & model of the hardware during configuration
allows the wizard to display only settings that are appropriate for that specific model, making configuration
more accurate.

If you add a different model than you used in configuration then ThinManager will adjust the configuration to
match the new hardware. This is down with help from the TermCap database. See TermCap Database for
details.

A WinTMC connection needs to be configured as Generic/Personal Computer. See WinTMC Overview for
details.

Note: The default Make and OEM Model is set to the oldest unit, the ACP DC-30-100 because all following
units exceed its capabilities. If you configure your units as a DC-30-100 you will want to adjust the video
setting once the actual hardware is attached, as the DC-30-100 video is limited to 800x600, 256-color
resolution.

Select Next to continue, Finish to save and close, or Cancel to close without saving.

Automation Control Products ThinManager 5.0 Help Manual Terminal Configuration e 182



10.1.1.5 Terminal Options

= Terminal Configuration Wizard x|

Terminal Options m
: (=<

Select the optionz far thiz terminal.
A

|' T erminal Replacement

I itsllows replacernent at terminal it off line

— Terminal Schedule

™ Set Schedule Scheduls |

— T erminal Effects
¥ Enable Teminal Eflects
v Show terminal status messages

— Shadowing
Allov terminal to be shadowed TES i

v Allows Interactive Shadow

< Back I Hest > I izt Cancel Help

Terminal Options Page

Importance of Page: Provides configuration of a few terminal functions.

Settings:

Allow replacement at terminal if offline — This allows the terminal to show up in the replacement
list during a new terminal connection

Set Schedule — This will allow the Schedule button to become active. See Scheduling for details.

Enable Terminal Effects - This allows the desktops in MultiSession to slide smoothly into the
desktop instead of appearing instantaneously.

Show terminal status messages, - This allows the terminal to display status messages in the upper
left corner of the screen.

Allow terminal to be shadowed — This dropdown sets the Shadowing setting allowing the
configuration of Shadowing Options.

Allow Interactive Shadow — This allows users with Shadowing permission to interactively shadow
the terminal. See Interactive Shadow for details.

Buttons:

Schedule — This launches the Event Schedule window for the terminal. See Scheduling for details.
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Why Change from Default Settings:

o Allow replacement at terminal if offline — This prevents an offline terminal from being selected
when adding a new terminal. Turning this off prevents a critical configuration from being transferred.
If this is turned off then an administrator will need to turn it back on if this terminal needs replaced.

e Show terminal status messages -Suppressing incidental messages like Display Client switching
and TermSecure logins can keep an operator from worrying about non-essential messages.

o Allow terminal to be shadowed - Changing the setting controls connection settings:
o0 No — This will prevent the terminal from being shadowed by anyone.

0 Ask — This will ask the user to allow shadowing. The user will need to say Yes on a message
window before the shadowing is allowed.

o Warn - Will display a message window alerting the terminal that it is to be shadowed, but
doesn’t require user input before the shadowing is allowed.

o0 Yes — Will allow shadowing to occur without warning or user input.

Allow Interactive Shadow — Unselecting will prevent the observer from controlling the session. This “Look
but don’t touch” mode prevents an observer from clicking the wrong buttons.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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10.1.1.6 Terminal Mode Selection Page

= Terminal Configuration Wizard x|

Terminal Mode Selection H

Select the operating modes for this terminal
A

tethod of Terminal Server Selection

" Select Individual Terminal Servers

Selecting Dizplay Clientz iz recommended.

— T ermSecure
[~ Enable TermSecure

— kuiltibd oritor
[ Enable Multibonitor

< Back I Hest > I izt Cancel Help

Terminal Server Specification

Importance of Page: This page has the settings that allow the use of Display Clients, TermSecure, and
MultiMonitor.

Settings:
Method of Terminal Server Selection

e Use Display Clients - This setting is required to use most features and functions like SmartSession
load balancing, MultiSession, and Terminal-to-Terminal shadowing.

e Select Individual Terminal Servers - This is a legacy setting from earlier versions of ThinManager.
Using this setting will limit the features available.

If Use Display Clients is selected, two other settings may become available:

e Enable TermSecure — This checkbox enables TermSecure on the terminal. This checkbox will only
be displayed if the ThinManager Server has a TermSecure license installed. See TermSecure for
details on this function.

e The Enable MultiMonitor checkbox will be displayed if the hardware selected on the Terminal
Hardware page is a MultiMonitor-capable thin client. Selecting this will allow the terminal to be
configured for MultiMonitor. See MultiMonitor for details.
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Why Change from Default Settings:
We recommend using Display Clients because that expands the features and functions available.

Select Next to continue, Finish to save and close, or Cancel to close without saving.

10.1.2 Terminals Using Individual Terminal Servers

Terminals may connect to a series of individual terminal servers by selecting the Select Individual Terminal
Servers on the Terminal Mode Selection page. Although this is not the recommended method this is
covered here.

= Terminal Configuration Wizard x|

Terminal Mode Selection ﬁ

Select the operating modes for thiz terminal
A

Methad of Terminal Server Selection

i |Uze Dizplay Clients
i iSelect Individual Terminal Servers

Selecting Dizplay Clientz iz recommended.

¢ Back I Hest = I izt Cancel Help

Terminal Configuration Wizard - Terminal Server Specification

Importance of Page: Used to select the legacy individual terminal server method.

Note: We strongly recommend using Display Clients because that expands the features and functions
available.

Settings:

e Select Individual Terminal Servers - This is a legacy setting from earlier versions of ThinManager.
Using this setting will limit the features available.
Selecting this enables use of the individual terminal server method.
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Select Next to continue, Finish to save and close, or Cancel to close without saving.

The Terminal Connection Type page is displayed next to allow the selection of the desired Client
Communication Protocol.

== Terminal Configuration Wizard x|

Terminal Connection Type m‘
}-.‘

Select the type of connection this terminal will make to the Terminal
Server.

Select the connection ype

© Citrie [T
" Citrix Device Services
£+ Flemate Deskiop Protocol [RDP}

< Back I Mest » I = Cancel Help

Terminal Configuration Wizard - Connection Type

Importance of Page: Selects the client/server communication protocol.
Settings:
e Citrix ICA — This allows the use of the Citrix© ICA protocol in client to server communications.

e Citrix Device Services — This is a legacy version of the ICA protocol used on Windows NT and
Windows 2000 terminal servers.

e Remote Desktop Protocol (RDP) — This is the default protocol from Microsoft®©. It is automatically
installed on Microsoft© terminal servers.

Why Change from Default Settings: This is where the terminal is configured to use the Citrix© ICA protocol
if the Citrix© ICA protocol is going to be used instead of the default RDP.

Select Next to continue, Finish to save and close, or Cancel to close without saving.

Selecting the Citrix ICA setting will change the path of the Terminal Configuration Wizard to display additional
configuration pages. See Citrix for detalils.
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= Terminal Configuration Wizard x|
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[ [ izt Cancel Help

Terminal Server Selection

Importance of Page: This allows the selection of the terminal servers that the terminal will use. Adding
multiple terminal servers to the Selected Terminal Server list will establish failover.

List Box:

e Available Terminal Servers — This is the list of the terminals configured in the Terminal Server
Configuration Wizard and available to the terminal.
If the Available Terminal Server list box is empty the Terminal Server Configuration Wizard can be
launched with the Edit Server List button to define the terminal servers.

e Selected Terminal Servers — This is the list of terminal servers that the terminal will connect to, in
the order that they will connect. Move the terminal servers to this list with the left and right arrow or by
double clicking on the name.

Listing two or more terminal servers configures Failover. The terminal will connect to the first in the
list. If it fails than the terminal will try the next in the list.

Buttons:

e Arrows — The left and right arrows move the terminal servers between list boxes. The up and down

arrow change the order that the terminal servers are used. The top terminal server is considered the
primary terminal server.
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e Edit Server List — This launches the Terminal Server Configuration Wizard that allows terminal
servers to be defined within ThinManager. Selecting Manage > Terminal Server List from the
ThinManager menu will also launch the Terminal Server Configuration Wizard.

e Override — This is not used with individual terminal servers.
Settings:

e Enforce Primary Terminal Server Connection — This will cause a terminal that failed over to a
backup terminal server to return to the primary terminal server whenever that server becomes
available.

Why Change from Default Settings: It is critical to list the terminal servers that the terminal will use. The
wizard will not advance without a terminal server selected.

If the Available Terminal Servers column is empty, the Terminal Server List Wizard needs to be run to
define the terminal servers. Select the Edit Server List to launch the Terminal Server Configuration Wizard
and define the terminal servers.

== Terminal Configuration Wizard x|

Dizplay Client 5election m
’-.‘

Select the Dizplay Clients to uze on this kerminal

Available Terminal Servers Selected Terminal Servers
T53[99.93.97.34) T51[99.598.97.99)
TS2099.98.597.217) Al
4
: hd
e w

Edit Server List | [Isermide |

¥ Enforce Primary Terminal Server Connectior:

¢ Back I Hest > I Finizh Cancel Help

Terminal Configuration Wizard - Terminal Server Selection

This is an example of a terminal with the terminal servers selected.
Select Next to continue, Finish to save and close, or Cancel to close without saving.
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10.1.3 Terminals Using Display Clients

Terminals may be configured to use Display Clients by selecting the Use Display Clients on the Terminal
Mode Selection page instead of using the Select Individual Terminal Servers setting.

== Terminal Configuration Wizard x|

Terminal Mode Selection H

Select the operating modes for this terminal
A

tethod of Terminal Server Selection

" Select Individual Terminal Servers

Selecting Dizplay Clients iz recommended.

TermSecure
[ [ Enable TermSecure

kALt crnikar
[ [ Enable Multitonitor

< Back I Mest » I = Cancel Help

Terminal Configuration Wizard - Terminal Server Specification

If the Use Display Clients is selected, two other settings may become available:

e Enable TermSecure, when checked, will enable TermSecure functionality. This checkbox will only be
displayed if the ThinManager Server has a TermSecure license installed. See TermSecure for details
on this function.

e The Enable MultiMonitor checkbox will be displayed if the hardware selected on the Terminal
Hardware page is a MultiMonitor-capable thin client. Selecting this will allow the terminal to be
configured for MultiMonitor. See MultiMonitor for details.

Select Next to continue configuration.
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10.1.4 Display Client Selection

The Display Client Selection page is displayed next to allow the selection of the desired Display Clients.
52 Terminal Configuration Wizard |

Display Client Selection
<

Select the Display Clients to use on this teminal
e

Auvailable Digplay Clients Selected Display Clients

Elxp_10 171

Shadow_Al
?Calculatn:nr
Rl EMai

il Hm =
_'; Reports
@Camem_mading Doclk

-
—

Edit Display Clients [dreermide |

|2 |~

< Back Med = Finish Cancel Help

Terminal Configuration Wizard — Display Client Selection

Importance of Page: This allows the selection of the Display Clients that the terminal will use. Adding
multiple Display Clients to the Selected Display Clients list will establish MultiSession.

List Box:

e Available Display Clients — This is the list of the Display Clients configured in the Display Client
Configuration Wizard and available to the terminal.
If the Available Display Client list box is empty the Display Client Configuration Wizard can be
launched with the Edit Display Clients button to define the Display Clients.

e Selected Display Clients— This is the list of the Display Clients that the terminal will connect to, in
the order that they will connect. Move the Display Clients to this list with the left and right arrow or by
double clicking on the name.

Listing two or more the Display Clients configures MultiSession. The terminal will display the first in
the list and cascade the others.
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Buttons:

e Arrows — The left and right arrows move the Display Clients between list boxes. The up and down
arrow change the order that the Display Clients are used. The top Display Clients is displayed on top
at startup.

e Edit Display Clients — This launches the Display Client Configuration Wizard that allows Display
Clients to be defined within ThinManager.

e Override — This allows a highlighted Display Client to use a different login or screen resolution than
the terminal.
See Display Client Override for details.

Why Change from Default Settings: It is critical to list the Display Clients that the terminal will use. The
wizard will not advance without a Display Client selected.

If the Available Display Clients column is empty, the Display Clients List Wizard needs to be run to
configure Display Clients. Select the Edit Display Clients button to launch the Display Client List Wizard as
shown in Display Client List.

= Terminal Configuration Wizard |

Display Client Selection (‘:"
Select the Display Clients to use on this terminal }
A
Auvailable Display Clients Selected Display Clients
{5 HelpDesk El HM
EKPJ 0 @Camem_b:uading Dock
SHxp_11 [ Shadow_All -
Eul calculator P || Hxr_12
M EMil T
; Reports bt -
Edit Display Clients
< Back Mext = Finish Cancel Help

Terminal Configuration Wizard — Display Client Selection

This is an example of a terminal with the Display Clients selected.
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10.1.4.1 Display Client Override

ThinManager has an Override button that will allow any Display Client to be configured to login with a
different user account than the terminal. The Override button becomes active when two or more Display
Client are added to the Selected Display Client column.

Override Settings for "T5Client1® Display Clienkt
— Login Settings
Owemde I s E
I Cancel |
Ilzermame
Fassword I
Yerify Pazsword I
Owermide I
Drarnain I
—%ideo Sethings
Owerride v
R ezalutian Color Depth
1024x768 | |eakColors 7|

Override Settings Window

Importance of Page: Allows a Display Client to use a different login or screen resolution than the terminal.
Settings:

e Override - Login Settings— This needs checked to use this setting.
Using this override with a blank username and password will force the user to manually login.

0 Username — Field for the username of the Windows®© user account you want to use.
o0 Password — Field for the password for the username.
o Verify Password — Field to confirm the password.
e Override - Domain— This needs checked to use this setting.
o Domain — Field for the domain of the user account.
e Override - Video Settings— This needs checked to use this setting.
0 Resolution — Dropdown for the video resolution to use for the Display Client.
0 Color Depth — Dropdown for the color depth to use for the Display Client.
Buttons:
e OK — Accepts changes and closes window.
e Cancel — Closes window without changes.
Why Change from Default Settings: The defaults are blank and will not override anything until changed.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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10.1.4.2 Virtual Workstations

If you choose a Workstation Display Client you will need to associate it to an available workstation. This is
done on the Complete the Workstation Display Client Configuration page.

2 Terminal Configuration Wizard |

Complete the Worlstation Display Client Configuration w
Select one or more workstations to add to this display client * = ‘

Select worlstations for Display Client P_12

Selected Workstations
-
|
Add Worlcstation || Add Virtual Waorkstation I Remove |
Edit |

Add one or more worlstations to this display client

Hewt > Eimizh Cancel Help

Complete the Workstation Display Client Configuration Page

Importance of Page: Allows a workstation to be associated with a Workstation Display Client so that the
terminal can display a workstation.
Buttons:

e Add Workstation — Accepts changes and closes window.

e Add Virtual Worlkstation — Closes window without changes.

e Remove — This removes a highlighted workstation.

e Edit — This allows a highlighted workstation to be changed.

e Arrows —The up and down arrow change the order that multiple workstations are used.

Why Change from Default Settings: The default is blank and will not deploy a workstation until a
workstation is added.

Selecting the Add Workstation button will launch the Add Workstation window.
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Add Workstation |

Warkstation IP Address I |

Waorkstation Display Mame I

Add Cancel

Add Workstation Window

Enter the Workstation name and IP address in the Workstation Display Name and Workstation IP Address
fields.
Selecting the Add Virtual Workstation button will launch the Add Virtual Workstation window.

Add Virtual Workstation |

Select VCenter Server I""' Eight 2 j

Available Virtual Workstations

Elﬂ _Figh _2 = oo
- B AcP Datacenter
- |7] Discovered virtual mai Lﬂall
[ [Z0 Test Folder
1 Training51
[ Training52
1 training53

@

() Vista_Ent_VS2008

- Vista_Ent_V52010  _
4| | _’l_l

Add Workstation Window

The Add Virtual Workstation window will show the configured VCenter Servers. Expand the tree and select
the desired virtual workstation. Select the Add button to apply that virtual workstation.

Virtual Machine Already Used |

This Virtual Machine or Virtual App has already been used by another
Waorkstation Display Client.

Error Message
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Each virtual machine can only be used once since workstations have a one-to-one relationship with the
accessing terminal. If you try to apply a workstation twice you will receive and error message.

=2 Terminal Configuration Wizard E3 |

Complete the Workstation Display Client Configuration m
Select one or more workstations to add to this display client ’ - ‘

Select workstations for Display Client P_12

Selected Workstations
v_Eight_#"ACP Datacenter'training b4

Add Worcstation Add Virtual Waorkstation | Remove

e

< Back Finish Cancel Help

Complete the Workstation Display Client Configuration Page

Once a workstation has been applied for that display client it will be listed in the Selected Workstations
textbox.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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10.1.4.3 Terminal Interface Options

58 Terminal Configuration Wizard

Terminal Interface Options ;q
fhiin)

Select the display client selectar and main menu options that will be
available on the teminal.

— Display Client Selection Options

¥ Show Selector on Temminal: Selector Options |

¥ Enable Tiling Tiling Options
[~ Screen Edge Display Client Selection

Main Menu Options

Main Menu Options

< Back Mest = Finish Cancel Help

Terminal Interface Options Page

Importance of Page: This page contains the setting that allows navigation between sessions when using
MultiSession.

Settings:

e Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down
menu that can be activated by mouse.

e Enable Tiling — This checkbox, when selected, allows the Display Clients to be tiled on the monitor to
provide an overview of all the sessions at once. See SessionTiling Options for details.

e Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch
windows if the mouse is moved off screen.

Buttons:

Selector Options — This button launches the Group Selector Options window that has the settings for
switching between sessions when using MultiSession. See Terminal Interface Options Hotkeys for details.

Tiling Options— This button launches the Tile Options window that has the settings for tiling sessions when
using MultiSession. See Terminal Interface Options Hotkeys for details.
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Main Menu Options — This allows configuration of the TermSecure Main Menu. See TermSecure Menu for
details.

Why Change from Default Settings: These settings allow you to control how MultiSession is displayed and
navigated.

Select Next to continue, Finish to save and close, or Cancel to close without saving.

10.1.4.4 Hotkey Configuration Page

5 Terminal Configuration Wizard

Hotkey Configuration W

Configure the hotkeys to apply to this terminal } 5 ‘
— Teminal Hothkeys

I iEnable Instant Failover Hotkeys: [hange Hotkeys |

[V Enable Display Cliert Hotheys Change Hotkeys |

I~ Enable Tiing Hotkey Change Hotey |

[V Enable Main Menu Hotkey Change Hotley |

< Back Met = Finish Cancel Help

Hotkey Configuration Page

Importance of Page: Used to configure hotkeys to make it easier to access sessions and functions.
Settings:

e Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching between
the two active sessions of an Terminal Services Display Client that is using Instant Failover.

e Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between different
sessions of a terminal using MultiSession.

e Enable Tiling Hotkey — This checkbox, if selected, allows SessionTiling to be activated by a hotkey
combination.
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¢ Enable Main Menu Hotkey — This checkbox, if selected, allows the TermSecure Main Menu to be
activated by a hotkey combination.

Buttons:

e Change Hotkeys (Enable Instant Failover Hotkeys)— This button launches the Select Hotkeys
window that has the settings for hotkeys when using Instant Failover. See Hotkey Configuration for
details.

e Change Hotkeys (Enable Group Hotkeys)— This button launches the Select Hotkeys window that
has the settings for hotkeys when using MultiSession. See Hotkey Configuration for details.

e Change Hotkeys (Enable Tiling Hotkeys)— This button launches the Select Hotkeys window that
has the settings for hotkeys when using Tiling. See Hotkey Configuration for details.

e Change Hotkeys (Enable Main Menu Hotkeys)— This button launches the Select Hotkeys window
that has the settings for hotkeys when using TermSecure. See Hotkey Configuration for details.

Why Change from Default Settings: These settings allow you to control sessions with hotkeys.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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10.1.5 Continuation of the Terminal Configuration

The configuration paths (Independent Terminal Servers vs. Display Clients, ICA vs. Device Services and
RDP) unite at the Login Configuration. However, the Log In Information page varies depending on it the
terminal is using individual Terminal Servers or Display Clients.

10.1.5.1 Login for Display Client Users

== Terminal Configuration Wizard x|

Log In Information m
,_, (=<

Enter the log in infarmation ta log in automatically. Leave the log in
information blank or fill only some of the fields to force manual log in. A

—"Windows Log In Infarmation
sernanme IThinMan

Ixxxxxxxxxxxxxx

Pazzword

"Yerify Pazsword

Ixxxxxxxxmmxxx

Darmain I-i"-EF'

¢ Back Hest > Finizh Cancel Help

Login Information - Use Display Clients

Importance of Page: This page allows a terminal to automatically login without user action.
Settings:

e Username — Enter a valid Windows user account.

e Password — Enter the password.

o Verify Password — Re-enter the password for confirmation.

e Domain - Enter the domain, if Domain accounts are being used.

e Path - Enter the path to the desired application in the field. This will be the only program to run and
the desktop, icons, and start menu will be hidden.
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Command Line Options — This field provides a space for command line options and switches. This
field may not be required.

Initial Folder - This field is provided in case you need to specify the working directory for the program
when using a relative path for the initial program. This field may not be required.

Buttons:
Verify - The Verify button will contact the domain controller to validate the accuracy of the domain
user account.

Select the Verify button to check the user.

]|

¥alidate Users

Windows Loging To Check Cancel |
D'amain | | zer | Hesult |
AP Thintdan valid "Werify |

Validate Users Window

A Validate Users window will be displayed with the status of the user. If the user account is a valid domain
account, the results will show valid. If the results show invalid, try another account.

Why Change from Default Settings: Using the auto-login feature allows a terminal to connect and load
sessions without requiring user input. It also hides the login account so the user doesn’t know the account

and can’t use it for unauthorized access to the network.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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10.1.5.2 Video Resolution Page

& Terminal Configuration Wizard

Yideo Resolution H

Select the video resalution far this terminal.

— Select Video B esolution

R ezalution Color Depth Fefrezsh Rate

;I IE#K Colors ;I IEEIHz ;I

These are the rezolutionz supported by the Thin Client
model pou selected.

10244768

< Back I Hest > I Finizh Cancel Help

Terminal Configuration Wizard - Video Configuration

Importance of Page: This page sets the video resolution that the terminal will use.
Settings:

e Resolution — Select the desired screen size. The list will contain the sizes available for the hardware
that was chosen on the Terminal Hardware page.
WinTMC configurations show a Full Screen option.

e Color Depth — Select the desired color depth. The list will contain the values available for the
hardware that was chosen on the Terminal Hardware page.

e Refresh Rate — Select the desired refresh rate for the monitor. The list will contain the values
available for the hardware that was chosen on the Terminal Hardware page.

Why Change from Default Settings: The monitor that is used may have a different resolution than the
default value. A Windows®© 2003 or 2008 terminal server can display 16K colors but a Windows© 2000
terminal servers can only display 256 colors.

A terminal that is using MultiMonitor can have the screen resolution of each monitor set. See MultiMonitor for
more details.
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= Terminal Configuration Wizard x|

MultiM onitor Yideo Settings

Select the number of monitors and a video mode far each manitar, } ‘
A

Murnber of Manitars i 2 3 v 4 i 5

— Manitar ¥ideo Modes

Color Diepth IE#K Colors *I

Resalution Refresh Rate
Maritor [1024768 =] fez =]
Monitor 2 [102a788 x| eoHz 7]
Moritor 3 [1024x763 x| fsHz 7]
Maoritor 4 |1024x763 = e+

< Back izt Cancel Help

MultiMonitor Video Settings

Importance of Page: Configures the video resolution of each monitor for a MultiMonitor terminal.
Settings:

e Number of Monitors — These radio buttons allow you to define how many monitors the terminal will
use..

e Color Depth — Select the desired color depth. The color depth will be used for all monitors..
¢ Resolution — Select the desired screen size for each monitor used.
e Color Depth — Select the desired color depth for each monitor used.
e Refresh Rate — Select the desired refresh rate for each monitor used.
Buttons:

Why Change from Default Settings: MultiMonitor allows you to use different sized monitors instead of
requiring that all are the same. This page allows you to adjust the settings to match your configuration.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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10.1.5.3 WinTMC Settings Page

A terminal that is set for use as a WinTMC PC client by using Generic/PersonalComputer in the Make and
Model field of on the Terminal Hardware page will display a page for WinTMC settings. It is not shown for

normal terminals.
== Terminal Configuration Wizard x|

WinTHMC Settings
Select the local devices to be redirected, the experience zettings: and ’ ‘
clhent control zettings. A

— Redirect Local Resources
[ Redirect Serial Paort
[ Rediect Drives
" Fedirect Printers
™ Redirect Sound
™ Redirect Smart Cards

— Clent Control S ettings
¥ allow client to be closed

¥ allow client to be sized

¥ always maintain monitor connection
™ Show gioups as separate windows

— Expenence Settingz
¥ Show desktop background

¥ Show window contents while dragging
¥ Show menu / window animations

V¥ Show themes

¢ Back I Hest > I Finizh Cancel Help

WInTMC Settings

Importance of Page: Used to configure the WinTMC client that converts a PC into a terminal services client
that is controlled and managed through ThinManager.

Settings:

e Redirect Local Resources:

0 Redirect Serial Ports — Enable this setting to make local serial ports available in a session.
Serial Port redirection does not work when you connect to a terminal server running Windows
2000 or earlier.

0 Redirect Drives — Enable this setting to make local drives available in a session. Drive
redirection does not work when you connect to a terminal server running Windows 2000 or
earlier.

0 Redirect Printers — Enable this setting to make your local printer available in a session.
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0 Redirect Sound —Enable this setting to allow audio played in your session to play locally.
Sound redirection does not work when you connect to a terminal server running Windows
2000 or earlier.

0 Redirect Smart Cards — Enable this setting to make your smart card available in a session.
Smart card redirection does not work when you connect to a terminal server running
Windows 2000 or earlier.

e Client Control Settings:

o Allow client to be closed — Enable this setting if you want your user to be able to close the
client.

o0 Allow client to be sized — Enable this setting if you want your user to be able to resize the
client.

o Always maintain monitor connection — Enable this setting to keep the monitoring
connection active when WinTMC is closed to allow shadowing. Unselecting this checkbox will
release the WinTMC license when the WinTMC program is closed but will deny shadow
access.

0 Show groups in separate windows — This checkbox, if selected, will display multiple
Display Clients as separate windows rather than in one window shell.

e Experience Settings:

o0 Show Desktop Background — Enable this setting if you want your user to be able to select a
Windows Desktop Background. If not set, the background will be a solid color.

o Show window contents while dragging — Enable this setting if you want the window
contents of a window to be shown while the window is being dragged.

0 Show menu/window animations — Enable this setting if you want menu/window animations
to be enabled on the client.

0 Show Themes — Enable this setting if you want your user to be able to select a Windows
Theme.

Note: These functions may be denied by user policies or terminal server configuration. Check the Microsoft©
Local Policy, Group Policy, and Terminal Services Configuration. See Non-ThinManager Components for
details.

Why Change from Default Settings: The Redirect Local Resources settings allow the user to access the
resources on the PC.

The Client Control Settings can be set to prevent the WinTMC from being closed. If you want to convert a
floor PC to a dedicated terminal you can install WinTMC on the PC and have it launch automatically by
placing it in the Startup folder (C:\Documents and Settings\%username%.\Start Menu\Programs\Startup). The
user can't close WinTMC if the Allow client to be closed and the Allow client to be sized settings are
unchecked.

The Experience Settings give a PC-like desktop experience but use more resources.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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10.1.54 Terminal Module Selection Page

52 Terminal Configuration Wizard 5[

Module Selection m
Select the modules that load on this terminal at boak up. ’ ‘
A

[nztalled Modules

b odule

e @ | kowe Dawmn |

Add... Configure... | Femave |

< Back Finizh | Cancel | Help |

Terminal Configuration Wizard - Module Selection

Importance of Page: This page attaches modules to a terminal so that it can use touch screens, sound, USB
drives, etc.

Settings:

e Installed Modules — This list box displays the modules that are added to the terminal. Modules
added to a group will show a group icon.

Buttons:

e Move Up & Move Down — These buttons changes the order that the modules load during boot up
by rearranging the module list. They are rarely used.

e Add... —This opens the Attach Module to Terminal window to allow a module to be added to the
terminal.

e Configure... — Open the Modules Properties window by highlighting the module in the Module list
box and clicking the Configure button.

e Remove — Remove a module by highlighting it in the Module list box and clicking the Remove
button.

Why Change from Default Settings: Certain features and functions are activated by use of modules.
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Select Next to continue, Finish to save and close, or Cancel to close without saving.

10.1.5.5 Attaching a Module

A Module is a component of the firmware that is not needed for the basic functionality but may be desired for
advanced functionality. These features include Touch Screen drivers, serial mouse drivers, High Speed Serial
drivers, Shared Keyboard and Mouse, USB Memory Card Reader, and Instant Failover. See Module
Overview for details.

To attach a Module to a Terminal, select the Add... button to launch the Attach Module to Terminal window.
Attach Module ko Terminal |

tModule Type I.-'-‘-.II kodules ;I

Add Serial Part
Advantech SRK-3380 Local Storage

Advantech PCM-5821 Mizcelaneous

Advantech PCM-837] Mouze

Advantech UNO-205/RDP

Allen-Bradley Werzail Screen 5 aver

AMD Geode Videa Drver

Arista BE24-4CP Sound Driver

Arizta 6824-ACP Sound Driver

Anista 7824-ACP Sound Driver

Arista AP-3200 Sound Driver

Arizta ARP-16:% Touch Screen Diriver

Arigta BowPC-201H Sound Driver ;I

Cancel |

Attach Module to Terminal

The Attach Module to Terminal window will show the modules that are available to the terminal. The
Module Type drop-down box sorts the modules by categories to make the modules easier to find.

Highlight the desired module and select the OK button to add the module to the configuration.
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52 Terminal Configuration Wizard 5[

Module Selection G
Select the modules that load on thiz terminal at boot up. ’ = ‘

[nztalled Modules

b odule
@. Screen Saver Module

@ k.ev Block Module

Diwnapro Touch Screen Driver

e @ | kowe Dawmn |

Add... Configure... | Femave |
< Back I Hest > I Finizh | Cancel | Help |

Terminal Configuration Wizard - Module Selection

Terminals that are members of a Group may show icons to represent the properties of added modules.

. @ The Group icon represents modules assigned to a parent Group.

¢ No icon indicates that the module was added to that particular Group or Terminal and not a parent
Group.
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52 Terminal Configuration Wizard 5[

Module Selection m
Select the modules that load on thiz terminal at boot up. ’ = ‘

[nztalled Modules

b odule
@. Screen Saver Module

@ k.ev Block Module

Diwnapro Touch Screen Driver

bove Lp | b ove Dowin |

Add... Configure... Remowve |
< Back I Hest > I Finizh | Cancel | Help |

Module Configuration

Highlighting a module and selecting the Configure button will open the Module Properties window and allow
changes to the module configuration.
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Module Properties x|

Parameter | Walue | -
Cantraller Type 5C3
Fort COM1
Baud Rate BA&00
M anitor Murnber 1
Double Touch Area [pisels] 10 |
Swap #Y Coordinates HO
Murmber of Calibration Paints ]
Calibration b argin Percentage 10
. I Calikratine Hetk o RIMF Illj

Parameter IEn:-ntrn:nIIer Type

Walue |5|:3 j

Set to Default | Set
Done I Cancel |

Module Properties
On the Modules Properties window, select the parameter to change, select the new value in the drop-down
list, and click the Set button. This will change the setting.
The Set to Default button will restore the module to the default settings.

Select the Done button to close the Module Properties window and to return to the Terminal Configuration
Wizard.

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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10.1.5.6 ThinManager Server Monitor List Page

This page is not displayed when Auto-synchronization is used. See Auto-synchronization.

= Terminal Configuration Wizard x|

ThinM anager Server Monitor List
Thiz terminal will eztablizh a maonitoring connection to all Thinkd anager

Servers in this list. }.-4

Available Thinkanager Servers Selected Thinkdanager Servers
Gaold [192.168.1.30] Blue [192.168.1.36)
Green [192.168.1.34) .
— w
Edit Server List

¢ Back

Finizh Cancel Help

Terminal Configuration Wizard - ThinManager Server Monitor List

Importance of Page: If you are using two ThinManager Servers without automatic synchronization them the
terminal will normally only send its connection status (green light) to the ThinManager Server that it booted
from. This page allows you to list multiple ThinManager Servers so that the terminal will send its status
information to all the ThinManager Servers

Settings:

e Available ThinManager Servers — This is the list of defined ThinManager Servers. Selecting the
Edit Server List button will launch the ThinManager Server List Wizard to add new ThinManager
Servers.

e Selected ThinManager Server — This is the list of ThinManager Servers that the terminal will send
its connection status to. Move ThinManager Servers from the Available list to Selected list by double
clicking or using the arrow buttons while highlighted.

Buttons:

e Arrows — These buttons move highlighted ThinManager Servers from one list to the other or
rearrange the order listed.
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e Edit Server List — This launches the ThinManager Server List Wizard that allows the defining of
ThinManager Servers.

Why Change from Default Settings: Adding ThinManager Servers to the Selected ThinManager Server
allows control, configuration, shadowing , and rebooting of a terminal from a backup ThinManager Server if

the primary ThinManager Server fails.
Select Next to continue, Finish to save and close, or Cancel to close without saving.

10.1.5.7 Monitoring Configuration Page

= Terminal Configuration Wizard x|

Select the setting for how aften the Terminal Server status iz
monitored by thiz terminal.

Monitoring Configuration m
t-.‘

— Manitar [nteral

tdanitar [ntereal

Manitar Timeout
t onitar Fetry 3 =
Frimary Up Delay Multiplier |5 =
Prirary Up Delay 30 Seconds

¢ Back [HEwt > | Finizh I Cancel Help

Terminal Configuration Wizard - Monitoring Configuration

Importance of Page: This page sets the speed that failover is detected and initiated. A thin client creates a
socket connection to the terminal server. If the socket is disconnected the terminal will try to reconnect and
failover based on these settings.
Settings:

e Monitor Interval

0 Monitor Interval (Fast/Medium/Slow) — These settings have a set rate for the frequency
that the terminal server status is checked.
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0 Monitor Interval (Custom) — This setting allows the administrator to change the settings
from the defaults.

e Monitor Interval — This is the period of time the terminal will wait after losing the socket connection
before it tries to reconnect.

e Monitor Timeout — This is the period of time the terminal will wait between tries.

e Monitor Retry - This is the number of times the terminal will try to reestablish a connection before
failing over.

e Primary Up Delay Multiplier - This is a constant used to generate the Primary Up Delay time.
Field:

e Primary Up Delay - This is a delay added (usually set to 30 or 60 seconds) to allow a Terminal
Server to get fully booted before the terminal will try to login. This time period is equal to the
Monitoring Interval times the Primary Up Delay Multiplier.

This prevents a terminal using Enforce Primary from switching back to its primary terminal server
before it is ready.

Why Change from Default Settings: Faster rates will cause a quicker failover but will check on terminal
server status more often, causing more network traffic. Slowing down the rate will cause less traffic but will
slow the failover speed a little..

Select Finish to save and close, or Cancel to close without saving.
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11PXE Server Configuration

11.10verview

PXE (Preboot Execution Environment; sometimes pronounced "pixie") is an environment that allows a
computer to boot over a network. ThinManager provides a complete PXE boot environment that does not
require any additional software components. The ThinManager PXE Server conforms to version 2.1 of the
Intel PXE boot specification.

11.2Thin Client Hardware Requirements

The Thin Client computer must be capable of PXE Booting. Most standard BIOS ROMS include a PXE Option
ROM. In order to PXE boot, the PXE Option ROM must be enabled in the BIOS. The PXE boot method (boot

from network) should be set to first in the boot order. Disabling the other boot devices in the BIOS will ensure

that the unit will only boot via PXE.

11.3Methods of Operation

11.3.1 ThinManager Only Method

Using this method, the Thin Client will acquire an IP address and PXE boot options from the ThinManager
PXE Server. No standard DHCP Server is required. You must have the ThinManager PXE Server enabled
and the desired network interfaces enabled. Select the “Not using standard DHCP Server” server mode.

11.3.2 ThinManager Proxy Method

Using this method, the Thin Client will acquire an IP address from a standard DHCP server. There is no need
to set any PXE related boot options in the DHCP server configuration. These options will be sent to the Thin
Client by the ThinManager PXE Server. You must have the ThinManager PXE Server enabled in
ThinManager and you must select the “Using standard DHCP server with Boot Options” server mode.

11.3.3 Stand-Alone DHCP Server Method

Using this method, the Thin Client will acquire an IP address from a standard DHCP server including the
specified PXE boot options. This method is required if your DHCP server is installed on the same machine as
ThinManager. You must set Option 66 (Boot Server Host Name) to the IP address of your ThinManager
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Server and Option 67 (Boot File Name) to “acpboot.bin”. You must have the ThinManager PXE Server
enabled and you must select the “Using standard DHCP server” server mode.

See Network Interface Configuration for details.

11.4PXE Server Configuration Wizard

1141 Enabling the ThinManager PXE Server

Open the ThinManager PXE Server Configuration Wizard by selecting Manage > PXE Server from the
menu.

58 PXE Server Wizard |

PXE Server Configuration “5""
’.-*

Enable | Disable PXE Server

= Back I Mexk = I Finish Zancel Help

PXE Server Configuration

Enable PXE Server must be selected to boot PXE thin clients from ThinManager.
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11.4.2 Network Interface Configuration

52 PXE Server Wizard |

Network Interface Configuration "@"

Select the settings for each network interface
A

Select Interface to Configure

Primary I[P Address 10.3.10.30

— PXE Server Maode

™ Ising standard DHCP server
™ |Using standard DHCP server with Boot Options
¥ Mot using standard DHCP =zerver

¥ Allow Mew PXE clients

< Back Mext = Finish Cancel Help

Network Interface Configuration

Select a network interface from the drop down list to configure from the Select Interface to Configure
dropdown. This allows each network adapter to be configured individually. The primary IP Address reflects
the current IP address for the selected adapter.

PXE Server Mode

Select Using Standard DHCP server if you want to have a standard DHCP server assign IP
addresses to thin clients on the same network as the selected network adapter. The PXE Boot
options will be provided by ThinManager automatically. This selection will require no changes to your
DHCP server configuration.

Select Standard DHCP server with Boot Options if you want a standard DHCP server to assign IP
addresses and PXE boot options to thin clients on the same network as the selected network adapter.
Set Option 66 (Boot Server Host Name) to the IP address of your ThinManager Server and Option
67 (Boot File Name) to “acpboot . bin”. The PXE boot options will not be provided by
ThinManager. You must use this mode if your DHCP server is installed on your ThinManager Server.

Select Not using standard DHCP server if you want ThinManager to assign IP addresses to thin
clients without the need for a DHCP server. Using this mode requires that you set up IP address
ranges. Use this mode if you want to use static IP assignments (reservations). ThinManager will not
assign IP addresses to non-PXE booting devices.

Automation Control Products ThinManager 5.0 Help Manual PXE Server Configuration e 216



Allow New PXE clients allows unknown PXE thin clients to connect to ThinManager through the selected
network interface. Uncheck this option if you only want known clients to connect.

Note: Uncheck this setting if you are planning to have more than one non-synchronized ThinManager Server
on your network. You will need to temporarily enable this option to add a new thin client. For proper operation,
you can only have this option enabled on one ThinManager Server at a time.

11.4.3 Network Interface Configuration for Synchronized
ThinManager Servers
5% PXE Server Wizard |

Network Interface Configuration @
Select the settings for each network interface * = ‘

Select Interface to Configure

Broadcom NetLink (TM) Gigabit Ethemet |
Interface Primary IF Address 10.3.10.30

— Synchronization Interface
Metwork Inteface to synchronize this configuration with

Interface Primary |P Address 10.3.10.30

— PXE Server Mode
* Using standard DHCP server

™ IUsing standard DHCP eerver with Boot Options
™ Net using standard DHCP server

¥ Allow New PXE clients

< Back Mest = Finish Cancel Help

Network Interface Configuration for Synchronized ThinManager Servers

The Network Interface Configuration page will display a network interface dropdown for each ThinManager
Server if you are using auto-synchronization.

Select a network interface from the Select Interface to Configure to configure the primary ThinManager and
select a network interface from the Synchronization Interface to configure the secondary ThinManager
dropdown. This allows a network adapter on each ThinManager Serverto be configured individually.
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11.4.4 IP Address Range Configuration

The IP Address Range Configuration page displays the current ranges of IP Address being used by
ThinManager to assign to thin clients. It also gives the ability to edit the IP ranges.

Note: This section of the PXE Server Wizard is only used when the Not using standard DHCP server option
is selected in the Network Interface Configuration.

B8\ PXE Server Wizard |
IP Address Range Configuration @
Configure each range of IP Addresses } - ‘
Beginning IP Address I Ending IP Address I
10,3,10,100 10.3,10,109

add | Delete | Edit |
< Back | exk = | Firish I Zancel | Help |

IP Address Range Configuration

Select the Add button to launch the IP Address Range window to add a range of IP addresses for the PXE
Server.
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11.4.4.1 Adding or Editing an IP Address Range
IP Address Range |

: | 0 .0 .0 .0
Starting IF Address

o . o0 . a .0
Ending IP Address I

255 ., 255 , 255 . 0
Subnet Mask I

Router IP Address I °o.o .0 .0

Exclusions Reservations | Advanced |

oK | Cancel |

IP Address Range

The IP Address Range window has fields for the IP addresses to be assigned.

Fields:

Starting IP Address: This is first IP address you want the PXE Server to pass out.
Ending IP Address: This is last IP address you want the PXE Server to pass out.
Subnet Mask: This is the subnet mask of the network.

Router IP Address: This is the IP address of your router, if needed. Leave as 0.0.0.0 if not needed.

Buttons:

Exclusions launches the Exclusion window to exclude a specific IP addresses from the available
range.

Reservations launched the Reservation window that allows reserve a specific IP address to be
assigned to a thin client based on the thin client MAC address.

Advanced launches the Advanced IP Range Settings window that allows DHCP options to be
added.

Clear IP Assignments will clear the setting from the IP Address Range window.
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11.45 Exclusions

Exclusions |
Beginning IP' Address | Ending IP Address |
Add Edit Delete

Exclusion Window

Selecting the Add button will launch the Exclusion Range window that allows you to remove one or more IP
addresses from the range of IP addresses passed out by the PXE server.

Exclusion Range |

Exclusion Start IP Address I sec . ogc . oot oo

Exclusion End IP Address I Jee . 7B ZEE | oEE

Cancel |

Exclusion Range Window

Enter the first and last IP addresses of the range you want to exclude in the Exclusion Start IP Address and
the Exclusion End IP Address. If you have a single IP address you want to exclude then enter it in both the
Exclusion Start IP Address and the Exclusion End IP Address fields.
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11.4.6 Reservations

Reservations E I

Hardware Address | Secondary Hardware Add. .. | IP Address |
0000a00a00000 00o0aoa00a01 0.0.0.0
4 |+
Add Delete |
Ok, |

Reservation Window
Reservations allow you to associate a specific IP address to a specific thin client by associating the 1P
address with the MAC address of the thin client.
Select the Add button to add a reservation.

Reservation |

Hardware Address (MAC) I

Secondary Hardware Address (MAC) I

255 . 255 ., 255 ., 255
IP Address I

; Cancel |

Reservation Window

Hardware Address is the primary MAC address of the thin client.

Secondary Hardware Address is the MAC address of the second network interface of the thin client (if
present).

IP Address sets the IP address to be reserved for the desired thin client. This will be the address assigned to
the thin client when connected through either the primary or the secondary thin client network interface.
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11.5Terminal Group Configuration Wizard

Using Terminal Groups allows a configuration to be defined for a group of terminals. Terminals added to a
group will inherit the group properties to speed the configuration process. Using Groups can also aid in
management because many tasks can be done on the group level instead of repeating them for multiple
terminals.

e Groups can be nested within groups, providing deeper levels of organization.

e All Group Settings use a forced inheritance because of the use of nested Groups. Once a setting has
been selected as a group property, every terminal group and terminal beneath it will use that setting.

e Group Settings will be designated on the Configuration and Modules tabs with the Group icon of two
blue monitors.

11511 Group Settings Checkbox

The Terminal Group Configuration Wizard establishes the terminal settings for a group of terminals, while the
Terminal Configuration Wizard establishes the terminal settings for the individual terminal. The Terminal
Configuration Wizard and the Group Configuration Wizard use the same forms so they are very similar, with a
few different settings.

Note: This Help document will only show the differences between the Group Configuration Wizard and the
Terminal Configuration Wizard. See Terminal Configuration Wizard for details.

The Group wizard will have Group Setting checkboxes for each setting. Selecting this checkbox will force
that setting to be inherited by nested sub-groups and member terminals. The Group Settings of any sub-
group or terminal will be grayed out to prevent changes if the group setting is selected on the parent.
Changes need to be made at the Group level.

Automation Control Products ThinManager 5.0 Help Manual PXE Server Configuration e 223



& Terminal Configuration Wizard

Terminal Group Options }q

Select the options for terminalz in thiz group.

— T erminal Replacement

1 ¥ | &)l replacement at terminal i aff line

— Terminal Schedule

2 ™ Set Schedule S cheduls |

Group Setting v

— T erminal Effects
¥ Enable Teminal Eflects
3 ¥ Show terminal status messages

— Shadowing
Allaw terminal to be shadowed TES x
4 V¥ Allow Interactive Shadow

< Back I Hest > I Finizh Cancel Help

Group Setting Example

This example shows variations in the use of four Group Settings on the Terminal Group Options page of a
nested group.

Terminal Replacement (1) and Terminal Schedule (2) were configured in the parent group and cannot be
changed in this child group. Terminal Replacement (1) was set as checked, while Terminal Schedule (2)
was set as unchecked.

The Terminal Effects (3) Group Setting is selected for this Group. It will be grayed out in child groups and
member terminals.

The Shadowing (4) Group Setting is unselected, making it available to be set for child groups and member
terminals.
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11.5.1.2 Group Name Page

The Group Configuration Wizard can be launched by selecting Edit > Add Terminal Group or by or right
clicking on the Terminals branch in the tree and selecting Add Group.

=& Terminal Configuration Wizard |

Enter the name far the terminal group

Terminal Group Name m
h-;‘

— Group Mame

Thiz muzt be a unique name using letters, numberz, hyphens [-],
and underzoores ] anly.

— Terminal Group

Change Group |

Pemizzions | Group Setting [
< Back I Hest > I Finizh | Cancel | Help |

Group Configuration Wizard — Terminal Group Name

Importance of Page: This page allows the Group to be named.
Fields:
e Group Name - This is the name given to the group. Keep it under 15 characters.
e Terminal Group — This is the name of a parent group if this group is a sub-group.
Buttons:

e Change Group - This launches a window that allows the group to be added as a sub-group to
another group.

e Permissions — This allows the Terminal Group to be assigned Access Groups for security. This is a
function of TermSecure. See Permissions for details.

Checkbox:
e Group Setting — This will make the Permission a group setting that is inherited by all members.
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Why Change from Default Settings: A group needs a name at creation. The group can be added to another
group using the Change Group button.
ThinManager

Duplicate Terminal or Group MName

Duplicate Name Warning

If an existing name is selected, a Duplicate Name Warning popup will be displayed when the Next button is
selected.

Terminal Groups can be added to other Terminal Groups, creating a multi-level hierarchy. This is done with
the Change Group button that launches the Select Group window.

Select Terminal Group |

T r T |:|| Ok I
=- G.ru:uup
- SubGroupd Cancel |

Select Terminal Group Window

The Select Group window will show a tree displaying the group hierarchy. Highlight the Terminal Group that
you want to join and select the OK button to join or select the Cancel button to quit without joining.
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& Terminal Configuration Wizard

Terminal Group Hame }q

Enter the name for the terminal group

— Group Mame

ISubGrDup.ﬂ.

Thiz rmust be a unique name uging letterz, numbers, hyphens [-],
and underscores [_] only.

— Terminal Graup

Groupl Change Group |

Permiszions | GruupSettlng |
¢ Back I Hest > I Finizh | Cancel Help

Terminal Group Configuration Wizard — Terminal Group Name Page

The parent Terminal Group you joined will be displayed in the Group field.

Select the Next button to continue or select the Cancel button to close the configuration wizard without
saving.

11.5.2 Changing a Terminal’s Group
A terminal is added to a group from the Terminal Name page of the Terminal Configuration Wizard.
Open the Terminal Configuration Wizard by either:

e Highlighting the terminal in the ThinManager tree pane by clicking on the terminal name or icon and
select Edi t >Modify from the ThinManager menu bar.

¢ Right clicking on the terminal icon in the ThinManager tree pane and select Modify.
e Double clicking on a terminal icon in the ThinManager tree pane.

This will launch the Terminal Configuration Wizard.
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& Terminal Configuration Wizard

Terminal Mame
Enter the name for thiz terminal, select the terminal group to which

thiz terminal belongs, or chooze to copy the configuration from A
another terminal,
— Terminal Hame
Terminall
Thiz rmust be a unique name uging letterz, numbers, hyphens [-],
and underscores [_] only.
— Terminal Graup
— Copy Settings
[T Copy Settings from another Terminal Copy Fram |
Permiszions |
¢ Back | Hest > | Fimizh | Cancel Help

Terminal Configuration Wizard - Terminal Name Page

The first page of the wizard, Terminal Name, has a Change Group button. Select the Change Group button

to launch the Select Terminal Group window.
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Select Terminal Group

]
=1~ Terminals QK I

El G_ru:uup1

Cancel

SublEroLpd,
i SybGroupB
Group?

Select Group Window

The Select Terminal Group window has a tree of the Terminal Groups. Highlight the desired Terminal Group
and select the OK button. Selecting Terminals will remove the terminal from group membership.

The Cancel button will close the Select Group window without making changes.
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& Terminal Configuration Wizard

Terminal Hame
Enter the name for thiz terminal, select the terminal group to which
thiz terminal belongs, or chooze to copy the configuration from
another terminal,

— Terminal Mame

Terminall

Thiz rmust be a unique name uging letterz, numbers, hyphens [-],
and underscores [_] only.

— Terminal Graup

IGru:uup1 WS ubGroupd, Change Group

— Copy Settings

i

[T Copy Settings from another Terminal Copy Fram

Pemizsions |

¢ Back Fimizt | Cancel

Help

Terminal Group Display

Once a group is selected for the terminal the group will be displayed in the Terminal Group field.

Note: The terminal will need to be restarted for the changes to take effect.
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11.5.3 Unique Group Configurations

Several pages of the Group Configuration Wizard are different than the Terminal Configuration Wizard.
These include the Log In Information page, the Group Video Resolution, and Module pages.

11.53.1 Group Login Information Page
== Terminal Configuration Wizard |

Log In Information

Enter the log in infarmation ta log in automatically. Leave the log in ’ ‘
A

information blank or fill only some of the fields to force manual log in.

—"Windows Log In Infarmation

|lzername I

Pazzword

|
"Yerify Pazsword I
|

Werify |

D'amain

¢ Back

Finizh Cancel Help

Log In Information - Use Application Groups

The Log In Information page is different in the Group Configuration Wizard than the Terminal
Configuration Wizard.

It is recommended that each terminal login to a Terminal Server with a unique profile. For this reason, the
Group Username, Password, and Domain are inactive in the Terminal Group Configuration. These need to
be set individually during the Terminal Configuration.
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11.5.3.2 Group Video Resolution Page

& Terminal Configuration Wizard

Group ¥ideo Resolution

Select the video resalution far this group } ‘
A

— Select Video B esolution

Group Setting [

R ezalution Color Depth Fefrezsh Rate

;I IEEEEDIDrs ;I IEEIHz ;I

These are the rezolutionz supported by the Thin Client
model pou selected.

10244768

< Back I Hest > I Finizh Cancel Help

Group Configuration Wizard - Video Configuration
The Group Video Resolution page has a drop-down box that allows the video resolution to be set for all
members of the Group.

The Windows 2000 terminal connection uses a 256-color depth. The 64K-color depth is available by using
RDP connected to a Windows 2003 or 2008 Terminal Server.

The Group Setting checkbox will lock the settings for the group and all member terminals.

Note: It is not recommended to set the Video Resolution as a Group Setting because of the variety of monitor

sizes and the ease at which they are changed. These settings are better set as an individual terminal setting
to provide the flexibility to switch monitors.
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11.5.3.3 Group Module Selection Page

5 Terminal Configuration Wizard

Module Selection

Select the modules that load on this terminal at boak up. ’ ‘
A

[nztalled Modules

b odule
Q F.ew Block Module
I@. Screen Saver Module

Elographics Touch Screen Driver

bove Lp | b ove Down |

Add... Configure... | Femowve |

< Back I Hest > I Finizh | Cancel | Help |

Group Configuration Wizard - Module Selection

A Module is a component of the firmware that is not needed for the basic functionality but may be desired for
advanced functionality. These features include Touch Screen drivers, serial mouse drivers, High Speed Serial

drivers, Shared Keyboard and Mouse, USB Memory Card Reader, and Instant Failover. See Module
Overview for details.

Terminals that are members of a Group may show icons to represent the properties of added modules.

. IEH The Group icon represents modules assigned to a parent Group.
=
[
Gt~ The Group icon with yellow plus sign represents properties that are changed on the
terminal from the Group settings. This is limited to touch screen calibration.

¢ No icon indicates that the module was added to that particular Group or Terminal and not a
parent Group.

If you add a module to a group it will display the group icon and any configuration will need to be made at the
group level.
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If you add a module to a terminal it will not display an icon and any configuration will need to be made at the
terminal level.

See Modules for Details.

The rest of the Group Configuration Wizard pages follow the Terminal Configuration Wizard pages.
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12Display Servers

Display Servers are devices that provide content that can be displayed on the client. Examples include the

traditional terminal server and IP cameras.

The Terminal Server List Wizard allows configuration of Terminal Services Display Servers. The Camera

Configuration Wizard allows configuration of Camera Display Servers

12.1Terminal Services Display Servers

The Terminal Server List Wizard can be launched by:

¢ Right clicking on the Display Servers Terminal Servers branch and choosing the Add Terminal

Server command

e Right clicking on the Display Servers Terminal Servers branch and choosing the Edit Terminal

Server command.

Terminal Server List Wizard |

areen [192.168.1. 34
Black [192.168.1.35)
Blue [192.168.1.36)
Purple [192.168.1.33)

Cancel

Edit Server |
Add Server

Femove Server |

Find Servers |

]9

Terminal Server List Wizard

Importance of Page: This allows you to define the terminal servers that will be used within ThinManager.
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Fields:

e {Unnamed) — The list box will contain the names and IP addresses of defined terminal servers.
Buttons:

e Edit Server — This will open the properties for a highlighted terminal server in the list.

e Add Server - This will launch the Terminal Server Configuration Wizard to allow a new terminal
server to be defined.. See

e Remove Server — This will remove a highlighted terminal server from the list.

e Find Servers - This will launch the Available Terminal Servers window for automated terminal
server addition.

e Cancel - This will close the wizard without action.
e OK — This will close the wizard after accepting changes.

Why Change from Default Settings: The terminals require terminal servers to connect and run sessions on.

12.1.1.1 Available Terminal Servers Search

Available Terminal Servers |

Choose a Terminal Server to Add...

Cancel

Find

Dramain or WwoarkGroup ta zearch

Available Terminal Server Window

The Available Terminal Servers window will display any Microsoft© terminal servers that are a member of
the same domain or workgroup as ThinManager. Select the Find button to display the member servers.
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Available Terminal Servers

Chooze a Terminal Server to Add...

Dramain or Work Group to zearch

| Cancel |
_ fnd |

ACF Find

BLACK,
BLUE
BROWwWHN
CREAM
GREEM
TaM

Available Terminal Server Window

The Domain or WorkGroup to Search field will allow ThinManager to search a different domain or
workgroup. Enter the domain of workgroup to search and select the Find button to display the member
servers.

Once the terminal servers are listed, highlight one and select the OK button to add it to the Terminal Server
Configuration Wizard. This will launch the Introduction page of the Terminal Server Wizard.
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12.1.1.2 Terminal Server Wizard Introduction Page
5% Terminal Server Wizard |

Terminal Server Wizard

Introduction g

The Terminal Server Wizard defines the Terminal Servers on your networl.
This allows the listing of Terminal Servers for easy selection.

If you are using a DMS server you will only need to enter the server name.
ff you are not using a DM server you will enter a server name and IP address.

The server name must be the name used to identify the server on the networl:.

< Back

Finish Cancel Help

Terminal Server List Wizard Introduction

Importance of Page: This displays introductory information.

Select Next to continue or Cancel to close without saving.
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12.1.1.3 Terminal Server Name Page

5 Terminal Server Wizard |

Terminal Server Name W
Erter the Teminal Server Mame and Log In infarmation. } ‘
A

Teminal Server Name Il

bl Ear P | 265 . 285 . 255 . 255 T |

— Log In Information

Domain

|ser Mame

Password

Verfy Password

Schedule |

Please enter a valid |P Address

< Back Hewt = Eimizh Cancel Help

Terminal Server List Wizard — Terminal Server Name

Importance of Page: This page defines the terminal server and allows the addition of an administrative user
account for increased management.

Fields:

e Terminal Server Name - Enter the computer name as found in the Microsoft© System Properties
(NetBIOS name). The name will already be entered if the Find function on the Available Terminal
Servers window was used.

e Terminal Server IP — Entered the IP address of the terminal server.

Login Information — Enter a Windows user account with administrative rights for the terminal server if you
wish to display data from the terminal server within ThinManager. This is required to populate the User,
Sessions, and Process tabs of the details pane. See Details Pane for details.

e Domain - Enter the domain for the computer, if it is a member of a domain.
e User Name — Enter the user name of the administrative account here.
e Password - Enter the password for the administrative account used in the User Name field.

e Verify Password — Re-enter the password for the administrative account used in the user name field.
Passwords that do not match will be indicated by a warning message on the page.

Buttons:
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e Discover — The Discover button will automatically fill in the IP address for a terminal server listed in
the Terminal Server Name field.

e Schedule — The Schedule button will launch the Event Schedule for the terminal server. This allows
the scheduling of repeated functions like rebooting and disabling.
See Scheduling for details.

Why Change from Default Settings: ThinManager uses a connection to the terminal server to pull the
process, user, and session information for the detail pane tabs and to determine the load for SmartSession
load balancing. Entering a username and password in the User Name and Password fields allows
ThinServer to connect to the server for this data.

Select Next to continue, Finish to save and close, or Cancel to close without saving.

12.1.1.4 Terminal Server Capabilities Page

5% Terminal Server Wizard |
Terminal Server Capabilities W
Select the capabilties of this Teminal Server. ’ . ‘
— Supported Connection Types
I Citrix ICA

[ Citiix Device Services

¥ Microsoft Remote Desktop Protocal

— Terminal Server Options

v ‘Available for Display Clientz using Smart Session;

< Back Mext = Finish Cancel Help

Terminal Server Capabilities
Importance of Page: This allows a terminal server to be used for SmartSession. It also defines what
communication protocols the server can use.
Settings:

e Supported Connections — This is a list of client/server communication protocols that the
terminal server can use.

o Citrix ICA — Check this checkbox if a Citrix server-side program is installed on the terminal
server to provide the ICA protocol.
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o Citrix Device Services - Check this checkbox if Citrix Device Services is installed and
licensed on the terminal server. Citrix Device Services is a legacy deployment of the ICA
client but is no longer supported by Citrix. Thin clients can still connect to terminal servers
with Device Services, but no new Device Services terminal servers can be licensed.

o Microsoft Remote Desktop Protocol - RDP is installed by default on Windows Terminal
Servers. Uncheck the Microsoft Remote Desktop Protocol checkbox if you don’'t want to
access to the terminal server with the protocol.

e Available for Smart Session Server — This checkbox makes the terminal server available for
Application Groups that use SmartSession to provide load balancing. See Display Client
SmartSession Settings Page for more details.

Why Change from Default Settings: Add SmartSession if you want to use SmartSession. Add Citrix ICA if
that is being used.

Note: Configuring a terminal server to use SmartSession uses a SmartSession license.

Select Next to continue, Finish to save and close, or Cancel to close without saving.

12.1.1.5 Data Gathering Page

52 Terminal Server Wizard |
Data Gathering w
Erter the Data Gatherng intervals. *
)
— Data Gathering Intervals
* fast
" Medium
= Slow
" Custom
Smart5ession Data Update Interval g _I seconds
Process Lpdate Interval 2 _I seconds
Session Update Interval g _I seconds
< Back Mext = Finish Cancel Help
Data Gathering
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Importance of Page: This page sets the frequency that ThinManager polls the terminal servers for user,
session, and process information.

Settings:

e Data Gathering Intervals (Fast/Medium/Slow) - These settings set the rate of the frequency that
ThinManager polls the terminal server for data.

e Data Gathering Intervals (Custom)- This setting allows the polling speeds to be set.

0 Smart Session Data Update Interval is the amount of time between the retrieval of
SmartSession data, CPU usage, memory usage, and session count, from the terminal server.
This setting affects the update speed of the Server Rankings used in SmartSession load
balancing.

0 Process Update Interval is the amount of time between the retrieval of the process
information on the terminal server. This setting affects the speed of the update of the process
information on the Processes tab for the terminal server.

0 Session Update Interval is the amount of time between the retrieval of session data from
the terminal server. This setting affects the speed of the update of the user information for the
sessions on the Users and Sessions tabs for the terminal server.

Why Change from Default Settings: Faster rates will lead to quicker updates but will add more network
traffic. Slowing down the rate will cause less traffic but will slow the update rate a little.

Select Next to continue, Finish to save and close, or Cancel to close without saving.

If this terminal server is used as a SmartSession server, the Next button will go to a SmartSession
Configuration page. If this terminal server is not configured as a SmartSession server, the Next button will be
grayed out and the Finish button will close the wizard.
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12.1.1.6 SmartSession Configuration Page

5% Terminal Server Wizard |
Smart Session Configuration m
Erter the SmartSession limits for this Terminal Server. } ‘
ot
—CPU Lkilization

Minimum

o

Madimum 100.0

P

— Memary Ltilization

| Bk

Minimum 0

Maximum 1000 %
— Sessions

Minimum

Maximum 50

< Back Hest > | Fish |  Caneel | Help

Terminal Server List Wizard - SmartSession Configuration

Importance of Page: This allows SmartSession data to be tweaked.

ThinManager uses the CPU utilization, Memory utilization, and number of sessions on the terminal server
to define the SmartSession terminal server’s available resources. ThinManager uses these resource values to
rank the load of the SmartSession servers. ThinManager supplies this load data to the terminals to allow the
terminals to connect to the terminal server with the lightest load and greatest available resources.

The SmartSession Configuration page allows the configuration of the three parameters that ThinManager
uses to determine availability for SmartSession. ThinManager will scale the range between the Minimum field
and Maximum field as 100%.

Settings - The three values used in SmartSession are:
e CPU Utilization — The percentage of CPU usage on the terminal server.
e Memory Utilization - The percentage of CPU usage on the terminal server.
e Sessions — The number of sessions on a terminal server.

Fields:

e Minimum - the value that ThinManager will use as the starting point of the load. A value below the
Minimum is considered to be unused.
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e Maximum - the value that ThinManager will consider the parameter as reaching 100% utilized and
is unavailable.

Why Change from Default Settings: Changing the Minimum and Maximum values will change the range
used to calculate SmartSession loads and can influence SmartSession behavior.

Select Finish to save and close or Cancel to close without saving.

12.2Camera Configuration Wizard

The Camera Configuration Wizard allows an IP Camera to be configured as a Display Server within
ThinManager.

Launch the Camera Configuration Wizard by right clicking on Cameras in the Display Servers branch and
selecting Add Camera.

12.21.1 Camera Name Page

=2\ Camera Configuration Wizard |

Camera Name
X

Erter the camera name and network location

—Camera Name

Camera Name Il

Change Group |

—Camera Model
Make IGeneric j
Madel | Default j

—Camera MNetworl Setup

IP Address I

Part IE'[:I

Flease enter a Camera name

¢ Back Hewt 5 Fiish | [ Cancel | Help

Camera Configuration Wizard

Importance of Page: This page names and addresses the IP Camera.

Fields and Settings:
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e Camera Name and Group
o Camera Name — Enter a name for the camera.
0 Change Group — This button allows the camera to be added to a Camera Group.
e Camera Model
0 Make — Use the drop-down to select a manufacturer.
0 Model — Use the drop-down to select a model.
e Camera Network Setup
o IP Address — Enter the IP address of the IP camera.
o0 Port — Enter the port used.
Why Change from Default Settings: Each camera needs to be defined.

The first page of the camera configuration wizard requires that a camera name be entered. Select the make
and model of the camera you are configuring and the IP address and Port that has been previously assigned
to the camera. The IP address and port are set by using the camera manufacturers configuration software or
through the use of the camera’s web browser interface.

12.2.1.2 Camera Authentication Page

5 Camera Configuration Wizard |
Camera Authentication m
Enter the camera usemame and password } ‘
oy
|lzemame Il
Paszword I
Verfy Password I

< Back Hews | Fish |  Cancel Help

Camera Authentication
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Importance of Page: This page provides authentication, if needed.
Fields:

e Username — Enter a username, if needed.

e Password — Enter a password, if needed

o Verify Password — Re-enter the password for accuracy.

Why Change from Default Settings: If your camera requires authentication enter it on this page. If the
camera has been configured to allow anonymous connections, leave the information blank.

The terminal uses the authentication information when connecting to the camera. Authentication information
is setup in the camera by using the camera manufacturers configuration software or through the use of the
camera’s web browser interface.

12.2.1.3 Camera Model Options

== Camera Configuration Wizard |

Camera Model Options p

Select the camera model specific options
iy

¥ include Camera Options:

Resolution I G40 480

L L

Frames per second |5

Compression (0-100) |3D

Show Clock |NO j
Show Date [no =]
Show Text |NO j
Text Position |TCIF‘ j
Text |

< Back Hest > | Fish |  Cancel Help

Camera Model Options

Importance of Page: This page allows additional camera configuration.
Fields:
e Include Camera Options — This checkbox shows addition options when checked.

e Options — The options shown vary by make and model of the camera hardware. Please see camera
documentation for their help.
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Why Change from Default Settings: The camera can controlled in finer detail.

Some cameras support additional configuration options. These options can be configured on this page. If you
wish to use the default options then leave the Include Camera Options unchecked. The newly created
camera will appear in the ThinManager tree as follows.

B2 ThinManager M=l B3
Edit Manage Install Tools View RemoteView Help
ICuhalt j Config | Eu:unneu:tl Event Lu:ugl
=g Cobalt [ Attibute [ Walue
Q Terminals Camera Configuration
= ﬁ Display Servers Camera Marme Carnera3l
W Terminal Servers Camera IP Address 10.3.10.31
E| Cameras Camnera Port an
& Webinar b @k acturer Generic
L Camerah Model Defaul

Camera3l
Eﬂ---f_.}.] VCenter Servers
E|...|:| Display Clients

- ﬁ TermSecure Users

For Help, press F1

<

R

Camera Tree View
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12.2.2 IP Camera Group Configuration

The camera group configuration wizard can be launched by right clicking on the Cameras branch of the
ThinManager tree and selecting the Add Camera Group option.

==\ Camera Configuration Wizard |

Camera Group Mame t.’_"
'

Enter the camera group name

Camera Group Name

Camera Group Mame I

Change Group |

S Hews> | Fish |  Canosl Help

Add Camera Group Wizard

Enter the Camera Group Name and select Finish. The Camera group will be shown in the ThinManager tree
as follows.
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52 ThinManager

Edit Manage Install Tools \View RemoteView Help

=] B3

|Cobalt

[

Coanfig | EDnnECtI Event Ll:ngl

=g Cobalt
Q Terminals
EI a Display Servers
i Terminal Servers
E| Cameras
-
Camera7l
Camera3il
Camera3l
EI[E,] VCenter Servers
[+ [l Display Clients
- ﬂ TermSecure sers

1

For Help, press F1

| Attribute | Y alue
Camera Configuration
Carnera Mame WWebinar

<

bz

Camera Group Tree View
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12.2.3 IP Camera Administration

Once a camera is configured in ThinManager, the Connect tab can be used to connect to the camera and
perform camera administration from ThinManager.

B2 ThinManager v4.0 - Education Dept. - ACP WHQ

Edit Manage Install Tools Yiew RemateWisw Help

E";a? Cobalt Config  Connect I Event LDQI
Q Terminals
=B i Display Servers
ﬁ Terminal Servers
E Cameras
i ﬁ Webinar
Camera30
Camerasl
ﬂggj} VCenter Servers
E||:| Display Clients
H- ﬁ TermSecure Users

DEs-g10 | LI¥E ¥IDED | SETUP MAINTENA

Camera

1l

Logout

This section shows your IP camera's live video. You can control yor
Current resolution is 320 X 240,

3l

3l

FUNCTION

& activex  © Java

LI¥E YIDEO

2011-04-(

For Help, press F1

Camera Connect Tab

Camera log in information may be requested when using the connect tab. The authentication information
entered during the camera configuration is not used when using the connect tab.
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13Display Clients

Display Client is the term used to denote the graphic rendering of the output from a Display Server. This could
be a traditional Terminal Server session, IP Camera display, a Terminal-to-Terminal Shadow session or a
workstation session.

13.1Display Client List

The Display Client List Wizard can be launched by either:
e Right clicking on the Display Client branch and choosing the Add Display Client command
e Right clicking on the Display Client branch and choosing the Edit Display Client command.
Available Display Clients |

&dd

E dit

Delete

il

Cancel | | k. I

Display Client List Wizard
The opening window of the Display Client List Wizard will show any Display Clients that are defined or will
be blank if none have been defined.
Fields:
e (Unnamed) — The list box shows Display Clients that are created.
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Buttons:
e Add Group — This will launch the Display Client Wizard to create a new Display Client.
e Edit Group — This will open the properties for a highlighted Display Client.
e Delete Group — This will remove a highlighted Display Client from the list.
e Cancel — This will close the wizard without action.

e OK - This will close the wizard after accepting changes.

13.1.1.1 Display Client Name Page

5= Display Client Wizard

Client MName w
Enter the Display Client name. } ‘

Client Mame ||

Type of Display Client

Teminal Services - I

Permissions |

Flease enter a Display Client name

< Back I Hent = Eimizt Cancel Help

Display Client Name Page

Importance of Page: This page starts the configuration wizard, sets the name, and the type of Display Client.
Fields:

e Group Name - This field is used to name the Display Client.
Settings:

e Type of Display Client drop-down box selects the function of the Display Client.

o0 Terminal Services — This creates a Display Client that allows a terminal to connect to a
terminal server, login, and run a session.
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0 Terminal Shadow — creates a Display Client that allows a terminal to be shadowed by
another terminal.

o0 Camera — creates a Display Client that allows the use of IP Cameras.

0 Workstation — creates a template for workstation deployment. The Workstation Display
Client gets assigned to a specific workstation when it is applied to a terminal. See Virtual
Workstations for details.

Buttons:

e Permissions - The button will launch the Permissions window that allows Permissions to be set for
TermSecure. This is discussed in Permissions.

Why Change from Default Settings: The group needs a hame and a type assigned to it.

This section covers Terminal Services Display Clients. Once the Type of Display Client is set to Terminal
Services select Next to configure the group options.

13.2Terminal Services Display Clients

The Terminal Services Display Clients of ThinManager have the same function as the Terminal Server
Groups from pre-3.2 versions of ThinManager and the Application Groups of ThinManager 3.2 and 3.3. They
allow a terminal to connect to a terminal server, login, and run a session. The specific terminal server that the
terminal connects to is based on the Display Client configuration and options.
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13.2.1.1 Display Client Options Page

5% Display Client Wizard

Display Client Options ﬁ

Select the options that apphy to this Display Client

—Client Options
¥ Allow Display Client to be tiled;
¥ Allow Display Client to be moved (MuttiMonitor)
™ Include IP Camera Overlays

— Display Client Connection Options

v Always maintain a connection
¥ Connect at boot-up
[ Disconnect in the background

< Back Mexdt = Finish Cancel Help

Display Client Options

Importance of Page: This page allows the configuration of Display Client parameters
Checkbox:

e Allow group to be tiled — If checked, this allows the Display Client to be tiled in SessionTiling. See
SessionTiling Options for details.

e Allow Group to be moved (MultiMonitor) — If checked, this allows an Display Client to be moved
from one MultiMonitor screen to another. See MultiMonitor for details.

e Include IP Camera Overlays —This will allow IP Camera overlays to be added to this Display Client.

e Always maintain a connection — This keeps a session active, reconnecting and restarting if it is
closed. If unchecked, the user can close a session and another session won'’t start automatically.

e Connect at boot-up — If checked, the terminal will start a session for this Display Client at boot up. If
unchecked, a user action is required to start the session.

e Disconnect in background — If checked, an Display Client being used in a MultiSession
configuration will disconnect once it is moved into the background. This could be done to require
fewer resources.
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Why Change from Default Settings: The Alays maintain a connection and Connect at boot up
checkboxes, if unselected, will lower the demand on the terminal servers by allowing sessions to be closed
until needed.

Select Next to continue, Finish to save and close, or Cancel to close without saving.

13.2.1.2 Terminal Services Display Client Type Page

5% Display Client Wizard |
Temminal Services Display Client Type m
Select the type of connection for this Teminal Services Display ’ ‘
Client. oY

— Terminal Server Type
Select the type of Teminal Server for this Display Client

™ Citric ICA Servers
™ Citrix Device Services Servers
{* Hemote Desktop Protocol Servers:

< Back Mext = Finish Cancel Help

Terminal Services Display Client Type

Importance of Page: Each Terminal Services Display Client can use a single protocol to connect to the
terminal servers.

Settings:
e Citrix ICA — This allows the use of the Citrix© ICA protocol in client to server communications.

e Citrix Device Services — This is a legacy version of the ICA protocol used on Windows NT and
Windows 2000 terminal servers.

e Remote Desktop Protocol (RDP) — This is the default protocol from Microsoft®©. It is automatically
installed on Microsoft© terminal servers.

Why Change from Default Settings: Change to the Citrix© ICA protocol if the Citrix© ICA protocol is going
to be used instead of the default RDP.
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Select Next to continue, Finish to save and close, or Cancel to close without saving.

13.2.1.3 Terminal Services Display Client Options Page
5% Display Client Wizard |

Temminal Services Display Client Options W
Select the options for this display client * - ‘

— Terminal Services Options

[ Application Link
[” Enforce Primary
[T Instant Failover
v Alow Auto-Login

< Back Mext = Eimizh Cancel Help

Terminal Services Display Client Options

Importance of Page: This page sets the roles of the Display Client.
Checkbox:

SmartSession Group — - This adds SmartSession to the Display Client which provides load
balancing between member terminal servers.

SmartSession uses CPU availability, memory, and the number of sessions on the member terminal
servers to determine the load on the servers. Thin clients connect to the terminal server in the Display
Client with the most available resources. See SmartSession Option for details.

Application Link Group (AppLink) — - AppLink, provides the Initial Program function to thin clients
that connect to members of the Display Client. The Initial Program function launches a program
instead of the desktop. Closing the program will end the connection and force a reconnection to a
session running the application. See AppLink Option for details.

Enforce Primary - This allows a thin client to connect to its original terminal server if that terminal
server has failed and recovered. This is not available if SmartSession is selected.
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e Instant Failover (requires license) - This provides Instant Failover where the terminal will connect to
two terminal servers in the Display Client. The terminal will have an active session on two terminal
servers but will only display one session. If the first terminal server fails, the session of the second
terminal server session is immediately displayed, eliminating any downtime due to terminal server
failure.

e Allow Auto-Login - If checked, the terminal will use the login information supplied in the terminal
configuration to automatically logon to the terminal server. If unchecked, the user will be required to
manually login to the terminal server.

Why Change from Default Settings: Display Client features like SmartSession and Instant Failover are
added on this page. You can force users to manually login to a session by deselecting the Allow Auto-Login
checkbox.

Note: Enforce Primary is not available with SmartSession.

13.2.1.4 SmartSession Option

SmartSession is a load balancing strategy that allows terminals to connect to the member of an Terminal
Services Display Client that has the most available resources. ThinManager monitors the CPU load, memory
availability, and number of sessions on the terminal servers and ranks them by availability. When a thin
client connects to a member of an Terminal Services Display Client with SmartSession, the terminal connects
to the terminal server with the lightest load.

SmartSession
Server Ranking
AN 182.680
Application "B" 32.75
Group " 64.55
with
SmartSession np 243.50

ThinManager polls the terminal servers for resource
availability and assigns a ranking to pass to the terminals.

Terminals connect to the terminal server with the lowest
ranking. Lower humbers mean a lighter load.

This example is ranked B-C-A-D

SmartSession
Each member terminal server needs SmartSession configured in the Terminal Server Display Server
Wizard. See Terminal Server Capabilities Page for details.

Once ThinManager has polled the terminal servers and established the availability of their resources,
ThinManager passes the Server Ranking to the thin clients for its connection instructions.

Automation Control Products ThinManager 5.0 Help Manual Display Clients e 257



ISEThinHa nager =] B3

Edit Manage Instal Tools View RemoteView Help

Cl=-. -
EW Cobalt Config  Server Rank |
- M Terminals :
i . i | Load | Line Ciolor
ﬁ Display Servers Silwar A ETA
[+ (5} vCenter Servers Gieen 171.293
=|- [l] Display Clients Blue 80353 B——

[L]ﬂ Terminal Services
; Calculator
- EMai
j“_'_J HMI
_ﬂ Reports
Eﬂ---ﬁ! _Camera

Eﬂ@ Terminal Shadow
Eﬂ---@ Workstation

[+ ﬁ TermSecure Lsers

For Help, press F1

ThinManager Interface — Server Rank Tab

The Server Rankings are displayed on the Server Rank tab when a Terminal Services Display Client is
highlighted in the ThinManager tree. In the example above a thin client would connect to Green because it
has the lowest load.

13.2.1.5 AppLink Option

AppLink provides the Initial Program functionality to a Terminal Services Display Client. If AppLink is
enabled, the path to an Initial Program is entered into the AppLink Page of Terminal Services Display
Client Wizard. This program will be the only program to run in that session.

Note: If the AppLink option is not used then the terminal services session will display a desktop.

Note: If a Terminal Services Display Client contains several terminal servers, the path must be valid on all
terminal servers. If different terminal servers have different paths to the desired program, write a batch file to
open the program.

13.2.1.6 Instant Failover Option

Terminal Services Display Clients can provide Instant Failover without using the Instant Failover Module.
With Instant Failover a terminal will connect to a session on two terminal servers. Both sessions are active but
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only one is displayed. If the first terminal server fails, the second session is immediately displayed, eliminating
any downtime due to terminal server failure.

Note: AppLink and Auto-Login is normally used with Instant Failover to provide instant access to an
application.

Instant Failover is configured by selecting the Instant Failover checkbox on the Terminal Services Display
Client Options page of the Terminal Services Display Client Wizard,

Instant Failover works with the terminal servers of a Display Client, not between different Display Clients.

Note: Do not use the Instant Failover Module when using Instant Failover in Display Client.

In a standard Terminal Services Display Client, the terminal will use the first listed terminal server as the
primary server and will use the second listed terminal server as the secondary server.

If using SmartSession, the primary session will be on the server with the lightest load and the backup
session will be on the terminal server with the second lightest load.

13.2.1.7 Display Client Members Page

5% Display Client Wizard |
Display Client Members 'm'
Select the Terminal Servers for this display client. ’ ‘
AR
Available Terminal Servers Selected Terminal Servers
Gray (10.3.10.43) Blue (10.3.10.41)
Green (10.3.10.40) .
— w
Edit Server List
< Back Mext = Finish Cancel Help

Display Client Members
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Importance of Page: This allows the selection of the terminal servers that will be members of the Display
Client. Adding multiple terminal servers to the Selected Terminal Server list will establish failover.

List Box:

e Available Terminal Servers — This is the list of the terminals configured in the Terminal Server
Configuration Wizard and available to the terminal.
If the Available Terminal Server list box is empty the Terminal Server Configuration Wizard can be
launched with the Edit Server List button to define the terminal servers.

e Selected Terminal Servers — This is the list of terminal servers that the Display Client will use.
Move the terminal servers to this list with the left and right arrow or by double clicking on the name.
Listing two or more terminal servers configures Failover.

The terminal will connect to the terminal servers in the order listed unless SmartSession is used. The
terminal will connect to the terminal server with the lightest load if SmartSession is being used.

Buttons:

e Arrows — The left and right arrows move the terminal servers between list boxes. The up and down
arrow change the order that the terminal servers are used. The top terminal server is considered the
primary terminal server.

e Edit Server List — This launches the Terminal Server Configuration Wizard that allows terminal
servers to be defined within ThinManager. Selecting Manage > Terminal Server List from the
ThinManager menu will also launch the Terminal Server Configuration Wizard.

Why Change from Default Settings: It is critical to list the terminal servers that the Display Client will use.
The wizard will not advance without a terminal server selected.

If the Available Terminal Servers column is empty, the Terminal Server List Wizard needs to be run to
define the terminal servers. Select the Edit Server List to launch the Terminal Server Configuration Wizard
and define the terminal servers.

If the Display Client is using the SmartSession option, the Next button will launch the SmartSession
Settings page.

If the Display Client is not SmartSession Group the Finish button will complete the Display Client
configuration.
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13.2.1.8 Display Client SmartSession Settings Page

5 Display Client Wizard |
Smart Session Settings w
Erter the SmartSession weights for this display client } ‘
A
— Smart Session Weights
CPU Utiization Weight ol
Memony Litilization Weight I =1
Sessions Weight I 1.0 j
— Queuing
Queue Tme  Min I 0 Sec Manx 120 Sec
[T Irfinite
< Back Medt = Finish Cancel Help

Smart Session Settings

Importance of Page: This allows tweaking of SmartSession values by adjusting the weights of the
SmartSession settings.

ThinManager multiplies the CPU utilization, Memory utilization, and number of sessions on the terminal server
by the Weight shown to define the SmartSession terminal server’s available resources.

The higher the Weight, relative to the others, the greater the importance that parameter has in determining
the load for SmartSession.

The SmartSession load = (CPU weight * CPU Utilization %) + (Memory weight * Memory Utilization %) +
(Session weight * Session Utilization %)
Settings:

e CPU Utilization Weight — This is the CPU multiplier.

¢ Memory Utilization Weight — This is the Memory multiplier.

e Session Weight — This is the Session multiplier.

Queuing controls the rate that terminals connect to the terminal servers in the Display Client to allow
processor intensive applications to load one at a time instead of many sessions forming at once, bringing the
server to a halt. As terminals that use SmartSession Queuing boot, they request their terminal server from
ThinManager. ThinManager will send the first terminal to the terminal server with the lightest load and will put
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the other terminals in a queue for the interval defined in the Min _ Sec field. This allows the terminal server
load to stabilize and allows ThinManager to re-sample the loads and send the terminal to the terminal server
with the lowest current load.

Fields:

e Min _ Sec — This is the amount of seconds that a terminal will wait in the queue before being sent to
a terminal server that has another terminal connecting. The terminal may wait longer than this value
to connect if the CPU of the terminal server exceeds the Maximum CPU Utilization defined on the
SmartSession Configuration page of the Terminal Server Configuration wizard. See
SmartSession Configuration Page for details.

e Max _ Sec — This is the maximum amount of seconds that a terminal will wait in the queue before
being sent to the terminal server to login, regardless of the load.

Checkbox:

e Infinite - If the Infinite checkbox is selected, ThinManager will wait until the CPU utilization of the
terminal server has regained an acceptable range before sending other terminals to it to login.

Why Change from Default Settings: The values can be tweaked to alter performance, if needed.

Note: The Weighs are relative. Increasing all three Weights from “1” to “10” doesn’t change the relative
values.

If the Display Client uses the AppLink option, an AppLink page will be displayed by selecting the Next button.
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13.2.1.9 Display Client Linked Application Page

5\ Display Client Wizard |
Applink \ O J
Erter the linked application path. } - ‘
— AppLink Path

Program Path and Filename

Browse

i

Command Line Options

Start in the following folder

Browse

i

< Back I Hest > Einizh Cancel Help

AppLink Path

Importance of Page: This page configures the Display Client as an AppLink group where it will launch a
single application in the session. If this application is closed the terminal will reconnect and re-launch the
application.

Fields:

e Program Path and Filename - Enter the path to the desired application in the field.

Note: Quotation marks may be needed when there is a space in the path.

e Command Line Options — This field provides a space for command line options and switches. This
field may not be required.

e Startin the following folder - This field is provided in case you need to specify the working directory
for the program when using a relative path for the initial program. This field may not be required.

Buttons:

e Browse — The Browse button will allow you to select the executable file using a file browser. Make
sure the path is correct on all terminal servers.
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Note: If a Terminal Services Display Client contains several terminal servers, the path must be valid on all
terminal servers. If different terminal servers have different paths to the desired program, write a batch file to
open the program.

Why Change from Default Settings: This allows you to control a users access. If the Display Client uses
AppLink the user will not get a desktop or icons but will be limited to the application specified. Closing it will
re-launch the program, assuring that it is always running.

Selecting the Finish button will close the Display Client List wizard and display the created terminal server
groups.

13.3Camera Display Clients

The Camera Display Client configuration wizard can be launched by right clicking on the Camera branch of
the ThinManager tree and selecting the Add Display Client option.

%2 Display Client Wizard |

Client Name w

Enter the Display Client name.
i

Client Name

Type of Display Client

Camera Lo I

Permissions |

< Back Mext = Finish Cancel Help

Camera Display Client Wizard — Name

Importance of Page: Allows haming and selection of Display Client type.
Fields:
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¢ Client Name — Name for Display Client.

e Type of Display Client — Drop-down to select type of Display Client.
Button:

e Permissions — Sets TermSecure permissions. See Permissions for details.
Why Change from Default Settings: The display client needs a hame.
Enter the name of the Display Client and any TermSecure permissions on this page.

5= Display Client Wizard

Display Client Options ;’@"

Select the options that apply to this Display Client

Client Options
I Allow Display Cliert to be tiled;
[T Mlow Display Cliert to be moved {MuttiMonitor)

< Back Mext = Finish Cancel Help

Camera Display Client Options

Importance of Page: Sets Display Client options.
Checkbox:
e Allow Display Client to be tiled — Allows tiling of the client.

e Allow Display Client to be moved (MultiMonitor)— Allows the Display Client to be opened in any
MultiMonitor window.

Why Change from Default Settings: Provides additional options.
Select if this Display Client can be tiled and if when using MultiMonitor it can be moved to a different screen.

Automation Control Products ThinManager 5.0 Help Manual Display Clients e 265



13.3.1.1 Overlay Layout Page

%% Display Client Wizard

Owverlay Layout
Select the size and location of the |IP camera averdays ’ ‘
iy

Choose Camera Layout

Add Over |

Remave [hrerla}r

Display Size 1024x768 |

< Bk Hews | Fish |  Cancel Help

Camera Display Client Overlay Layout

Importance of Page: Sets camera layout
Settings:

e Choose Camera Overlay — Allows you to set the layout of the displays. You may have a single
overlay or multiple overlays on the Display Client.

¢ Display Size — Sets the size (resolution) of the display to be shown.
Buttons:
e Add Overlay — Adds an overlay to the Display Client.
e Remove Overlay — Removes a highlighted overlay from the Display Client.
Why Change from Default Settings: You need at least one overlay in the Display Client.

This page determines the layout of the camera overlays. You can define your own custom layout or choose
from predefined layouts. The Display Size selection should be set to the resolution of the terminal screen to
which the Display Client will be added. The picture on this page represents the overlay layout.
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%2 Display Client Wizard

Overlay Layout H

Select the size and location of the IP camera averdays

Choose Camera Layout Custam j

Display Size 1024x768 |

<Back Hest > | Fish |  Cancel Help

Camera Display Client Layout Selection

Use the layout drop down to select the desired layout.
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5\ Display Client Wizard

Overlay Layout m
Select the size and location of the |P camera overdays ’ ‘
oy

Choose Camera Layout

Sdd werday |
Flemm-'e Elwarleu,I

Py e 1024x768 -]

< Back Mexdt = Finish Cancel Help

Camera Display Client 2x2 Layout Selection

Once a layout has been selected, it will be represented graphically. Select Next to configure the overlays.
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13.3.1.2 Overlay Cameras Page

5 Display Client Wizard

Overlay Cameras
Select the cameras available in the overday

Cverday Name

— Posttion / Size
Left Top Width Height

| T 512 |m_

—Cameras to show

¥ Al Cameras Available

Hdd |
[Helete |

Set Initial Camera |

Cweray Options

< Back Mesd > Finish Cancel

Help

Camera Display Client Overlay definition

Importance of Page: Configures the overlays.

Fields:

e Overlay Name — Name for the overlay (filled in by default).
Settings:

e Left — Sets the left side of the overlay in pixels.

e Top - Sets the top of the overlay in pixels.

e Width — Sets the overlay width in pixels.

e Height — Sets the overlay height in pixels.
Buttons:

Add - Adds a camera to the overlay.
Delete — Removes a highlighted camera from the overlay.
Set Initial Camera — Sets the initial camera from a series of cameras.

Overlay Options — Launches the Overlay Options page.
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Checkbox:

e All Cameras Available — This makes all cameras available if checked. If unchecked the Add button
allows specific cameras to be added.

Why Change from Default Settings: Each Camera Display Client needs overlays.

Each overlay will be given a default name. The grey region of the screen representation is the overlay which
is currently being configured. If the All Cameras Available checkbox is checked, all of the cameras will be
available to be selected by the user at the terminal.

Select Camera or Group

: Camerail Cancel
=k W ebinar
i Carnerari

X
: Ok, I
Cameraid |

Set Initial Camera Dialog

Selecting the Set Initial Camera button allows the camera the overlay will start on at boot up to be selected.
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5% Display Client Wizard

Overlay Cameras
Select the cameras available in the overday

Crverday Name

— Posttion / Size
Left Top Width Height
|: 0 512 384

—Cameras to show
[ Al Cameras Available

Ll

Camera30 Add
Camera3l
Delete
Set{mitial Eamera |
Cveray Options |
< Back Meast = Finish Cancel Help

Overlay Camera Selection

If the All Cameras Available checkbox is unchecked, cameras must be added manually. Use the Add button
to add cameras to the list. Adding more than one camera allows the user to select from these cameras at the
terminal and allows the cycling between the listed cameras.
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Select Camera or Group

|

3 Ok I
- Camera30
- Camera3l Cancel |
=- Webinar

i Camerar]
Camera Selection
Overlay Options

— General Ophions

¥ Interactive
[T Scale
[T Crop

[ Show Complete Camera Mame

Cancel

x|
_ Corcel |

Boarder Size IMedium j

— Title Optionz
Title Pasitian [Top [
Title Size INDrmaI j

— Cyeling Options

[ Enable Cycling

—

Cycle Time [zecs]

Overlay Options

Clicking the Overlay Options button will allow the setting of additional overlay options.

General Options:

TermMon ActiveX Control can be used by an application to enable the overlay.

Enable Overlay — This option allows the overlay to be started in a disabled non-visible state. The
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Interactive — This option allows the user on the terminal to interact with the overlay. If the user
clicks in the overlay area, he can perform functions such as switching cameras and making the
overlay full screen.

e Scale — This option will scale camera frames to be to the size of the overlay window. Aspect ratio will
be maintained.

e Crop — This option will crop the camera frame if it is larger than the camera overlay. This option
when combined with the Scale option will always fill the entire overlay area.

e Show Complete Camera Name — Using this option allows the entire path of the camera to be
displayed. The path includes any groups of which the camera is a member.

e Border Size — This setting determines the size of the overlay outside border.
Title Options:
e Title Position — This is the position of the camera name within the overlay.

e Title Size — This is the size of the camera name when displayed within the overlay. Set this to Don’t
Show Title if you do not want the camera name displayed.

Cycling Options:
e Enable Cycling — Check this setting to cycle between the cameras assigned to the overly.

e Cycle Time — This is the time in seconds that the overlay will display each camera before switching
to the next camera.

52 ThinManager
Edit Manage Install Tools View RemoteView Help

EI;EE’ Cobalt Config |
Q Terminals
ﬁ Display Servers
[El VCenter Servers

I Attribuate | Walue -
Dizplay Client Configuration

E| |:| Display Clients Digplay Client Mame Camera_Loading
Client Type IF Camera —
Dizplay Client Options
Allows client to be Tiled YES
Client Can be moved [Multibd onitor] L]

------ Overlay_3
Eﬂ---@ Terminal Shadow
Eﬂ---ﬁ Warkstation Dwverlay Marme Dvverlay_1
- B TermSecure Users Left Pasition 0
Top Pogition 0
Wwidth 512
Height 384
Available Cameras Carnera3l _ILI
4 [o] | L2 | | k
For Help, press F1 I_ A

Camera Display Client Tree View
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Once a Camera Display Client has been configured it will be reflected in the ThinManager tree under Display
Clients->Camera.

5 Terminal Configuration Wizard El
Dizplay Client 5election E
Select the Display Clients to uze on this kerminal ’ ‘
A
Available Digplay Clients Selected Dizplay Clients

ShadowClient] CamClient

ShadowClient2 .

T5Client1 _—

T5Client2

| |»

Edit Digplay Cligntz | [Isermide |

¢ Back I Hest > I Finizh Cancel Help

Terminal Configuration Display Client Selection

During the terminal configuration, select the desired Display Clients for the terminal. Multiple Display Clients
can be added to the configuration for a MultiSession configuration.
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B2 ThinManager

Edit Manage Install To

ols  View RemoteView Help

=] B3

E‘bﬂf Cobalt

= [

1

1
LT

1

=
B [
=

«

EI |8 Terminals

Groupl
Alpha

- g

IR

1

_:|...

|:_:|...

d Overlay_1

F

Camera3

Overlay_2

Cverlay_3

Camera3

il

For Help, press F1

Canfig |

| Attribbe

| W alue -

Dizplay Client Configuration

Digplay Client Mame
Client Type

Dizplay Client Optionsz

Allow client to be Tiled

Client Can be moved [Multibd onitor]

Camera Overlays

Owverlay Mame
Left Position
Top Position
Wwidth

Height

| Axailable Cameras
4

LoadingDock

IF Camera —

YES

Owerlay_1
n

n

512

284

Cameradl _ILI
3

e 2

Camera Display Client Terminal Tree View

When the terminal is running, the Camera Display Client status will be reflected in the ThinManager terminal
tree view. The status of each Camera Overlay and Camera will be displayed. A green lightning bolt on the
Display Client icon represents that Display Client is in the foreground. A yellow lightning bolt on the Display
Client icon represents that the Display Client is in the background. A green lighting bolt on the overlay icon
represents an active overlay. A green lightning bolt on the camera icon represents an active connection to the

camera.
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13.3.2 Adding a Camera Overlay to a Display Client

% Display Client Wizard

Display Client Options }(."

Select the options that apphy to this Display Client

— Client Options
I¥ Allow Display Cliert to be tied
¥ Allow Display Client to be moved (MuttiMonitor)
V¥ iInclude IP Camera Cverlays!

— Display Cliert Connection Options

v Always maintain a connection
v Connect at boot-up
[T Disconnect in the background

< Back Mest = Finish Cancel Help

Terminal Configuration Display Client Options

During the terminal configuration check the Include IP Camera Overlays option to add camera overlays to a
Display Client.

Automation Control Products ThinManager 5.0 Help Manual Display Clients e 276



%% Display Client Wizard |

Overlay Layout g

Select the size and location of the |P camera overdays

Choose Camera Layout Custom j

Display Size 1024x768 |

< Back Hest > | Fish |  Cancel Help

Terminal Configuration Overlay Layout

Camera Overlays can be configured before completing the Terminal Configuration wizard,

|
Owerlay Mame ID“’Efla-'r'_B |LI

Cancel

Position / Size -
Left Top tadidth Height

RO 300 320 |24E1

Terminal Configuration Add Camera Overlay

Clicking the Add Overlay button will allow the creation of the overlay. Enter the name position and size of the
desired overlay.
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5% Display Client Wizard

Overlay Layout

Select the size and location of the |P camera overdays

<

x|

Choose Camera Layout

Custom

7
Add Over |

ag,r

1024768 |

Lisplay Size

« Back Finish Cancel Help

Camera Overlay Layout

Once an overlay has been added, it will be represented as a white outlined square on the layout page.

Selecting the Next button will allow the completion of the configuration camera overlays
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5% Display Client Wizard

Overlay Cameras
Select the cameras available in the oveday

Crveray Mame

— Posttion / Size
Left Top Width Height
|5[:-[:- 300 320 |24[:-

—Cameras to show
v Al Cameras Available

&dd

[relete

f

Set Initial Camera |

Cveray Options

< Back Heke | Fish |  Cancel Help

Overlay Camera Selection

The camera overlay configuration can be completed as described in the IP Camera Display Server
Configuration Wizard section.

13.3.3 Camera Overlays and TermMon ActiveX Control

Camera Overlays can be controlled by an application by using the TermMon ActiveX Control. The Control can
be used to perform operations such as switching cameras and changing the overlay size and position. See
TermMon ActiveX for details.
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13.4Terminal Shadow Display Clients

Terminal Shadow Display Clients allow a terminal to shadow another terminal. The Shadow Display Client
can contain a specific terminal or several terminals.

13.4.1.1 Group Name Page
®\Display Client Wizard x|

Client Mame H

Enter the Dizplay Client name.
A

Client M ame

Type aof Dizplay Client

Terminal Shadow j

Pemizzions |

Pleaze enter a Dizplay Client name

¢ Back I [HEwt > izt Cancel Help

Terminal Shadow Display Client - Group Name Page

Importance of Page: This page starts the configuration wizard, sets the name, and the type of Display Client.
Fields:

e Group Name - This field is used to name the Display Client.
Settings:

e Type of Display Client drop-down box selects the function of the Display Client.

0 Terminal Services — This creates an Display Client that allows a terminal to connect to a
terminal server, login, and run a session.

o Terminal Shadow — creates an Display Client that allows a terminal to be shadowed by
another terminal.
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Buttons:

e Permissions - The button will launch the Permissions window that allows Permissions to be set for
TermSecure. This is discussed in Permissions.

Why Change from Default Settings: The group needs a name and a type assigned to it.

This section covers Terminal Shadow Display Clients. Configure the Display Client by selecting Terminal
Shadow from the Type of Display Client drop-down after naming the group.

Select the Next button to continue.

®\Display Client Wizard x|

Dizplay Client Options

Select the options that apply ta this Dizplay Client ’ ‘
A

— Client Options
v allow Display Client to be tiled
[T Allow Display Client to be moved [Mulitonitor]

[ Include IP Camera Overlays

— Dizplay Client Connection Options

¥ Always maintain a connection
¥ Connect at boot-up

[T Disconnect in the background

¢ Back

Finizh Cancel Help

Terminal Shadow Display Client —Display Client Options

Importance of Page: This page allows the configuration of Display Client parameters
Checkbox:

e Allow group to be tiled — If checked, this allows the Display Client to be tiled in SessionTiling. See
SessionTiling Options for details.

e Allow Group to be moved (MultiMonitor) — If checked, this allows a Display Client to be moved
from one MultiMonitor screen to another. See MultiMonitor for details.

e Include IP Camera Overlays —This will allow IP Camera overlays to be added to this Display Client.

e Always maintain a connection — This keeps a session active, reconnecting and restarting if it is
closed. If unchecked, the user can close a session and another session won't start automatically.
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e Connect at boot-up — If checked, the terminal will start a session for this Display Client at boot up. If
unchecked, a user action is required to start the session.

e Disconnect in background — If checked, a Display Client being used in a MultiSession configuration
will disconnect once it is moved into the background. This could be done to require fewer resources.

Why Change from Default Settings: The Always maintain a session for this group and Start a session
at boot-up for this group checkboxes, if unselected, will lower the demand on the terminal servers by
allowing sessions to be closed until needed.

Select Next to continue, Finish to save and close, or Cancel to close without saving.

13.4.1.2 Terminal Shadow Display Client Page

The Terminal Shadow Display Client page allows the selection of the terminal or terminals to be shadowed.
®\Display Client Wizard x|

Terminal Shadow Dizplay Client

Select the terminal to shadow, }
A

— Terminal ta Shadow
¥ Al Terminalz Awvailable

&dd

[elete

f

— Shadow Dizplay Client Options

¢ Back [HEwt > | Finizh I Cancel Help

Terminal Shadow Display Client — All Terminals Available

Importance of Page: This page selects what terminals are available to be shadowed using Terminal-to-
Terminal Shadowing.

Checkbox:

e All Terminals Available — This checkbox allows all terminals to be shadowed. Unselect it to limit
Terminal-to-Terminal Shadowing to specific terminals.

e Interactive Shadow — This checkbox allows interactive shadowing of the terminals.
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Fields:
e Terminal to Shadow - This list box shows the terminals available to shadow.
Buttons:

e Add - This button adds terminals to the Terminal to Shadow list box when All Terminals Available
is unselected.

o Delete — This button deletes a highlighted terminal from the Terminal to Shadow list box when All
Terminals Available is unselected.

Why Change from Default Settings: The default setting grants permission to shadow all of the terminals.
Unselecting the All Terminals Available checkbox allows specific terminals to be added.
Additionally, multiple shadow groups can be created, each with a specific terminal or group of terminals.

By default the Shadow Group is configured to allow all terminals to be shadowed. Unselecting the All
Terminals Available checkbox will allow the designation of specific terminals.

®\Display Client Wizard x|

Terminal Shadow Dizplay Client H

Select the terminal to shadow,

— Terminal ta Shadow
[ A&l Teminals Asvailable

Delete |

— Shadow Dizplay Client Options

¥ Interactive Shadow

¢ Back [HEwt > Finizh Cancel Help

Terminal Shadow Display Client —Select Terminals

Select the Add button to launch the terminal selection window.
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Select Terminal or Group

]
=1~ Terminals QK I

-- Group

=8 Group? Cancel

Teminal_2 A

Terminal_2_B
Teminal_2_C

- desk_B820

- Desk_Uno_2053

- Groupd

- Multiton

- Teminal_3_B

- Unitd2

- Unitd3

- finThC

& ApplGEroup

- Z_T5E

Select Terminal or Group Window

Select a terminal for shadowing by highlighting it in the Select Terminal or Group window and selecting the
OK button. The window will close after each selection.

To add multiple terminals repeat the process by selecting the Add button on the Terminal Shadow Display
Client page.
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5=\ pisplay Client Wizard x|

Terminal Shadow Display Chent ’m‘

Select the terminal to shadow,
A

— Terminal to Shadow
[T All Teminals &vailable

Group2\Teminal_2_& Add
Group2iTeminal_2_B
Group2sTeminal_2 C

Iritdz Delete

i

— Shadow Dizplay Client Optiohs

¥ Interactive Shadow

Cancel Help

< Back [ewt >

Terminal Shadow Display Client — Selected Terminals

The Terminals to Shadow textbox will display the terminals added to the list.

Select Terminal to Shadow

LInitd?

Terminal_2_A,
Terminal_2_B
Terminal_2_C

Terminal Selector
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When a terminal launches a Shadow Display Client that has multiple members a Select Terminal to Shadow
window will be displayed to allow the selection of the terminal to shadow. Highlight the desired terminal and
select the OK button.

13.4.1.3 Display Client List Window

Available Display Clients x|

Calculator
ShadowGroupl Add
“Word
Hidl :
|C&_Desktop Edit
Group2

Delete

il

Cancel | ak. I

Available Display Clients

After an Display Client is configured the Display Client List will show configured Display Clients.
Additional groups can be configured by selecting the New Group button.

The Display Client List wizard can be closed by selecting OK.
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14 Failover and Instant Failover

14.1Failover Introduction

ACP uses specific terms to cover different topics that are concerned with keeping data viable during computer
failure.

Replacement: If a terminal fails or is destroyed, the session stays active on the terminal server while the thin
client is replaced. This is covered in Adding Thin Client Hardware.

Failover: Failover is the ability to switch between multiple terminal servers if a terminal server fails. This is
built in to every ThinManager System and thin client. This is covered in Failover.

Instant Failover: Instant Failover is the ability of thin clients to connect and login to two terminal servers
simultaneously. This allows applications to be pre-loaded so that a failure to one terminal server causes
minimal impact because the terminal will quickly switch to an existing session. This is covered in Instant
Failover.

Redundancy: Redundancy refers to multiple ThinManager Servers. Thin clients are not dependent on
ThinManager after booting and will continue to run if the ThinManager Server fails. However, rebooted
terminal will wait until the ThinManager Server is restored until it boots and receives its configuration. For this
reason many people use a backup, or Redundant ThinManager Server. This is covered in Redundancy
Overview.

14.2Failover

Every thin client has the ability to switch between multiple terminal servers if a terminal server fails. Each thin
client has a program that monitors its terminal server. If the terminal server fails to respond to the terminal, it
will drop the broken connection and connect to a backup terminal server, allowing it to continue to function.

Failover requires:
e Two or more terminal servers
e |dentical Microsoft user accounts on each, or domain permissions on both

o |dentical applications on each, with the same path, to make life easier
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Failover without Redundancy

Primary Secondary
Terminal Server Terminal Server

— ThinManager Server

— Space for terminal
sessions

Space for backup

sa@ssions

ThinManager Ready thin clients

Simple Failover - Before Failure

This shows a pair of terminal servers, one used as the primary with the terminals connected and running
sessions, and a second terminal server as the backup, or secondary terminal server.

Failover without Redundancy

Failed Secondary
Terminal Server Terminal Server

/.= — ThinManager Server
]

L

/)

Space for backup
s@ssions

ThinManager Ready thin clients

Simple Failover, After Failure
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This shows the results of a failure of the primary terminal server. The thin clients would detect the failure and
switch to the secondary terminal server where they would login and continue running.

Note: This does not synchronize the hard drives. Failover gives you the ability to continue to run the thin
client by connecting to a backup. Data pulled from an outside source like a PLC or file server would be the
same on either terminal server.

14.2.1 Failover Setup For a Terminal Using Terminal Services
Display Clients

Failover is configured in the Terminal Configuration Wizard. It is configured differently when using individual

terminal servers and Display Clients.

Terminal Services Display Clients allow a terminal to run a session from a list of terminal servers. The Display
Client will have Failover capability if two or more terminal servers added to it. This is configured in the
Terminal Services Display Client Wizard.

Launch the Display Client Wizard by right clicking on the Display Clients branch in the tree. Alternatively, you
can right click on an existing Terminal Services Display client in the tree and select Modify.

Available Display Clients |

Calculator

HelpDesk Add
Reparts
Hedl
=P 10 Edit
=P 1
=P_12

Ebdail
Loadingl ock,
Shadow_all

il

Delete

Cancel | | k. I

Display Client List

Select the Add button to add a new Display Client, or highlight an existing Terminal Services Display Client
and select the Edit button to edit an existing Display Client.
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5 Display Client Wizard |

Display Client Members w
Select the Temminal Servers for this display client. } ‘
A
Available Terminal Servers Selected Terminal Servers
Training51 (10.5.10.51) Blue (10.3.10.417)
Training52 (10.5.10.52) Green (10.3.10.40) ‘l
‘ hd
e B,
Edit Server List
< Back Med = Finish Cancel Help

Application Group Wizard - Application Group Members

Member terminal servers are added on the Display Clients Members page. Adding two or more terminal
servers to the Selected Terminal Servers field will enable failover. The terminal will connect to the terminal
servers in the order given, unless the Display Client is using SmartSession.
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5% Display Client Wizard

Terminal Services Display Client Options

Select the options for this display client * ‘
[y

— Terminal Services Options

v Application Link
™ Erforce Frimary
[T Instant Failover
v Mlow Auto-Login

< Back Med = Finish Cancel Help

Terminal Services Display Client Options

SmartSession uses the CPU usage, Memory usage, and the number of sessions on a terminal server to
determine its load. Terminals using Terminal Services Display Clients with SmartSession will start a session
on the server with the lightest load, instead of the order listed.

Selecting the SmartSession checkbox on the Display Client Options page of the Display Client Wizard
configures SmartSession. When SmartSession is used the Enforce Primary checkbox is no longer relevant.
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14.3Instant Failover

Basic failover is built into every ThinManager thin client. Detecting that the primary server is down and
connecting to a backup server is usually achieved in10 to 20 seconds, depending on the monitoring
configuration. Some applications will need additional time to launch and initialize the programs. Instant
Failover was developed for people who need the session to switch to another terminal server and start
running immediately, without any delays for starting the applications.

When using Instant Failover, the thin client starts sessions on two servers at once. The sessions are
cascaded on the thin client, with the primary session on top. If the primary terminal server fails, the preexisting
secondary session is switched to the forefront.

Instant Failover - Part 1
Terminals with Instant Failover module login to two terminal servers at once

Primary Terminal Server Backup Terminal S_erver
= Active = Active
- ; Sessions - & Sessions

ACP Enabled Thin Clients with Instant Faillover Module

Instant Failover, Part 1

When a thin client using Instant Failover boots, it connects to two terminal servers, logs in, and starts two
sessions.
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Instant Failover - Part 2
Teminals run both sassions
The active PHimary session is cascaded to hide Backup session

Primary Terminal Serwver Backup Terminal 5 erver

— Primary Backup
R Active Active
Sessions Sessions

Hidden
Backup Session

Instant Failover, Part 2

The thin client cascades both sessions and displays the primary session in front. You cannot see the
secondary session as it is hidden in back. There is a optional hot key toggle available to allow toggling
between sessions. See Hotkey Configuration for details.
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Instant Failover - Part 3
If the Prim ary fails, the terminal will toggle the cascaded windows,
displaying the Backup session in front

Primary Terminal Server Backup Terminqllsgrver

Backup
Active
Sessions

Backup Session
moved to front

Instant Failover, Part 3

If the primary server fails, the thin client will detect its failure. The thin client will then switch the focus of the
window, showing the secondary session. This session is already initialized so the user is able to proceed at
once.

Note: Use a Username, Password, and Initial Program to allow the thin client to login automatically and start
a program so that the background session is immediately ready and not needing a login and program launch.

If the Enforce Primary feature is used, the thin client will switch back to the primary once it is back online.

Note: thin clients that use instant failover may require 64 MB of memory.
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14.4Instant Failover Configuration

Instant Failover is configured as part of Terminal Services Display Clients if Display Clients are used or added
as a module if the thin client is using individual terminal servers.

14.4.1 Instant Failover Setup using Terminal Services Display
Clients
Terminal Services Display Clients allow a terminal to run a session from a list of terminal servers. The Display

Client will have Instant Failover capability if two or more terminal servers added to it and the Instant Failover
option is selected. This is configured in the Terminal Services Display Client Wizard.

Launch the Display Client Wizard by right clicking on the Display Clients branch in the tree. Alternatively, you
can right click on an existing Terminal Services Display client in the tree and select Modify.

Available Display Clients x|

T5Clientl

CamChent1 Add
ShadowClient1

T5Client2

CamClient2 E dit

ShadowChent2

il

Delete

Cancel | | k. I

Display Client List

Select the Add button to add a new Display Client, or highlight an existing Terminal Services Display Client
and select the Edit button to edit an existing Display Client.
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5=\ Display Client Wizard x|

Terminal Services Dizplay Chent Ophtions G
Select the options for this display client } ‘
A

— Terminal Services Optiohs

[ Application Link
[ Enforce Primary
IV Instant Failover

v Allow Asta-Lagin

< Back I Mest » I Finizh Cancel Help

Display Client Wizard — Terminal Services Options Page

Select the Instant Failover check box on the Display Client Options page to enable instant failover for the
Display Client.

Note: Do not use the Instant Failover Module when using Instant Failover within a Display Client

The Terminal Services Options page allows the configuration of other parameters in addition to the Instant
Failover such as SmartSession and AppLink. See the Terminal Services Display Client Options for details.

Each Terminal Services Display Client needs two or more terminal servers to get Instant Failover to function.
This is done on the Display Clients Members page of the Display Client Wizard.
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5=\ Display Client Wizard x|

Display Chent Members

Select the Terminal Servers for this display client. } ‘
A

Ayailable Terminal Servers Selected Terminal Servers
TS52[99.93.57.217) T51[99.95.97.99)
T53(99.93.97.34) N |

| |~

M

Edit Server Lizt

< Back I Mest » I = Cancel Help

Display Client Wizard — Display Client Members Page

Select two or more terminal servers from the Available Terminal Servers list and move them to the Selected
Terminal Servers list by highlighting and double clicking, or by using the Arrow button.

The thin client will start sessions on the top two terminal servers in the Select Terminal Server list, with the
top terminal server as the primary and the second terminal server as the backup, unless SmartSession was
chosen on the Group Options page.

If more than two terminal servers are selected, the thin client will connect to the other terminal servers if one
of the other terminal servers fails.

14.4.2 Switching Between Instant Failover Sessions

Instant Failover can be configured to allow a user to toggle between the two instant failover sessions. This is
done differently when using individual terminal servers and Display Clients.

14.4.3 Switching Between Sessions with Display Clients

Instant Failover can be configured to allow a user to toggle between the two instant failover sessions when
the thin client is using Display Clients by using a hotkey. To configure the hotkey run the Terminal
Configuration Wizard for the terminal or terminal group that is using a Terminal Services Display Client with
Instant Failover and proceed to the Hotkey Configuration page.
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52 Terminal Configuration Wizard 5[

Hotkey Configuration

Configure the hotkeys to apply to this terminal b ‘

— Terminal Hotkeys

[¥' Enable Inzstant Failover Hotkeps Change Hotkeys |
[¥ Enable Dizplay Client Hotkeys Change Hotkeys |
¥ Enable Tiing Hatkey Change Hotkey |

< Back I Hest > I Finizh Cancel Help

Terminal Configuration Wizard — Hotkey Configuration Page
When a thin client is using Terminal Services Display Clients, selecting the Enable Instant Failover Hotkeys
check box will allow the user to switch between instant failover sessions using the default CTL + F9 hot key.

The default hotkey can be changed by selecting the upper Change Hotkeys button and launching the Select
Hotkeys windows.
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Select Hotkeys

— Ingtant Failowver Hotkey

&% Control Kep I F9 j

Al kKey

Select Hotkeys Windows

The hot keys needed to switch between instant failover sessions can be changed on the Select Hotkeys
window. Select the Control Key or Alt Key radio button and a function key from the drop down box and
select the OK button to accept the changes.

14.4.4 Instant Failover Tree Icons

Under each Terminal are icons representing the Terminal Servers that they connect to. The lightning bolt
color indicated the connection status.

' ? Active session on terminal server

j; Instant Failover hackup session

: f Mo session on terminal server

Terminal Server Connection Icons

A Red lightning bolt represents a lack of connection to the terminal server.
A Green lightning bolt represents a connection to the terminal server with an active session.

A Yellow lightning bolt represents a connection to the terminal server with an active session that is the
backup in Instant Failover mode.
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=10l

Edit Manage Insktall Tools Wew RemoteWiew Help

1w
Elgi( THMServer

EIQ Terminals
@ Termizroupl

- 3 TS
- a Display Servers
- [l Display Clients
- ﬁ TermSecure Users

... 151

For Help, press F1

Configuratian | Mndulesl Schedulel F'ru:upertiesl Ewent Lu:ugl Shaduwl Hepu:urtl

Attribute

Terminal |dentification

Terminal Mame

Terminal Properties

tadel Mumber
bl anufacturer

Yideo Controller

Login Username

Login Domain

R eplaceable

Allow Shadowing

Allows Inkeractive Shadowing
Terminal Effects

Show Status Messages

IJze Display Clients

W alue -

Term3

BaoxPC140
Aizta

Yia Unichrome

YES
YES
YES
YES
YES

YES =
| b

Instant Failover

If a terminal that is configured for Instant Failover is expanded in the ThinManager tree, the Primary Terminal
Server should have a green lightning bolt, while the Secondary Terminal Server should have a yellow

lightning bolt, as shown in the example.
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15Modules

15.1Module Overview

Modules are software components that can be loaded to increase the functionality of the terminal. Modules
include touch screen drivers, sound drivers, and special device drivers. Modules are included with
ThinManager and are registered automatically during ThinManager installation. Updates to modules (primarily
touch screens) are posted on the ThinManager website for download and installation.

Note: “Installing a module” refers to the registration of the module with the ThinManager Server, while
“Adding a module” refers to attaching the module to a particular group or terminal.

This section includes:

o A list of available Modules.
. Instructions on installing and adding Modules.
. Details on specific modules.

Note: Certain modules, like the video modules, do not need to be added to specific terminals but will be
downloaded automatically in ThinManager. These modules do have to be installed in ThinManager to be
available for the download to happen.

These modules may need to be added to the terminal in older versions of ThinManager that are using new
firmware.

15.1.1 Module List

ThinManager divides the modules into a number of categories or types to make navigation of the module list
easier. Although details on the specific modules will follow, the types and modules include:

Note: Certain modules are used in limited, specific cases and are considered advanced modules. These are
marked with a (*). See Advanced Modules for details.

ICA - See ICA Modules

. Citrix ICA UseAlternateAddress Module
. Citrix ICA wfclient.ini Extension Module
o ICA Client Version 6.0 (*)
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ICA Client Version 8.0 (*)

Keyboard — See Keyboard Modules

Key Block Module

Key Block Single Key Module

Keyboard Configuration Module

Share Keyboard and Mouse Master Module

Share Keyboard and Mouse Slave Module

Local Storage - See Local Storage Modules

USB Flash Drive Module
USB Memory Card Reader Module

Miscellaneous - See Miscellaneous Modules

Add Serial Port

Firmware Update Module (formerly the Disk On Chip / Compact Flash Update Module)

Instant Failover Module (* no longer used)
Local Printer Module

MultiMonitor Module

MultiMonitor2 Module

Redundant Ethernet Module

Second Network Module

Serial to TCP Module

Terminal Shadow Module

TermMon ActiveX Configuration

Time Zone Redirection Module

Mouse - See Mouse Modules

Mouse Configuration

PS/2 Mouse Configuration

Serial Mouse Driver

Share Keyboard and Mouse Master Module

Share Keyboard and Mouse Slave Module

RDP - See RDP Modules

RDP Experience Module

RDP Module for ThinManager v2.4 and Older
RDP Port Module

RDP Serial Port Redirection Module

RDP Session IP Module

Screen Saver - See Screen Saver Modules
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MultiSession Screen Saver Module

Screen Saver Module

Sound - See Sound Modules

AMD ¢s553x Sound Driver
Advantech ARK-1382 Sound Driver
Advantech ARK-3380 Sound Driver
Advantech PCM-5820 Sound Driver
Advantech PCM-9372 Sound Driver
Advantech UNO-1150 Sound Driver
Advantech UNO--1170 Sound Driver
Advantech UNO-2053E Sound Driver
Advantech UNO--2173 Sound Driver
Allen-Bradley VersaView 200R Sound Driver
Arista 5824-ACP Sound Driver
Arista 6824-ACP Sound Driver
Arista 7824-ACP Sound Driver
Arista AP-3200 Sound Driver

Arista AP-3300 Sound Driver

Arista BoxPC-201H Sound Driver
Arista BoxPC-240 Sound Driver
DC_30_ 100 Sound Driver
DC_40_100 Sound Driver

Gigabyte TA3LB Sound Driver

Intel 8x0 Sound Driver

Intel HAD Sound Driver

NTA-6020 Sound Driver

TC3000 Sound Driver

TC3500 Sound Driver

TeleVideo TC7X30 Sound Driver
Universal Sound Driver

VIA 82xx Sound Driver

Xycom XA1300 Sound Driver

TermSecure - See TermSecure Modules

RF ldeas pcProx Module
RF Ideas pcProx USB Module

TermMon ActiveX Configuration Module
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o USB Flash Drive Module
. Wavetrend Tag Reader Module
Touch Screen - See Touch Screen Modules
o Arista ARP-16XXXAP-ACP Touch Screen Driver

. CarrollTouch Touch Screen Driver

o Contec Touch Screen Driver

o DMC TSC Series Touch Screen Driver

. DMC Touch Screen Driver

. Dynapro Touch Screen Driver

. Elographics Touch Screen Driver

. Gunze AHL Touch Screen Driver

. Hampshire TSHARC Touch Screen Driver
o MicroTouch Touch Screen Driver

. Panjit TouchSet Touch Screen Driver

o PenMount Touch Screen Driver

o Ronics Touch Screen Driver

. Touch Control Touch Screen Driver

o Touch International IR Touch Screen Driver
. USB Touch Screen Driver

. Xycom 33XX Touch Screen Driver
. Zytronic Touch Screen Driver
Video Driver - See Video Driver Modules.
. Custom Video Mode Module
Video?2 Driver - See Video Driver Modules.
o Custom Video Mode Module
(*) Denotes an advanced module See Advanced Modules for details.

15.2Installing a Module

Installing a Module adds a new module to ThinManager so that it is available to Terminal Groups and
Terminals. To install a module, open the Modules window by selecting Install > Modules from the

ThinManager menu bar to launch the Modules window.
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Modules for Server Cobalt |

tadule Type I.-’-'-.II W odules j
D eszcription | Werzion | Licenze B... | :l
Contec Touch Screen Driver 412 MOME
Core Yideo Module 41.0 HOME
Core Viden?2 Maodule 413 HOME
Cuztom Yideo Mode Module 413 HOME J
DC_30_100 Sound Driver 400 HOME
DC_40_100 Sound Driver 4.00 HOME
DMC T5C Senes Touch Screen Driver 412 HOME
DMC Touch Screen Driver 412 HOME
Dyrapro Touch Screen Driver 414 MOME
Elographics Touch Screen Diriver 415 HOME
Firmware Update Module 41.2 HOME
Geode Video Driver 41.0 HOME
Gigabyte TASLE Sound Driver 400 MOME
Gunze AHL Touch Screen Diriver 415 HOME
Harmnzhire TSHART Tanch Seraen Diwver A14 RIMMFE LI
[nztall Module... | Remove Module fram Al Terminalz

Modules Window

The Module window shows all of the modules installed on the ThinManager Server.

Modules for Server Cobalt |

todule Type

D eszcription | W erzion | Licenze B... | -

Arizta ARPTE== 0015061512 Touch Screen Driver 4.1.5 HOME

CarrallTauch Touch Screen Driver 415 HOME

Contec Touch Screen Driver 412 HOME

DMC T5C Senes Touch Screen Driver 412 MOME

DMC Touch Screen Diriver 41.2 HOME

Dynapro Touch Screen Driver 414 HOME

Elographics Touch Screen Diriver 415 HOME

Gunze AHL Touch Screen Driver 415 MOME

Hampzhire TSHARC Touch Screen Driver 41.4 HOME

MicraT ouch Touch Screen Driver 415 HOME

Parldit TouchSet Touch Screen Diriver 415 HOME —
Perkdount Touch Screen Driver 415 MOME

Ronics Touch Screen Driver 41.2 HOME

Tauch Control Touch Screen Driver 413 HOME

Trich Ikternatinnal 1B Toock Seresn Drivear 4172 MIMMF LI

[nztall Module... | Remove Module fram &l Terminalz

Sorted Modules

The installed modules can be sorted by using the Module Type dropdown list.

Automation Control Products ThinManager 5.0 Help Manual Modules e 305



To install additional modules select the Install Module button. This will launch a file browser window.

% ThinManager = =] B2

Edit Manage Install Tools Wiew Remoteview Help
g BEE
E‘ﬁ‘: el | Configuration | Licensesl F'rl:upertiesl "-.J'ersil:unsl Synchrnnizatiunl Eve 4 I "I

— Lookjn: | ) Madules
Dezcription

Modules for Server Gold IT

x| & & ey E-

AMD Geode
AMD Geode
Add Serial Pr
Advantech &
Advantech P
Advantech P
Advantech U
Advantech U
Allen-Bradley
Arizta BE24-A

|| usb_card_reader, mod
|| tsharc.mod

[ ]l

okbauch, mod

Arizta BE24-A

ke 7824 | 1€ DAme:

Ielu:ut-:uuu:h.mu:ud

Open I

Arizta AP-32(
Arizta ARPIE
drizta BawPT

Files of type: IMu:u:IuIe Files

[~ Open az iead-only

Cancel

i

4

Remaove Module fram Al Terminalz

Dane

For Help, press F1

e

Module File Browser Window

Browse to the new module, usually downloaded from the ThinManager web site (www.thinmanager.com).
Highlight the new module, and select the Open button. This will add the new module to the list of modules.

Selecting the Remove Module from All Terminals button will remove the highlighted module from all
terminals. It does not uninstall the module from the ThinManager Server; it just removes its use by all groups

and terminals.

Select the Done button to close the Modules window.
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15.3Adding a Module to a Group or Terminal

Modules are added to terminals or groups of terminals on the Module Selection page of the Terminal
Configuration Wizard or the Terminal Group Configuration Wizard.

52 Terminal Configuration Wizard |
Module Selection (.’
Select the modules that load on this terminal at boot up. ’ ‘
A
Installad Modules
Module

fave g | I owe o |

Add... | Eatfigure... | Hemowve |
< Badk Next > Fish | Cancel | Hep |

Terminal Configuration Wizard - Module Selection

To add a Module to a Terminal, select the Add... button to launch the Attach Module to Terminal window.
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‘& Terminal Configuration Wizard

Module Selection
Select the modules that load on this terminal at boot up.

Attach Module to Terminal

=

Mody tModule Type I.-'-‘-.II Modules

T,

£dd Serial Part kevboard
Advantech ARE-133]Local Storage
Advantech ARK-338( Miscellaneous
Advantech PCM-592(Mouse
Advantech PCM-9371BDF

Advantech MO-1150 Sound Driver
Advantech UNO-1170 Sound Drver
Advantech UMO-2053E Sound Driver
Advantech UMO-2173 Sound Criver
Allen-Bradley Werzaview 2008 Sound Driver
Arizta BE24-4CP Sound Driver

Anizta 6824-ACP Sound Driver

Arigta 7824-4CP Sound Driver

i

Cancel |

]|
(5

}uu... I AT AT I L= |

cBack | Neas | Fsh |  Cancel |

Hep |

Attach Module to Terminal

The Attach Module to Terminal window will show the modules that are available to the terminal. The
Module Type drop-down box sorts the modules by categories to make the modules easier to find.

Highlight the desired module and select the OK button to add the module to the configuration.
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% Terminal Configuration Wizard

Module Selection (.’
Select the modules that load on this terminal at boot up. ’ - ‘

Installed Modules

Module
@. Screen Saver Module

[ Key Block Module

Blographics Touch Screen Driver

fmsve g | kMawe Bown |

Add... | Eonfigure... | Femave |

< Back Nest > Frsh |  Cancel | Hep |

Terminal Configuration Wizard - Module Selection

Terminals that are members of a Group may show icons to represent the properties of added modules.

. @The Group icon represents modules assigned to a parent Group.

o No icon indicates that the module was added to that particular Group or Terminal and not a
parent Group.
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15.4Changing Module Parameters

Many modules have parameters that can be changed. With the new inheritance rules from ThinManager 3.0
module parameters can’t be changed for modules that are inherited from a parent group. Changes must be
made at the level that the module was added.

= Terminal Configuration Wizard |

Meodule Selection ;2‘

Select the modules that load on this terminal at boot up.

Installed Modules

Module
I@. Screen Saver Module

[ Key Block Module

Hographics Touch Screen Driver

Maove Up | Move Down |

Add... | Configure... | Remaove |

< Back Nest > Fsh |  Cancel | Hep |

Module Configuration

Highlighting a module on the Module Selection page and selecting the Configure button will open the
Module Properties window and allow changes to the module configuration.
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Module Properties E3 |

Parameter | Walle | -
Connection Type Serial
Part [Senial Only] COr1
b onitor Mumber 1
Double Touch Area [pisels] 10 [
Double Touch Time [milizeconds) 1000

Touch De-bounce Timeout [milizecondz] 0
Swap =y Coordinates MO
Right Click Haold Time [millizeconds] DISABLED

Rinht Clirl: &rea Inivale] 1M ket
4 | »

Parameter IEn:-nnec:tin:nn Type

Yalug I Senal j

Set bo Default | Set
[Done I Cancel |

Module Properties

On the Modules Properties window, select the parameter to change, select the new value in the drop-down
list, and click the Set button. This will change the setting.

The Set to Default button will restore the module to the default settings.

Note: The Set button must be selected to apply the change.

Select the Done button to close the Module Properties window and to return to the Group or Terminal
Configuration Wizard.
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52 ThinManager v4.1 =] B3

View RemoteView Help

Edit Manage Instal Tools

=g Cobalt
= ™ Terminals
E@ Groupl
s
Q Alpha
- B MultiMonitor 1
Q Sierra
H- ﬁ Display Servers
EI[:] VCenter Servers
F-- [l Display Clients
H- ﬁ TermSecure Lsers

[ |

1

For Help, press F1

.Eu:unfiguraticun Modules | Schedulel F'n:upertiesl Event Lu:ugl Shadu:uwl Hepu:urtl

I Attribute

| Yalue -

Inztalled Modules

@ Module
@ Dovnload
@ Screen Saver

@Wait Time in Minutes

@ IJze Dizable Time Period

Bl Disable Start Hour (0-23]

L Disable End Hour (0-23)

@ Farce Off when Start Hour Reached

@ Module
@ Dovnload
[ Black

L] Black Chil+itDel
Q Block Chl+Esc

lﬂlé Elock Al
4

Screen Saver Module
soreenzaver. mad

BlankScreen

K.ey Block Module
kew_block.mod

MO

YES

YES

= o
| 3

Module Icons in ThinManager

The status of the modules is displayed on the Modules tab of the Details pane of ThinManager.

154.1.1

Module Loading Order

Highlighting a module and selecting the Move Up or Move Down button can change the order that the

modules load.
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% Terminal Configuration Wizard

Module Selection

Select the modules that load on this terminal at boot up. » ‘

Installed Modules

Module
IQ:]. Screen Saver Module

[ Key Block Module

Hographics Touch Screen Driver

Maove Up | Move Down |

Add... | Configure... | Remaove |

< Back Nest > Fsh |  Cancel | Hep |

Module Loading Order

The loading order of modules rarely needs to be adjusted.

15.5Individual Module Details

ThinManager divides the modules into a number of categories or types to make navigation of the module list
easier. The types and modules include ICA, Local Storage, Miscellaneous, Mouse, RDP, Screen Saver,
Sound, TermSecure, Touch Screen, and Video.

15.61CA Modules

The ICA Modules are advanced modules for advanced users of the ICA client communication protocol.

15.6.1 Citrix ICA UseAlternateAddress Module

The Citrix ICA UseAlternateAddress Module is used by advance Citrix users to specify connections to
Citrix Servers.
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Configuration includes UseAlternate Address, Browser Protocol, and HttpBrowser Addresses.

15.6.2 Citrix ICA wfclient.ini Extension Module

The Citrix ICA wfclient.ini Extension Module is used by advance Citrix users. This module allows up to 8
strings of text to be added to the wfclient.exe for passing Citrix parameters.

15.7Keyboard Modules

The Keyboard Modules are modules used to control or alter keyboard behavior.

15.7.1 Key Block Module

The Key Block module traps certain keystrokes and prevents them from being sent to the terminal server for

processing.
e |
Parameter | Walue |

Black Chil HO
Block Chrl+alt+Del YES
Block Chrl+E =z YES
Black Al MO
Black Al+F4 MO
Block Alt+F HO
Block Alt+T ab MO
Block Windows Key YES
Block Menu Key HO

Parameter I

Y alue |

Set to Default | Set
Cancel |

Key Block Module

The key combinations to be blocked can be configured by in the Module Properties. To launch this, highlight
the module on the Module Selection page and select the Configure button. A Module Properties dialog box
will be displayed. Select the parameter to change in the Module Properties window, select the Value in the
dropdown box and click the Set button.

The key combinations that have a value of YES will be blocked from reaching the terminal server.

15.7.2 Key Block Single Key Module

The Key Block Single Key module traps specific individual keystrokes and prevents them from being sent to
the terminal server for processing.
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15.7.3 Keyboard Configuration Module

The Keyboard Configuration Module allows key settings on a keyboard attached to a thin client to be set.

Module Properties EH |

Parameter | Walue |
Mum Lock State On_at_Startup
Capz Lock State Or_At_Startup
Scroll Lock State Off_ak_Startup
Fepeat Delay [msz) R00
Repeat A ate [chars/zec] a0
Dizable Aepeat for Enter Key MO
F.eyboard Layout Englizh{UnitedStatesz]

Parameter INum Lock State

Yalue I Or_At_Startup ;I

Set to Default | Set
Dane I Cancel |

Keyboard Configuration Module Parameters

The Keyboard Configuration parameters include:

Num Lock State — This allows the Number Lock to be set to On at startup, Off at startup, always On,
or always Off.

Cap Lock State — This allows the Caps Lock to be set to On at startup, Off at startup, always On, or
always Off.

Scroll Lock State — This allows the Scroll Lock to be set to On at startup, Off at startup, always On,
or always Off.

Repeat Delay (ms) — This parameter sets the amount of time that a key needs to be held down
before it starts repeating the keystroke. If this parameter is set to Disable a key will only send one
keystroke even if the key is held down.

Repeat Rate (char/sec) — This parameter sets the number of characters per second that a held down
key will send.

Disable Repeat for Enter Key — This parameter, when set to Yes, will prevent the Enter key from
repeating if it is held down.

Keyboard Layout — This parameter allows the thin client to use keyboards other than the default
English (United States) keyboard map.
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15.8Local Storage Modules

The Local Storage modules allow the use of USB ports on thin clients. The USB ports are not active by
default for security.

15.8.1 USB Flash Drive Module

The USB Flash Drive Module allows USB flash drives to connect to a terminal. The parameters include:

Module Properties E |

Parameter | Walue |
Dinive Access Rights in Sezsion Mone
Ilze with TermSecure HO
Alloww b anual Logan YES
Prarnpt far Pazsward MO
Farameter I
Walue |
Set bo Default Set
Cancel |

USB Flash Drive Module Properties

The USB Flash Drive Module has several parameters.

Drive Access Rights in Session - ReadWrite allows the user to read and write to the flash drive.
ReadOnly allows the user to read data but not write data, and None sets the flash drive to access
only the unique serial number to make it usable as a TermSecure ID device.

Use with TermSecure - This needs to be set to YES to allow the device to be a TermSecure
identifier. A NO setting, in conjunction with a ReadWrite Access Rights setting, will allow the device
to be used as a remote storage drive

Allow Manual Login - This value, when set to Yes, will allow a TermSecure user to log into a
terminal without a TermSecure ID device. If set to No, TermSecure users must use a TermSecure 1D
device to log in.

Prompt for Password - This value, when set to Yes, will require a TermSecure User to enter their
password for access, even if the password is configured in ThinManager.
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15.8.2 USB Memory Card Reader Module

The USB Memory Card Reader Module allows USB card readers to connect to a terminal. The parameters
include:

) Number of Slots in Reader - This value sets the number of slots that the card reader uses.

o Read Only Access - This value, when set to Yes, will limit the user to reading the card. This
value, when set to No, will allow the user to read and write to the card.

15.9Miscellaneous Modules

These are modules that don't fit in other categories.

15.9.1 Add Serial Port

The Add Serial Port Module is only used to configure the serial ports of daughter boards that add additional
serial ports to terminals. Add a module for each additional serial port. Each module will let the user configure
one additional port.

. Port Number - This value is to be set to the port number of the new port.
. Port Address - This value is to be set to the port address of the new port.
. IRQ - This value is to be set to the IRQ of the new port.

. UART- This value is set to the chipset type for the new port.

15.9.2 Firmware Update (Disk On Chip / Compact Flash) Update
Module

The Firmware Update is the new name for the Disk On Chip/Compact Flash Update module in
ThinManager 3.1.

ACP enables some models of terminals to store the firmware with Disk On Chip or Compact Flash storage so
that the unit doesn’t have to download the entire firmware at boot but can boot locally and download just the
configuration to save bandwidth. This is most commonly used with units that will connect over low bandwidth
networks, like wireless networks or WANs. These units can use the Firmware Update module to download
and flash new firmware when the firmware is updated in ThinManager.

The ability to update stored firmware terminals eliminates the need to send the terminal back to the
manufacturer to update the firmware.

Note: The firmware download can vary, depending on the bandwidth of the connection and the size of the
firmware update.

It is recommended that updates be done over a wired LAN instead of over a wireless connection, when
possible.

The Firmware Update module has two configurable parameters.

. Confirm at Terminal - This setting, if set to Yes, will prompt the operator to choose between
immediately updating firmware or waiting until the next boot up. If Confirm at Terminal is set to No, the
firmware download will take place immediately.

. Force Update - Normally a stored firmware terminal with the Firmware Update module will check
firmware version numbers at boot and only download a new firmware if the versions are different. This
setting, if set to Yes, will force the terminal to always download the firmware for re-flashing.
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Note: The module will download firmware when it detects a different firmware. Since this will only happen at
the first reboot after updating the ThinManager firmware, it is safe to leave this module added to terminals
permanently when Force Update is set to No. It does not need to be added and removed each time the
firmware is updated. However, since it will update when the firmware is different, it will try to update the
firmware if you boot it from a ThinManager server with older firmware.

159.2.1 Firmware Update Program

Once the new firmware has downloaded, an update program will run on the terminal to rewrite the new
firmware to the storage. The program will display a warning stating that the terminal must not be reset or
powered off during the process, usually around 30 seconds. Ignoring the warning can corrupt the stored
firmware, so it is important to leave the terminal alone for that period of time.

Note: Heed the warning. The terminal must not be reset or powered off during the brief period that the update
program is writing the firmware to the firmware storage device.

It is recommended that updates be done over a wired LAN instead of over a wireless connection, when
possible.

15.9.2.2 Stored Firmware Terminal Configuration

A stored firmware terminal loads the firmware locally before connecting to the ThinManager server. The
stored firmware terminals have a setup program that allows configuration of the connection. Enter the
program by selecting any key when Select any key to configure is displayed during the boot process. A setup
screen will be displayed.

ThinClient Configuration Editor
Copyright 1999-2007 Automation Control Products

Terminal IF Address Type : DHCP

ThinManager Server IP Address Type : DHCP {(Dption 066)
Set fChange Password
Save Changes & Exit
Di=card Changjes & Exit

ThinClient Configuration Editor — Default Values

The IP Addressing method is set to DHCP by default.
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ThinClient Configuration Editor
Copyright 1999-2007 Automation Control Products

Terminal IP Address Type
ThinManager Server IP Addres= Type

e Password
Save Changes & Exit

In=zcard Chanjes & Exit

ThinClient Configuration Editor — Changing Values

To change a value, navigate with arrow keys to the desired property. Pressing the Enter key will allow the
input and acceptance of new values.

ThinClient Configuration Editor
Copyright 1999-2007 Automation Control Products

Terminal IP Address Type : Static
Terminal IP Addres=s t192.166.1.113
ThinManager Server IP Address Type : Static
Primary ThinManager Serwver IF Rddress :192.168. 1. 35
Secondary ThinManager Server IP Addres=s

Router IF hddress 3

Subnet Mask : 255,255, 255.0
DHS Server 5

Set fChange Password
Save Chamges & Exit
Di=zcard Changjes L Exit

ThinClient Configuration Editor — Static IP Addresses

The changes may be saved or discarded before the boot process is resumed.

15.9.3

Local Print Module

The Local Print Module simplifies printing through the parallel port on thin clients.

There are three steps:

1.
2.

Install the print driver on the terminal servers that the client will connect to.

Add the Local Print Module to the thin client as described in Adding a Module to a Group or

Terminal.

Configure the Print Driver Name parameter in the module to contain the print driver's name.
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Module Properties EH |

Parameter | Walue |
Prirter Driver Mame MOME

Parameter IF'rinter Diriver Marne

Yalue IHF' Lazer)et G000 Senes PCL

Set to Default |

Done Cancel

Local Print Module Properties

. Printer Driver Name - The Local Print module works when the name of the print driver is entered
in the Value field for the Printer Driver Name. The Print Driver name is provided by the properties page

for the printer.

The Printer Property page for a printer can be launched by selecting Start > Settings > Printers and
selecting the appropriate printer. This will launch the Printer Queue window.

EE HP LaserJet 5000 Series PCL =]

Printer Document  Wiew Help
Dacurnent Mamme | Skakus | Owner | Pages | Size | Subirr

Jl |

|IZI docurment(s) in quele |

.=

Printer Queue window

Select Printer > Properties to launch the Printer Properties page.

Automation Control Products ThinManager 5.0 Help Manual Modules e 320



ﬁ HP LaserJet 5000 Series PCL

= Awvailable from I 12:00 &bd j Ta I 1200 &84 +I_I
Friority: |1 _I?
Driver: IHF' Laserlet 5000 Series PCL ;I Mew Diriver... |

£+ Spool print documents zo program finishes printing faster

" Start printing after last page iz spoaled
" Start printing immediately

" Print directly ta the pritter

[ Hold migmatched docurments
™ Piint spooled documents first
[ Keep printed documents

¥ Enable advanced printing features

Frinting Defaults. .. | Frint Processar... | Separator Page... |

k. I Cancel | Ay |

Advanced Printer Properties

The Printer Property page shows the Print Driver name on the Advanced tab. This is the name that needs
to be entered into the Local Print Module.
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&% Print E |

General | La_l,lcuutl F'apera’llualityl

— Select Printer
¥ g
Add Prinker Fax
Status: Ready [ Frint ko file
Location:
C _ Find Printer... |
armment:
— Page Fange
0+ Al Mumber of copies: I'I 3:
' Selection ) Cument Page
" Pages:  [1-65535 ¥ Coflzte
Enter either a zingle page number or a single
page range. For example, 5-12

Erint I Cancel | 1] |

Client Print Window

When printing from the client, the printer will be displayed as Printer/username/session number as shown
in the example.

15.9.4 MultiMonitor Module

_

One Thin Client, Multiple Monitors, Multiple Desktops
with MultiMonitor

MultiMonitor
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The MultiMonitor Module was introduced to allow MultiMonitor capable thin clients to be configured for use
with MultiMonitor before MultiMonitor was integrated into ThinManager 3.1.

Note: This module provides primitive functionality compared to the integrated settings of ThinManager 3.1+
and is no longer used.

See MultiMonitor for details.

15.9.5 Redundant Ethernet Module

Some thin clients have two network ports. The Redundant Ethernet module allows the thin client to use both
ports with a single IP address and a single MAC address.

The thin client will use the primary (LAN1) port under normal conditions. If this port, cable, or switch fails, the
Redundant Ethernet module will allow the thin client to activate and switch to the backup (LAN2) portin a
seamless fashion.

15.9.6 Second Network Module

Some thin clients have two network ports. The Second Network module allows the thin client to use both ports
on different networks.

Module Properties E3 |

Parameter | Walue |
IP b ethod STATIC
IP Address [Static Only) 0.0.0.0
MNettdazk [Static Only) 28R.255 2550
Fauter [Static Only)] 0.0.0.0
Parameter I
Walue |
Set to Default | Set
Cancel |

Second Network Module

e |P Method — This allows the second port to use DHCP or a static IP.
e |P Address (Static Only) — This allows the second port to be assigned a static IP address.
e NetMask (Static Only) — This allows the second port to be assigned a subnet mask.

¢ Router (Static Only) - This allows the second port to be assigned a router.
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15.9.7 Terminal Shadow Module

This module needs to be installed in ThinManager but is not applied to a terminal. A terminal will automatically
download this module if it is needed.

15.9.8 TermMon ActiveX Configuration Module

This configures the TermMon ActiveX control that collects terminal information and can perform terminal
functions. It is listed as both a Miscellaneous Module and a TermSecure Module but is described in the
TermSecure section.

See TermMon ActiveX Control for details.

15.9.9 Terminal Shadow Module

The Terminal Shadow module enables the Terminal-to-Terminal shadowing feature that was added in
ThinManager 3.2. This module isn’t added to a terminal but is automatically downloaded to terminals using
terminal-to-terminal shadowing. This terminal needs to be available on ThinManager and is installed
automatically to ThinManager when ThinManager 3.2+ is installed or ThinManager is updated to v3.2+.

15.9.10 Time Zone Redirection Module

The Time Zone Redirection Module allows a terminal to display local time when it is connected to a terminal
server in another time zone.

Module Properties EH |

Parameter | Walue |
Eaztemn

Time Zone

Parameter ITime Zohe

Yalue I E astem LI

Set to Default | Set
Done I Cancel |

Time Zone Module Properties

. Time Zone - This parameter can be highlighted to activate the Value drop-down that contains
time zones. Select the Set button to accept the changes.

Windows 2003 terminal servers need to have time zone redirection allowed in the Group Policy Console.
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Tﬂl GPO1 - [Console Root'Local Computer Policy’, Computer Configuration’ Administrative Templates', Windo... =] E3

----- (L Task Scheduler
=[] Terminal Services

----- 5 ClientjServer data redirecti

: I:l Licensing

------ [ sessions

-7 System
-2 Metwork

[ T YT T

----- ([ windows Installer
----- [ Windows Messenger
----- ([ Windows Media Digital Rights M—
----- [ Windows Media Player
----- ([ windows Update

[E}] File  Action Miew Favorites  'Window  Help | - |5’ |5|
& - | | | E2
[ Console Root | | setting | Statke |

E'f‘j Local Computer P':'"_':V _ - Fallow Time Zane Redirection Mok configured
El@ Computer C':"-'F'g"'_rat":"—' =4 Do not allow clipboard redirection Mok configured
% ﬁftdware :etttt.lngs = Do not allow smart card device redirection Mot configured
|:| ,ﬁ..:lln _D_Wts I:.'E |nT|;|s It = Allow audio redirection Mok configured
E___Dm;::igﬂab:‘:i;nmz:;is = Do not allow COM part redirection Mot configured
_____ | NetMeetinE =4 Do not allow client printer redirection Mok configured
_____ &3 Internet Explorer @ Do nok allow LPT port redirection Mot configured
_____ (] Application Compatibility &‘ Do not allow drive redirection Mok configured
_____ [ Internet Information Services =4 Do not set default client prinker to be default... Mot configured

I:l Encryption and Security

------ [ Temporary Folders
------ [L session Directary

_’I—I Extended 3 Standard £

Group Policy Console

The Allow Time Zone Redirection policy is found under Local Computer Policy\Computer
Configuration\Administrative Templates\Windows Components\Terminal Services\Client/Server data
redirection folder of the Group Policy.

Please see Microsoft documentation for information on Group Policy.

15.9.11 User Override Module

The User Override Module is a temporary module that allowed users of ThinManager 3.1 to use the User
Override function in Application Groups It is no longer needed in ThinManager 3.2+.

See Display Client Override for the current method of User Override.
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15.10

15.10.1

Mouse Modules

Mouse Configuration Module

The Mouse Configuration Module allows USB or PS/2 mice to be configured and allows the use of two mice.
Configuration of mouse settings include:

Primary Mouse Type -This setting allows both a PS/2 mouse and USB mouse to be used on a
terminal. This setting will define which mouse is considered the primary mouse.

Mouse Protocol - This value allows the selection of different protocols used by the mouse.

Scroll Mouse - The value, when set to Yes, allows a scroll mouse to function on a terminal.

Acceleration Multiplier - This value allows the mouse movement to be slowed down or sped up.

Acceleration Threshold (pixels) - This value is the number of pixels a mouse must move before
the acceleration multiplier takes effect.

These parameters can be changed by highlighting the parameter and choosing a new value in the Value
dropdown box. Use the Set button to accept the new parameter value.

Module Properties E |

Parameter | W alue |
Primary Mouze Type P5/2
Mouze Protocol Default
Scrall Mouze HO
Acceleration Multiplier 3
Aoceleration Threshold [pixels] 4

Parameter IF'rimar_l,l touze Type

Ve [TEEAG—G—G—GG—— - |

Set to Default |

Done I

Set

Cancel |

Mouse Configuration Module

ThinManager supports USB mice with the latest firmware. The Mouse Configuration Module allows
configuration of USB mice.

A thin client can have both a USB and a PS/2 mouse installed. This module allows the selection of the
primary mouse when using two mice.
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15.10.2 PS/2 Mouse Module

The PS/2 Mouse Module is the forerunner of the Mouse Configuration Module. It allows the changing of PS/2
settings like mouse type, acceleration and threshold. All of these features are now available in the Mouse
Configuration Module.

. Mouse Type -This value allows the selection of PS/2 or USB mouse type.

o Scroll Mouse - The value, when set to Yes, allows a scroll mouse to function on a terminal.

. Acceleration Multiplier - This value allows the mouse movement to be slowed down or sped up.
. Acceleration Threshold (pixels) - This value is the number of pixels a mouse must move before

the acceleration multiplier takes effect.

15.10.3 Serial Mouse Driver

The Serial Mouse Driver allows a serial mouse to be used with thin clients.

Module Properties E |

Parameter | W alue |
Mouse Type Auto
Serial Port COkT

Parameter IMDUSE Type

Walue I,.i-.,ut.;. ;I
Set to Default | Set

Done I Cancel |

Serial Mouse Module

Mouse Type - This value defines what type of mouse is used.
Serial Port — Set this value to the serial port number used for the mouse.

15.10.4  Share Keyboard and Mouse Modules

The Share Keyboard and Mouse module allows several thin clients to be controlled with a single keyboard
and mouse without the need of a KVM switch (Keyboard/Video/Mouse).

The Share Keyboard and Mouse has a Master module that is added to the controlling terminal, and a Slave
module that is added to the dependent terminals.
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Left Master Right

] ] R |
=L

Share Keyboard & Mouse Module

Shared Keyboard and Mouse Layout

The Share Keyboard and Mouse can be used by placing several monitors connected to thin clients side-by-
side or top-to-bottom. The Share Keyboard and Mouse Master module is loaded on the center thin client.
This module is configured by adding the IP addresses of the secondary slave thin clients. The other terminals
receive the Share Keyboard and Mouse Slave module.

mTerminal Configuration Wizard |
. =]
Module Selection caaa"
Select the modules that load on this terminal at boaot up. 1&
™M

Inztalled Modules

b adule
Share K.eyboard and Mouze Master Module

fowve g | ave Down |

Add... Eaonfigure... | Bemave |

¢ Back Finizh | Cancel | Help |

Share Keyboard and Mouse Master Module

Once the Share Keyboard and Mouse Master Module is added to a terminal, it can be configured by
highlighting it in the Installed Module window and selecting the Configure button.
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Module Properties EH |

Parameter | Walue |
Left Terminal [P Address MOME
Right Terminal IP Address HOME
Top Terminal IP Address HOME
Bottorn Terminal P Address MOME
Allowa Interactive Shadow of baster MO

Parameter ILeft Terminal IP Addresz

Yalue |1 92 168.1.101

Set to Default | Set
Done I Cancel |

Share Keyboard and Mouse Master Module Properties

. Left Terminal IP Address - Enter the correct IP address for the Slave terminal on the left of the
master terminal, if used, and select the Set button.

. Right Terminal IP Address - Enter the correct IP address for the Slave terminal on the right of
the master terminal, if used, and select the Set button.

. Top Terminal IP Address - Enter the correct IP address for the Slave terminal on the top of the
master terminal, if used, and select the Set button.

) Bottom Terminal IP Address - Enter the correct IP address for the Slave terminal on the bottom
of the master terminal, if used, and select the Set button.

. Allow Interactive Shadow of Master - Normally a terminal with the master module loaded is
blocked from interactive shadow. If you want to allow interactive shadowing on the master, highlight the
Allow Interactive Shadow of Master parameter, select Yes from the Value drop-down, and select the
Set button.

The Share Keyboard and Mouse Slave module is loaded on the secondary thin clients using the same
methods as other modules are loaded.
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Module Properties EH |

Parameter | Walue |
b azter P &ddr AR

Parameter IMaster IP Address
Walue [ahe

Set to Default | Set
Done I Cancel |

Share Keyboard and Mouse Slave Module Properties

. Master IP Address - This setting allows the slave module to be configured to connect to a
specified master by entering the IP address of the master terminal and selecting the Set button.

Select the Done button when finished.

Once the ACP Enabled thin clients are booted, the mouse on the master thin client can be moved seamlessly
into the other desktops. The keyboard will be active in whatever screen the mouse pointer is on.

This allows an operator to have control of several displays with only one keyboard and mouse. The mouse
movement is seamless, allowing access to displays without switching.

Note: A Master Share Keyboard and Mouse session cannot be interactively shadowed in ThinManager
unless it is configured to allow it.

The keyboards and mice for the slave thin clients can be left attached but stowed away until a multi-user
configuration is needed.

The Share Keyboard and Mouse Master module is licensed for each master thin client. The Share
Keyboard and Mouse Slave module is free. Each master module can have 1 to 4 slave units. Future
releases will expand the number of slaves that the master can control.

15.11 RDP Modules

15.11.1 RDP Experience Module

The RDP Experience Module allows a session connected to a Windows 2003 terminal server with RDP to add
features to the session.
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Module Properties EH |

Parameter | Walue |
sktop Background YRS
Show Windaw Contentz While Dragaing - YES
Allovs Menu and YWindow Animation YES
Allow Themes YES

Parameter I.-'l'-.II-:nw Dezktop Background
Walue IYES LI

Set to Default | Set
Done I Cancel |

RDP Experience Module Parameters

The RDP Experience Module parameters are:

) Allow Desktop Background - This setting, if set to Yes, will allow a terminal to show a desktop
background.
. Show Window Contents While Dragging - This setting, if set to Yes, will allow a terminal to

show window contents while dragging.

. Allow Menu and Window Animation - This setting, if set to Yes, will allow a terminal to show
window and menu animations.

. Allow Themes - This setting, if set to Yes, will allow a terminal to show a desktop Theme.

These features are only available with Windows 2003 Server. In order to use these features, they must be
enabled by using the Windows Group Policy Editor. See Microsoft documentation for details.
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'iii GPO1 - [Console Root'Local Computer Policy'.User Configuration', Administrative Templates'Desk... =]

= EF Local Computer Policy
Computer Configuration
-8 User Configuration
-] Software Settings
-] Windows Settings
ElI:l Adrinistrative Templates
-] Windows Components

i1 Start Menu and Taskbar
=[] Desktop

- 43 Active Deskbop

(L1 Active Directory
-] Contral Panel

[ shared Folders

-] Metwork

[#-(_] Swstem

[%] File  Action Wiew Favorites  Window  Help |_|ﬁ’|£|
& = | | =2
[ Console Roat Setting | State |

@ Enab
@ Disable Active Deskbop

@ Cisable all items

@ Prohibit changes

@ Prohibit adding items

@ Prohibit deleting ikems

= Prohibit editing items

@ Prohibit closing iterns

@ fdd Delete ikems

@ Active Deskiop Wallpaper

@ Allaws anly bitmapped wallpaper

le Active Desktop

Mot configured
Mot configured
Mot configurad
Mot configured
Mot configured
Mot configured
Mot configurad
Mot configured
Mot configured
Mot configured
Mot configurad

Extended }\ Standard f

Group Policy Console

Windows 2003 adds a variety of features that can be accessed or denied by Windows Group Policies as
shown in the example. Please consult Microsoft documentation for assistance with these features.

15.11.2

RDP Module for ThinManager v2.4 and Older

The RDP Module for ThinManager v2.4 and Older module is used to allow older versions of ThinManager

to use RDP.

ThinManager didn’t support RDP until the v2.4.1 release. Users with older versions of ThinManager can use
the RDP client communication protocol with older versions of ThinManager by adding the RDP Module for
ThinManager v2.4 and Older to the terminal and installing a ThinManager firmware that is v02.05.00 or later.

15.11.3

RDP Port Module

The RDP Port Module allows that port that RDP communicates to the terminal server to be changed from the

default 3389 to another port.
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Module Properties EH |

Parameter | Walue |
ROP Server Paort Murmber [decimal] 3389

Parameter IHDF‘ Server Port Murnber [decimal]

Yalue |3389

Set to Default | Set
Done I Cancel |

RDP Port Module Parameters

The RDP Port Module allows the port that RDP uses to be changed from the default 3389.

. RDP Server Port Number (decimal) - Enter the new port number for RDP in this value.

15.11.4 RDP Serial Port Redirection Module

The serial ports on a thin client can be remapped by adding the RDP Serial Port Redirection module to the

thin client without additional configuration. Once the thin client is booted, the COML1 in the session will refer to
the COML1 on the terminal, while the COM2 in the session will refer to the COM2 on the terminal. This function
requires Windows 2003 to work.

Additionally the COM Port Mapping needs to be allowed. This is done on the Terminal Services
Configuration Console. To open the Terminal Services Configuration Console in Windows 2003 select Start
> Administrative Tools > Terminal Services Configuration.
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tscc - [Terminal Services Configuration',Connections]

File Action  Yew Help
-=  OR| XEFR 25

,, Terminal Services Configuration Cormmernkt

----- 5] Connections

I:I Server Settings

Terminal Services Configuration Console

Launch the RDP-tcp Properties page by highlighting the Connections folder in the tree pane and double-
clicking the RDP-tcp in the right pane. This will launch the RDP-tcp Properties page.
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RDP-Tcp Properties |

Logon Settings | Seszions I

Clignt Settings

General I
Femate Control

E nwironment

I ebwork, Adapter I Permizsions

— Connection

¥ ilze connection settings from user settings

¥ | Connect client dives at logon
¥ | Connect client printers at logon

¥ | Diefault ta mait client printer

W Limit Maximum Colar Depth

|15 it

Dizable the following:
™ Drive mapping
[T Windows printer mapping

[ LPT port mapping

=

[T COM port mapping
[ Clipboard mapping

[ Audio mapping

k. I Cancel Apply

COM Port Mapping Allowed

The Com port mapping checkbox must be unselected to allow the RDP Serial Port module to function on

the Windows 2003 terminal server.

15.11.5 RDP Session IP Module

The RDP Session IP Module allows a terminal to use an alias IP address for a specific Application Group

session.
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Module Properties EH |

Parameter | Walue |
Graup Mame Mone

Sezzion [P Address 0.0.0.0

Sezzion [P Address for Ingtant Failowver 0.0.0.0

Parameter IGru:nup M arne

Yalue INDHE

Set to Default | Set
Done I Cancel |

RDP Session IP Module

The RDP Session IP module has three settings:
e Group Name — This specifies the Application Group to use.
e Session IP Address — This is the IP address to use as the alias.

e Session IP Address for Instant Failover — This is the IP address to use for a backup session it the
Application Group is configured to use Instant Failover.

15.12 Screen Saver Modules

15.12.1 MultiSession Screen Saver Module

The MultiSession Screen Saver Module is a screen saver for use on terminals configured with
MultiSession. See MultiSession Overview for details.
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Module Properties EH |

Parameter | Walue |
tode Cycle
Start Delay Time in secs 300
Switch Interval in zecs [Cecle only) 15

Parameter IMn:u:Ie

Yalue I I:_'r'CIE LI

Set to Default | Set
Done I Cancel |

MultiSession Screen Saver Module Parameters

The MultiSession Screen Saver Module has two modes. It can be set to cycle through the MultiSession
windows when the terminal is inactive, or it can be set to return to the main MultiSession screen when the
terminal is inactive.

The parameters are:

. Mode - The Cyclic mode will switch between all active sessions on the terminal. The
GotoFirstGroup mode will switch the terminal to the main session when it is inactive.

. Start Delay Time in secs - This is the number of seconds of inactivity that the terminal will allow
before starting the screen saver.

. Switch Interval in secs (Cyclic only) - This is the number of seconds that the terminal will
display each session when using the Cyclic mode.

15.12.2 Screen Saver Module

Screen Saver Module is a module that loads a screen saver on the client. The screen saver will run when
the terminal is idle to protect the monitor. Since the screen saver runs on the client, it saves CPU resources
on the terminal server.
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Screen Saver on Thin Client

Module Properties

Parameter Walue
Screen Sawer BlankS creen
Whait Time in Minutes 30
I1ze Dizable Time Period MO

Digable Start Howr [0-23] 0
Dizable End Hour  [0-23] ]

Force Off when Startt Hour Reached MO

Parameter |

Y alue |

Set to Default

Cancel |

MultiSession Screen Saver Module Parameters

The Screen Saver Module configuration includes:
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Screen Saver - the graphic that is displayed when the screen saver is active.

Wait Time in Minutes - the length of time that the terminal needs to be idle before the screen

saver starts.

Use Disable Time Period - the screen saver can be set to be disabled, or unavailable during a

time block. This could be used to prevent the screen saver from running during normal business hours.

. Disable Start Time (0-23) - This sets the start of the disabled
time block. 0 is Midnight and 23 is 11:00 p.m.

. Disable End Time (0-23) - This sets the end of the disabled time
block. 0 is Midnight and 23 is 11:00 p.m.

° Force Off when Start Hour is Reached - If set to Yes, this will
turn the screen saver off when the Disable End Time is reached.

15.13

Sound Modules

The use of sound from a thin client requires four things:

hardware with a Line Out plug
An amplified speaker
The Universal Sound Driver Module

Either a Windows 2003 Server terminal server or Citrix server-side software.

Plug the speaker(s) into the Line Out plug on the terminal, add the module, and connect to the terminal

server.

ThinManager 4.1 simplifies sound by providing a Universal Sound Driver Module. This module can be
added to any thin client that has an audio jack to enable sound.

Note: Some thin clients, like the Advantech PCM-5820, may require that a sound harness be plugged into the
motherboard.
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Module Properties EH |

Parameter | Walue |

Audio B andwidth [IC4 Only] HIGH
Sound In Seszion EMABLED
Terminal Sound Effects EMABLED

Parameter I

Walue |

Set to Default | Set
Cancel |

Universal Sound Driver Parameters

These Sound modules have several settings:

. Audio Bandwidth (ICA Only) - This parameter can be set to Low, Medium, or High bandwidth
when using Citrix ICA.

. Sound in Session - This setting, when set to Enabled, will allow sound generated within the
session to be played through the terminal. When this is set to Disabled the session sounds will be turned
off but system sounds will still be generated during TermSecure login for audio feedback during the login
process.

. Terminal Sound Effects - This setting, when set to Enabled, will allow terminal sound effects
like TermSecure login sounds on the terminal.

15.14 TermSecure Modules

15.14.1 RF Ideas pcProx Module

The RF Ideas pcProx Module uses a serial device that allows a terminal to use RF Ideas pcProx cards as
TermSecure ID cards
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Module Properties E3 |

Parameter | Walle |

Fart CORT
Murmber of Data Bits 26
I1ze Facilty Code YES
Allows b anual Logaon YES
Prarmpt for Pazsword MO
Zero Pad Facility Code and ID HO

Fararneter I

Yalue |

Set to Default | St
Cancel |

RF Ideas pcProx Module Parameters

. The parameters are:

. Port - This selects the port that the RF Ideas pcProx card reader is installed.

. Number of Data Bits — Different cards use different numbers of data bits in their format. This
sets the number of data bits to match that used by the card as an identifier. The choices are 26, 37, or
Raw.

. Use Facility Code - This value, when set to Yes, will require the addition of the card’s Facility
Code to the Card / Badge ID number.

. Allow Manual Login - This, when set to Yes, will allow a TermSecure user to log into a terminal
without a TermSecure ID device. If set to No, TermSecure users must use a TermSecure ID device to log
in.

. Prompt for Password - This, when set to Yes, will require a TermSecure to enter their password

for access, even if the password is configured in ThinManager.
o Zero Pad Facility Code and ID — This will add a zero to the number string. This is rarely needed.

See Card and Badge Configuration for a TermSecure User for details.

15.14.2 RF Ideas pcProx USB Module

The RF Ideas pcProx USB Module uses a USB device that allows a terminal to use RF Ideas pcProx cards
as TermSecure ID cards
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Module Properties E3 |

Parameter | Walle |

tode TemSecure
Allonw b anual TemSecure Logon YES
Frompt for TermSecure Pazsword HO

Fararmeter I

Yalue |

Set to Default | St
Cancel |

RF Ideas pcProx Module Parameters

. The parameters are:

. Mode — This allows the device to be used in TermSecure Mode or Wedge mode. The Wedge
mode sends data straight to the session as a keyboard wedge.

. Allow Manual TermSecure Login - This, when set to Yes, will allow a TermSecure user to log
into a terminal without a TermSecure ID device. If set to No, TermSecure users must use a TermSecure
ID device to log in.

. Prompt for TermSecure Password - This, when set to Yes, will require a TermSecure to enter
their password for access, even if the password is configured in ThinManager.

See Card and Badge Configuration for a TermSecure User for details.

15.14.3 TermMon ActiveX Configuration

This configures the TermMon ActiveX control that collects terminal information and can perform terminal
functions.
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Module Properties EH |

Parameter | Walue |
Allow Actives Connections YES
Orly Allay Connections from Session YES
Parameter I
Walue |
Set to Default | Set
Cancel |

TermMon ActiveX Module Parameters

Normally the TermMon ActiveX, when registered on a terminal server, allows a terminal server session to
communicate with its terminal and act upon it without the need of the TermMon ActiveX module. The
TermMon ActiveX module can be added to the terminal configuration to either deny the default terminal
server to terminal access or to allow access to other sessions and PCs.

. Allow ActiveX Connections - This value, when set to Yes, will allow the ActiveX control to
function. Setting this value to No will prevent any ActiveX communication to the terminal, including the
default terminal server to terminal access.

. Only Allow Connections from Session - This value, when set to Yes, will allow other terminal
server sessions and PCs to communicate to the terminal with the ActiveX functions. If set to No, the only
communication allowed is between the terminal and a session on the terminal server belonging to the
terminal, providing that the Allow ActiveX Connections is set to Yes.

See TermMon ActiveX Control for details.

15.14.4 USB Flash Drive Module

The USB Flash Drive Module can be used to allow USB flash drives to be used as TermSecure ID devices. It
is also listed under Local Storage modules.

See USB Flash Drive Module in the Local Storage Modules for details.

15.145 Wavetrend Tag Reader

The Wavetrend Tag Reader Module allows a terminal to use Wavetrend RFID cards as TermSecure 1D
cards. This allows a user to login through TermSecure when they approach the terminal and logs them out
when they leave the area. The distance required to login and log out are configurable in the module.
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Module Properties EH |

Parameter | Walue |

Fart COkT
I1ze Wendor Code YES
Alloa b anual Logon YES
Prampt for Pazsword MO
Entry Sigrnal Strength B0
Exit Signal Strength B0
Entry Senzitivity 1
Exit Sensitivity 1

Fararmeter I

Yalue |

Set to Default St
Cancel |

Wavetrend Tag Reader Module Parameters

The parameters are:

Port - The WaveTrend Tag Reader Module connects to a thin client through the serial port. The Port setting
specifies which COM Port the reader is attached to.

Use Vendor Code - This, if set to YES, includes the vendor code as part of the identifier number.

Allow Manual Login - If set to YES, this allows a TermSecure User to use the hotkey to initiate logins, or the
device. If set to NO, it will force a TermSecure User to use a device to login.

Prompt for Password - NO allows the device to login without a password. YES forces every TermSecure
User to enter a password after using the device.

Entry Signal Strength - The signal strength required to register the card as in range.
Exit Signal Strength - The signal strength required to register the card as out of range.

Entry Sensitivity - The number of reads above the Entry Signal Strength reads that are required to register
as “Entered”.

Exit Sensitivity - The number of reads below the Exit Signal Strength that are required to register as “Exited”.

15.15 Touch Screen Modules

. Arista ARP-16XXXAP-ACP Touch Screen Driver

. CarrollTouch Touch Screen Driver
° Contec Touch Screen Driver
. DMC TSC Series Touch Screen Driver
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) DMC Touch Screen Driver

. Dynapro Touch Screen Driver

. Elographics Touch Screen Driver

. Gunze AHL Touch Screen Driver

. Hampshire TSHARC Touch Screen Driver
o MicroTouch Touch Screen Driver

. Panjit TouchSet Touch Screen Driver

o PenMount Touch Screen Driver

o Ronics Touch Screen Driver

o Touch Control Touch Screen Driver

o Touch International IR Touch Screen Driver
o USB Touch Screen Driver

. Xycom 33XX Touch Screen Driver
ModueProperties 3|

Parameter | W alue -
b onitor Humber 1 —
Double Touch Area [pixels] 10

Double Touch Time [milizeconds) 1000

Touch De-bounce Timeout [millizecondz] 0

Swap = Coordinates MO

Right Chick Hold Time [millzeconds] DISABLED |-
Right Click Area [pisels] 10

Murnber of Calibration Points 5

Calibration Margin Percentage 10

Calibration Hotkey HOME -
4 | | »

Parameter IM:::nitu:ur Murnber
Walue |1 ;I
Set o Default | Set

Done I Cancel |

Touch Screen Parameters

Some, but not all, touch screen modules have parameters that can be modified. These may include:

Connection
° Connection Type — Sets whether the touch screen uses Serial or USB to connect.
. Port or Port (Serial Only) — Sets the COM port that a serial touch screen is connected to.
. Baud Rate - Sets the speed used for communication between the terminal and the touch screen

on some serial touch screens.
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. Monitor Number — Used to specify which monitor in a MultiMonitor scheme will use for the touch
screen. MultiMonitor thin clients with multiple touch screens will need a module loaded for each touch
screen used.

. Controller Type - Sets the model of touch screen controller on some touch screens.
Calibration

. Number of Calibration Points — This sets the number of calibration points that the calibration

program uses during the calibration process.

. Calibration Margin Percentage — This sets the distance from the edge of the screen that the

calibration points are displayed.

. Calibration Hotkey — This allows a function key to be set as a hotkey so that the calibration can

be launched from a keyboard.

. Calibration Hotkey Modifier— This setting adds CTL or ALT to the hotkey to launch the

calibration from the keyboard, if desired.

. Calibration Touch Down Time (seconds) — This setting, when enabled, will launch the
calibration program when the screen is touched and held for the assigned number of seconds. This
cannot be used with the Right Click Hold Time.

. Calibration (entered automatically) — This is set automatically by machine. These are the
values set during the calibration process.

. Orientation (entered automatically) - This is set automatically by machine. Used at the direction
of Tech Support in error correction.

. Swap XY Coordinates — If X and Y are reversed, this setting will correct the orientation.

Touch Settings

. Double Touch Area (pixels) — This sets the size of the area that a second touch will register as
a double touch.
. Double Touch Time (milliseconds) - The amount of time between touches that qualifies as a
double touch.
) Touch De-Bounce Timeout - a time interval used to prevent a single touch from being registered
as multiple touches.

Right Click
. Right Click Hold Time (milliseconds) - This setting, when enabled, will treat a touch that is

held for the assigned number of seconds as a Right Click of the mouse. This cannot be used with the
Calibration Touch Down Time.

. Right Click Area (pixels) - This sets the size of the area that a second touch will register as a
right click.

15.15.1 USB Touch Screen Driver Module

The USB Touch Screen Driver Module is designed to be used by any touch screen that uses a USB
connection to the thin client.
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15.16 Video Driver Modules

The method of downloading video drivers was changed in ThinManager 3.0. In previous versions all of the
video drivers were contained in the firmware and were downloaded at boot. In v3.0 the video was split out of
the firmware and each thin client will only download the video driver that it needs.

One does not need to add the video module to the terminal but only needs to have the video module installed
in ThinManager to make it available. As each terminal connects to ThinManager it will download the correct
module.

These modules are normally installed with ThinManager. See Installing a Module to see how to update or add
new modules.

Note: Users with ThinManager 2.6 and earlier may need to add the individual video module to the terminal if
using certain models of thin clients. This doesn’t apply to ThinManager 3.0 and later.
See http://www.thinmanager.com/support/downloads.shtml for details.

15.17 Advanced Modules

Advanced Modules are modules that are rarely used because they address a limited specific issue and are
not needed in normal configurations. These include the Core Video Modules, Legacy Video Module, ICA
Client Modules, and Instant Failover Module.

These modules are hidden unless the Show Advanced Module checkbox is selected on the Attach
Modules to Terminals window.

Attach Module to Terminal |

Module Type | &l Modules - |
Show &dvanced Modules v

Firrware Update Module "
Gigabyte TAZLE Sound Driver [
Gunze AHL Touch Screen Driver

Hampszhire TSHARC Touch Screen Driver

|CA Clent Wersion 6.0

|CA Client Yersion 8.0 _|

| mztant Failloyver b odule

K.ep Black Module

kK.ep Block Single Kep Module
F.eyboard Configuration Module
Legacy Yideo Module

Local Printer bModule
Miu:ru:uTu:uuu:h_Tu:uuu:_h Screen Driver b |

Cancel |

Advanced Module -Instant Failover

15.17.1 ICA Client Version 6.0/ ICA Client Version 8.0

The ICA Client Module Client Version 8.0 is a module is not added to terminals but needs to be installed in
ThinManager for terminals using the ICA protocol. If a terminal is configured to use the ICA client
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communication protocol on the Terminal Server Specification page of the Terminal Configuration Wizard,
the terminal will automatically download the v8.0 module to enable ICA functionality.

If a user wants to use the 6.0 version of the ICA protocol they will need to add the ICA Client Module Client
Version 6.0 to the terminal.

15.17.2 Instant Failover Module

The Instant Failover Module is to be used only with terminal configurations that use the legacy “Individual
Terminal Servers” method instead of the preferred Display Clients method.

Since the use of Display Clients is a preferred method of getting terminal services sessions over using the
legacy “Individual Terminal Servers” the module is hidden from view unless the Show Advanced Modules
checkbox is selected.

Instant Failover allows a terminal to connect to a session on two terminal servers. Both sessions are active
but only one is displayed. If the first terminal server fails, the second session is immediately displayed,
eliminating any downtime due to terminal server failure. See Instant Failover for details.

Note: The Instant Failover Module is only used with terminals using Individual Terminal Servers. (See
Terminal Server Specification Page).

Terminals using Application Groups use a checkbox to enable Instant Failover. (See Instant Failover with
Terminal Services Display Clients).

Do not use this module while using Application Groups.

The Instant Failover function requires an Instant Failover license for each terminal that uses it.
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15.17.2.1 Instant Failover Configuration When Using Individual Terminal Servers

The thin client cascades both sessions, with the primary in front. You cannot see the secondary session as it
is hidden in back. There is an option that allows one to switch between sessions with a hot key.

Module Properties E |

Parameter | W alue |
Hat Key Sezsion Switching DISABLED
Hat K.ey Combination is CTRL+ Fa

Parameter |H|:|t K.y Sezzion Switching

Walue |DISABLED |

Set to Default | Set
Done I Cancel |

Instant Failover Module Properties

. Hot Key Session Switching - If this parameter is set to Enabled, the hot key combination will
allow the toggling between sessions.

. Hotkey Combination is CTRL+ - The value of the hot key is defaulted to CTRL+F9 but can be
assigned to any function key.
15.17.2.2 Advanced Video Modules

The Core Video Module, Core Video2 Module, and Legacy Video Module do not need to be added to a
terminal but need to be installed in ThinManager. The terminal will download it if needed. These modules are
installed during ThinManager installation so should not be a concern.
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16 Citrix ICA

ACP ThinManager supports two client/server communication protocols, the Microsoft© RDP and the Citrix
ICA. Terminals and Display Clients can be configured to use one or the other with a simple radio button.

16.1Terminals Using Display Clients with ICA

If a terminal is using the display clients to receive applications then Terminal Services Display Clients can be

configured to use the ICA protocol. These display clients will show up in the Available Display Clients list on
the Display Client Selection Page.

5%\ Terminal Configuration Wizard |

Dizplay Client 5election

Select the Display Clients to uze on this kerminal ’ ‘
A

Ayailable Digplay Clientsz Selected Dizplay Clients
Graphics ICadop]
Hil .
Feports ICAApp2 e |
BackCamerall } FrontCarmerall
- hd

Edit Digplay Cligntz Overide |

¢ Back I Hest > I Finizh Cancel Help
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Terminal Using Display Clients and ICA Display Clients

Select the desired Display Clients from the Available Display Clients list and move them to the Selected
Display Clients list. The terminal will use the Display Clients selected, both RDP and ICA.

16.2Display Client Configuration Wizard

A Display Client can be configured to use the ICA protocol on the Terminal Services Display Client Type
page of the Display Client Configuration Wizard.

S¥\Display Client Wizard |
Terminal Services Display Client Type w
Select the type of connection for thiz Terminal Services Dizplay ’ ‘
Client. )

— Terminal Server Type

Select the type of Terminal Server for this Display Client

™ Citix Device Services Servers

" Femote Desklop Protocol Servers

¢ Back I Hest > I Fimizh Cancel Help

Terminal Services Display Client Type Page

Importance of Page: Configures the Display Client to use the Citrix ICA Protocol
Settings:
e Citrix ICA Servers — This allows the Display Client to use the Citrix ICA as its protocol.

e Citrix Device Services Servers — This allows the Display Client to use archaic Device Services
Servers.

o Remote Desktop Protocol Servers — This uses the default Microsoft © RDP as its protocol.
Why Change from Default Settings: You need to select the Citrix ICA Servers to use the ICA protocol.

Select Next to continue.
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16.2.1.1 Citrix ICA Page

52 Display Client Wizard x|
Citnx ICA H

Enter the [CA optians far thiz dizplay client
A

— Select Encryption Level

T - |
— Enter the |Ca Browser Address

[T Usze a Citrix Published &pplication

— Enter the name of the Publizhed &pplication

< Back I Ment » I Eirizh Cancel Help

Citrix ICA Page

Importance of Page: Configures the Citrix Settings
Settings:

e Encryption Level — This drop-down sets the Citrix encryption level.
Fields:

e |CA Browser Address — Entering the ICA browser address aids in connection across routers,
subnets, and domains.

o Enter the name of a Published Application - This field allows the desired published application to
be designated when the Use a Citrix Published Application checkbox is selected.

Checkbox:

e Use a Citrix Published Application — This checkbox, if selected, will allow usage of Citrix Published
Applications to deploy programs to the thin client.

Why Change from Default Settings: Check the Use a Citrix Published Application checkbox and enter
the published application in the Enter the name of a Published Application field to use an ICA published
app..

This finishes the wizard, graying out the Next button and activating the Finish button.

Automation Control Products ThinManager 5.0 Help Manual Citrix ICA o 353



Note: Published Application should have a continuous name and not contain spaces.

If the Display Client is using a Citrix Published Application the wizard will finish with this page.

If the Display Client is not using Citrix Published Application the wizard will continue to allow the selection of
Terminal Servers that are configured to use the ICA protocol. See the Terminal Server Capabilities Page for
details.

16.2.2 Terminal Using Citrix and Individual Terminal Servers

The Terminal Connection Type page of the Terminal Configuration Wizard allows the selection of the
desired Client Communication Protocol on terminals is using the legacy “Individual Terminal Servers” instead
of the preferred Display Client method.

= Terminal Configuration Wizard x|

Terminal Connection Type
Select the type of connection this kerminal will make to the Terminal } ‘
Server. A

Select the connection wpe

£ Citrix Device Services

" Remote Desktop Protocol [RDP]

¢ Back I Hest = I izt Cancel Help

Terminal Configuration Wizard - Connection Type

Select the Citrix ICA radio button to use the ICA protocol.
Once the Citrix ICA protocol is selected the wizard will display the Citrix ICA Configuration page.
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16.2.2.1 Citrix ICA Configuration Page

52 Terminal Configuration Wizard 5[

Citrix ICA Configuration m
g =

Chonose the settings for Citris [CA.
A

E ncryption

Bazic j

Are pou uging Publizhed Applicationg?

= Yes

< Back I Hest > I izt Cancel Help

Terminal Configuration Wizard - Citrix ICA Configuration

Importance of Page: Sets the ICA encryption Level and enables use of Published Applications.
Fields:

Encryption - The Encryption drop-down box sets the level of Citrix encryption.

Buttons:

e Areyou using Published Applications — This allows the usage of Citrix Published Applications for
deploying programs.

Why Change from Default Settings: Citrix ICA has a feature called Published Applications. If you are
using Published Applications, select the Yes radio button, then select the Next button to continue to the Citrix
Published Application dialog.

If you are not using Published Applications, select the No radio button, then select the Next button to continue
to the Terminal Server Selection page.
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16.2.2.2 Citrix Published Applications Page

= Terminal Configuration Wizard x|

Citrix Published Applications m
t-.‘

Enter the publizhed application thiz terminal shauld run. Enter the [CA
brovezer if neceszary to help the terminal find the publizhed
application.

Publizhed Application Mame

|CA Browser

< Back I [ [ izt Cancel Help

Terminal Configuration Wizard - Citrix Published Applications

Importance of Page: Defines what Citrix published application to have the terminal

Fields:
e Published Application Name — Enter the name of the desired published app you wish to run.
e |CA Browser — Enter the ICA master browser name, if needed.

Why Change from Default Settings: Allows use of a published application.

Enter the name of the desired Published Applications in the Published Applications Name field. Do not use
spaces in the name when creating a Published Application for Terminal Services.

Citrix uses ICA Browsers as part of the system. Because the ICA client may have problems detecting an ICA
browser across a router or switch, an ICA Browser field is provided for entering the name of an ICA browser.

Select the Finish button to create the Terminal, or select the Next button to rejoin the main configuration path
to configure more options.

Terminals using the Select Individual Terminal Servers will be shown the Terminal Server Selection page
where the desired terminal servers can be selected.

Automation Control Products ThinManager 5.0 Help Manual Citrix ICA o 356



17Hotkeys

ThinManager provides hotkeys for switching between Display Clients, initiating SessionTiling, and other
functions.

17.1Terminal Configuration Wizard Hotkeys Display
Clients

The Terminal Configuration Wizard has several hotkeys that can be configured

Automation Control Products ThinManager 5.0 Help Manual Hotkeys o 357



17.1.1.1 Terminal Interface Options Hotkeys

= Terminal Configuration Wizard x|

Terminal Interface Oplions m
t-.‘

Select the dizplap client zelectar and main menu options that will be
available on the terminal.

— Digplay Client Selection Options

¥ Show Selector on Terminal Selector Options |

W Enatls Tiling Tiing Options |

[T Screen Edge Dizplay Client Selection

< Back I Hest > I Finizh Cancel Help

Terminal Interface Options Page
A terminal using multiple Display Clients will need to have a method to switch between sessions. This is
configured on the Terminal Interface Options page.
Group Selector Options allow on-screen switching of sessions.

e Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down
menu that can be activated by mouse.

e Enable Tiling — This checkbox, when selected, allows the Display Clients to be tiled on the monitor to
provide an overview of all the sessions at once. See SessionTiling Options for details.

e Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch
windows if the mouse is moved off screen.

The Selector Options button will launch the Group Selector Options window that allows configuration of the
on-screen Group Selector bar.
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Display Client Selector Options El
v Auto-hide Selector

[ Tile on Selector activation Cancel |

Selectar Menu Size Morrnal j

Group Selector Options Window

The Group Selector Options window has several settings.

e The Auto-hide Group Selector checkbox will hide the Group Selector until the mouse is moved to
that space.

e The Tile on Group Selector activation checkbox, when selected, will tile the Display Clients when
the auto-hid selector is chosen. This allows the user to select from the available sessions.

e The Group Selector Menu Size drop-down box allows the setting of the size of the Group Selector
font.

Select the OK button to accept changes or the Cancel button to close.

17.1.1.2 SessionTiling Options

Selecting the Enable Tiling checkbox on the Terminal Interface Options page of the Terminal
Configuration wizard will allow the sessions to be tiled for selection.

Feports
Graphics
Shadaw_All
b &t b enu

Tiled Sessions on a Terminal

Once the sessions are tiled the session selection can be made by:
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Using the Group Selector, if selected on the Terminal Interface Options page.

Clicking on the desired session if the Tile Interactive checkbox is unselected on the Tile Options
page.

Right clicking on the desired session if the Tile on right click (mouse or touchscreen) checkbox is
unselected on the Tile Options page.

The Tiling Options button will launch the Group Selector Options window that allows configuration of the
on-screen Group Selector bar.

Tile Options x|

¥ Show Grid

Tile [nactivity Time 50

Cancel

[ Tile Display Clients at startup
[T Include Main Menu as tile

[ Tile onright click [mouse or touchscreen]

[ Tile Interactive

Tile Options

The Tile Options window has several settings.

Show Grid — This checkbox, when selected, will show the tiled sessions in a grid with each grid
labeled with the session name as while the session is loading.

Tile Inactivity Time — This field sets the length of time that the terminal screen will stay focused on a
selected session before reverting back to a tiled state due to inactivity.

Tile Display Clients at startup — This checkbox, when selected, will show the sessions tiled when
the terminal first connects to its sessions.

Include Main Menu as tile — This checkbox, when selected, will include a session displaying the
TermSecure Main Menu.

Tile on Right click (mouse or touchscreen) - This checkbox, when selected, will initiate tiling when
a session is right clicked.

Tile Interactive — This checkbox, when selected, will allow a user to click into a tiled session and
control it interactively without switching focus to a single session. To focus on a single session use
the Group Selector Dropdown or the tiling hotkey (CTL + T), if enabled.

Select the OK button to accept changes or the Cancel button to close.
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17.1.1.3 Hotkey Configuration

= Terminal Configuration Wizard x|

Hotkey Configuration H

Configure the hotkeys to apply ta this teminal
A

— Terminal Hotkeys

[¥ {Enable Instant Failover Hotkeps Change Hotkeys |
[¥ Enable Dizplay Client Hotkeys Change Hotkeys |
¥ Enable Tiing Hatkey Change Hotkey |

< Back I Hest > I Finizh Cancel Help

Hotkey Configuration Page

Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations that
allow switching between sessions.

e Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching between
the two active sessions of a Display Client that is using Instant Failover.

e Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between different
sessions of a terminal using MultiSession.

o Enable Tiling Hotkey — This checkbox, if selected, allows SessionTiling to be activated by a hotkey
combination.

Selecting the Change Hotkeys button when Enable Instant Failover Hotkeys is selected will allow the
hotkeys to be changed from the default.
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Select Hotkeys

— Ingtant Failowver Hotkey
& Control Key

Al kKey

[E

Select Instant Failover Hotkeys

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed by selecting the

Alt Key radio button or using the drop-down to select another function key.

Selecting the Change Hotkeys button when Enable Group Hotkeys is selected will allow the MultiSession
switching hotkeys to be changed from the default.

Select Hotkeys

— Mext Group Hotkey

&% Control Kep IF'agE Do LI
Al kKey

— Previouz Group Haotkey
&+ Cantrol Key Page Up ;I
i Al Key

=]|

Cancel |

Select MultiSession Switching Hotkeys

The default hotkey for MultiSession switching is set to Control+Page Up and Control+Page Down. This can
be changed by selecting the Alt Key radio button or using the drop-down to select another hot key.

Selecting the Change Hotkeys button when Enable Tiling Hotkeys is selected will allow the hotkeys to be

changed from the default.
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Select Hotkeys |

— Tile Hotkey
&% Control Kep It LI Cancel |
Al kKey

Select SessionTiling Hotkeys

The default hotkey for SessionTiling activation is set to Control+t. This can be changed by selecting the Alt
Key radio button or using the drop-down to select another hot key.

Select the OK button to continue or the Cancel button to close without accepting changes.

17.1.1.4 TermSecure Hotkeys

When the Enable TermSecure checkbox is checked on the Terminal Server Specification page additional
TermSecure functionality is enabled to access to the main menu for logging into TermSecure.
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= Terminal Configuration Wizard x|

Terminal Interface Oplions H

Select the display client selector and main menu options that will be
available on the terminal. A

— Digplay Client Selection Options

¥ Show Selector on Termingk Selector Options |

W Enatls Tiling Tiing Options |

[T Screen Edge Dizplay Client Selection

tdain kenu Options

¥ Show Main Menu on 5 electar Main Meru Options

< Back I Hest > I Finizh Cancel Help

Terminal Interface Options — TermSecure Enabled

The Terminal Interface Options page will display the Show Main Menu on Group Selector checkbox.

The Show Main Menu on Group Selector, when selected, will add the main TermSecure menu as an option
on the Group Selector dropdown.

The Main Menu Options button will launch a window for Main Menu settings.

Main Menu Options E

[ allow reboot £ restart

[T Show Virtual Keyboard Cancel |

Main Menu Options

The Main Menu Options window has several settings.

e Allow reboot/restart — This checkbox, if selected, will add a Reboot and a Restart button on the
main TermSecure login window.
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e Show Virtual Keyboard — This checkbox, if selected, will prompt the display of a virtual keyboard for
TermSecure logins. This is helpful for thin clients with touch screens.

Select OK to save setting or Cancel to close without saving.

The Hotkey Configuration page has an additional TermSecure setting when the Enable TermSecure
checkbox is checked on the Terminal Server Specification page.

== Terminal Configuration Wizard x|

Hotkey Configuration

Configure the hotkeys to apply ta this terminal } ‘
A

— Terminal Hotkeys

[™ Enable Instant Failover Hotkeys [hange Hatkeys |
I¥ ‘Enable Display Client Hotkeys Change Hotkeys |
[¥ Enable Tiing Hotkey Change Haotkey |
[¥ Enable Main Menu Hatkey Change Hatkey |

¢ Back I Hest = I Finizh Cancel Help

Hotkey Configuration — TermSecure Enabled

The Enable Main Menu Hotkey checkbox, when selected, will allow the TermSecure Main Menu to be
launched with a hotkey combination. The Change Hotkey button allows the default CTL+m combination to
be changed.
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Select Hotkeys

— Switch Uszer Hotkep
& Control Key

Al kKey

fm

Select HotKeys Window for Main Menu

The default hotkey for the Main Menu is set to Control+m. This can be changed by selecting the Alt Key

radio button or using the drop-down to select another hot key.
Select the OK button to continue or the Cancel button to close without accepting changes.

TermSecure is covered more thoroughly at TermSecure User Configuration Wizard.
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18Multiple Monitors

18.1Introduction to Multiple Monitors

ACP ThinManager has two methods of providing multiple monitors in a thin client system - the Share
Keyboard and Mouse method and the MultiMonitor method.

The Share Keyboard and Mouse module allows several thin clients, each with a single video port, to be
controlled with a single keyboard and mouse without the need of a KVM switch (Keyboard/Video/Mouse). The
Share Keyboard and Mouse system ties several desktops together with a common mouse and keyboard so
that the user has increased real estate under their control. Because each screen is still an independent
desktop, programs don't need to be rewritten in a new resolution for a larger desktop. Instead, one would run
the normal sized application on each of the desktops, allowing the operator to view different windows on
different monitors.

See Share Keyboard and Mouse Modules for details on deployment.

The MultiMonitor method uses specific thin clients that have multiple video ports built into the hardware.
Each MultiMonitor thin client can have from two to five monitors attached. These monitors can be configured
to merge into an expanded desktop (called “spanned” by ACP) or can display individual desktops (called
“screened” by ACP), or combinations of “spanned” and “screened” sessions.

WinTMC now supports MultiMonitor if the PC has Windows running on multiple video cards.

See MultiMonitor for details on deployment.

18.2Share Keyboard and Mouse Modules

The Share Keyboard and Mouse module allows several thin clients to be controlled with a single keyboard
and mouse without the need of a KVM switch (Keyboard/Video/Mouse).

The Share Keyboard and Mouse has a Master module that is added to the controlling terminal, and a Slave
module that is added to the dependent terminals.
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Left Master Right

] ] R |
=L

Share Keyboard & Mouse Module

Shared Keyboard and Mouse Layout

The Share Keyboard and Mouse can be used by placing several monitors connected to thin clients side-by-
side or top-to-bottom. The Share Keyboard and Mouse Master module is loaded on the center thin client.
This module is configured by adding the IP addresses of the secondary slave thin clients. The other terminals
receive the Share Keyboard and Mouse Slave module.

52 Terminal Configuration Wizard ﬂ

Module Selection m
Select the modules that load on this terminal at boaot up. ’ ‘
A

Inztalled Modules

b odule

Share F.eyboard and Mouze Master Module

bove Up | Move Down |

Add... Configure... | Remowve |
¢ Back I Hest = I Finizh | Cancel | Help |

Share Keyboard and Mouse Master Module

Once the Share Keyboard and Mouse Master Module is added to a terminal, it can be configured by
highlighting it in the Installed Module window and selecting the Configure button.
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Module Properties EH |

Parameter | Walue |

Left Terminal IP Addresz MOME
Right Terminal IP Address HOME
Top Terminal IP Address HOME
Bottarn Terminal IP Address MOME
Allow [nteractive Shadow of kaster MO

Parameter I

Walue |

Set to Default Set
Cancel |

Share Keyboard and Mouse Master Module Properties

. Left Terminal IP Address - Enter the correct IP address for the Slave terminal on the left of the
master terminal, if used, and select the Set button.

. Right Terminal IP Address - Enter the correct IP address for the Slave terminal on the right of
the master terminal, if used, and select the Set button.

. Top Terminal IP Address - Enter the correct IP address for the Slave terminal on the top of the
master terminal, if used, and select the Set button.

) Bottom Terminal IP Address - Enter the correct IP address for the Slave terminal on the bottom
of the master terminal, if used, and select the Set button.

. Allow Interactive Shadow of Master - Normally a terminal with the master module loaded is
blocked from interactive shadow. If you want to allow interactive shadowing on the master, highlight the
Allow Interactive Shadow of Master parameter, select Yes from the Value drop-down, and select the
Set button.

The Share Keyboard and Mouse Slave module is loaded on the secondary thin clients using the same
methods as other modules are loaded.
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Module Properties EH |

Parameter | Walue |
b azter P &ddr AR

Parameter IMaster IP Address
Walue [ahe

Set to Default | Set
Done I Cancel |

Share Keyboard and Mouse Slave Module Properties

. Master IP Address - This setting allows the slave module to be configured to connect to a
specified master by entering the IP address of the master terminal, and selecting the Set button.

Select the Done button when finished.

Once the ACP Enabled thin clients are booted, the mouse on the master thin client can be moved seamlessly
into the other desktops. The keyboard will be active in whatever screen the mouse pointer is on.

This allows an operator to have control of several displays with only one keyboard and mouse. The mouse
movement is seamless, allowing access to displays without switching.

Note: A Master Share Keyboard and Mouse session cannot be interactively shadowed in ThinManager
unless it is configured to allow it.

The keyboards and mice for the slave thin clients can be left attached, but stowed away until a multi-user
configuration is needed.

The Share Keyboard and Mouse Master module is licensed for each master thin client. The Share
Keyboard and Mouse Slave module is free. Each master module can have 1 to 4 slave units.

18.3MultiMonitor

MultiMonitor is configured in the Terminal Configuration Wizard or the Group Configuration Wizard.
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18.3.1.1

MultiMonitor Hardware Specification

52 Terminal Configuration Wizard

Terminal Hardware

Select the manufacturer and model af this terminal.

=

X

IJze thiz to configure the type of hardware far this terminal.

Make A OEM

td odel

DEM hodel
Wideo Chipzet

Terminal 1D

I - |

{BosPC140

BoxPC140-ACF

Wia Unichrome

OD20EFE ¥D4C2

-

Clear |

< Back I Hest > I

Finizh Cancel Help

MultiMonitor — Terminal Hardware

MultiMonitor configuration is initiated in the Terminal Configuration Wizard when a MultiMonitor-capable
thin client is selected on the Terminal Hardware page.

Select the Next button to continue.
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52 Terminal Configuration Wizard 5[

Terminal Mode Selection ﬂ

Select the operating modes for this terminal
A

tethod of Terminal Server Selection

i |lze Dizplay Clients
" Select Individual Terminal Servers

Selecting Dizplay Clientz iz recommended.

TermSecure
[ ¥ Enable TemSecure

|' kA ualtibd cribor

< Back I Hest > I Finizh Cancel Help

MultiMonitor — Enable MultiMonitor

MultiMonitor requires the use of Display Clients. Once the Use Display Clients checkbox is selected on the
Terminal Server Specification page the Enable MultiMonitor checkbox becomes visible.

Select the Use Display Clients and the Enable MultiMonitor checkboxes, and then select the Next button.

Note: WinTMC now supports MultiMonitor if the PC has Windows running on multiple video cards. Selecting
the Enable MultiMonitor checkbox will allow you to configure a WinTMC client for MultiMonitor use.

Select the Next button to continue.
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18.3.1.2 MultiMonitor Monitor Configuration

52 Terminal Configuration Wizard 5[

MultiM onitor Yideo Settings

Select the number of monitors and a video mode far 2ach manitar, ’ ‘
A

MNumber of konitars 2 3 v i E
— Mornitor Yideo Modes
Color Diepth Im
Resalution Refresh Rate
Maritor [1024768 =] fez =]
Maritor 2 [tozas7es =] feoHz 7]
Moritor 3 [1024x7e8 =] [eHz 7]
Maritor 4 [1o2as7ee =] feoHz 7]

< Back I Hest > I izt Cancel Help

MultiMonitor — Video Settings
The MultiMonitor Video Setting allows the user to choose how many monitors will be connected to the
MultiMonitor thin client using the Number of Monitors radio button.
The Color Depth dropdown allows the color depth to be set for all the monitors.

The Resolution and Refresh Rate can be set for each monitor using the dropdowns.
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52 Terminal Configuration Wizard

MultiM onitor Yideo Settings
Select the number of monitors and a video mode far each manitar,

=

X

Murnber of kMonitars

— Manitar ¥ideo Modes
Color Diepth

b4 aritar 1
Maritar 2
b aritar 3

M aritar 4

2 3 v 4 5
IE#K Colors *I
Rezalutian Refrezh Rate

[1024x763 =l

ERERd

[1024w788 =]

EREE

[1024x763 =l

Sl0=E00

ERERd
EER

< Back I Hest > I izt

Cancel

Help

MultiMonitor — Video Settings

The monitors do not need to use the same resolutions but can be individually configured.

Select the Next button to continue.
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18.3.1.3 MultiMonitor Monitor Layout Page

52 Terminal Configuration Wizard 5[

Monitor Layout ("
Select the phyzical maonitor lavaut and the layaut of the teminal ’ ‘
TEMVEN TETI0NE. A

Chooze your monitor layaut D D 1

|' tdain b onitor

O AtMouze (% 1 2 3 4

Chooze your zcreen layout

TermSecure |nitial Screen
[ i A B i C

< Back I Hest > I izt Cancel Help

MultiMonitor — Monitor Layout

The Monitor Layout page allows the configuration of the MultiMonitors.

The Choose your monitor layout dropdown will display the various physical arrangements that the monitors
can be placed in. Select the layout that matches your layout.

LA

e e L e

0ooe
{ (]
{ (]

Sample Monitor Layouts

The Main Monitor radio button determines which screen is considered the main monitor. This monitor will
display the TermSecure login window, Main Menu, and ThinManager messages.
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The Choose your screen layout dropdown with allow the assignment of sessions to the monitors. The
monitors can be combined into a “Spanned” session that contains two or more monitors or they can be
configured to hold an individual session per monitor, called “Screened”, or a combination of the two.

—i— —B—/

A

B

— g —

—A—

i
]

L —

_E_

—  — B —

_E_

Samples of Four-Monitor Configurations

L 0 —

]
]
I
]

L8 -
L8~

Note: The desktop of a spanned session is limited to 4096x2048. The selection of monitor resolution on the
MultiMonitor Video Settings page can affect the number of monitors that you can add to a spanned session.

The TermSecure Initial Screen radio button determines which screen is considered the main monitor for
TermSecure. This monitor will display the TermSecure Main Menu window and messages.

Select the Next button to continue.
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18.3.1.4 MultiMonitor Display Client Selection Page

52 Terminal Configuration Wizard

Display Chent Selection

Select the Display Clients to put on gach manitar

=

—A— —B— Screen b
Kl K3 »
I_:C_I |_:D_| Screen B
o . >
Aeallable Dizplay Clients
ShadowClient1 ‘
ShadowClhent?
TSClient] i ScreenC
T5Client2
CamClient1 }
CamClignt2 ‘
Screen D
Edt Display Clients | b
[Iwerde | ‘
< Back I Hest > I Finizh | Cancel Help

MultiMonitor — Display Client Selection

The Display Client Selection page allows Display Clients to be assigned to each screen.
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52 Terminal Configuration Wizard 5[

Display Chent Selection ﬂ

Select the Dizplay Clents to put on each monitor
A

Screen b
T5Client1
} T5Client2
; : : Screen B
Aeallable Dizplay Clients CamChentl
ShadowClhent2
CamClient2 | »
Screen C
ShadowClient1
Edt Display Clients | :
Owerde |
< Back Finizh | Cancel Help

MultiMonitor — Display Client Selection

Highlight the desired group and select the arrow to move it to the desired screen.

The number of available screens is based on the combination of screened and spanned sessions selected on
the Monitor Layout page. Each screen can have more than one Application Group.

The Override button allows you to assign a different user account or video resolution to a Display Client.
Highlight a Display Client and select the Override button to launch the Override Setting window.

Automation Control Products ThinManager 5.0 Help Manual Multiple Monitors e 378



Owverride Settings for ‘Calculator’ Display Client

— Login Settings e —— -

Overide [~
|lzermarme I Cancel |
Password I
Werify Pazsword I

Owerride [

Cramair I
—applink Command Line
Command Line Options Override r
—%ideo Settings
Oweride r
R ezalutian Color Depth
240320 | |256Colos )

Override Setting Window

The override function is important when you want to run several copies of the same application on the
MultiMonitor terminal because Microsoft limits each user to a single instance of an application by default.
Without the override function you will get a single application that bounces from window to window.

Check the Override checkbox of the setting you desire to override and fill in the appropriate fields.
Select OK to accept the changes and select Cancel to cancel the changes.

Select the Next button to continue.
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18.3.1.5 MultiMonitor Selection Configuration

= Terminal Configuration Wizard x|

Screen Options m
: (=<

Set the aphionz for each screen.
A

—Screen A Options
¥ Allow Display Clients to move to/fiom screen

M air b anitar |'| 'I Selection Options I

— Screen B Options
[v iallow Dizplay Clients to move taffrom screer

b aity b cmitar |3 "I Selection Options |

— Screen C Ophions
[ Allows Display Clients to move toffiom screen

K ain b anitar 4 7 Selection Optiors |

< Back Hest > Finizh Cancel Help

MultiMonitor - Screen Options

Terminals using MultiSession can be configured to allow sessions to be moved from monitor to monitor for

user preference. This is configured by selecting the Allow groups to move to/from screen checkbox. If left
unselected the sessions will stay in the assigned monitor.

The Screen Options settings are:

e Allow groups to move to/from screen — This checkbox, if selected, will allow a session from a
MultiSession group to be moved to or from the monitor to suit a user’s preference.

e Main Monitor — This drop-down sets what monitor in a spanned set will display the Display Client
Selector menu.

e Selector Options — This button launches the Group Selector Options window to allow
configuration of the Display Client selector.
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Display Client Selection Options 5[
v Show Display Client 5elector Selector Options | k. I

Tiling Optionz | Cancel |

Group Selector Options Window

The Group Selector Options allows configuration of the Display Client selection when using MultiSession.

e Show Group Selector — This checkbox, if selected, will display the Display Client Selector to
allow the user to switch between MultiSession groups.

e Enable Tiling — This checkbox, if selected, allows multiple sessions to be tiled to allow a visual
selection.

The Selector Options button launches the Group Selector Options window.

Display Client Selector Options ﬂ

Cancel |

[ Tile on Selecton activatian

Selectar Menu Size Marrnal j

Group Selector Options Window

The Group Selector Options Window has three settings.

e Auto-hide Group Selector — This checkbox, if selected, will hide the drop-down Display Client
selector unless the mouse is hovering over the top center of the screen. This checkbox, if unselected,
will show the drop-down Display Client selector at the top center of the screen.

e Tile on Group Selector activation — This checkbox, if selected, will tile the sessions when an auto-
hid group selector is activated.

e Group Selector Menu Size — This drop-down sets the size of the text in the group selector.
The Tiling Options button launches the Tile Options window.

Tile Options |

¥ Show Grd

Tile Inactivity Time &0 Ca

[T Tile Display Clients at startup
[ Include Main Menu as tile
[ Tile onright click [mouse or touchscreen]

[ Tile Interactive

Tile Options Window
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The Tile Options Window has five settings.

Show Grid — This checkbox, when selected, will separate tiled sessions with black lines.

Tile Inactivity Time — This is the amount of time in seconds that will elapse before an inactive
session will revert to a tiled mode.

Tile Display clients at startup — This checkbox, when selected, will tile the display clients when the
terminal first connects.

Include Main Menu as tile — This checkbox, when selected, will display the TermSecure Main Menu
as a tiled group.

Tile on Right click (mouse or touch screen) - This checkbox, when selected, will allow a right click
in a session to activate tiling. Holding a finger on a touch screen will trigger tiling if the Right Click
Hold Time (milliseconds) is used in the touch screen module.

Tile Interactive — This checkbox, if selected, will allow a user to select a tiled session and interact
with it without un-tiling the sessions.

18.3.1.6 Allow Group to Move Configuration

Each Display Client that is to be allowed to move needs to have this property configured in the Display Client
Wizard. Open the Display Client Wizard for the desired Display Client and navigate to the Display Client
Options page.

5=\ Display Client Wizard x|
Display Chent Options m
}-’

Select the optionz that apply ta this Dizplay Client

— Client Optionz
¥ Allow Display Client to be tiled
[ Allow Display Client to be moved [Mulitonitor]

[T Include IP Camera Overlays

— Digplay Client Connection Optionz

v always maintain a connection
¥ Connect at boot-up

¥ Discornect in the background

< Back I Mest » I Finizh Cancel Help

Display Client Wizard — Display Client Options
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To configure a Display Client to be moved from one MultiMonitor screen to another, select the Allow Group
to be moved (MultiMonitor) checkbox and select the Finish button to accept the change.

See Display Client List for details on the Display Client Wizard.
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19Virtualization in ThinManager

19.1Virtualization Overview

A virtual machine is an isolated and independent install of an operating system within a host operating
system. It allows one computer to run several virtual computers on one physical device. Virtualization, the use
of virtual machines, allows the quick deployment and repetition of computers, often by duplicating a folder
with a few files.

ThinManager 4.1 includes virtualization tools to help manage virtual servers and virtual workstations in a thin
client system.

19.2VCenter Servers

VCenter is a virtual machine management tool from VMWare. It allows IT administrators to control and
manage multiple ESX servers and their virtual machines in a single console.

ThinManager can connect to a VCenter Server and allow the control and management of the virtual
machines.
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52 ThinManager =] B3
Edit Manage Instal Tools View RemoteView Help

EH;;? Cobalt Sy |
Q Terminals
ﬁ Display Servers
------ VCenter Servers
|:| Display Clients
ﬁ TermSecure Users

I Attribute

YCenter Serverz Yiew Summary

Total WCenter Servers

For Help, press F1 | b

VCenter Servers Branch in the ThinManager Tree

The ThinManager tree has a VCenter Servers branch.

Right-click on the VCenter Servers branch to add a VCenter Server. It will launch a VCenter Server
Property Wizard.
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19.2.1.1 Virtual Machine Host Name

5\ vCenter Server Property Wizard |
Virtual Machine Host Name w
Erter VM Host name and |P Address } ‘
)
VCenter Server Name ||

VCenter IP Address | 295 - 255 . 255 . 255 Discover |

— Log In Information

|ser Name I

Fassward I

Verfy Password I

Please enter a YM Server name

< Back I Hesnt Firzh Cancel Help

Virtual Machine Host Name Page
Importance of Page: Virtual Machine Host Name Page allows a VCenter Server to be defined for use within
ThinManager.
Settings:
e VCenter Server Name — Enter the name of the VCenter Server you wish to connect to.
e VCenter IP Address — Enter the IP address of the VCenter Server.
e User Name — Enter an administrative account on the VCenter Server to allow a connection.
e Password — Enter the password of the administrative account.
e Verify Password — Re-enter the password of the administrative account for verification.
Buttons:
e Discover — This button will fill in the IP address of the listed VCenter Server.
Why Change from Default Settings:
ThinManager won’t connect to a VCenter Server unless you tell it to.
Select Finish to complete the configuration.
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52 ThinManager

Edit Manage Instal Tools View RemoteView Help

=] B3

E---g;? Cobalt
Q Terminals
ﬁ Display Servers
E| @ VCenter Servers
L@
|:| Display Clients
ﬁ TermSecure Users

For Help, press F1

Surnrnary | Recent Tasks I

I Attribute | Yalue
YCenter Server Summary
Mame W-Eight
IF Address 1031048
Pt Drefault
Datacenters
Folders

Yirtual M achines

Connection Status

YCenter Server Connectio...

Attemphing to connect bo WCenter Server

| ©

o

Connecting to VCenter Server

Once the VCenter Server is defined and the VCenter Server Property Wizard is closed, ThinManager will

connect to the VCenter Server.

Automation Control Products ThinManager 5.0 Help Manual

Virtualization in ThinManager o 388




52 ThinManager M=l B3

Edit Manage Instal Tools View RemoteView Help

o
E‘W Cobalt Sumrmary | Fecent Tasksl
Q Terminals

I Attribute | Yalue

ﬁ Display Servers

: YCenter Server Summary
=[5 vCenter Servers

e Name W-Eight
|:| Display Clients IF Address 103108
- 8 Termsecure Users Port Defaul
Datacenters
Folderz

Yirtual M achines

Connection Status Connected

YCenter Server Connection Status

i

For Help, press F1 s

Connected VCenter Server

Once the VCenter Server has connected the VCenter Servers branch can be expanded to see the virtual
machine information imported from the VCenter Server.

= |f,4| VCenter Servers Tree Branch
=]- (%} Defined VCenter Server

"3 Datacenter
------ E'l_l Stopped Virtual Machine

""" Iﬁ| Suspended Virtual Machine
- E]_E- Running Virtual Machine

VCenter Server Tree Icons

The tree will show the defined VCenter Servers, datacenters in the VCenter Server, and virtual machines.

The virtual machine icons show the state they are in; stopped, suspended, or running.
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19.2.2 VCenter Server Right-Click Menus

The branches of the VCenter Server tree have various right-click menus:

e VCenter Servers:

0 Add vCenter Server — Launches the VCenter Server Property Wizard to allow a VCenter
Server to be defined.

e Defined VCenter Servers:

(0]

Remove — Removes the defined VCenter Server from ThinManager.

e Datacenter:

(0]

0

Rename — Allows you to rename the datacenter.

Delete — Allows you to delete the datacenter.

e Virtual Machine:

o0 Power Operations:
= Power On — Turns on a stopped or suspended virtual machine.
= Power Off — Turns off a stopped or suspended virtual machine.
= Suspend — Suspends a running virtual machine and stores the state.
= Reset — Cycles power to the virtual machine to restart the virtual machine.
0 Snapshot:
= Take Snapshot — Captures and stores the state of the virtual machine.
= Revert to Current Snapshot — Reapplies the stored state of a previously saved
virtual machine.
= Snapshot Manager — Launches the Snapshot management tool.
0 Rename - Allows the virtual machine to be renamed.
o Remove from Inventory — Removes the virtual machine from the tree without deleting the
files.
0 Delete — Removes the virtual machine from the tree AND deletes the file system.

19.2.2.1 Snapshots

Snapshots save the state of the virtual machine in a file. Snapshots allow you to preserve a working status
before applying new applications, programs or updates. If the changes fail or are undesired, then the
shapshot can be restored allowing the virtual machine to return to the pre-change state.

Right-clicking on the virtual machine and selecting Snapshot>Take Snapshot will launch the Create
Snapshot window.
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Create Snapshot |

Snapshot Mame I

Snapshot Description

¥ Indude virtual Machine Memory Image
[ Suspend Guest File System (requires YMWare Tools)

Create Snapshot Window

The Create Snapshot window allows you to name the snapshot and enter a description.
Select OK to save the snapshot or Cancel to close without saving.
Multiple snapshots of a virtual machine can be taken.

Right-clicking on the virtual machine and selecting Snapshot>Revert to Current Snapshot will apply the last
shapshot taken.

Right-clicking on the virtual machine and selecting Snapshot>Snapshot Manager will launch the Snapshot
Manager window.
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Dialog

T(ﬂiningE 1 Revert To
¥ T51-20011_0403

Delete

Delete Al

Edit

.

Snapshot MName ITE 1-20011_0408
Snapshot Desciption April 8, 2011 ]
hd|
Creation Date |4,rs,r.zu 119:17:05 PM

Snapshot Manager

The Snapshot Manager window shows all saved snapshots for the selected virtual machine. The Snapshot
Manager window shows the name, description, and creation date of a highlighted snapshot.
Buttons:

e Revert To — This applies the selected saved snapshot.

o Delete — This deletes a highlighted snapshot.

e Delete All — This deletes all saved snapshots.

e Edit — Opens the Create Snapshot window to allow changes to the name and description.

e OK —Closes the Snapshot Manager.
A dialog box will require confirmation before changes are made.

Revert to Snapshot |

Current virtual machine state will be lost, Revert to the selected snapshot?

Revert to Snapshot Warning
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19.3Virtual Terminal Servers

Virtual terminal servers can be added to ThinManager using two methods, Add Terminal Server and Add
Virtual Terminal Server.

Add Terminal Server — You can define a virtual terminal server as a regular terminal server in the Terminal
Server Wizard.

Right-click on the Terminal Server branch and select Add Terminal Server to launch the Terminal Server
Wizard. Add the virtual terminal server as you would a regular terminal server. This doesn't give you any
special configuration or tools.

Add Virtual Terminal Server — You can define a virtual terminal server as a virtual terminal server in the
Terminal Server Wizard.

Right-click on the Terminal Server branch and select Add Virtual Terminal Server to launch the Terminal
Server Wizard.

52 Terminal Server Wizard |

=<

Choose a VCenter Server
| v-Eight =

Choose the Virtual Machine to add as a Virtual Teminal Server

=] 5! V-Eight £3
El]_'[ ACP Datacenter
-8

() Training52
------ 1 training53
------ i training54
() Vista_Ent_VS2008

R Next > Firiish | Cancel | Help

VCenter Server Virtual Machine Selection List

The second page of the Terminal Server Wizard will display a Virtual Machine Selection Page.

Highlight the desired virtual machine and select the Next button.
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= Terminal Server Wizard |

Terminal Server Mame m
Enter the Teminal Server Name and Log In information. ’ ‘
A

Teminal Server Name

Teminal Server IP I w .5 .wm . A Dizscover |

— Log In Information
Domain I
|ser Mame I
Password I
Verfy Password I
Schedule |
< Back Mexd = Finish Cancel Help

Terminal Server Name Page

The Terminal Server Wizard will continue with the virtual terminal server filling in the fields.

These fields, and the schedule button, are the same as on the normal Terminal Server Wizard. See Terminal
Services Display Servers for details.

Select Next to continue configuring the virtual terminal server, select Finish to save the configuration and
close the wizard, or select Cancel to close the wizard without saving the changes.
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52 ThinManager Hi=] B3
Edit Manage Instal Tools View RemoteView Help

ey
E|5£<’ Cobalt 21| Config | F'ru:upertiesl Schedulel |lzers I Sessiunsl F'ru:u:essesl Graphl Event LLI_’I
[+ Terminals :
i I Attribute I alue
=~ ﬁ Display Servers - .
: ) Terminal Server ldentification
= i Terminal Servers
5 Blue Server Mame Training51
Co= IP Add 10.510.51
F- [0 Green ess
-
- j Training52 Terminal Server Configuration
Cameras Connection Types Supported Remote Dezkiop Pratocol
[+ [5 VCenter Servers Smart3 ezsion TES
[—]l:| Display Clients
Eﬁ Terminal Services Data Collection Update Times
? Calculator SrmartS ession Update Time 2
? EMail Process Information Update Time ]
@ Camera (2] Sezzion Information Update Time a

@ Terminal Shadow
[@ Workstation
[+ ﬁ TermSecure Users

B

||

For Help, press F1 | b

Virtual Terminal Servers in the ThinManager Tree

Standard Terminal Server

=4=|--- Virtual Terminal Server

+].-. = Virtual Terminal Server defined as a
.- standard Terminal Server

Terminal Server Tree Icons

Virtual Terminal Servers will show a different icon than a standard terminal server.

A virtual terminal server that is defined as a standard terminal server will show the standard terminal server
icon.
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5 Display Client Wizard |

Display Client Members \ O /
- vy

Select the Temminal Servers for this display client.

Available Terminal Servers Selected Terminal Servers
Blue (10.3.10.41) Green (10.3.10.40)
Training51 (10.5.10.51) ‘l
} Training52 (10.5.10.52)
! hd
Fe .
Edit Server List
< Back Med = Finish Cancel Help

Selected Terminal Servers in a Display Client

Virtual and standard terminal servers are treated identically when choosing display clients.

19.4Virtual Workstations

Windows workstations, XP Pro, Vista Business, or Windows 7 Pro, can be virtualized for deployment as a
desktop. ThinManager can deploy these virtual desktops to thin clients to limit the upkeep and management
of the operator’s workstation.

194.1 Workstation Display Clients

First a Workstation Display Client needs to be created. This will act as a template for the workstation
deployment. Later when the Workstation Display Client is added to a terminal you will need to assign which
virtual workstation.

Launch the Workstation Display Client Wizard by right-clicking on the Display Client branch of the
ThinManager tree or by right-clicking on the Workstation Display Client branch of the ThinManager tree.
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5 Display Client Wizard

Client Name m
Enter the Display Client name. } ‘
Client Name SalesDeskiop

Type of Display Client
Waorkstation j
Permissions |
< Back MNeat = Firzh Cancel Help

Client Name Page of Display Client Wizard

Enter a name for the Workstation Display Client. Select Workstation from the Type of Display Client drop-
down if you launched the wizard from the Display Client branch.

Select Next to continue with the wizard.
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5%\ Display Client Wizard

Display Client Options g

Select the options that apply to this Display Client

—Client Options
¥ Allow Display Client to be tiled;

[~ Allow Display Client to be moved (MultiMonitor)
™ Include IP Camera Overlays

— Display Client Connection Options

v Always maintain a connection
¥ Connect at boot-up
[ Disconnect in the background

—Wirtual Workstation Options

[T Start Vitual Machine f neceszany
[T Suspend Virtual Machine when not needed

< Back Med = Finish Cancel Help

Display Client Option Page of Display Client Wizard

The Workstation Display Client adds Virtual Workstation Options to the Display Client Options page of
the Display Client Wizard. The Client Options and Display Client Connection Options are the same as
other Display Clients. See Terminal Services Display Clients for details.

Virtual Workstation Options:

e Start Virtual Machine if necessary: This checkbox, if selected, will automatically start a suspended
or stopped virtual machine when it connects.

e Suspend Virtual Machine when not needed: This checkbox, if selected, will suspend the virtual
machine when the terminal is powered off.

Select Next to continue with the wizard.
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5% Display Client Wizard

Terminal Services Display Client Options

Select the options for this display client } ‘
i)

— Terminal Services Options

[T Smantsession

[~ Enforce Primany

[ Instant Failover
v Alow Auto-Login

< Back News | Fish | Cancel Help

Terminal Services Display Client Options Page of Display Client Wizard

The Display Client presents the Display Client Wizard similar to the Terminal Services Display Client Wizard,
with the exception of omitting the addition of terminal servers. Since workstations have a one-to-one
relationship to the terminals the workstations are assigned when the terminal is configured.

Select Finish to accept the changes and close the wizard.
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EI . Display Clients
ﬁ Terminal Services
...... ; Terminal Services Display Client Icon

Iél 5 Camera

...... @ Camera Display Client Icon

|':"| . Terminal Shadow
------- Iﬂ‘ Terminal Shadow Display Client Icon

EI @ Workstation

------- Workstation Display Client Icon

Display Client Icons

When the Workstation Display Client is created it will be added to the tree with the Workstation Display Client
icon.

19.4.2 Terminals and Virtual Workstations

Workstations can only deploy their session once to a remote user so the workstation is assigned to its remote
connection when the Workstation Display Client is applied to a terminal.

Open the Terminal Configuration Wizard for the terminal that you want to assign a workstation to.

Automation Control Products ThinManager 5.0 Help Manual Virtualization in ThinManager o 400



22 Terminal Configuration Wizard

Display Client Selection

Select the Display Clients to use on this terminal b ‘

i)
Awailable Display Clients Selected Display Clients
E HelpDesk st E SalesDesktop
[ Shadow_Al
i';':alculatur :
MM 3
@ LoadingDock T
——— By,
Edit Display Clients | [Ayerride |
< Back Mest = Eimizh Cancel Help

Display Client Selection of the Terminal Configuration Wizard

The Workstation Display Clients will show up in the Available Display Clients list on the Display Client
Selection page of the Terminal Configuration Wizard. Move the desired Workstation Display Client to the
Selected Display Client list for deployment.

Workstation Display Client Icon

Workstation Display Clients have their own icon.
Select Next to continue the wizard.
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% Terminal Configuration Wizard

Complete the Workstation Display Client Configuration t.’
Select one or more workstations to add to this display client } 5 ‘

Select workstations for Display Client "SalesDesktop”

Selected Workstations
A |
|
Add Workstation Add Virtual Warkstation | Remove |
Edit |

Add one or maore workstations to this display client

Hewnt s Eimizh Cancel Help

Complete the Workstation Display Client Configuration Page

The next page of the wizard is the Complete the Workstation Display Client Configuration Page.

Importance of Page: Each deployment of a Workstation Display Client needs to be tied to an available
workstation.

Buttons:

e Add Workstation — This button will launch a window that allows a workstation to be designated for
use by this terminal.

e Add Virtual Workstation — This button will launch a window that allows a virtual workstation to be
designated for use by this terminal.

e Remove — This button remove a highlighted workstation from the Selected Workstation list.

e Edit — This button will re-open the window that allowed a workstation to be added to the Selected
Workstation list.

e Arrows — This button will change the loading order of the assigned workstations.
Fields:

e Selected Workstations — This textbox will display the workstations assigned to the terminal.
Why Change from Default Settings:
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ThinManager won't connect to workstation unless you tell it to.

&\ Terminal Configuration Wizard |
Complete the Worlkstation Display Client Configuration m
Select one or more workstations to add to this display client } ™

Select workstations for Display Client "SalesDesktop’
Selected Worlkstations

Add Workstation |

[—

Workstation IP Address I |

 I—

Waorkstation Display Mame I

Add I Cancel |

T |
Edit |

Add one or more worlcstations to this display client

< Back et = Eirizh Cancel Help

Add Workstation Window
Selecting the Add Workstation button on the Complete the Workstation Display Client Configuration
Page will launch the Add Workstation window.
Enter the name and address of the workstation in the appropriate fields.

Select Add to accept the configuration or select Cancel to close the window.
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&\ Terminal Configuration Wizard

Complete the Workstation Display Client Configuration m
Select one or more workstations to add to this display client b - ‘

Add Virtual Workstation |
Select

Select VCenter Server I\-‘-Eight j

Select
——  Available Virtual Workstations

=[5 v-Eight - Add |
-5 AcP Datacenter

...... [Z3 Discovered virtual mar L‘Ell

[~ [ Test Folder
------ ﬁl Training51

------ 5 Trainings2
------ 51 training53
0 [ 51 trainings4 J

Vista_Ent_V52008

------ (51 vista_Ent_¥S2010 .
« | Ll_l

Add o

cBack | mews | Firish | Cancel | Help

Add Virtual Workstation Window

Selecting the Add Virtual Workstation button on the Complete the Workstation Display Client
Configuration Page will launch the Add Virtual Workstation window.

The VCenter Server tree will be displayed in the Available Virtual Workstation pane. Highlight the desired
virtual workstation and select the Add button to apply the virtual workstation to the terminal.

Select Cancel to close the window without accepting the configuration.
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22 Terminal Configuration Wizard

Complete the Workstation Display Client Configuration ﬂ

Select one or more workstations to add to this display client

Select workstations for Display Client "SalesDesktop”

Selected Workstations
W-Bight"ACP DatacenterVista_Ent_VS2008

Add Workstation Add Virtual Warkstation | Remove

S

< Back Finish Cancel Help

Complete the Workstation Display Client Configuration Page

Once a workstation or virtual workstation is assigned to the terminal it will be displayed in the Selected
Workstations window.
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52 ThinManager
Edit Manage Instal Tools View RemoteView Help
E|'*;32‘ Cobalt S ummary |
=] Terminals
B Q I Attribute | Yalue
@ Groupl . :
Q. Albh ¥irtual Machine Summary
pha
ol Moo 1 Mame Yizta_Ent_WS2008
E| s Haoszt Mame
EE SalesDesktop IP Address
. 5 Vista Ent VSI008 Guest 05 icrogzoft Windoes Yista [32-bit)
- ﬁ Pisplay Servers Mermony Size 1024 MEB
[} (5} VCenter Servers LR Court 1
[ v-Eight Provigioned Storage 4301 GB
(=|-[ll] Display Clients Comritted Storage 2259 GR
ﬂ Terminal Services
E Camera
@ Terminal Shadow
E Workstation
[+ ﬁ TermSecure Lsers
| | i
For Help, press F1 I_ o

Workstation in ThinManager Tree

The ThinManager tree will display the workstation icons for the terminal once the terminal is restarted to apply
the configuration changes.
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20Scheduling

ThinManager allows tasks to be automated with the Schedule function. This applies to Terminals, Terminal
Groups, Terminal Servers, TermSecure Users, and the ThinManager Server.

20.1Terminal Schedule

Selecting the Schedule button on the Terminal Options page will launch the Event Schedule window and
allow a schedule to be created for terminal events.
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& Terminal Configuration Wizard

Terminal Options m
(=<

Select the options for this terminal,

— T erminal Replacement

Iw ifsllow replacemnent at terminal if off line

— Terminal Schedule

¥ Set Schedule 5 chedule |

— T erminal Effects
¥ Enable Teminal Eflects
v Show terminal status meszages

— Shadowing
Allov terminal to be shadowed TES il

W Allow Interactive Shadow

< Back I Hest > I Finizh Cancel Help

Terminal Configuration Wizard - Terminal Options Page

Check the Set Schedule checkbox and select the Schedule button to launch the Event Schedule window.

Note: The Schedule for Terminal Groups is the same as for individual terminals. It has an advantage of
applying the scheduled events to a whole group of terminals instead of requiring a configuration for each
event on each terminal.

Automation Control Products ThinManager 5.0 Help Manual Scheduling e 408



Event Schedule

Event Type | Timne |
Dizable Terminal every Saturday at 11:00 P
Rezet Teminal Seszions every Saturday at 11:30 P
Enable Terminal every Sunday at 05:00 Ak

Edit [Nelete k. |

Event Schedule

The Event Schedule will list events for the terminal or group. It has four buttons:

The Add button will launch a Schedule window to allow an event to be configured.
The Edit button will allow a highlighted event to be changed.
The Delete button will remove a highlighted event.

The OK button will accept changes and close the Event Schedule window.

Events can be added by selecting the Add button to launch the Schedule window.
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Schedule |

— Ewvent Type

— Repeat |nterval
" Once Orly £ Time Interval
& wieekly /Daly ¢ Monthly = Yealy

—wieekly Schedule
[~ Monday

E D
r Tuegda_u M

[ wednesday

[ Thureday
™ Friday
[T Saturday
[~ Sunday
. ="
Tine |1n.nn P =

Cancel | ] I

Schedule Window

The Schedule window has several configuration settings.
Event Type is a drop-down box that allows event selection:

e Disable Terminal - This will prevent a terminal from being used, although its terminal server sessions
will still be running on the terminal servers.

e Enable Terminal - This will allow a disabled terminal to become active again.
e Reboot Terminal - This will cycle power on the terminal and reload its configuration.

e Reset Terminal Sessions - This will logoff the sessions that the terminal has open on terminal
servers.

The Repeat Interval radio buttons allow the event in the Event Type drop-down to be run Once Only,
Weekly/Daily, Monthly, or Yearly.

e Selecting Once Only will show a Select Date field for the event.

e Selecting Weekly/Daily will show a Weekly Schedule list for the event to run. The Every Day button
will select all the days in the list.

e Selecting Monthly will show a Select Day of Month field for the event.
e Selecting Yearly will show a Select Date field for the event.
The Time field allows the selection of the time that the event should occur.

Select the OK button to close the Schedule window.
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Select Add to add another event to the Event Schedule or select OK to close the Event Schedule window
and return to the terminal configuration.

20.2Terminal Server Schedule

The Terminal Server Name page of the Terminal Server Wizard has a Schedule button to configure a
schedule for terminal server events.

=2 Terminal Server Wizard |

Terminal Server Name m
}.-.‘

Enter the Terminal Server Hame and Log In information,

Terminal Server Mame IEreen

Terminal Server [P I 132 .88 .1 34 Digcover |

— Log In Information

Darmair I
thirrmar
Izer Hame I
Ixxxxxxxxxxxxxx
Pazsword

Ixxxxxxxxxxxxxx

Yerify Pazswaord

< Back Hest > Finizh Cancel Help

Terminal Server Wizard — Terminal Server Name Page

Select the Schedule button on the Terminal Server Name page of the Terminal Server Wizard to launch the
Event Schedule window.
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Event Schedule

Event Type | Time |

Dizable Terminal Server every S aturday at 11:00 P
Enable Terminal Server every Sunday at 05:00 Akd
Reboot Terminal Server every Sunday at 05:30 AM

&dd

Delete | k. |

Event Schedule

The Event Schedule will list events for the terminal or group. It has four buttons.

The Add button will launch a Schedule window to allow an event to be configured.
The Edit button will allow a highlighted event to be changed.
The Delete button will remove a highlighted event.

The OK button will accept changes and close the Event Schedule window.

Events can be added by selecting the Add button to launch the Schedule window.
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Schedule |

— Ewvent Type

Dizable Terminal Server

— Repeat |nterval
" Once Orly £ Time Interval
& wieekly /Daly ¢ Monthly = Yealy

—wieekly Schedule
[~ Monday

E D
r Tuegda_u M

[ wednesday

[ Thureday
™ Friday
[T Saturday
[~ Sunday
. ="
Tine | 200 PM =

Cancel | ] I

Schedule Window

The Schedule window has several configuration settings.

Event Type is a drop-down box that allows event selection:

Disable Terminal Server - This will disconnect all the thin clients connected to the terminal server.
The sessions will remain idle on the terminal server unless they are set to disconnect in the Terminal
Services Configuration console. See Disable Terminal Server for details.

Enable Terminal Server - This will allow a disabled terminal server to accept thin client connections
again.

Reboot Terminal Server - This will cycle power on the terminal server and restart it.

The Repeat Interval radio buttons allow the event in the Event Type drop-down to be run Once Only,
Weekly/Daily, Monthly, or Yearly.

Selecting Once Only will show a Select Date field for the event.

Selecting Weekly/Daily will show a Weekly Schedule list for the event to run. The Every Day button
will select all the days in the list.

Selecting Monthly will show a Select Day of Month field for the event.

Selecting Yearly will show a Select Date field for the event.

The Time field allows the selection of the time that the event should occur.

Select the OK button to close the Schedule window.
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Select Add to add another event to the Event Schedule or select OK to close the Event Schedule window
and return to the terminal server configuration.

20.3ThinManager Server Schedule

The ThinManager Server Configuration Wizard has a System Schedule page that allows the Scheduler to
be launched. This allows tasks to be scheduled for the ThinManager Server.

20.3.1.1 System Schedule

5= ThinManager Server Configuration Wizard x|

System Schedule H

Edit the system schedule
A

Syztemn Schedule

Edit Scheduls

< Back

Finizh Cancel Help

System Schedule

Select the Edit Schedule button to launch the Event Schedule window.
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Event Schedule |

Select Event Categaony I systerm ;I

Event Type | Tirne |

&dd Edit Delete

Event Schedule Window

The Event Schedule window allows events to be scheduled by selecting the Add button when system is
displayed in the Select Event Category drop-down box.
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Schedule |
— Ewvent Type

— Repart Template File
I Ewvent Log LI

— Report Output File
¥ Auto Generate Filename

— Repeat Interval

" Once Only £ Time Interval
&+ weekly / Daily £ Monthly i Yearly
—weekly Scheduls

[ Monday

[T Tuesday 4|Ever_l,l Day
[T wednesday

[T Thursday

[ Friday

[T Saturday

[T Sunday

| F:00 P =

Cancel | ]9 I

Time

Schedule for Weekly Event

The Schedule dialog allows events to be scheduled for the ThinManager. The two main events are Run
Report and Backup Configuration Database.

Select the desired event in the Event Type drop-down.
If Run Report is chosen, select the desired report in the Report Template File drop-down.

If Backup Configuration Database is chosen the backup file will be automatically chosen if the Auto
Generate Filename checkbox is selected. To use a different filename, uncheck the Auto Generate Filename
checkbox and enter the desired name in the Report Output Filename. A Browse button will appear to allow
selection of the file.

The Repeat Interval radio buttons control the frequency of the event. The time selection varies with the
Repeat Interval chosen.
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Schedule |
" Ewvent Type

IBackup Configuration Databaze ;I

— Backup Filz
[V Awto Generate Filename

Browse |

— Repeat Interval
" Once Only £ Time Interval
£ weekly £ Daily £ Manthly i Yearly

Select Day of Manth

18-

| £:00 P =

Cancel | ]9 I

Time

Schedule for Monthly Event

Select the appropriate time for the event and select OK to accept the configuration and Cancel to cancel the
changes.

While the Event Schedule window is open, other scheduled events can be viewed by selecting the event
type in the Select Events Category drop-down. The event categories are system (ThinManager Server),
terminal (Terminals), terminalserver (Terminal Servers) and user (TermSecure Users).
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Event Schedule |

Select Evert Categoy :

I arne | Ewvent Type | Time |
£ _TSE Dizable Terminal every Saturday at 11:00 PM

£ _T5E Reset Teminal Seszion:  every Saturday at 11:30 PM
£ T5E Enable Terminal every Sunday at 05:00 Akd
desk_BE20 Dizable Terminal every Saturday at 11:00 P
deszk_HE20 Reboot Terminal every Saturday at 11:30 PM

Add Edt Delete

Events Schedule

New events cannot be added for the non-system categories, but existing events can be changed by
highlighting an event and selecting the Edit button. Events can be deleted by selecting the Delete button.

The OK button accepts the changes and closes the window.
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20.4TermSecure User Schedule

TermSecure Users and TermSecure User Groups have a schedule on the User Options page of the
TermSecure User Configuration Wizard.

5= TermSecure User Configuration Wizard |

User Options E
(=

Select options for this uger.
4

—Logln / Log Out Options

Inactivity Timeout 120 zeconds
Reset Sessions at Logout -
Activate Uzer Group at Log In -

— |zer Schedule

S cheduls Schedule |

— T erminal Effects
¥ Enable Teminal Effects

— Shadowing
Al kerminal o be shadowed TES l

¥ Allow Interactive Shadow

¢ Back | Hent = | Finizh I Cancel | Help

TermSecure User Terminal Configuration Wizard — User Options Page

Check the Set Schedule checkbox and select the Schedule button to launch the Event Schedule window.

Note: The Schedule for TermSecure User Groups is the same as for individual TermSecure Users. It has an
advantage of applying the scheduled events to a whole group of users instead of requiring a configuration for
each event on each user.
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Event Schedule |

Event Type | Timne |
Dizable Uzer every day at 09:00 P
Enable Uzer every day at 06:00 Ak

Edit [Nelete k. |

Event Schedule

The Event Schedule will list events for the TermSecure User or TermSecure User group. It has four buttons:
e The Add button will launch a Schedule window to allow an event to be configured.
e The Edit button will allow a highlighted event to be changed.
o The Delete button will remove a highlighted event.
e The OK button will accept changes and close the Event Schedule window.

Events can be added by selecting the Add button to launch the Schedule window.
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Schedule |

— Ewvent Type

Dizable Uzer

— Repeat |nterval
" Once Orly £ Time Interval
& wieekly /Daly ¢ Monthly = Yealy

—wieekly Schedule
[~ Monday

E D
r Tuegda_u M

[ wednesday

[ Thureday
™ Friday
[T Saturday
[~ Sunday
. =
Tine | 7.00FM :

Cancel | ] I

Schedule Window

The Schedule window has several configuration settings.
Event Type is a drop-down box that allows event selection:

e Disable User - This will prevent a user from logging in through TermSecure or will disconnect and
existing session.

e Enable User - This will allow a user to become active again.

The Repeat Interval radio buttons allow the event in the Event Type drop-down to be run Once Only,
Weekly/Daily, Monthly, or Yearly.

e Selecting Once Only will show a Select Date field for the event.

e Selecting Weekly/Daily will show a Weekly Schedule list for the event to run. The Every Day button
will select all the days in the list.

e Selecting Monthly will show a Select Day of Month field for the event.
e Selecting Yearly will show a Select Date field for the event.
The Time field allows the selection of the time that the event should occur.
Select the OK button to close the Schedule window.

Select Add to add another event to the Event Schedule or select OK to close the Event Schedule window
and return to the terminal configuration.
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21 Reports

21.1Reports

ThinManager has the ability to run reports to show and collect data on the ThinManager system. These
reports can show the event log, configurations, uptimes, and other data.

A Reports tab on the Details pane will show a report for a highlighted ThinManager Server, terminal, terminal
group, terminal server, TermSecure user, or TermSecure user group.

Reports can be scheduled to be run and saved as * . html files for storage or further analysis.

21.2Report Template Installation

ThinManager will install a number of reports into the ThinManager folder (C-\Program
Files\Automation Control Products\ThinManager\ReportTemplates) during
installation.

Additional report templates can be downloaded from www.thinmanager.com/support/downloads.shtml as they
become available.

New reports are installed by selecting Install > Reports from the ThinManager menu. This launches the
Reports window.
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Reports |

f* Report Templates i~ S0L Files i~ |mages, Finished Reports ete.
R eport Description | Fepart Type | Fepart Template
Terminal Login Settings Fpghem TeminaldutologinS ettingsT emplate. b
Terminal Configuration Chan...  terminal TerminalConfigChanges T emplate. html
Terminal Configuration zWztem TerminalConfigurationT emplate. html
Properties of All Terminalz zpztem TeminalPropertiesT emplate. kil
Teminal Server Resource E...  terminal server TeminalServerResourcel ventzTemp
Terminal Seszion Events Log  terminal TerminalS ezsionkE ventsT emplate. htrml
Termminal Shadow Events terminal TerminalshadowE ventsT emplate. html
Terminalz Properties zpztem TerminalzRepart T emplate. html
TemSecure LogindLogout E... wser IlzerLoginE wentT emplate. html
Ewent Log Fpghem eventlogtemplate. himl
Terminal Lptime Repaort zWztem terminialuptimetenmplate. html
1] | 0

[nztall Delete

Reports Window

Select the Install button to launch a file browser.

e Report Templates — If this radio button is selected the file browser will browse for * . html files.
e SQL Files — If this radio button is selected the file browser will browse for * . sql files.

e Images, Finished Reports, etc. — If this radio button is selected the file browser will browse for
assorted files.

Laak jm: I = ReportTemplates j a £ Eg-

Ej terminals,sgl {] userlogins, sgl
Ej terminalserverresourcesyents, sgl

I‘;:J terminalsessions.sql

Ej terminalshadoweyents, sgl

Ej kerminaluptineg, sql

I?l termprops.sql

KN [+

File name: | Open I
Filez af bype: ISE!L Llueries j Cancel |

[T Open az read-only

File Browser
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Each report has a * . html component and a * . sq I component. Select the Report Templates radio
button, browse to the new * . html file, and select Open to install. Select the SQL Files radio button,
browse to the new * . s file and select Open to install. Once these two components are added the report
will be available.

21.3Selecting Reports

The reports are displayed on a Report tab in ThinManager. To select which report will be displayed on the
Report tab select View > Reports from the ThinManager menu to launch the Select Reports window.

select Reports | x| |

J | Cancel |

System Fepart IF'ru:nperties of All Terminals
Termninal Fepaort ITerminaI Configuration Changes j
Terminal 5 erver Feport ITerminaI Server Aesource Eventfj

TemSecure User Report I TermSecure Login/Logout Eventj

Select Reports Window

The Select Reports window has four fields that determine which report is displayed on the report tab.

e System Report — This selects the report to display on the report tab when the ThinManager
Server is highlighted.

e Terminal Report — This selects the report to display on the report tab when a terminal or terminal
group is highlighted.

e Terminal Server Report — This select the report to display on the report tab when a terminal
server is highlighted.

e TermSecure User Report — This selects the report to display on the report tab when a
TermSecure User or TermSecure User Group is highlighted.

Use the drop-down list to select the desired report.
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21.4Report Tab

The reports selected in the Select Reports window will be displayed on the Report tab in ThinManager.

= ThinManager M[=] E3

Edit Manage Instal Tools View RemoteView Help

E'}E{ ';D_b-?"t .Eu:unfiguraticunl Mu:udulesl Schedulel F'ru:upertiesl Event Lu:ugl Shadow Feport |
=~ M Terminals &
- B[l Groupt THINMANAGER
F- 0 Alpha M
- [ MultiMonitor 1 L
[ [ Serra Terminal Configuration
E| ﬁ Display Servers
i Terminal Servers
[+ B8 Cameras Description Time User
+- (53] VCenter 5
GJ ENIET SErvErs Terminal Created g;dgj'r;; phurns
[+ Il Display Clients s2ih
TermSecure Users Terminal Configuration 041111
2 Changed 18:22:04 iscicen
Terminal Configuration 041111 B
Changed 18:28:58 P
Terminal Configuration 041111 BRI
Changed 18:56:57 P
4] I _>I_I
For Help, press F1 I_ i
Report Tab

Highlight the desired ThinManager Server, terminal, terminal group, terminal server, TermSecure user, or
TermSecure group, and then select the Report tab to display the report.
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21.5Print Report

A Report can be printed by selecting the Report tab then selecting View > Print from the ThinManager menu.
A Print window will be displayed to allow the selection of the printer.

L >

General | I:Iptigngl

— Select Printer

F=2 HP Laser Jet 5000 Series PCL (s Macromedia FlashPaper

HP LaserJet P1006A q{,;g Microsaft ¥PS Document W
L KOMICA MIMCLTA magicolor 543000

| i
Status: Feady [ Frnttofile  Preferences |

Location:
Comment: Find Printer... |
— Page Hanage

Loy Mumber of copies: I'I 3:

{ Selection ) Current Page

" Pages |1 ¥ Collate
E nter either a single page number or a single

page range. For example, 5-12

Frint I Caricel | Apply |

Print Window

Highlight the desired printer and select the Print button to print the report.
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21.6Scheduling Reports

Reports can be scheduled to be run once at a specified time or to be run regularly at a specific time. The
reports are saved as * . html files for storage or further analysis.

To schedule report generation open the ThinManager Server Configuration Wizard by highlighting the
ThinManager Server and selecting File > Modify.

& ThinManager Server Configuration Yizard El

System Schedule ﬂ

Edit the systern zchedule
A

Syztem Schedule

Edit Schedule

Finizh Cancel Help

¢ Back

ThinManager Server Configuration Wizard — System Schedule

Navigate to the System Schedule page and select the Edit Schedule button to launch the Event Schedule
window.
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Event Schedule |

Select Event Categaony I systerm j

Event Type | Tirne |

&dd Edit Delete

Event Schedule Window

Select the Add button to open the Schedule window.
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Schedule |
— Ewvent Type

I Run Report j

— Repart Template File

T erminal Uptime B eport

— Report Output File
¥ Auto Generate Filename

— Repeat Interval

" Once Only £ Time Interval
&+ weekly / Daily £ Monthly i Yearly
—weekly Scheduls

[ Monday

[T Tuesday 4|Ever_l,l Day
[T wednesday

[T Thursday

[ Friday

[T Saturday

[T Sunday

| F:00 P =

Cancel | ]9 I

Time

Schedule Window

The Schedule window allows system events to be configured.
e Event Type — This drop-down allows the event to be chosen. There are two types:

e Backup Configuration Database — This allows a scheduling of automatic configuration
backups.

e Run Report — This allows a report to be run and saved as a * . html file on a regular basis.
e Report Template File - This drop-down allows the selection of the report to run.
e Report Output File — This applies the naming convention to the saved reports.

e Auto Generate Filename — This checkbox, if selected, will save the file to the ThinManager
folder with the report name and a time stamp as its title.

o Ifthe Auto Generate Filename is unselected, the field allows entry of the desired filename.
The filename needs to end in .html.

There are a few switches that allow the file name to be modified with a timestamp for
identification purposes. If you do not use a timestamp, the file will be overwritten each time
the report is run.

e %c — Adds date and time
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e  %h — adds hour (0-24)
e %M — adds minute (0-59)
e %x —adds date
e %X —adds time
e Repeat Interval — These radio buttons allow the frequency of the report generation to be set.

e Time — The fields to set the time of the report generation changes to match the Report Interval
selected by the radio button. The Time field may allow dates, days, hours, or intervals to be set
for the report.

Once the report is configured, select OK to accept the report schedule.

Event Schedule |
Select Event Categaony I systerm j
Ewvent Type | Time |
Fiun Report everny Wednesday Friday at 06:00 P
Fun Report every Friday at 05:00 Pk
Run Report an day 07 at 05:00 Abkd

Edit [Velete ] 4 |

Event Schedule

The scheduled report will be displayed in the Event Schedule window.
e Select Add to add another report schedule.
e Select Edit to edit the schedule of a highlighted report.
e Select Delete to delete the schedule of a highlighted report.
e Select OK to accept the schedules and close the window.

When a report is run the files are saved for viewing.

Automation Control Products ThinManager 5.0 Help Manual Reports e 430



J File Edit ‘iew Favorites Tools  Help | : ‘.'

J Qeack ~ €3 - [ F | - search Folders | & 3 X ) | =

J Address L0 C:\Program Files\aukomation Control Productsh ThinManager|\Repaorts
Mame I Size I Dake Modified | Type AI
& eventlog_2008_04_20_17_00, html 18 KE 4/20/2008 5:00 PM Firefax ..
i;| kerminaluptime_2008_02_15_21_00.html 3KE  2/15/2008 10:00 PM Firefowx D,
_ﬂ; kerminaluptime_2008_0Z_03_21_00.html 3KE  2/8/2005 10:00 PM Firefow D...
@ kerminaluptime_2008_0Z_01_21_00.html 3KE  2/1)2005 10;00 PM Firefow D,..
_ﬂ; kerminaluptime_2008_01_18_21_00.html 3KE  1/158/2008 10:00 PM Firefox D...
ﬂ; kerminalupkime_2003_01_11_21_00.html 3KBE  1/11[2008 10:00 PM Firefaowx D...
.ﬂ; kerminaluptime_2003_01_04_21_00.html IEB  1/4)2008 10:00 PM Firefox D...
ﬂ; terminaluptime_2007_12_23_21_00.html IKB  12/28/2007 10:00PM  Firefox D...
_ﬂ; terminaluptime_2007_12_21_21_00.html IKB 120212007 10:00PM  Firefox D...
i;| kerminaluptime_2007_12_14_21_00.html I3KE  12/14)2007 10:00PM Firefox D,
_ﬂ; kerminaluptime_2007_12_07_21_00.html 3KE  1207[2007 10:00 PM Firefow D...
@ kerminaluptime_2007_11_30_21_00.html 3KE  11f3002007 10:00PM Firefox D...
_ﬂ; kerminaluptime_2007_11_23_21_00.html 3KE  11[23/2007 10:00PM Firefox D...
ﬂ; kerminalupkime_2007_11_16_21_00.html IKBE 11018f2007 10:00PM  Firefox D...
.ﬂ; kerminaluptime_2007_11_09_21_00.html IEB  11/9/2007 10:00 PM Firefox D,
ﬂ; terminaluptime_2007_11_09_20_00.html IKE 1192007 9:00 PM Firefox D...
_ﬂ; terminaluptime_2007_11 _02_21_00.html 3B 11)2/2007 ;00 PM Firefox D...
i;| kerminaluptime_2007_0%_21_21_00.html 3KE  9/21/2007 ;00 PM Firefowx D,
_ﬂ; kerminaluptime_2007_0%_14_21_00.html 3KE  9/14/2007 200 PM Firefow D...
@ kerminaluptime_2007_09_07_21_00.html 3KE 97 2007 9:00 PM Firefow D,..
_-.i‘fl kerminaluptime_2007_08_31_21_00.html 3KE  8/31/2007 9:00 PM Firefox D, T
J Gl

Dimensions: 150 x 50 Type: JPEG Image Size: 2.75KE 2,75 KB | 4 My Computer p

Saved Reports

Once the report has run it can be opened in a web browser.
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{= c:\Program Files', Automation Control Products’, ThinManagerReports'.eventlog_2009_10_08_1... [H[=]
AL Ié, C\Program Files)Aukarmation (j X Iﬁ Google }'J.:.v;
J File Edit \iew Favorites Tools  Help J x %Canvert - @ Select
‘:T:E @C:'I,F‘rcugram Files! Automation Control Products! ThinMa. i J iy?i’ Y s
THINMANAGER -
=l
Event Log
10108109
Event Type Type Name Description Time User
Synchronization systemn systemn Mot Synchronized agfggfgg
Firrmware 10/08/09
Firmware system systemn firmware.acpv04.00.999 release 07-23:96 system
installed o
Terminal Capabilities Database 10/08/09
TermCap systemn systemn fermcap.db.4.0.0release’ 07-23-38 system
installed o
Synchronization systemn systemn Mot Synchronized ag’gg’lgg
) Configuration database restored 10/08/09
Caonfiguration systemn systemn from Gold_backup.db 07-35:19 systemn
Connection terminalserver Green Diata collection failed ag’lgg’lgg
Caonnection terminalserver Green Data collection established 10{08{09
07:35:20 -
4| | 3
|D-:|ne |_|_|_|_|_|_| 3’ My Compuber | L T | '7':",', 0% -~ =

Report Shown in Internet Explorer

Once the report is generated the data can be saved or reformatted as desired using standard HTML tools.
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21.7Changing the Report Logo

Each report template has a ThinManager TM3 logo as part of the report header. This can be changed to your
company logo.

1. Create a copy of the desired logo in * . Jpg format with a size of 150x50 pixels. A white
background is helpful if the logo is irregularly shaped.
2. Name the file 10go150x50. jpg.
3. Copy the 10g0150x50. jpg into the ThinManager folder ( C:\Program
Files\Automation Control Products\ThinManager\Reports by default).
4. Open the report to see the change.
= ThinManager

Edit Manage Inskall Tools Wiew Remotebiew Help

=10 x|

er

b .Licensesl F'ru:upertiesl ‘-.-’ersiu:unsl S_I,Inu:hru:unizatinnl Event Log Feport | 1 I "I

EIQ Terminals _I
Q Termiroupl
- I Term2 PB, GD&E
[+ ™ Terma
- ﬁ Display Servers T'Ermmal Prﬂ
Eﬂ---|§| Display Clienks
[+ ﬁ TermSecure Users
. Bow
Hardware Firmware
Hame Mac IP Address Maodel \ersion Uzrgr;:

Term3 0020EFBY04C2 99.93.97.71 BoxPC140 »04.00.999 5.5

-
4 I )
Far Help, press F1 | [ 4

Report with New Company Logo

The new logo will be displayed on all reports.
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22WINnTMC Fat Client

22.1WinTMC Overview

WinTMC is a ThinManager Client for PCs running Windows NT/2000/XP/Vista/Windows 7 operating systems.
WinTMC provides similar functionality to that of a Terminal. The WinTMC client can use failover, Instant
Failover, SmartSession, MultiSession, and AppLink, among others. Once the WinTMC client is installed the
client can be managed remotely through ThinManager instead of locally.

Note: WinTMC should not be installed on a computer that is running ThinManager. A port conflict will prevent
either from running properly. WinTMC is meant for PCs and not servers.

WinTMC must use Display clients.

WinTMC supports MultiMonitor if the PC has Windows running on multiple video cards.
WinTMC does not support Tiling.

See WIinTMC Installation for details on installation.

22.2Local WinTMC Configuration

When WinTMC starts, a Configure button will be displayed on the splash screen.
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e

WinTMG

WinTMC Splash Screen

Click on the Configure button to specify the ThinManager Server(s) to use.

ThinManager Server List

Enter new Thinkdanager Server Mame or IP &ddres= 0
| Add
Cancel

Set Pazsword

dd

Current T hinkdanager Servers

tove Up

tove Down

Help

About

i

WIinTMC ThinManager Server List Configuration
The ThinManager Server List allows the WinTMC to be pointed to one or more ThinManager Servers to retrieve its
configuration.

Enter the IP address or name of your ThinManager Servers in the Enter new ThinManager Server Name or
IP Address field and click the Add button to add them to the Current ThinManager Servers list.

The WinTMC will try to connect to the ThinManager Servers in the order listed, so the order can be changed
with the Move Up and Move Down buttons.
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Unneeded ThinManager Servers can be removed with the Delete button.

This configuration menu can be password protected by selecting the Set Password button. Once the
password is set, when WinTMC is started and the Configure button is clicked, a password will be required to
change the configuration.

Mo ThinManager Server specified

You muskt specify at least one ThinManager Server

No ThinManager Server Specified

If the OK button is selected without entering a ThinManager Server, an error window will remind you to enter a
ThinManager Server address.

Once the local configuration is set, WinTMC will connect to a ThinManager Server and attempt to retrieve its
configuration.

Terminal Replacement Dialog |

Choose a Terminal to replace

Aoct_1 - Accounting
Acct_2 - Accounting
Aoct_3 - Accounting
Acct_4 - Accounting
Prad_Line1a - Production
Prod_Line1B - Production
Frod_Linel1C - Production
Prod_Line2d, - Production
Prod_LineZB - Production
Salez_1-Sales

Sales 2 - Sales
Sales_3-Sales

Sales 4 -Sales

Create a new Terminal

Terminal Replacement Dialog

If the WInTMC PC has not been defined, the user will be prompted with a dialog box to allow for the creating a
new configuration or replacing an existing terminal configuration on the ThinManager Server.

This functionality is similar to that of the create/replacement menu on a Thin Client. See Replace or Create
New Mode for details on that method.

Once the WIinTMC has been assigned a configuration you will not need to make a selection again.

If you want to run WinTMC without the configure button, you can run it from a command line with the
ThinManager Servers separated by semi-colons (i.e. WinTMC TMS1; TMS2; TMS3). This will
eliminate the configure button when WinTMC is started.
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22.3WIinTMC Configuration in ThinManager

If you want to pre-create a WinTMC client in ThinManager using the Terminal Configuration Wizard, select
GENERIC for the Make/OEM and PersonalComputer for the Model on the Terminal Hardware page of the
Terminal Configuration Wizard.

22 Terminal Configuration Wizard |

Terminal Hardware m
Select the manufacturer and model of this terminal. ’ ‘
A

IUse this to corfigure the type of hardware for this teminal.

Make / OEM GENERIC j

Model PersonalCompiter

OEM Model OTHER
Video Chipset UNKNOWN

Clear |
Teminal ID Mone
Edit |
< Back Next > Eiriiah | Cancel | Help |

WinTMC Settings in Terminal Hardware

The Terminal ID will fill in with the name of the PC.

The Terminal Configuration Wizard for a WinTMC client is the same as for a thin client with a few exceptions.
These include:
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22.3.1.1 WinTMC Video Mode Page

22 Terminal Configuration Wizard

Video Resolution m
(=<

Select the video resolution for this teminal.

— Select Video Resolution

Resolution Color Depth
FullScreen j

G4k Colors

These are the resolutions supported by the Thin Client
model you selected.

< Back Mest = Finish Cancel Help

Video Resolution for WinTMC

The Video Mode for WinTMC includes a setting for FullScreen.
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22.3.1.2 WinTMC Settings Page

%% Terminal Configuration Wizard

WinTMC Settings

Select the local devices to be redirected, the experience settings and } ‘
client control settings. iy

— Redirect Local Resources
[” Redirect Serial Ports!
™ Redirect Drives
[~ Redirect Printers
[T Redirect Sound
[~ Redirect Smart Cards

—Client Control Settings
¥ Alow cliert to be closed

¥ Allow client to be sized

v Always maintain monitar connection
[ Show groups as separate windows

— Experience Settings
¥ Show desltop background

¥ Show window conterts while dragging
¥ Show menu / window animations

¥ Show themes

< Back Mest = Finish Cancel Help

WinTMC Settings
The Terminal Configuration Wizard includes a WinTMC Settings page.

WinTMC clients can also be configured on the WinTMC Settings page. These only apply to connections made
by the WinTMC fat client.

The settings include:
Redirect Local Resources:

e Redirect Serial Ports - This checkbox, if selected, will make local serial ports available in a
session. Serial Port redirection does not work when you connect to a terminal server running
Windows 2000 or earlier.

e Redirect Drives - This checkbox, if selected, will make local drives available in a session. Drive
redirection does not work when you connect to a terminal server running Windows 2000 or
earlier.

e Redirect Printers - This checkbox, if selected, will make your local printer available in a session.

e Redirect Sound - This checkbox, if selected, will allow audio played in your session to play
locally. Sound redirection does not work when you connect to a terminal server running Windows
2000 or earlier.
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e Redirect Smart Cards - This checkbox, if selected, will make your smart card available in a
session. Smart card redirection does not work when you connect to a terminal server running
Windows 2000 or earlier.

Client Control Settings:

e Allow Client to be closed - This checkbox, if selected, will enable your user to close the client
(WinTMC program).

o Allow client to be sized - This checkbox, if selected, will enable your user to resize the client.

e Always maintain monitor connection — Enable this setting to keep the monitoring connection
active when WinTMC is closed to allow shadowing. Unselecting this checkbox will release the
WinTMC license when the WinTMC program is closed but will deny shadow access.

e Show groups in separate windows — This checkbox, if selected, will display multiple Application
Groups as separate windows rather than in one window shell.

Experience Settings:

e Show Desktop Background - This checkbox, if selected, will enable your user to select a
Windows Desktop Background. If not selected, the background will be a solid color.

e Show window contents while dragging - This checkbox, if selected, will show the window
contents to be shown while the window is being dragged.

e Show menu/window animations - This checkbox, if selected, will enable menu/window
animations on the client.

e Show Themes - This checkbox, if selected, will enable your user to select a Windows Theme.

Note: These functions may be denied by user policies or terminal server configuration. Check the Microsoft
Local Policy, Group Policy, and Terminal Services Configuration. See Non-ThinManager Components for
details.
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22.3.2 MultiMonitor WinTMC

ThinManager now supports MultiMonitor for WinTMC if the PC has Windows running on multiple video cards.

Selecting the Enable MultiMonitor checkbox will allow you to configure a WinTMC client for MultiMonitor
use.

5% Terminal Configuration Wizard |

Terminal Mode Selection \ O /
=

Select the operating mades far this teminal

— Terminal Mode

V¥ Use Display Clients

¥ Enable MutiiMoritar

< Back Meaxt = Eimizh Cancel Help

MultiMonitor — Enable MultiMonitor

MultiMonitor requires the use of Display Clients. Once the Use Display Clients checkbox is selected on the
Terminal Mode Selection page the Enable MultiMonitor checkbox becomes visible.

Select the Use Display Clients and the Enable MultiMonitor checkboxes, and then select the Next button.

The Terminal Configuration Wizard will display the MultiMonitor Video Settings page, Monitor Layout
page, and Display Client Selection page like it does for thin clients. See MultiMonitor for details.

22.3.3 WinTMC Modules

WinTMC clients cannot use the ThinManager modules because they are running Windows locally. One must
install touch drivers, sound drivers, printers, and etc. through the local Windows operating system instead of
relying on ThinManager modules.
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22.3.4 WinTMC Licensing

A PC running as a WinTMC terminal requires a WinTMC license in addition to the Terminal Connection
license.

WinTMC licenses are sold with out redundancy and inherit the redundancy of the Terminal Connection
licenses in the Master License.

See Licensing ThinManager for details.
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23Shadowing

Shadowing is a popular management tool that allows an authorized user to view what is running on a remote
client. There are two methods:

e ThinManager Shadow

e Terminal-to-Terminal Shadow

23.1ThinManager Shadow

Shadowing of a terminal can be initiated from within ThinManager by using the Shadow tab in the Detail pane
of ThinManager. To shadow, highlight the desired terminal in the ThinManager tree and select the Shadow
tab.
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B ThinManager =101 x|

Edit Manage Insktall Tools Wew RemoteWiew Help

. B
Elw TMServer Eu:unfiguratiu:unl Mndulesl Schedulel F'ru:upertiesl Event Log Shadow | Hepu:urtl
= Terminals

.@ Termizroupl
Q Termz
Q‘ Terms3

- a Display Servers
- [l Display Clients
- ﬁ TermSecure Users

(|

F1

P Fub, dak ebs s on e Halp s,

iy B A

For Help, press F1 i

Shadow — Shadow Scaled to Window

The shadowed terminal can be viewed full-sized or scaled to fit in the Details pane. Select RemoteView >
Shadow scaled to Window to scale the session and unselect the option to view it life sized.

23.1.1 Shadow Access

Access to the shadow function is controlled by membership in ThinManager User Groups. By default only
administrators are allowed to shadow.

Shadowing privileges can be established through the use of ThinManager Security Groups. The

o ThinManager Administrators and Administrators can shadow terminals and interactively
control the terminal session.

. ThinManager Power Users can shadow terminals from within ThinManager but cannot interact
with the session. They are in View-only mode.

. ThinManager Interactive Shadow Users can shadow terminals from within ThinManager and
can interact with the session.

. ThinManager Shadow Users can shadow terminals from within ThinManager but cannot interact
with the session. They are in View-only mode.

. ThinManager Users cannot shadow a terminal.
. See ThinManager Security Groups for details.
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RemoteView > Interactive Shadow on the menu bar prevents the interaction with the shadowed session if

unselected.

RemoteView > Scaled to Window on the menu bar, if selected, will display the entire session in the Shadow
tab. If unselected, it will display the session at normal size with scroll bars, if needed.

23.1.2

Configure Shadowing

Shadowing can be configured on the Terminal Options page of the Terminal Configuration Wizard or
Terminal Group Configuration Wizard.

= Terminal Configuration Wizard x|

Terminal Options m
,, (=<

Select the options for this terminal.
A

— Terminal Replacement

I itullows replacemnent at terminal it off line

— Terminal Schedule

[~ SetSchedule Scheduls |

— T erminal Effects
¥ Enable Teminal Effects
¥ Show terminal status meszages

— Shadowing
Allove terminal to be shadowed = bl

v Allow Interactive Shadow

¢ Back I Hest = I Finizh Cancel Help

Terminal Configuration Wizard - Shadow Configuration

The Allow terminal to be shadowed drop-down box allows the configuration of Shadowing Options.

No - Prevents members of the Group from being shadowed.

Ask - Will display a message window that will prompt for a positive response before the
shadowing is allowed.

Warn - Will display a message window alerting the terminal that it is to be shadowed, but doesn’t
require a positive response before the shadowing is allowed.

Yes - Allows shadowing to occur without warning or recipient input.
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Allow Interactive Shadow will allow members with Interactive Shadow privileges to shadow the terminal.
The Interactive Shadow privileges are configured in the ThinManager Server Configuration Wizard. See
ThinManager Server Configuration Wizard or ThinManager Security Groups for details.

Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. Unselecting
the Allow Interactive Shadow checkbox will prevent shadowing from within ThinManager.

23.1.3 Shadow Keystrokes

Because the CTL+ALT+DEL and the CTL+ESC keystrokes can’t be sent to the local machine to the
shadowed thin client, there is a menu item to send these commands. Select RemoteView > Send Key >
Send Ctl+Alt+Del or RemoteView > Send Key > Send Ctl+Esc to send these commands.

Note: The Key Block Module will block these commands from being sent to a shadowed session.

Changing the tab or selecting another tree icon will break the shadow connection.

23.1.4 Terminal-to-Terminal Shadowing

Terminal-to-Terminal shadowing is made possible with Terminal Shadow application groups. A Terminal
Shadow application groups allow a terminal to shadow another terminal without needed to run the
ThinManager interface or to be logged in as an administrator. This Shadow Group can contain a specific
terminal or several terminals.

See Terminal Shadow Display Clients for details on configuring Terminal Shadow application groups
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23.1.4.1 Terminal Shadow Application Group

5=\ Display Client Wizard

Chent Hame
Enter the Dizplay Client name.

X

=

Clignt M arne

Type of Display Client

Permizsions |

Pleaze enter a Dizplay Client name

< Back I Hest = = Cancel

Help

Terminal Shadow Application Group - Group Name Page

Configure the Terminal Shadow Application Group by selecting Terminal Shadow from the Type of

Application Group drop-down after naming the group.

Select the Next button to continue.
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23.1.4.2 Terminal Shadow Configuration

The Terminal Shadow Application Group page allows the selection of the terminal or terminals to be

shadowed.
x
Terminal Shadow Dizplay Client m
sy

Select the terminal to shadow,

— Terminal ta Shadow
W Al Teminals &vailable

A

[Nelete |

— Shadaw Dizplay Client Optionz

< Back [ [ | Finizh I Cancel Help

Terminal Shadow Application Group — All Terminals Available

By default the Shadow Group is configured to allow all terminals to be shadowed.

Unselecting the All Terminals Available checkbox will allow the designation of specific terminals.
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=2\ Display Client Wizard X

Terminal Shadow Dizplay Client ﬂ

Select the terminal ta shadow,
A

— Terminal ta Shadow
[~ &l Teminalz Available

&dd

Delete

f

— Shadow Digplay Client Options

IV Interactive Shadow

< Back Hest = | Finizh I Cancel Help

Terminal Shadow Application Group —Select Terminals

Select the Add button to launch the terminal selection window.
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Select Terminal or Group

]
=1~ Terminals QK I

-- Group

=8 Group? Cancel

Teminal_2 A

Terminal_2_B
Teminal_2_C

- desk_B820

- Desk_Uno_2053

- Groupd

- Multiton

- Teminal_3_B

- Unitd2

- Unitd3

- finThC

& ApplGEroup

- Z_T5E

Select Terminal or Group Window

Select a terminal for shadowing by highlighting it in the Select Terminal or Group window and selecting the
OK button. The window will close after each selection.

To add multiple terminals repeat the process by selecting the Add button on the Terminal Shadow
Application Group page.
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SR\Display Client Wizard x|

Terminal Shadow Dizplay Client ﬂ

Select the terminal ta shadow,
A

— Terminal ta Shadow
[~ Al Teminals Available

Group2iTeminal_2_& Add
Group2iT emminal_2_B
GroupsTerminal_2_ T
L nit0z Delete

f

— Shadow Digplay Client Options

IV Interactive Shadow

< Back Hest = Cancel Help

Terminal Shadow Application Group — Selected Terminals

The Terminals to Shadow textbox will display the terminals added to the list.
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23.1.4.3 Shadow Selection Screen

When a terminal launches a Shadow Application Group that has multiple members a Select Terminal to
Shadow window will be displayed to allow the selection of the terminal to shadow.

Select Terminal to Shadow

I Init0e

Terminal_2_A
Terminal_2_B
Terminal_2_C

Terminal Selector

Highlight the desired terminal and select the OK button.
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24 ThinManager Security

24.1ThinManager Security Groups

Access to ThinManager can be assigned to Windows User Groups on the ThinManager Security Groups
page.
& ThinManager Server Configuration Yizard El

ThinM anager Security Groups
Azzign access to Thintdanager funchions for Windows Lser Groups. } ‘
A

YWindows User Group Delete Group |
= Gl &dd Group |

—%indows User Group Permizsions
Anailable Alloveed

Connect

Shadow

Interactive Shadow
Reszet Sezzion:

Kill Processes

Rebaoat Terminal Servers

En:nnnec:t ta Termmal 5 ervers_l_l

<

¢ Back I Hest = I Finizh Cancel Help

ThinManager Security Groups

ThinManager allows different levels of access and functionality based on standard Windows groups.
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Standard Windows Groups can be created in the Computer Management console and given different
privileges in ThinManager.

ThinManager comes with privileges pre-defined for six groups:

e Administrators - The Microsoft defined Administrator group is given all privileges by default in
ThinManager. This may be denied by unselecting the various Windows User Group Permissions.

e ThinManager Administrators have full permission to do anything within ThinManager including the
power to logoff sessions, kill processes, send messages, restart terminals, calibrate touch screens,
change terminal configurations, update firmware, update the TermCap, and restore configurations.
Administrators and members of ThinManager Administrators can shadow terminals and interactively
control the terminal session. These privileges may not be removed and will be grayed out.

e ThinManager Interactive Shadow Users - Members of this group may shadow a terminal
interactively.

e ThinManager Power Users can logoff sessions, kill processes, send messages, restart terminals,
and calibrate touch screens. They cannot change terminal configurations, update firmware, update
the TermCap, and restore configurations. ThinManager Power Users can shadow terminals from
within ThinManager but cannot interact with the session.

e ThinManager Shadow Users - Members of this group may shadow a terminal but not interactively.

e ThinManager Users can view only. They cannot logoff sessions, kill processes, send messages,
restart terminals, or calibrate touch screens. ThinManager Users cannot shadow a terminal.

Additional Windows User Groups can be configured by selecting the Add Group button to launch the New
Windows Group window.

Mew Windows Group |

Enter windows User Group Hame

IEDmputerS Lppart

Cancel |

New Window User Group Window

Adding a Windows Group name in the field of the New Window Group window and selecting the OK button
will add the Windows User Group to the drop-down list.

Note: This doesn'’t create the user group on any servers. This just adds the name of an existing group to the
list that ThinManager is maintaining.
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52 ThinmManager Server Configuration Wizard x|

ThinManager Secunty Groups

Agzign access to Thintanager functions for Windows User Groups. ’ ‘
A

Windows Lzer Graup Celete Group

Thinkanager Uszers j

i

Add Group

—%indows zer Group Permizsions

Available Allowed
Shadow . Connect
[nteractive Shadow
Reset Seszions

Kill Proceszses
Feboaot Terminal Servers
Connect to Teminal Servers

Logoff TermS ecure Users -

Uzers are allowed to shadow terminals interactively

< Back I Hest > I Finizh Cancel Help

New ThinManager Security Group

Select the group from the Windows Users Group drop-down. Choose the permissions you want to grant to
the group by double clicking on the function in the Available Windows User Group Permissions list. Members
of the Windows User Group will have the selected permissions the next time they login.

Although ThinManager has Windows User Groups pre-configured with privileges, these groups have not been
created on the terminal servers.

To Create A Windows User Group Open the Computer Management Console by selecting Start > Settings
> Control Panel > Administrative Tools > Computer Management.
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O Ccomputer Management _ O] x|

Q Eile Action Yiew ‘window Help | =] =]
e 5 | Olm| X T
Q Compuker Management (L | “
=l Svstem Tools Groupname: | ComputerSuppor]

@ Event Yiewsr S
E Shared Folders Description: |

El- : Local Users and Gt Members:

- &4 Performance Logs

L Disk. Defragmenter
ez Disk Management
EEI--@ Services and Applicatic

Add... Eemave |

Ler

LCreate I Cloze |
| | |

Created ThinManager Security Groups

Highlight Groups in the tree and select Action > New Group.

Name the group and select the Create button.

Add Users to the Windows User Group.

Members of the Windows User Group will have the selected permissions the next time they login.

If groups are not created, members of the standard Windows Administrator group have full privileges in
ThinManager while members of the standard Windows User group will be denied access.

Note: The thinserver service will need to be stopped and restarted and the users will need to re-login for the
changes to take effect.

24.2ThinManager Server Security

ThinManager has a number of security settings for the ThinManager Server. Open the ThinManager Server
Configuration Wizard by right clicking on the ThinManager Server in the tree and selecting Modify, or
highlight the ThinManager Server and select Edit > Modify from the menu.
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52 ThinmManager Server Configuration Wizard x|

Unknown Terminals

Chooze whether unknown terminals are to be allowed to connect ko } ‘
A

thiz Thintd anager Server.

— Unknawn Terminalz

Allovw unknown terminals to connect v
Require pazswaord on unknown terminalz I
Fazsword I
Canfirm I

— Automatic Terminal Creation

Enable AutalCreate v

AutaCreate tazk I.-“-‘-.utl:uT 2

< Back I Hest > I Finizh Cancel Help

ThinManager Server Configuration Wizard

The second page of the wizard has two settings related to security:

. Allow unknown terminals to connect - This, when unchecked, will prevent any new terminals
connecting to the system.

o Require passwords on unknown terminals - This checkbox, if checked, allows new terminals
to be added, but only if the installer has the password.

Note: The use of this password setting in ThinManager is an effective way to limit hardware addition to
authorized users. DO NOT use the password setting in the BIOS of the hardware. Forgetting the BIOS
password can make the unit inoperable.
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52 ThinmManager Server Configuration Wizard x|

Select whether replacement of offline terminals iz allowed on thiz
Thinkdanager Server.

Terminal Replacement m
}-.‘

— Replacement

Check the "Enable Replacement' box to allow new terminals to replace
offline terminalz

Enable Replacement v

< Back I Hest > I Finizh Cancel Help

Terminal Replacement

On the Terminal Replacement page of the ThinManager Server Configuration Wizard is the Enable
replacement checkbox. This allows failed terminals to be replaced. If this is unchecked, terminals can still be
added, but only by using the Create New Terminal process.

This is a global setting that affects all terminals connected to this ThinManager Server. The Enable
replacement checkbox is also found on the Terminal Configuration Wizard of each terminal and the
Terminal Group Configuration Wizard of each Terminal Group so that the setting can be applied to
individual terminals and Terminal Groups.

24.2.1 Windows Security

The ACP ThinManager system delivers a Windows 2000/2003/2008 desktop to each thin client by default.
Each thin client has full access to the server resources, as if it is the server. However, just because the thin
client has the ability to have full access to the server resources doesn’t mean that the user should be granted
full access to the server. To prevent unauthorized changes to the server, it is recommended that each user
profile have security policies applied through the System Policy Editor to limit access to the needed functions.
Windows 2000/2003/2008 Security procedures are discussed in the Windows on-line help and in many books
and articles.

Administrators usually require that each user login to a terminal with their personal account and have the
Microsoft policy determine the user’s access rights.
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Note: Task Manager has a feature that allows the launching of applications. If using an Initial Application,
access to Task Manager should be denied in the security policy or with the Key Block Module to prevent a
user from launching unauthorized programs.
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25 TermSecure

25.1TermSecure Overview

TermSecure is a ThinManager feature that allows users to logon to a thin client and access user-specific or
terminal-specific Display Clients. This does not replace the Windows logon, but adds an additional layer of
security and control.

TermSecure has two main strategies:

e SecureAccess or Terminal-specific Applications: You can assign a display client to a terminal
and keep it hidden from operators with Permissions. A user with the proper TermSecure
credentials will be able to reveal and access the hidden application.

An example would be a recipe program that would allow a supervisor to initiate a product change.
This belongs to the station on the floor but you want to prevent users from initiating the change.

e SmartContext or User-specific Applications: You can assign Display Clients to a TermSecure
user and they can get access to it from any terminal in the plant. This can be initiated by either
manual login or the use of an authentication device.

This allows a user to leave one terminal, logon to a different terminal, and reconnect to their
session, essentially having the session follow him from terminal to terminal.

An example would assign a session with reports to a quality control worker who could login
anywhere and retrieve their reports.
SecureAccess or Terminal-specific Applications are controlled with Permissions.

SmartContext or User-specific Applications are controlled by adding the Display Client to the TermSecure
User configuration.

Note: TermSecure requires the usage of Display Clients instead of using individual terminal servers.

Five licenses of TermSecure are included with each Master License activation. Additional TermSecure
licenses can be purchased to add to the Master License.

25.2Users Types

There are three types of users in a ThinManager system. Windows Users and TermSecure Users are
important to TermSecure.
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25.2.1 Windows Users

Windows Users are the Microsoft accounts created in Windows that allow access to the Windows terminal
servers. These are configured within Windows and authenticated by Windows. They can be given varying
levels of access and power using Windows User Groups and Group Policies.

25.2.2 TermSecure Users

TermSecure Users are users who can go to a thin client and receive access to specific Display Clients due
to their membership in a TermSecure Access Group. The login and authentication is done by ThinManager a
level above the Windows login.

TermSecure grants and limits access to terminals and Display Clients but a Windows User login is still
required to actually logon to the terminal server.

25.2.3 ThinManager Security Group Users

ThinManager Security Group Users are Windows User Group members who have been configured in the
ThinManager Server Configuration Wizard to have varying levels of access and control within the
ThinManager program.

These groups are configured on the ThinManager Security Groups page of the ThinManager Server
Configuration wizard. See ThinManager Security Groups for details.

25.3Deploying TermSecure

TermSecure may require a number of steps to configure and deploy TermSecure:

1. TermSecure Access Groups can to be created to use Permissions (optional).
See Creating Permissions Groups for details.

2. Terminals can be assigned TermSecure Access Groups to limit access to specific users (optional).
See Permission Groups for Terminals for details.

3. Display Clients can be assigned TermSecure Access Groups to limit access to specific users
(optional).
See Permission Groups for Display Clients for details.

4. TermSecure Users need to be created.

TermSecure Users can be assigned to TermSecure Access Groups (optional).
See TermSecure User Configuration Wizard for details.

6. A Login strategy needs to be put in place. The TermSecure User can use the Terminal Login, their
TermSecure login, or a Windows login to access the terminal servers.
See Windows Login Information for details.

7. USB drives and ProxCards, if used, need to have the identification number entered in their
configuration (optional).
See Card/Badge Information for details.

8. The TermSecure User can then login to a thin client using TermSecure
TermSecure prompts the TermSecure User to login to the terminal servers using a Windows User
account, or it will pass the pre-configured Windows User account information to the terminal server
for auto-login, based on the login strategy selected.

9. The TermSecure User is granted access to all Display Clients that share the same TermSecure
Access as the TermSecure User, and is denied access to Display Clients that they don't share a
TermSecure Access Group membership.
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26 Permissions

Permissions restrict access to applications unless a person has been given a TermSecure login and the
matching permission set.

26.1Creating Permissions Groups

Permissions grant or limit access through the TermSecure Access Groups. Select the Permissions button in
the Terminal Configuration Wizard, the Terminal Group Configuration Wizard, the Display Client
Wizard, the TermSecure User Wizard, or the TermSecure Users Group Wizard to set these up.

e Terminal Permissions is the list of named permission groups whose members may
access a terminal. The Unrestricted group does not require a membership to access.

e Terminal Group Permissions is the list of named permission groups whose members
may access a terminal belonging to the Terminal group. The Unrestricted group does
not require membership to access.

e Display Client Permissions is a list of named permission groups whose members may
access and view a Display Client. The Unrestricted group does not require a login.

e TermSecure User Permissions is a list of named permission groups to which a
TermSecure User belongs.

e TermSecure User Group Permissions is a list of named permission groups to which
members of a TermSecure User Group belong.

A TermSecure User can use a terminal when they share membership in a TermSecure Access
Group.

A TermSecure User can use a Display Client when they share membership in a TermSecure
Access Group.
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26.1.1.1 Creating a TermSecure Access Group

Selecting Manage > TermSecure Access Groups from the ThinManager menu will launch the Access
Groups window.

Access Groups |

nrestncted
Al Users

Edit

[=

Add

Delete

i

Access Groups Window with Default Groups

Select the Add button to add an Access Group. The Add button launches an Access Group window.

Access Group

=]
Enter Group Hame

|| Cancel

E dit Members |

Permission Group Creation Window

Enter a name for the new TermSecure Access Group and select OK to create the group.
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Access Groups

IJrrestricted 0]
Al Jzers
S LIpEMiSOrE

ITzervices

Edit

-kl

&dd

Delete

[

Additional TermSecure Access Groups Created

The created Access Groups will be displayed in the Access Group window. These TermSecure Access
Groups, like Microsoft User Groups, do not have settings and parameters, but instead get their usefulness by
adding members to them or applying restrictions to them.

26.2Permission Groups for Terminals

TermSecure Access Groups are assigned to a terminal with the Permissions button on the first page of the
Terminal Configuration Wizard.

Note: Removing the Unrestricted group from a terminal and replacing it with a TermSecure Access group will
render the terminal functionless until a member of the group logs in.

Open the Terminal Configuration Wizard for an existing terminal by double clicking on it in the tree. Start the
Terminal Configuration Wizard for a new terminal by selecting Edit > Add Terminal.
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22 Terminal Configuration Wizard

Terminal Name ("
Enter the name for this teminal, select the terminal group to which } ‘
this terminal belongs, or choose to copy the corfiguration from A
another terminal.

— Terminal Mame

Siema

This must be a unigue name using letters, numbers, yphens (),
and underscores (_) only.

— Terminal Group

I Change Group |
— Copy Settings
[T Copy Settings from another Teminal Copy Frarm |
cBack | Mets | Fueh | Cancel Help

Terminal Configuration Wizard

Select the Permissions button on the first page of the Terminal Configuration Wizard to launch the
Permissions window to apply the TermSecure Access Groups to the terminal.

Permissions |

TermSecure Acces: Groups

Aoailable tember OF

Al Uzers
ITzervices
Supervizors

1
<

Permissions Window
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By default, the terminal uses the Unrestricted access group, allowing anyone access to the Display Clients
that are assigned to the terminal.

If Additional Permission Groups are configured, they will be displayed in the Available list. Access can be
granted or denied by moving the Access Groups into or out of the Member Of list by double clicking or
highlighting the desired group and selecting an arrow.

Permissions |

TermS ecure Accesz Groups

Ayailable tember Of

Al Uszers
ITzervices
nrestricted

|« |~

Object Permissions

If the terminal has the Unrestricted access group removed from Member Of list and is replaced by other
Access Groups, TermSecure will deny access to the terminal except for members of the selected access
groups.

Note: Removing the Unrestricted group from a terminal and adding a different group will render the terminal
functionless until a member of the group logs in.

Select OK to close the Permissions window.

26.3Permission Groups for Display Clients

TermSecure Access Groups are assigned to a Display Client with the Permissions button on the first page of
the Display Client Wizard.

Open the Display Client Wizard for an existing Display Client by double clicking on it in the tree. Start the
Display Client Configuration Wizard for a new Display Client by right clicking on the Display Client branch icon
and selecting Add Display Client.
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5%\ Display Client Wizard

Client Name m
Enter the Display Client name. } ‘
Client Mame HMI

Type of Display Cliert
Terminal Services j
< Back Mexd = Finish Cancel Help

Display Client Configuration Wizard

Select the Permissions button on the first page of the Display Client Configuration Wizard to launch the
Permissions window to apply the TermSecure Access Group to the Display Client.

Permissions |

TermSecure Access Goups

Anailable tember Of
Al Users
ITservices
Supervizors

Permissions
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By default, the Display Client uses the Unrestricted access group, allowing anyone access to the Terminal
Server.

If Additional Permission Groups are configured, they will be displayed in the Available list. Access can be
granted or denied by moving the Access Groups into or out of the Member Of list by double clicking or
highlighting the desired group and selecting an arrow.

Permissions |

TermS ecure Accesz Groups

Ayailable tember Of

Al Uszers
ITzervices
nrestricted

|« |~

Permissions Changed

If the Display Client has the Unrestricted access group removed from Member Of list and is replaced by
other Access Groups, TermSecure will deny access to the terminal except for members of the selected
access groups.

Note: Removing the Unrestricted group from a terminal and adding a different group will hide the Display
Client until a member of the group logs in.

Select OK to close the Permissions window.

26.4Permission Groups for TermSecure Users

TermSecure Access Group permissions can be applied to TermSecure Users. This is useful for
SecureAccess or Terminal-specific Applications.

Create a TermSecure User to apply the permissions by right clicking on the TermSecure User branch of the
ThinManager tree and selecting Add TermSecure User.

TermSecure Access Groups are configured on the first page of the wizard by selecting the Permissions
button.
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26.4.1.1 TermSecure User Information

22 TermSecure User Configuration Wizard

TermSecure User Information
<

Erter TermSecure usemame, password and pemission infamation.

— TermSecure User Information

|Iser Name I;’-‘-J:Iam

Password

I

Verify Password I“"‘“

Password Options |

— Eroup

I Change Group

— Copy Settings

[T Copy Settings from another Lzer Copy Franm

Pemissions |

CHE Next > Fish | Cancel Help

TermSecure User Information

Selecting the Permissions button will open the Permissions window that allows the assignment of a
TermSecure Access Groups.

Permissions |

TermSecure Access Goups

Anailable tember Of
ITservices :

Permissions
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The Permissions window for TermSecure Users does not show the Unrestricted or the All Users groups,
just the created groups. Access can be granted or denied by moving the Access Groups into or out of the
Member Of list by double clicking or highlighting the desired group and selecting an arrow.

Select OK to close the Permissions window.

Select Next to continue with the TermSecure User Configuration Wizard.

26.4.1.2 Card / Badge Information

The second page of the TermSecure User Configuration Wizard is the Card/Badge Information page.
52\ TermSecure User Configuration Wizard |

Card / Badge Information w
Enter card/badge information f user has one. } ‘
o

[ iThiz uzer will use a card, badge, or other device to log in:

—Card / Badge Information

Enter Card/Badge |10 number

[T &lways Prompt for Pazswornd

< Back Mext = Finish Cancel Help

Card / Badge Information Page

The Card / Badge Information Page enables the use of Identification devices such as USB flash drives, HID
ProxCards, and WaveTrend Radio Frequency IDs (RFIDs) as login devices. This will be covered later. See
Card and Badge Configuration for a TermSecure User for details

Note: Terminals using the USB flash drives, HID ProxCards, and WaveTrend RFIDs, as login devices will
need the appropriate module added. See TermSecure Modules for details.

Select the Next button to continue with the configuration.
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26.4.1.3 Display Client Selection
The next page of the TermSecure User Configuration Wizard is the Display Client Selection page.

58 TermSecure User Configuration Wizard |

Display Client Selection

Select "Yes" to specify Display Clients for this user. } ‘
)

Add Userspecific Display Clients 7

Answer "es" here f you want to select userspecific Display Clients in
addition to the Display Clients that are in the terminal configuration.

Any userspecific clients will be added to the clients specified in the teminal
configuration.

< Back Mest = Finish Cancel Help

Display Client Selection

The Display Client Selection page allows Display Clients to be assigned to the TermSecure User.

Add User specific Display Clients? - This setting, if set to No, will allow the TermSecure User to access the
display client hidden on a terminal with the TermSecure Access Group permissions. This is used with
SecureAccess or Terminal-specific Applications.

This setting, if set to Yes, will allow the selection of Display Clients for the TermSecure User that will be
added to the terminal when the TermSecure User logs in top the terminal. This is used with SmartContext or
User-specific Applications.

Select the Next button to continue with the configuration.
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26.4.1.4 Terminal Interface Options

The next page of the TermSecure User Configuration Wizard is the Terminal Interface Options page.
5% TermSecure User Configuration Wizard |

Terminal Interface Options ﬂ

Select the group selector and main menu options that will be
available on the teminal. N

— Display Client Selection Options
[ Use Temminal Settingsi

¥ Show Selector on Teminal Selector Options |

[~ Enable Tiling Tilirig [ ptichs |
[~ Screen Edge Display Client Selection

Main Menu Options

Main Menu Options

< Back Mest = Finish Cancel Help

Terminal Interface Options

The Terminal Interface Options page sets the menus and hotkeys for the TermSecure User so a terminal
using MultiSession will need to have a method to switch between sessions.

See Terminal Interface Options for details.
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26.4.1.5 Terminal Hotkey Options

The next page of the TermSecure User Configuration Wizard is the Terminal Hotkey Options page.

5% TermSecure User Configuration Wizard |

Termminal Hotkey Options (.,
Select the haotkeys that will be available on the teminal . ’ 5

~ Terminal Hotkeys

[™ Use Teminal Settings:
I~ Enable Instant Failover Hotkeys [Change Haotkeys |
[¥ Enable Display Client Hotkeys Change Hotkeys |
I™ Enable Tiing Hotkey Change Hofiey |
< Back Mest = Finish Cancel Help

Terminal Hotkey Options

Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations that
allow switching between sessions.

See Terminal Hotkeys for details.
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26.4.1.6 User Options
The final page of the TermSecure User Configuration Wizard is the User Options page.
5% TermSecure User Configuration Wizard |

U=zer Options F;"

Select options for this user.

—Log In / Log Out Options
Inactivity Timeout 1.20 seconds
Reset Sessions at Logout r
Activate User Group at Log In r
— User Schedule
[ Set Schedule Schedule |
— Terminal Efects
¥ Enable Teminal Efects
— Shadowing
Allow teminal to be shadowed YES Bl
¥ Allow Interactive Shadow

« Bacit Hent > | Fish |  Cancel | Help

User Options

See User Options for details.

Select Finish to finish the configuration.

26.5Shortcut Method of Adding TermSecure Access
Groups

Members can be added to TermSecure Access Groups quickly through the TermSecure Access Group
Wizard.

Open the TermSecure Access Group Wizard by selecting Manage > TermSecure Access Groups from the
ThinManager menu. This will launch the Access Groups window.
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Access Groups

IJrrestricted
Al Users

Levell
Lewvel?

K

Edit

-kl

&dd

Delete

[

Access Groups Window

Highlight the desired TermSecure Access Group and select the Edit button.

Access Groups E |

Inrestricted
Al Uszerz

Levell
Level?

Access Group

E nter Group Mame
Edit tembers |

Access Group Window

Select the Edit Members button to launch the Access Group Members window.
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Access Group Members

& Teminals

" Teminal Server Groups " TemSecure Users

Terminal Mame

| Terminal Path

Cancel

i

&dd

Remove

[

Access Group Members Window

Select the Terminals, Display Clients, or TermSecure Users radio button to configure that category and

Select Terminal | x| |

select the Add button.

[=]- Terminals
- MasterGroup
- 1_5820
2 UWD
3 _Anstahi24
4 Spare
e B WARTMC

Cancel

ok I
[Eem=

Select Terminal Window

A Select Terminal window will be displayed with a tree of the configured terminals and terminal groups.
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Select the desired terminals and terminal groups and select OK for each addition.

Access Group Members

" Teminals

™ Dizplay Clients i~ TemSecure Users

Termninal Mame

| T erminal Path |

Q Term3

Cancel

x|
ak. |
L

Femove |

Access Group Members

The Access Group Members window will show the members of the TermSecure Access Group. These can be
removed by highlighting and selecting the Remove button.

Display Clients and TermSecure Users can be added by the same process of adding by selecting the

appropriate radio button.

Access Group Members

" Terminals

select Application Group

* fpplication Groups " TemSecurs Users

Applicatiaon
ﬁ i Report:

ESktDp_EIau:k
Deszktop_Cream = |
Desktop_Green ance |
Desktop_Tan

Graphicz

Reparts

Shadow_5E20
Shadow_ Ay

]|

i —_————=

E|
k. |
_ Carcsl |

Cancel

Femove |

Display Client Selection
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Access Group Members

= Teminals * Application Groups " TemSecurs Users ok

Cancel

Application Group |

@ Analytics
Add
@ Reparts

Remove

R

Member Display Clients

Members can be removed by highlighting them and selecting the Remove button.

26.6TermSecure User Configuration Wizard

A TermSecure User can be configured with a user name, password, and user-specific Display Clients. When
the user logs into a terminal with that identity, TermSecure will allow the user access to the personalized
Display Clients for that user in addition to the Display Clients already assigned to the terminal.

Note: The TermSecure Users branch of the ThinManager tree will not be visible unless a Master License is
installed on the ThinManager Server.

The TermSecure User Configuration Wizard is launched by right clicking on the TermSecure Users branch
of the ThinManager tree and select Add TermSecure User.
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26.6.1.1 TermSecure User Information
The first page of the TermSecure User Configuration Wizard is the TermSecure User Information page.

== TermSecure User Configuration Wizard |

TermSecure User Information W
.-.‘

Erter TermSecure usemame, password and pemission infomation.

— TermSecure User Information

|ser Mame |

Password I
Verfy Password I

Password Options |

—Group

I Change Group

[T Copy Settings from anaother Lser Copy Fram

— Copy Settings

Pemissions |

Flease enter a name

cBack | e | Fish | [ Cancel | Help

ThinManager User Information

The TermSecure User Information has fields for the user name and password that will be used by the
TermSecure User to log into ThinManager security to access TermSecure functions.

The TermSecure User Information is for account information:

e User Name - Enter the user name that the user will use to log into the TermSecure system. Although
this can be the same as the Windows user name, the TermSecure user name is independent of the
Microsoft Windows login. This TermSecure user name can be tied to a Windows login later in the
wizard on the Windows Login Page.

e Password - Enter the password for the TermSecure User in this field.
o Verify Password - Re- enter the password for the ThinManager User in this field.

e The Password Options button launches the Password Maintenance Options window that
regulates rules for the ThinManager User password.
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Password Maintainance Options |

— Paszword Complexity Beguirements

Minimum Pazzword Length ||!1

[ Must contain numberz [ Must contain symbols
[ Must contain capital letters

— Paszword Maintainance

[T Allow User to change password
™ Force User bo change password at next login

[ Force Uzer to change password periodically

Izer musgt change pazswaord every I danz
Cancel | ] I

Password Maintenance Options

Password Complexity Requirements:

e Minimum Password Length - Sets the amount of characters that the password must contain to be
valid.

e Must contain numbers - This checkbox, if checked, will require that the password contain at least
one number in it.

e Must contain symbols - This checkbox, if checked, will require that the password contain at least
one symbol in it.

e Must contain capital letters - This checkbox, if checked, will require that the password contain at
least one capital letter in it.

Password Maintenance:

e Allow User to change password - This checkbox, if checked, will allow the user to change the
password at the TermSecure menu.

e Force User to change password at next login - This checkbox, if checked, will require the user to
change the password at the TermSecure menu when they login the next time.

e Force User to change password periodically - This checkbox, if checked, will require the user to
change the password at the TermSecure menu on the schedule set by the User must change
password every X days field.

e User must change password every X days - This field sets the time period between the scheduled
password changes caused by the Force User to change password periodically checkbox.

The OK button closes the window with any changes. The Cancel button closes the window without changes.
Group:

e The Change Group button opens the Choose User Group window that allows a User to be placed
in an existing TermSecure Users Group.
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Choose User Group

5|
El- U_sers QK I

=1 East

- Delaware Cancel
- b aryland
- Mework,
[=]- Morth

- Michigan
- Ohino

- Wizconzin
= South

- Florida

- [Ae0rgia
= West

- Arizoha

- Califormia
- Mevada

Choose User Group

If TermSecure User Groups have been created, the Choose User Group window will display the
TermSecure User Group branch of the ThinManager tree.

To add the TermSecure User to a TermSecure Users Group, highlight the desired TermSecure Users
Group and select the OK button.

To change the TermSecure User to a different TermSecure Users Group, highlight the desired
TermSecure Users Group and select the OK button.

To remove the TermSecure User from all TermSecure Users Groups, highlight the top-level Users
branch and select the OK button.

The OK button closes the window with any changes. The Cancel button closes the window without changes.

Copy Settings:

The Copy Settings from another User checkbox, if selected, activates the Copy From button that

allows the configuration of an existing TermSecure User to be applied to the current TermSecure
User.

The Copy From button opens the Select User window that allows the selection of the desired
TermSecure User configuration.
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Select User

5|
El- U_sers QK I

[+ East
= Marth Cancel
EI Wiscunsin

i BillCheddar

i MaryMozzarella

[+ South

[+ "West

- Bdams

- Jefferson

- Madizon

- Monroe

- Wy aghinighan

Select User Window
The Select User window will show a tree with the existing TermSecure User Groups and the TermSecure
Users.

Highlight the TermSecure User whose configuration you want to copy and select the OK button. The OK
button closes the window with any changes. The Cancel button closes the window without changes.
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26.6.1.2 Card / Badge Information
The next page of the TermSecure User Configuration Wizard is the Card/Badge Information page.

5% TermSecure User Configuration Wizard |

Card / Badge Information w
Erter card/badge information f user has one. } ‘
A

[ This user will use a card, badge, or other device to log in!

—Card / Badge Information

Enter Card/Badage |0 number

[T &lways Prompt for Pazsword

< Back Meast = Finish Cancel Help

Card / Badge Information Page

The Card / Badge Information Page enables the use of Identification devices such as USB flash drives, HID
ProxCards, and WaveTrend Radio Frequency IDs (RFIDs) as login devices. This will be covered later. See
Card and Badge Configuration for a TermSecure User for details

Note: Terminals using the USB flash drives, HID ProxCards, and WaveTrend RFIDs, as login devices will
need the appropriate module added. See TermSecure Modules for details.

Select the Next button to continue with the configuration.
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26.6.1.3 Display Client Selection
The next page of the TermSecure User Configuration Wizard is the Display Client Selection page.

& TermSecure User Configuration Wizard |

Display Client Selection

Select "Yes" to specify Display Clients for this user. * ‘
A

Add Userspecific Display Clients 7

Answer "es" here f you want to select userspecific Display Clients in
addition to the Display Clients that are in the terminal configuration.

Any userspecific clients will be added to the clients specified in the teminal
configuration.

< Back Mest = Finish Cancel Help

Display Client Selection

The Display Client Selection page allows Display Clients to be assigned to the TermSecure User. When the
TermSecure User logs onto a terminal, these Display Clients will be available on the terminal for him.

Add User specific Display Clients? - This setting, if set to Yes, will allow the selection of Display Clients for
the TermSecure User that will be added to the terminal when the TermSecure User logs in top the terminal.
This provides the user-specific Display Clients.

This setting, if set to No, will rely on Permissions to grant access to terminal-specific Display Clients.
Select the Next button to continue with the configuration.
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26.6.1.4 Display Client Specification

The next page of the TermSecure User Configuration Wizard is the Display Client Specification page.

5% TermSecure User Configuration Wizard |
Display Client Specification m‘
Select the Display Clients to which this user can connect. ’ ‘
A
Awailable Display Clients Selected Display Clients

E HelpDesk ﬂﬂepnrts

E; |'| a I:I L _,".‘."

@XP] 1 | ﬂ

1
[T
o 1
= B
o
=]
|A|v

@ LoadingDock

Edit Display Clients Cvemde |

< Back Mest = Finish Cancel Help

Display Client Specification Page
The Display Client Specification page allows Display Clients to be assigned to the TermSecure User if the
Add User specific Display Clients? radio button is set to Yes.

Move a Display Client you want the TermSecure User to use into the Selected Display Clients list by
double-clicking on it in the Available Display Clients list or by highlighting it and clicking the Right Arrow
button.

To add a new Display Client, select the Edit Display Clients button to launch the Display Client Wizard. See
Display Client List for details.

Select the Next button to continue with the configuration.
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26.6.1.5 Windows Login Information
The next page of the TermSecure User Configuration Wizard is the Windows Log In Information page.

& TermSecure User Configuration Wizard |

Windows Log In information W
Erter Windows usemame and password information } . ‘

—Windows Log In Information

[ Use Teminal Configuration Login Information:

[~ Same as TemmSecure User usemame/password

|Isemame

Werify Password

|
Password I
|
|

Domain

< Back Mext = Finish Cancel Help

Windows Login Information

The Windows Log In Information page allows the configuration of how the TermSecure User will log on to
the Windows terminal servers.

There are several Windows login options for the TermSecure User.

1. The TermSecure User can use the terminal’s username and password to auto-log on to the terminal
server. To do this, check the Use Terminal Configuration Login Information checkbox

2. The TermSecure User can use the TermSecure User username and password to auto-log on to the
terminal server. To do this, check the Same as TermSecure User username/password checkbox.
The TermSecure User username and password must match a Windows User username and
password to get authenticated by Windows.

3. The TermSecure User can use a separate username and password to auto-log on to the terminal
server. To do this, use the fields for the Username, Password, and Domain that are provided.

4. The TermSecure User can be required to manually log onto the terminal servers. To do this, leave the
checkboxes unchecked and the Username, Password, and Domain empty.

Select the Next button to continue with the configuration.
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26.6.1.6 Terminal Interface Options

The next page of the TermSecure User Configuration Wizard is the Terminal Interface Options page.

5% TermSecure User Configuration Wizard |

Temminal Interface Options m
Select the group selector and main menu options that will be } - ‘

available on the teminal.

— Display Client Selection Options
[ Use Temminal Settingsi

¥ Show Selector on Teminal Selector Options |

[~ Enable Tiling Tilirig [ ptichs |
[~ Screen Edge Display Client Selection

Main Menu Options

Main Menu Options

< Back Mest = Finish Cancel Help

Terminal Interface Options

The Terminal Interface Options page sets the menus and hotkeys for the TermSecure User so a terminal
using MultiSession will need to have a method to switch between sessions.

Group Selector Options allow on-screen switching of sessions.

Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the properties
that were configured for use with the terminal.

Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down
menu that can be activated by mouse.

Enable Tiling - This checkbox, if selected, allows the sessions to be tiled so that the user can make a
visual selection of the desired selection.

Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch
windows if the mouse is moved off screen.

Selector Options - This button, if selected, will launch the Group Selector Options window.

Tiling Options - This button, if selected, will launch the Tile Options window.
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Display Client Selector Options

[ Tile on Selector activation Cancel
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Group Selector Options Window

The Group Selector Options window has several settings.

The Auto-hide Group Selector checkbox will hide the Group Selector until the mouse is moved to
that space.

The Tile on Group Selector checkbox, when selected, will tile the Display Clients when the auto-hid
selector is chosen. This allows the user to select from the available sessions.

Select the OK button to accept changes or the Cancel button to close.

The Tiling Options button will launch the Group Selector Options window that allows configuration of the
on-screen Group Selector bar.

Tile Options |

Tile Inactivity Time IEEI Cancel |

[T Tile Dizplay Clients at startup

[ Include Main Menu as tile

[T Tile onright click [mouse or touchscreen)

[T Tile Interactive

Tile Options

The Tile Options window has several settings.

Show Grid — This checkbox, when selected, will show the tiled sessions in a grid with each grid
labeled with the session name as while the session is loading.

Tile Inactivity Time — This field sets the length of time that the terminal screen will stay focused on a
selected session before reverting back to a tiled state due to inactivity.

Tile Display Clients at startup — This checkbox, when selected, will show the sessions tiled when
the terminal first connects to its sessions.

Include Main Menu as tile — This checkbox, when selected, will include a session displaying the
TermSecure Main Menu.

Tile on Right click (mouse or touchscreen) - This checkbox, when selected, will initiate tiling when
a session is right clicked.

Tile Interactive — This checkbox, when selected, will allow a user to click into a tiled session and
control it interactively without switching focus to a single session. To focus on a single session use
the Group Selector Dropdown or the tiling hotkey (CTL + T), if enabled.

Select the OK button to accept changes or the Cancel button to close.

Automation Control Products ThinManager 5.0 Help Manual Permissions e 491



The Main Menu Options button will launch the Main Menu Options window that allows configuration of the
TermSecure Main Menu.

Main Menu Options Ed |

[~ Usze Teminal 5ettings

[ Allow reboot # restart

Cancel |

¥ Show Main Menu on Selector

Main Menu Options Window
The Allow Reboot/Restart checkbox, if selected, will add a Reboot and Restart button to the main menu.

26.6.1.7 Terminal Hotkey Options

The next page of the TermSecure User Configuration Wizard is the Terminal Hotkey Options page.

& TermSecure User Configuration Wizard |
Temminal Hotkey Oplions @
Select the hotkeys that will be available on the teminal. ’ . ‘
~ Terminal Hotleys ———
[ Use Temminal Settings:
[~ Enable Instant Failover Hotkeys [Change Hatkeys |
[v Enable Display Client Hotkeys Change Hotkeys |
[¥ Enable Tiling Hotkey Change Hotley |
< Back Mext = Finish Cancel Help

Terminal Hotkey Options
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Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations that
allow switching between sessions.

Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the properties
that were configured for use with the terminal.

e Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching between
the two active sessions of a Display Client that is using Instant Failover.

e Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between different
sessions of a terminal using MultiSession.

o Enable Tiling Hotkey — This checkbox, if selected, allows SessionTiling to be activated by a hotkey
combination.

Selecting the Change Hotkeys button when Enable Instant Failover Hotkeys is selected will allow the
hotkeys to be changed from the default.

Select Hotkeys |
— Ingtant Failover Hatkey
@ Conholkey  [Fo =] Cancel |
Al Key

Select Instant Failover Hotkeys

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed by selecting the
Alt Key radio button or using the drop-down to select another function key.

Selecting the Change Hotkeys button when Enable Group Hotkeys is selected will allow the MultiSession
switching hotkeys to be changed from the default.
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Select Hotkeys

Al Key

— Mext Dizplay Client Hotkey

I Fage Down j

= Control Key

i Al Key

— Previouz Dizplay Client Hotkey

FPage Up j

Select MultiSession Switching Hotkeys

The default hotkey for MultiSession switching is set to Control+Page Up and Control+Page Down. This can
be changed by selecting the Alt Key radio button or using the drop-down to select another hot key.

Selecting the Change Hotkeys button when Enable Tiling Hotkeys is selected will allow the hotkeys to be

changed from the default.
Select Hotkeys

— Tile Hotkey

Al Key

=]|

Cancel |

Select SessionTiling Hotkeys

The default hotkey for SessionTiling activation is set to Control+t. This can be changed by selecting the Alt
Key radio button or using the drop-down to select another hot key.

Select the OK button to continue or the Cancel button to close without accepting changes.
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26.6.1.8 User Options
The final page of the TermSecure User Configuration Wizard is the User Options page.

= TermSecure User Configuration Wizard |

Select options for this user.

Uzer Options a

— Log In / Log Out Options
Inactivity Timeout 120 seconds
Reset Sessions at Logout r
Petivate User Group at Log In r
— User Schedule
[ Set Schedule Schedule |
— Terminal Effects
¥ Enable Teminal Effects
— Shadowing
Allow teminal to be shadowed YES i
¥ Allow Interactive Shadow

< Back Hent > | Fish |  Cancel | Help

User Options

Log In / Log Out Options

e Inactivity Timeout - TermSecure will log a TermSecure Users off the terminal after this much
inactive time has passed.

e Reset Sessions at Logout - This checkbox, if selected, will logoff a session when the TermSecure
User logs off.

e Activate User Group at Log In - This checkbox, if selected, will display the TermSecure User’s first
Display Client when the user logs in to the terminal.

User Schedule
e Set Schedule -

Selecting the Schedule button on the User Options page will launch the Event Schedule window and allow
a schedule to be created for terminal events.

See Terminal Schedule for details.

Terminal Effects
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e Enable Terminal Effects - This allows the use of Terminal Effects. This currently includes sliding
Windows and message rollups.

Shadowing

e Allow terminal to be shadowed - This drop-down box allows the configuration of Shadowing
Options.

(0]

(0]

(0]

No - Prevents the TermSecure Users from being shadowed.

Ask - Will display a message window that will prompt for a positive response before the
shadowing is allowed.

Warn - Will display a message window alerting the terminal that it is to be shadowed, but
doesn’t require a positive response before the shadowing is allowed.

Yes - Allows shadowing to occur without warning or recipient input.

e Allow Interactive Shadow - This checkbox, if selected, will allow members with Interactive Shadow
privileges to shadow this TermSecure User.

Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. Unselecting
this will prevent shadowing from within ThinManager.

Select Finish to finish the configuration.
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26.7TermSecure Users Group Configuration Wizard

TermSecure Users can be organized into TermSecure User Groups, just as Terminals can be organized into
Terminal Groups. Each setting of the TermSecure Group has a Group Setting checkbox. If this box is
selected then that setting will be applied to each member of the TermSecure Group.

The TermSecure Users Group Configuration Wizard can be launched by right clicking on the TermSecure
Users branch of the tree and selecting Add TermSecure User Group.
26.7.1.1 TermSecure User Group Information

The first page of the TermSecure Group Configuration Wizard is the TermSecure User Group
Information page.

= TermSecure User Configuration Wizard x|
TermSecure User Group Information m
=

Enter the TermSecure User Group name.

— GEroup Mame

Uszer Mame |

Pazzwiord I

Werify Pazsword I

Fazsword Options | Group Setting [

— Eroup

Change Group |

Permizsiong | Group Setting [

Fleaze enter a name

< Black | Hest = | = | Cancel I Help

ThinManager User Group Information

The TermSecure User Group Information has fields for the group name and membership.
e User Name - This field names the TermSecure User Group.
Group Setting - This checkbox, if selected, applies this configuration to all members of the group.

The rest of the TermSecure Group Configuration continues as the TermSecure User Configuration, with the
addition of the Group Setting checkboxes.
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28 TermSecure User Configuration Wizard

User Group Options

Select options for users in this group

<

—Log In / Log Out Options

Inactivity Timeout
Reset Sessions at Logout

Activate User Group at Log In

Group Setting
L seconds v
r v
v 2

Group Setting v

— |User Schedule
¥ Set Schedule Schedule |
Group Setting [
— Terminal Effects
¥ Enable Teminal Efects
Group Setting [
— Shadowing
Allow terminal to be shadowed YES =
v Allow Interactive Shadow
< Back Hews> | Fish |  Cancel | Help

TermSecure Group Configuration Wizard

Group Settings that are selected will be grayed out for members of the group. Group Settings that aren't
selected will be available for configuration on the individual TermSecure User configuration page.
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& TermSecure User Configuration Wizard

User Options m

Select options for this user.

—Log In / Log Out Options
Inactivity Timeout 120 seconds
Heszet Sezsione at Logout [
Sativate [Uzer Group at Log ln ~
— |User Schedule
¥ SetSchedule Schedule |
— Terminal Efects
¥ Enable Teminal Efects;
— Shadowing
Allow terminal to be shadowed YES Bk
v Allow Interactive Shadow

< Back Heds | Frish |  Cancel | Help

TermSecure Group Member

Select Finish to complete the configuration.
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26.8Adding a TermSecure User to the TermSecure User

Group

To add a TermSecure User to a TermSecure User Group, create a new TermSecure User by right clicking on
the TermSecure Users branch in the ThinManager tree and select the Add TermSecure User option or

double click on an existing user to launch the wizard.

5= TermSecure User Configuration Wizard

TermSecure User Information

Enter TermS ecure ugemame, password and permizzion information.

x|
b

— TermSecure Lser Information

IJzer Mame IWashingtDn

Pazzwiord I

Werify Pazsword I

Pazzword Optionz |

— Group

Change Group I

— Copy Settings
[T Copy Settings from another Lser

Eapy Eram |

Permizzions |

cBack | Mewts | Finish

| Cancel Help

TermSecure User Information Page

Select the Change Group button. This will launch the Choose User Group window.
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Choose User Group

- Users

- East
- Delaware
- b aryland
- Mework,
[=]- Morth
- Michigan
- Ohino
- Wizconzin
= South
- Carolinas
- Florida
B 3 enrgia
= West
- Arizoha
- Califormia
- Mevada
- Central

Cancel

]|
aEk. I
_ Coreel |

Choose User Group Window

Highlight your TermSecure Users Group and select OK. This will accept the changes and close the window.
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& TermSecure User Configuration Wizard

TermSecure User Information

Enter TermS ecure ugemame, password and permizzion information.

X

<

— TemSecure User Information

Izer Mame IWashingtDn

Pazzwiord I

Werify Pazsword I

Fazsword Options |

[T Copy Settings fram another User

— Eroup
ISDuth'\G Enrgia Change Group |
— Copy Settings

Eapy Eram

Permizsiong

L

cBack | Mews | Firish |

Cancel

Help

TermSecure User Information Page

The TermSecure User Group will now be displayed in the Group field.

Select Next to continue.
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= TermSecure User Configuration Wizard x|

Card / Badge Information H

Enter card/badge information if uzer haz one.
A

[ Thiz user will uze a card, badge, or other device to log irt

— Card / Badge Information

Enter Card/Badge |0 number

™| &lways Frompt far Fasswond

< Back I Mest » I Finizh Cancel Help

Card/Badge Information

The Card/Badge Information options are available because these are individual settings, not group settings.

Select Next to continue.
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= TermSecure User Configuration Wizard x|
Display Chent 5pecification H

Select the Dizplay Clhents to which this user can connect,
A

Ayailable Digplay Clientz Selected Dizplay Clients

ShadowClient] T5Client1

ShadowClient? il
T5Client2 _—
CamClient1
CamClient2

=IR2

Edit Display Clientz | [Ivermide |

< Back Finizh Cancel Help

Display Client Specification

Each of the settings that have the Group Setting checkbox selected in the TermSecure User Group wizard
will be grayed out because the Group Setting enforces the configuration of each chosen parameter.

Select the Finish button to accept the configuration.

26.9TermSecure Login

To log in a TermSecure User on a terminal, go to a terminal that has the Enable TermSecure checkbox
selected on the Terminal Server Specification page.

Type the default CTL+m or other designated hotkey at the keyboard or select from group selector

The Main Menu will be displayed on the terminal.

MAAIMN MAER L

Log In AboLt
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TermSecure Main Menu

The About button to see details about the terminal.

About

Terminal Mame = Terminall
Termsecure ser Mame = MNone
IP Address =192 .168.3.101
Firmware Yersion =+3..00.01

About Menu

Select OK to close the About window.

Select the Log In button to login.

Termzecure Log On

Enter User Mame

TermSecure Log On Screen

Enter your TermSecure User user name in the Enter User Name field.
Select OK.

TermSecure Log On

Enter Password:

..............................

Password Screen
Enter the password in the field.

Select the OK button. If the user name and password are correct, ThinManager will allow the login.
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2 ThinManager [_ O] x|

Edit Manage Instal Tools View RemoteView Help

E‘"’.’ﬁ( "F"'_'_:'_t'alt Configuration | Mu:udulesl Schedulel F'n:upertiesl Event Lu:ugl Shadu:uwl Hepu:urtl
= M Terminals -
- I Attribute | Yalue -
M Group1 - —
& Terminal Identification
- Alpha (Adam) .
E‘. ool iMoo 1 Terminal Mame Alpha
Q Sierra
=N @ VCanter Servers b odel Mumber BE24-ACF
@ v_Eight_2 kM anufacturer Arizta
[ Display Clients Video Controller 53 Savaged
E| ﬁ TermSecure Lsers
m Groupl Login U semame adrnin
@ Adam (alpha) Login Comain
- D Eve Replaceable YES
Allow Shadowing YES
Allow Interactive Shadowing YES
Terminal Effects YES
Show Status Meszages YES
I1ze Dizplay Clients YES i
4| | 3
For Help, press F1 | I_ i

ThinManager With TermSecure Log On
Once a TermSecure User is logged into a terminal, ThinManager will display the TermSecure User’'s name
after the terminal name in the tree.
ThinManager will add the name of the terminal after the TermSecure User name in the tree.

Right-clicking on a terminal and selecting Go to TermSecure User will move the focus to the TermSecure
user that is logged into the terminal.

Right-clicking on a TermSecure user and selecting Go to Terminal will move the focus to the terminal that
the TermSecure user is logged into.

26.9.1 Logging Out

The TermSecure User can be logged out by:

e Opening the TermSecure Main Menu (type CTL+m) on the terminal and selecting the Log Off
button.

e Right clicking on the TermSecure User in the ThinManager tree and selecting Logoff User.

e Restarting or Rebooting the terminal that has a TermSecure User logged in.
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MAIN MEML

Switch User Log Off | About | ' Cancel |

Broorrormerroroereerroos

Main Menu

The Switch User button will log off the TermSecure User and open the Login screen for another TermSecure
User. The Log Off button will log of the TermSecure User and return to the terminal’s display.

26.10 TermSecure Menu

The TermSecure Menu that is displayed on a terminal that allows TermSecure Users to manually log on to a
terminal is configurable for use with TermSecure. This menu is generated from the terminal and not the
terminal server session.

MAA I MWAER L

Basic TermSecure Menu
The TermSecure Menu can be configured by a number of settings in the Terminal Configuration Wizard
and TermSecure User Wizard.
The Main Menu is activated on the Terminal Interface Options page of the Terminal Configuration Wizard
and/or TermSecure User Configuration Wizard.
26.10.1.1 Main Menu Configuration - Terminal Configuration Wizard

Open the Terminal Configuration Wizard by double clicking on the desired terminal in the ThinManager
tree. Terminals using Display Clients will display the Terminal Interface Options page. This page will display
Main Menu options when TermSecure is enabled for the terminal.
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= Terminal Configuration Wizard x|

Terminal Interface Oplions m
Select the display client selector and main menu options that will be }

available on the terminal. --‘

— Digplay Client Selection Options

¥ Show Selector on Terminal Selector Options |

W Enatls Tiling Tiing Options |
[T Screen Edge Dizplay Client Selection

tdain kenu Options

¥ Show Main Menu on 5 electar Main Meru Options

< Back I Hest > I Finizh Cancel Help

Terminal Interface Options Page

A terminal using MultiSession will need to have a method to switch between sessions. This is configured on
the Terminal Interface Options page. For terminals using TermSecure, additional Main Menu options are
available, as shown. See Terminal Interface Options for a terminal for a comparison.

Group Selector Options allow on-screen switching of sessions.

e Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down
menu that can be activated by mouse.

Analytics
Analytics
Reports

Tile
Main Menu

On-Screen Group Selector
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e Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch
windows if the mouse is moved off screen.

e Selector Options button will launch the Group Selector Options window that allows configuration of
the on-screen Group Selector.

Group Selector Options |

v fto-hide Group Selector

[ Tile on Group Selectar activation

Cancel |

Group Selector Menu Size M armnal j

Group Selector Options Window

The Auto-hide Group Selector checkbox, if selected, will hide the Group Selector until the mouse is
move to that space.

The Tile on Group Selector activation checkbox, when selected, will tile the Display Clients when
the auto-hid selector is chosen. This allows the user to select from the available sessions.

The Group Selector Menu Size drop-down box allows the setting of the size of the Group Selector
font.

Main Menu Options allow on-screen switching of sessions.

e Show Main Menu on Group Selector - This checkbox, if selected, will display the TermSecure Main
Menu as an option on the Group Selector drop-down.

e The Main Menu Options button will launch a window for Main Menu settings.

Main Menu Options E

[ allow reboot £ restart

¥ Show virtual Keyboard Cancel |

Main Menu Options

The Main Menu Options window has several settings.

e Allow reboot/restart — This checkbox, if selected, will add a Reboot and a Restart button on the
main TermSecure login window.

e Show Virtual Keyboard — This checkbox, if selected, will prompt the display of a virtual keyboard for
TermSecure logins. This is helpful for thin clients with touch screens.

The Allow reboot/restart checkbox, if selected, will add a Shut Down button to the TermSecure Main Menu.
The Shut Down button leads to a menu with a Restart and Reboot button.
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MAAIN METU

Switch User Log Off | ShuDown | About |

Main Menu with Shut Down Button

Once the user logs out, a Shut Down button will appear on the Main Menu. Selecting the Shut Down button
will launch the Shut Down Menu.

Shut Down

Restart | Rehoot | - Cancel |

Shut Down Menu

The Shut Down window has two buttons.

e Restart, when selected, will log off the TermSecure User, reload the configuration and load any
changes.

e Reboot, when selected, will log off the TermSecure User, power off the terminal and reload firmware
and configuration.

1 2 3 4 5 g 7 8 a 0 - = Y '
Tab | q | w | @ r 1 W u | 0 p [ ] Dhal
a 5 d f g h i k I : ' Return

Shift z X c W b n i : f

Temirese Log On
Em=r User hlame

ar
“con Your Hadge

Terminal Virtual Keyboard
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If the Show Virtual Keyboard checkbox is selected a virtual keyboard will be displayed on the terminal. This
is helpful for touch screen users.

Select OK to save setting or Cancel to close without saving.

26.10.1.2 Main Menu Hotkey - Terminal Configuration Wizard

The Hotkey Configuration page has an additional TermSecure setting when the Enable TermSecure
checkbox is checked on the Terminal Server Specification page.

= Terminal Configuration Wizard x|

Hotkey Configuration H

Configure the hotkeys to apply ta thiz terminal
A

— Terminal Hotkeys

[ Enable Instant Failover Hotkeys Change Hotkeys |
[ {Enable Display Client Hotkeys Change Hotkeys |
IV Enable Tiling Hotkey Change Hatkey |
¥ Enable Main Menu Hotkey Change Hatkey |

¢ Back I Hest > I Finizh Cancel Help

Hotkey Configuration — TermSecure Enabled

The Enable Main Menu Hotkey checkbox, when selected, will allow the TermSecure Main Menu to be
launched with a hotkey combination. The Change Hotkey button allows the default CTL+m combination to be
changed.
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Select Hotkeys

— Switch Uszer Hotkep

% Control Key I m LI

Al kKey

Select HotKeys Window for Main Menu

The default hotkey for the Main Menu is set to Control+m. This can be changed by selecting the Alt Key
radio button or using the drop-down to select another hot key.

Select the OK button to continue or the Cancel button to close without accepting changes.

MAS I BAER L

Main Menu

The Main Menu can be launched with the Ctrl+ m hotkey if the Enable Main Menu Hotkey checkbox is
selected.

26.11 Card and Badge Configuration for a
TermSecure User

TermSecure allows the use of USB drives and RFID cards as login devices at terminals. This is configured on
the Card/Badge Information page of the TermSecure User Configuration Wizard. The TermSecure
Users Configuration Wizard can be launched by double clicking on a TermSecure User in the ThinManager
tree or by right clicking on the TermSecure Users branch of the tree and selecting Add TermSecure User.
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x|
Card / Badge Information }ﬁ"

Enter card/badge information if uger haz one,
A

¥ This user will uze a card, badge, or other device to log in

— Card / Badge Information

Enter Card/Badge |0 number

[~ Ahways Prompt for Password

< Back I Ment » I Finizh Cancel Help

Card / Badge Information Page
e This user will use a card, badge, or other device to log in - This checkbox, if selected, enables
the use of a USB device, card or badge to login to a terminal.

o Enter Card/Badge ID number - This field is for the unigue identification number of the ID device.
This can be filled manually or automatically. See Automatic Card/Badge ID Number Entry and Manual
Card/Badge ID Number Entry for instructions on the methods.

e Always Prompt for Password - This checkbox, if selected, will require a password in addition to the
ID device to login to a terminal as a TermSecure User.

26.11.1  Automatic Card/Badge ID Number Entry

ThinManager can be configured to automatically add the Card/Badge ID number. There are a few conditions
that need met to allow this to happen.

e The Display “Create New User” dialog for unknown users check box on the Options page
must be selected.

e The terminal must use Display Clients.

e The terminal needs the Enable TermSecure checkbox on the Terminal Specification page of
the Terminal Configuration Wizard.
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e The USB Drive module, RF Ideas pcProx Module, or Wavetrend Tag Reader Module need
added to the terminal. The USB Drive module needs the Use with TermSecure parameter set to
Yes.

e The user needs to scan the card or insert the USB drive to start the TermSecure Configuration
Wizard.

Automatic Card/Badge use starts with the enabling of the Create New User dialog box. This is configured on
the Options window that is opened by selecting View > Options.

N |

— General Ophions

¥ Display "Create Mew Teminal* dialog for unknown terminals.

¥ Display "Create Mew User' dislog for unknown uzers.

— loon Optioks

[ Minimize ta the System Tray.

— License Options

Wiarn i licenze will expire within I'I 0 day|z].

A walue of O dizables warning.

cros |

Options Window

The Display “Create New User” dialog for unknown users check box, if selected, will launch the
TermSecure User Configuration Wizard on the ThinManager Server when an unknown ID device (USB key
or ID card) is read by a terminal. Once this checkbox is selected, scanning a new ID card or inserting an
undefined USB key will launch the TermSecure User Configuration Wizard with the Enter Card/Badge ID
number automatically filled in.
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= TermSecure User Configuration Wizard x|
TermSecure User Replacement m
(=

Agzign thiz card number to an existing wzer or create a new uzer

Mew Card Mumber - 133307151

Click “szign Card Humber to Existing Usen'' to replace the card number of
an exigting uzer. To create a new uger click "MHext',

Agzign Card Mumber to Existing User

TemSecure Lzer to replace;

< Back Mest » Finizh Cancel Help

TermSecure User Configuration — TermSecure User Replacement

When a new card is scanned or a new USB key is inserted into a USB slot on the terminal the TermSecure
User Configuration is launched with an option to assign the card to an existing user.

Selecting Next will open the TermSecure User Configuration Wizard and allow a new TermSecure user to be
configured.

Selecting Assign Card Number to Existing User will launch the Select TermSecure User to replace
window to assign the card/badge number to an existing TermSecure User account.
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Select TermSecure User o replace

x]
El- U_sers QK I

(- East
- Moith Cancel
& South
“West

Jefferzon
M adison
i Marnoe

Select TermSecure User To Replace Window

Highlight the desired TermSecure user and select OK. The wizard will display the TermSecure User
Information page with the selected user entered.
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& TermSecure User Configuration Wizard

TermSecure User Information

Enter TermS ecure ugemame, password and permizzion information.

X

— TemSecure User Information

Izer Mame I.-’-'-.dams

Pazzwiord I

Werify Pazsword I

Fazsword Options |

— Eroup
I Change Group |
— Copy Settings
[T Copy Settings fram another User Copy Franm |
< Black | Mest » | Finizh | Cancel

TermSecure User Information Page

If a TermSecure user was selected for the badge, the user will be displayed in the User Name field of the

TermSecure User Information page.

Selecting Next will continue with the configuration and show the Card/Badge Information page.
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= TermSecure User Configuration Wizard x|

Card / Badge Information bq

Enter card/badge information if uzer haz one.
A

¥ Thiz user will uze a card, badge, or other device to log in

— Card / Badge Information

Enter Card/Badge |0 number

[~ Aways Prompt for Password

< Back I Mest » I Finizh Cancel Help

Card/Badge Information Page

The card, badge, or USB drive number will be entered in the Enter Card/Badge ID number field.

Select Back to change the configuration, select Next to continue, select Finish to accept the changes, or
select Cancel to cancel changes.
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26.11.2 Manual Card/Badge ID Number Entry

Although the easiest method for assigning a card or badge is automatic as described in the Automatic
Card/Badge ID Number Entry section, ThinManager can be configured for manual entry

If the Display “Create New User” dialog for unknown users check box on the Options window is
unselected, the Enter Card/Badge ID number field will need to be entered manually. The Card/Badge 1D
number is accessible in the event log. To configure a terminal to allow a device one needs to:

e Turn the Event Log on

e Have the appropriate hardware on the terminal, either a USB port or a ProxCard reader.
e Add the appropriate module.

e Use the device once to have the device’s identifier entered to the event log.

e Openthe TermSecure User Configuration Wizard and enter the ID number to tie the TermSecure
User to the device.

e Login with the ID device.

26.11.2.1 Event Log
The Event Log is configured in the ThinManager Server Configuration Wizard.

Open the ThinManager Server Configuration Wizard by double clicking on the ThinManager Server icon in
the tree, or highlighting it and selecting Edit > Modify from the menu.

Navigate to the Historical Logging page.
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52 ThinmManager Server Configuration Wizard x|

Histoncal Logging H

Select the itemsz to log and how long to maintain the logged
inforrmatior. A

— Higtarical D ata

b aintain Higtoncal Log For I-I days

Clear Hiztary

—Ewvent Log

b aintain Event Log for I? dayz

Chooze events tolog

I Terminal Server Events

¥ Temminal Events

¥ Teminal Configuration changes
v TemSecure User Configuration changes

Clear Event Lag |

< Back I Hest > Finizh Cancel | Help |

Historical Logging Page

All events may be selected to be logged, but the Terminal Events checkbox is critical to the TermSecure
Device detection. Select the Terminal Events checkbox and select the Finish button.
26.11.2.2 USB Device Module

When using the USB drive as a TermSecure identifier, the USB Flash Drive Module needs added to the
terminal.

See USB Flash Drive Module for details.

26.11.2.3 ProxCard Reader Module

A ProxCard Reader works much the same as the USB device, but uses a different module, the RF Ideas
pcProx Module.

See RF Ideas pcProx Module for details.

26.11.2.4  WaveTrend Tag Reader Module

A WaveTrend Tag Reader works much the same as the USB device, but uses a different module, the
WaveTrend Tag Reader Module.

See Wavetrend Tag Reader for details.
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26.11.2.5 Device ldentifier Number
Next the ID device needs to be scanned or inserted to help find the ID number.
Insert the USB device or scan the ProxCard on the terminal.

A TermSecure message should be displayed.

Term3ecure Message

05deadiionnZ03000001236 Is Mot a Walid User D

TermSecure Message

The ID device will not work so the terminal will send a message with the ID device’s identifier number.
e Record this number.

This number is also entered in the event log if the Terminal Events were selected in the ThinManager Server
Configuration Wizard.

e Open ThinManager.
¢ Highlight the terminal in the tree and select the Event Log tab.

The ID for the device is entered in the log.

Automation Control Products ThinManager 5.0 Help Manual Permissions e 521



52 ThinManager =] B3

Edit Manage Instal Tools View RemoteView Help

E'}E{ ':_'Z'bf"t .Eu:unfiguraticunl Mu:udulesl Schedulel Properties  Event Log | Shadu:uwl Hepu:urtl
= M Terminals
: _ Event | |zer -
Q Groupl
e Login attempt failed for card id 18330175
Q‘jﬂ Alpha Terminal Shadow Ended
Q MultiMonitor 1 Termninal Shadow Started it

Q Sierra
ﬁ Display Servers
VCenter Servers
- (2 v_Eight 2
- [ll| Display Clients

For Help, press F1 | b

ThinManager Event Log

Next the ID number needs to be associated with the TermSecure User.
e Open the TermSecure User Configuration Wizard for the user you want to have use that ID device.

e Navigate to the Card / Badge Information page.
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= TermSecure User Configuration Wizard x|
TermSecure User Replacement m
(=

Agzign thiz card number to an existing wzer or create a new uzer

Mew Card Mumber : 13330175

Click “szign Card Humber to Existing Usen'' to replace the card number of
an exigting uzer. To create a new uger click "MHext',

i Asgsign Card Mumber to Existing User

TemSecure Lzer to replace;

< Back Mest » Finizh Cancel Help

Card / Badge Information Page

e Select the This user will use a card, badge, or other device to log in checkbox.
o Enter the ID Identifier from the earlier steps into the Enter Card/Badge ID number field.
e Select the Always Prompt for Password, if desired.

Now the Terminal is configured, the ID device is identified, and the TermSecure User is configured to use the
device.

¢ Insert the USB device into the USB port on the thin client or scan the ProxCard on the card scanner.
The USB device will log the TermSecure User into the terminal server.

e Open ThinManager.

e Highlight the ThinManager Server and select the Event Log tab.
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B2 ThinManager v4.1 =] B3

Edit Manage Instal Tools View RemoteView Help

E'}E{ Cobalt .Eu:unfiguraticunl Mu:udulesl Schedulel Propertiez  Event Log | Shadu:uwl Hepu:urtl
= 8 Terminals
Event | |Jzer -

Groupl
. @ P |1zer Seszion Established on Server Blue for Group Reportz
Q Alpha (Eve) IJzer Eve logged in

[+ M multiMonitor 1
Q Sierra

- ﬁ Display Servers

- E‘_? VCenter Servers
M- (3 v_Eight_2

- [l Display Clients

- ﬂ TermSecure Lsers

Q Eve (alpha)

For Help, press F1 | T

Event Log

The Event Log will show the results of the successful login. The terminal will have the TermSecure User
added to its icon in the tree, while the TermSecure User icon will show the name of the terminal that it is
logged into.
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27 TermMon ActiveX Control

The TermMon ActiveX Control can be used to collect information about a terminal and perform terminal
functions. For the purposes of this document Control will refer to the TermMon ActiveX Control.

This section is not meant as a tutorial on ActiveX controls but is a datasheet on the properties and functions
of the TermMon ActiveX control.

27.1Registering the Control

The TermMon ActiveX Control can be found on the ThinManager CD as termmon.ocCX.

The Control must be registered before it can be used. Copy the file termmon . 0oCX to the computer where
you want to use it. Register the OCX by executing regsvr32 <path\termmon.ocx>.

27.2Using the Control

27.2.1 TermMon ActiveX Configuration Module

If running the Control in the terminal’s terminal services session, no special configuration of the terminal in
ThinManager is required. The TermMon ActiveX Control Configuration Module is not required.

If the Control is not run in the terminal’s terminal services session, the TermMon ActiveX Control
Configuration Module must be added to the terminal configuration in ThinManager. In the module
configuration, Allow ActiveX Connections must be set to YES and Only Allow Connections from Session
must be set to NO.

The TermMon ActiveX Control Configuration Module can be used to prevent a connection from an
application running in the terminal’s terminal services session. This is accomplished by adding the TermMon
ActiveX Control Configuration Module to the terminal in ThinManager and setting the Allow ActiveX
Connections option to NO.

27.2.2 Read-Only Properties

The following properties are read only strings. An event will be generated any time one of these properties
changes. The Enable method must be invoked prior to reading these properties.

e TerminalName - This is the name of the terminal.

e TerminalModel - This is the terminal model number.

e TerminallP - This is the terminal IP address.

e TerminalMAC - This is the terminal MAC Address.

e TerminalBootLoaderVersion - This is the terminal network boot loader version.

e TerminalFirmwareVersion - This is the firmware version that the terminal is running.

e TerminalWindowsUsername - This is the Windows Username that is specified in the terminal’s
ThinManager configuration.
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e TermSecureUsername - This is the TermSecure username of the TermSecure user currently logged
onto the terminal. If no TermSecure user is logged on, this value will be blank.

e TermSecureWindowsUsername - This is the Windows Username associated with a TermSecure
user. This is the Windows Username for all TermSecure user sessions. If no TermSecure user is
logged on, this value will be blank.

e TerminalServerGroupList - This is a comma-separated list of Display Clients currently running on
the terminal.

e ConnectionState - This is the Control’'s connection state with the terminal.

e CurrentTerminalServerGroup - This is the Display Client that is currently being displayed on the
terminal.

e CurrentWindowsUsername - This is the Windows Username of the session where the Control has
been executed. This property is not available when the RuninSession property is set to False.

e TerminalServerName - This is the name of the Terminal Server where the Control is running. This
property is not available when the RuninSession property is set to False.

27.2.3 Read-Write Properties

These properties can be set by the application.

¢ RunInSession - When the RuninSession property is set to True, the Control will be running in the
terminal’s terminal services session. The terminal IP address will be determined automatically by the
control.

e OverridelP - If the RuninSession property is set to False, the OverridelP property specifies the IP
Address of the terminal that the Control will connect to.

Note: To use the OverridelP property, the TermMon ActiveX Control Configuration Module must be added to
the terminal configuration in ThinManager. In the module configuration, Allow ActiveX Connections must be
setto YES, and Only Allow Connections from Session must be set to NO.

e WatchdogTime — This is the number of seconds before the watchdog will reset the terminal session.
Once this property is set to a hon-zero value, the property must be updated before the watchdog time
reaches zero. To disable the watchdog, set this property to zero. The watchdog is disabled by default.

Note: The Enable Method does not need to be called for watchdog operation. Watchdog operation is
independent of the Enable and Disable Methods.

e ActiveScreen — For MultiMonitor configurations, this is the active screen number. A value of zero
(default) will set the active screen to the screen the mouse pointer is on when a method or command
is executed. A non-zero value will set the Active Screen to the screen number specified. All methods
and commands will be executed on the specified screen.

27.2.4 Events

When a property value changes, an event will be generated by the Control. When an Event occurs the event
code can be used to determine the property that changed. The Enable method must be invoked in order to
receive events (except for WatchdogTime). The event code is provided by the Control as follows:

e TermMonEvent.TerminalName
e TermMonEvent.TerminalModel

e TermMonEvent.TerminallP
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e TermMonEvent.TerminalMAC

e TermMonEvent.TerminalBootLoaderVersion

e TermMonEvent.TerminalFirmwareVersion

e TermMonEvent.TerminalWindowsUsername

¢ TermMonEvent.TermSecureUsername

e TermMonEvent.TermSecureWindowsUsername

e TermMonEvent.TerminalServerGroupList

e TermMonEvent.ConnectionState

e TermMonEvent.CurrentTerminalServerGroup

e TermMonEvent.CurrentWindowsUsername

e TermMonEvent.TerminalServerName

e TermMonEvent.WatchdogTime

27.2.5

Methods

e Enable - Invoking this method will enable the Control. The Control will attempt to connect to the
terminal and generate events to update the Control Properties. The Control will maintain a connection
to the terminal as long as it is enabled.

e Disable - Invoking this method will cause the Control to break the connection with the terminal.
Events will be generated to clear the Control Properties.

e Command - The Command method can be used to send terminal action commands. The Command
method requires one parameter which is the terminal command to be performed. The Enable method
must be invoked before these commands can be executed (except for noted exceptions). The
supported commands are:

(0]

O O O O O o o

Reboot - This command will initiate a terminal reboot.

Restart - This command will initiate a terminal restart.

Calibrate - This command will initiate a touch screen calibration.
GotoMainMenu - This command will cause the Main Menu to be displayed.
SwitchToNextGroup - This command will switch to the next Display Client.
SwitchToPrevGroup - This command will switch to the previous Display Client.
SwitchlinstFailover - This command will switch the instant failover group.

ChangeTermSecureUser - This command will disconnect any current TermSecure user
sessions and then display the TermSecure Log On menu.

LogOffAndChangeTermSecureUser - This command will log off any current TermSecure
user sessions and then display the TermSecure Log On menu.

LogOffTermSecureUser - This command will log off any current TermSecure user sessions
and will return to a Display Client which is assigned to the terminal. If no Display Clients have
been configured on the terminal, the TermSecure Log On menu will be displayed.

DisconnectTermSecureUser - This command will disconnect any current TermSecure user
sessions and will return to a Display Client which is assigned to the terminal. If no Display
Clients have been configured on the terminal, the TermSecure Log On menu will be
displayed.
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0 DisconnectSession - This command will disconnect the Terminal Services Session running
on the terminal. This command does not require that the Enable Method be invoked prior to
execution.

0 LogOffSession - This command will log off the Terminal Services Session running on the
terminal. This command does not require that the Enable Method be invoked prior to
execution.

o0 TileStart - This command will tile the Display Clients on the current Screen.

o0 TileEnd - This command will untile the Display Clients on the current Screen.

The Command Method constants are provided by the Control as follows:
TermMonCommand.Reboot
TermMonCommand.Restart
TermMonCommand.Calibrate
TermMonCommand.GotoMainMenu
TermMonCommand.SwitchToNextGroup
TermMonCommand.SwitchToPrevGroup
TermMonCommand.SwitchInstFailover
TermMonCommand.ChangeTermSecureUser
TermMonCommand.LogOffAndChangeTermSecureUser
TermMonCommand.LogOffTermSecureUser
TermMonCommand.DisconnectTermSecureUser
TermMonCommand.DisconnectSession
TermMonCommand.LogOffSession

TermMonCommand.TileStart

O O 0O O O o o oo o o o o o o

TermMonCommand.TileEnd

e ChangeTerminalServerGroup - This method can be used to change the Display Client currently
displayed on the terminal. This method requires one parameter which is the name of the Display
Client that the terminal should switch to.

e TermSecureCheckAccess - This method can be used to query the access rights of a TermSecure
user. This method requires two parameters. The first parameter is the name of the user. The second
parameter is the name of the Access Group. This method returns the result of the query as follows:

0 TermMonConst.Timeout - The request timed out.
0 TermMonConst.Busy - The Control is busy with another request.

o TermMonConst.InvalidMember - The user is not a member of the specified TermSecure
Access Group.

o TermMonConst.ValidMember - The user is a member of the specified TermSecure Access
Group.

o TermMonConst.UserNotFound - The TermSecure Username was not found.

0 TermMonConst.GroupNotFound - The Access Group Name was not found.
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e GetGroupScreen - This method can be used to determine which screen the specified Display Client
is currently on for MultiMonitor configurations. This method requires one parameter which is the name
of the Display Client.

e TermSecureLogonUser - This method can be used to Log On a specified TermSecure user. This
method requires two parameters. The first parameter is the name of the TermSecure user. The
second parameter is the password of the TermSecure user. The password will be encrypted before
being sent to the terminal. This method returns a result as follows:

0 TermMonConst.Success - The TermSecure user was successfully logged on.
TermMonConst.Timeout - The request timed out.

TermMonConst.Busy - The Control is busy with another request.
TermMonConst.UserNotFound - The TermSecure username was not found.

TermMonConst.BadPassword - The TermSecure password was invalid.

O O O O O

TermMonConst.NoPermission - The TermSecure user does not have permission to use the
terminal.

o0 TermMonConst.PasswordChangeReq - The TermSecure user is required to change his
password.

o TermMonConst.NoWindowsUsername - This TermSecure user does not have a Windows
Username specifed in the TermSecure user configuration. This is only required for Terminal
Services Display Clients assigned to the TermSecure User.

0 TermMonConst.NoWindowsPassword - This TermSecure user does not have a Windows
Password specifed in the TermSecure user configuration. This is only required for Terminal
Services Display Clients assigned to the TermSecure User.

e CameraOverlayEnable - This method is used to enable a camera overlay. This method requires two
parameters. The first parameter is the name of the Display Client the overlay is on. The second
parameter is the name of the overlay.

e CameraOverlayDisable - This method is used to disable a camera overlay. This method requires
two parameters. The first parameter is the name of the Display Client the overlay is on. The second
parameter is the name of the overlay.

e CameraOverlayCycleStart - This method is used to start camera cycling for a camera overlay. This
method requires two parameters. The first parameter is the name of the Display Client the overlay is
on. The second parameter is the name of the overlay.

e CameraOverlayCycleStop - This method is used to stop camera cycling for a camera overlay. This
method requires two parameters. The first parameter is the name of the Display Client the overlay is
on. The second parameter is the name of the overlay.

e CameraOverlaySwitchNext - This method is used to switch to the next camera in a camera overlay
list. This method requires two parameters. The first parameter is the name of the Display Client the
overlay is on. The second parameter is the name of the overlay.

e CameraOverlaySwitchPrev - This method is used to switch to the previous camera in a camera
overlay list. This method requires two parameters. The first parameter is the name of the Display
Client the overlay is on. The second parameter is the name of the overlay.

e CameraOverlayFullscreenEnter - This method is used to make the current camera in a camera
overlay enter full screen. This method requires two parameters. The first parameter is the name of the
Display Client the overlay is on. The second parameter is the name of the overlay.

e CameraOverlayFullscreenExit - This method is used to make the current camera in a camera
overlay exit full screen. This method requires two parameters. The first parameter is the name of the
Display Client the overlay is on. The second parameter is the name of the overlay.
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e CameraOverlaySwitchByName - This method is used to change cameras in a camera overlay. This
method requires three parameters. The first parameter is the name of the Display Client the overlay is
on. The second parameter is the name of the overlay. The third parameter is the name of the camera.
The camera name must include the full path if the camera is in a camera group.

e CameraOverlayMove - This method is used to change the position of a camera overlay. This method
requires four parameters. The first parameter is the name of the Display Client the overlay is on. The
second parameter is the name of the overlay. The third parameter is the x location. The forth
parameter is the y position.

e CameraOverlayResize - This method is used to change the size of a camera overlay. This method
requires four parameters. The first parameter is the name of the Display Client the overlay is on. The
second parameter is the name of the overlay. The third parameter is the width. The forth parameter is
the height.

e CameraOverlayResizeMove - This method is used to change the size and position of a camera
overlay. This method requires six parameters. The first parameter is the name of the Display Client
the overlay is on. The second parameter is the name of the overlay. The third parameter is the x
position. The forth parameter is the y position. The fifth parameter is the width. The sixth parameter is
the height.
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27.2.6 Control Constants

Constant values provided by the Control are as follows:

TermMonEvent

TerminalName
TerminalModel

TerminallP

TerminalMAC
TerminalBootLoaderVersion
TerminalFirmwareVersion
TerminalWindowsUsername
TermSecureUsername
TermSecureWindowsUsername
TerminalServerGroupList
ConnectionState
CurrentTerminalServerGroup
CurrentWindowsUsername
TerminalServerName
WatchdogTime

TermMonCommand

Reboot

Restart

Calibrate

GotoMainMenu
SwitchToNextGroup
SwitchToPrevGroup
SwitchInstFailover
ChangeTermSecureUser
LogOffAndChangeTermSecureUser
LogOffTermSecureUser
DisconnectTermSecureUser
DisconnectSession
LogOffSession

TileStart

TileEnd
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100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
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TermMonConst

Success

Fail
Disconnected
Connected
Timeout

Busy

Updating
RequestFailed
InvalidMember
ValidMember
UserNotFound

© 00 N o o0~ WN P O

[
= O

GroupNotFound

=
N

BadPassword

=
w

NoPermission

'—\
N

PasswordChangeReq

[N
;]

NoWindowsUsername

[N
(e}

NoWindowsPassword

27.3TermMon ActiveX Demo Application

The TermMon ActiveX Demo Application can be used to demonstrate the features of the Control. The demo
application is found on the ThinManager CD in the Terminal ActiveX folder as TermMon . exe.

To start the application in graphical mode, run TermMon . exe in a terminal’s terminal services session.

This will allow the Control functionality to be demonstrated.

The demo application can also be run non-graphically using command line options. The format is as follows:

TermMon -c <command> -f <output path and filename> -d <data> -a <ip
address>

The following commands are terminal action commands:

Reboot

Restart

Calibrate
GotoMainMenu
SwitchToNextGroup
SwitchToPrevGroup

SwitchlInstFailover
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The following commands return the result in the output filename.

ChangeTermSecureUser
LogOffAndChangeTermSecureUser
LogOffTermSecureUser
DisconnectTermSecureUser

ChangeTerminalServerGroup -d <groupname>

TerminalName -f <output filename>
TerminalModel -f <output filename>
TerminallP -f <output filename>

TerminalMAC -f <output filename>
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28Non-ThinManager Components

Microsoft Terminal Servers play an important role in the ThinManager system. It is recommended that you
become familiar with the documentation provided by Microsoft about their server. The following information is
provided as an aid to understanding terminal services and is not a substitute for Microsoft documentation.

Microsoft Terminal Services requires a license, either a TS CAL (Terminal Services Client Access License) on
a 2003 Server or a RDS CAL (Remote Desktop Services Client Access License) on a 2008 Server.

This section covers:
e Server 2003
e Server 2008
e DHCP (Dynamic Host Configuration Protocol) Servers

e Terminal Services Licensing

28.1Server 2003

28.1.1 Installing Terminal Services

A Windows 2003 Server can be made a terminal server by installing the Terminal Services role. This can be
done with either the Manage Your Server or through the Add/Remove Programs > Add/Remove Windows
Components.
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¥ File Server
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network, This terminal server will stop issuing temporary ~ requirements Microsoft TechMet
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information. Configuration List of Common Administrative
zd| Open Terminal Services Tasks
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the Internet Explorer Enhanced Security Configuration o R'?WEW the next steps for What's New
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Strategic Technology Protection
Program

[¥ Don't display this page at logon

Manager Your Server

Select the Add or remove a role link on the Manager Your Server splash screen to install the Terminal
Services role and/or the Terminal Services License Server role.
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Windows Components
You can add or remove components of Windows.

Tao add ar remaove a companent, click the checkbaox. A& shaded box means that anly
part af the companent will be installed. To zee what's included in a component, click
Dretailz.

LComponents;
[ Subsyztem for UMI=-bazed Applications 1.2MBE ;I
0.0 MEBE
0.7 MB

Terminal Server
Il r;"i Terminal Server Licenzing

) (=
[ €2 UDDI Services 4.9 ME
Wl FZ=11 Indate Ponk Certificates nnwe T
Dezcrption:  Configures this computer to allow multiple uzers to run one or more
applications remaotely.
Toatal disk gpace reqqlred: 4.0 KB Details,. |
Space available on dizk: 2222 MB

< Back I Mest » I Cancel | Help |

Windows Component Wizard

Terminal Services can be installed by selecting the Terminal Server checkbox in the Windows Component
Wizard.

The Windows Component Wizard is launched by selecting the Add/Remove Windows Component button
on Control Panel > Add/Remove Programs.

Each Microsoft terminal server system will need a Microsoft Terminal Server Licensing server install. This
doesn’t have to be a separate computer but is a program installed on an existing computer. It is installed by
selecting the Terminal Server Licensing checkbox on the Windows Component Wizard.

See Microsoft Licenses for details.

28.2Creating Microsoft User Profiles

A terminal needs a valid Windows User Profiles to log onto a terminal server.

Open the Computer Management Console by selecting Start > Administrative Tools > Computer
Management in Windows 2003/2008 to create a user profile.
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O computer Management [ _ O] =]

=) Fle Action view Window Help |;|i|£|
& = | NERESREY
Q Campuker Management (Lacal) Mare | Full Marme | Ciescription
EI@ Swstem Toaols madminl
@ Evert Yiewer 7 admin10
-] Shared Folders % admint 1
=-#3 Local Users and Groups }ﬁadminlz
a =Ll 7 admin1 3

}ﬁadminldr

- &4 Performance Logs and Alert: éﬁadminlE

E;, Device Manager _
EI@ Starage ?‘Qadmf”z
-2 Removable Storage 5 adm!rﬁ
& Disk Defragrmenter éﬁadmm
g Disk Management ;ﬁadminS
-8 Services and Applications 5 adming

ﬁ adrnin?
}ﬁadminﬁ
éﬁadming

}ﬁ,ﬁ,dministramr Built-in account For administering k-

| | 21l | &

Computer Management Console

Highlight the User sub-folder of Local Users and Groups in the Computer Management tree pane.
Select Action > New User. This will launch a New User dialog box.
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hewvser R

Uzer name: I

Full narme: I

Dezcrption: I

Pazzword: I

Confirm password: I

¥ User must change passward at nest logon
[T Ugzer cannot change password

[T | Password never expires

[T Account is dizabled

| [Create I Cloze

New User Dialog

Enter the user name for the user in the User name field.

Enter a password in the Password field.

Re-enter the password in the Confirm password field.

The User must change password at next logon check box forces the user to change the password.
Select the Create button to finish the profile.

Select the Close button to return to the Computer Management Console.

Note: Users need to be added to the Remote Desktop Users group or the Administrators group to be
allowed to connect to a terminal server.

28.3Software Installation On Windows 2003

Microsoft Windows 2003/Server requires that software be added in the “Install Mode” through the Control
Panel > Add/Remove Programs.

Select Start > Settings > Control Panel > Add/Remove Programs to launch the Add/Remove Programs
dialog box.

Note: Some software, especially downloaded software, doesn't allow the installer to install it through the
Add/Remove Programs tools. To manually put the machine into the install mode open a command prompt

and type:
change user Zinstall

This command sets the machine to install mode. When finished, type:
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change user /execute
This command returns the machine to the normal run mode.

Fj'g Add/Remove Programs

add a program Fram CO-ROM or Floppy disk,

Add programs From Microsaft

Add Mew
Progr:

i_;IE—_I:' To add a program from a CO-ROM or Floppy disk, click CD or Floppy, D or Floppy |
S,

To add new Windows Features, device drivers, and syskem updates wind Undat |
% over the Internet, click wWindows Update, NERNE SRERE

=] B3

Close |

Add/Remove Programs

Select the CD or Floppy button on the Add/Remove Programs dialog box to open the Installation wizard.

Automation Control Products ThinManager 5.0 Help Manual

Non-ThinManager Components e 540



Install Program From Floppy Disk or CD-ROM

|nzert the product's first installation floppy disk or CO-ROM,
and then click Hest.

Canicel

Install Program Window

The wizard will prompt for the installation of the software disk. Select Next to display the Run Installation
Program dialog box.

Note: If the new program starts in autorun and proceeds without going through the following procedures,
either stop the autorun and use the wizard to initiate the installation, or use the change user /Zinstall
command to place the machine in the install mode. Use the change user /execute command when
finished to return the machine to the Run mode.

Run Installation Program

Windows waz unable to find the installation program. Click.
Back to try again. Click Browse to find the installation
pragran rmantally.

Open:

|| Browsze. ..

< Back | Caricel

Run Installation Program
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Enter the command line of the installation program and select Finish, or select the Browse button to select

the installation file.

& Sin

31 Cor [F:Y

x| « ® e E

21

dos
info
Idcrm

ass
kiveali
unix:

File hamne:

BCROBAT
bootagnt
dri-snmp

rakedisk.
PSS YEr

Files of twpe:

[ v
[:I win9x

Esetup.exe

= i

ISelup Prograrns

e |
j Cancel /L

Browse File Window

Selecting the Browse button on the Run Installation dialog box will launch a Browse File window. Highlight

the installation file and select Open. This will begin the application setup.

After Installation

After installation, pleaze click Mext.

< Back

Cancel

After Installation Window

As the installation begins, an After Installation dialog box is displayed. It requests that the Next button be
selected when the installation is finished. When this button is selected a second confirmation window is

displayed.
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Finish Admin Install i : x|

“when the inztallation has ended [successfully or not),
pleasze click the Finish buttan or the Cancel button, DO
MOT CLICK, THE BUTTOMS BEFORE IMSTALLATION
H&5 EMDED!

<Back |i Finish Cancel

Finish Install Window

Select the Finish button when the installation is finished.

Note: If a choice is given to Reboot Now or Reboot Later, choose to reboot later once the entire setup is
completed and the dialog boxes are cleared.

28.3.1 Terminal Services Configuration

Microsoft provides the Terminal Services Configuration interface to configure how terminal services is
handled on each terminal server.

Select Start > Programs > Administrative Tools > Terminal Services Configuration to launch the
Terminal Services Configuration Console. There are two folders, Connections and Server Settings.

28.3.2 Terminal Services Connections

The Terminal Services Configuration tree has a Connections folder. Highlighting this folder will display the
installed client communication protocols.
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tscc - [Terminal Services Configuration',Connections]

File  Action Wiew  Help
e= OmBR @

,, Terminal Services Configuration Conneckion I Transport I Type I Zommenk I
a Conneckions %RDP-TCI:I tcp Microsaft RDP 5.2

------ (23] Server Settings

Terminal Services Configuration\\Connections Console - Connections

Double clicking on the RDP-tcp icon on the right will launch the RDP-tcp Properties
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28.3.2.1

RDP-tcp Login Settings

RDP-Tcp Properties |

Fiemaote Control | Client Settings | M etwork, Adapter I Permiszions
General Logon Settings | Sezziong Erwviranment
* lse client-provided logon information
" Always use the following logan information:
zer nanme: I
[amait I
Eazawond; I
Caonfirm password: I
[ always prompt for passward
k. I Cancel Apply

RDP-tcp Login Settings

The Login Settings should use the Use client-provided logon information radio button so that each user

will login with a unique account.

The Always prompt for password should be unselected to allow auto-logins.
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28.3.2.2 RDP-tcp Sessions Settings

RDP-Tcp Properties |

Femate Control I Client Settings l M etwork, Adapter I Permiszions
General I Logon Settings Sessions | E nwironment

I1ze this tab to 2et Teminal Services timeout and reconnection settings.

[ Owveride user settings

Endla dizzonnected zezsian: INEVET "’I
Sotive sezsian limit INever "I
|dle zezsion limit: INever vI

[ Owveride user settings
"When sezsion limit iz reached or connection iz broken:
= Dizconnect from session

¥ End session

[T | Overide weer zettings
Allowe reconnechion;

= From any client

€ From previous client

Cancel Apply

Individual User Account Sessions Configuration

Each user account can be configured individually in the Computer Management interface. These can be set
to end a disconnected session or an idle session after a period of time. The Terminal Services
Configuration Console allows these settings to be made for every user of the terminal server, speeding
configuration time.
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RDP-Tcp Properties |

Remate Cantrol I Clignt Settings l I etwork, Adapter I Permizsions
Gereral I Logon 5 ettings S EEsiong | E nvironment

Ilze thiz tab to zet Terminal Services timeout and reconnection settings.

¥ Overide user settings

End a dizconnected session: |'| it j

Active zezsion limit; INever

L L

Idle zezzion limit: INever
¥ Oweride user settings

"When sezsion limit iz reached or connection iz broken:
™ Dizconnect from session

* End session

[T | Overide weer zettings
Allowe reconnechion;

= From any client

€ From previous client

k. I Cancel Apply

RDP-tcp Sessions Settings

The Sessions tab of the RDP-tcp Properties allows all users to be configured with a consistent disconnect
policy by selecting the Override user settings checkbox.

Selecting End Session setting for the When session limit is reached or connection is broken and
selecting the Override user settings will cause a new session to be created when a terminal disconnects
and reconnects.
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28.3.2.3 RDP-tcp Client Settings

RDP-Tcp Properties |

General I Logon Settings | Sezsionz I Ervviranment
Femate Cantral Client Settings | Metwork Adapter I Pemissions
— Connection

W Uze connection settings from user settings
¥ | Connect client dives at logon
¥ | Connect client printers at logon

¥ | Diefault ta mait client printer

W Limit Maximum Colar Depth

|15 it =l

Dizable the following:
™ Drive mapping [T COM port mapping
[T Windows printer mapping [ Clipboard mapping

[ LPT port mapping

k. I Cancel Apply

RDP-tcp Client Settings

The Client Settings tab of the RDP-tcp Properties allows the color depth to be set in the Limit Maximum
Color Depth drop-down.

Drive mapping, LPT port mapping, COM port mapping, and audio mapping are allowed if the appropriate
Disable the following checkboxes are un-selected.

Audio mapping is disabled by default. You need to uncheck the Audio mapping checkbox to allow a thin
client to play sound.
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28.3.2.4 RDP-tcp Network Adapter Settings

RDP-Tcp Properties |

General I Logon Settings | Sezsionz | Ervviranment
Femate Cantral I Client Settings Metwork Adapter I Pemissions

The faollowing network, adapters are compatible with the selected transport
twpe. Select the netwark, adapter pou want to Lze.

Hetwork adapter:

Al metwark, adapters configured with thiz protocal j

" Unlimited connections

% b asimum connections: |1 0 ::I

k. I Cancel Apply

RDP-tcp Network Adapter Settings

The Network Adapter tab of the RDP-tcp Properties can be used to limit the number of active users to aid
in application licensing compliance.
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28.3.3 Terminal Services Connections

The Terminal Services Configuration tree has a Connections folder. Highlighting this folder will display the
installed client communication protocols.

tscc - [Terminal Services Configuration' Server Settings]

File  Action Wiew Help

- | En PR 25

,, Terminal Services Configuration Setkings | attribute |
-1 Connections 2¥]Delete temporary Folders on exit Yes
s | oerver Seftings Llse temporary folders per session Yes
Licensing Per Device
.ﬁ.ctive Deskkop Disable
F‘ermissien Compatibility Relaxed Securiby
Restrict each user to one session Yes
License server discovery mode Aukannatic

Terminal Services Configuration\\Connections Console - Connections

The Server Settings have several settings that can control the terminal services experience.

28.3.4 Licensing Mode

Microsoft expanded the Terminal Services Client Access License (TS CAL) program in Windows 2003. TS
CALs are available in two types, TS Device CALs and TS User CALs.

e The TS Device CAL licenses one device to connect to any Microsoft Terminal Servers as any
user. This functions like the previous Windows 2000 TS CAL.

e The TS User CAL licenses one user for any device to connect to any Microsoft Terminal Servers.

To change between the Per Device licensing and Per User licensing, double-click Licensing to launch the
Licensing Mode window.
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UcensngMode K|

Licenzing Mode: I Per Device j
R e

Thiz policy requires a license to be izsued to each client computer
[device] that connects ta the kerminal server.

Tao change this zerver to Remate Desktop far Administration, use Add/
Bemove Programs.

ak. I Cancel

Terminal Services Configuration Console- Licensing Mode

Select the desired mode from the Licensing Mode dropdown box and click OK.

28.3.5 Permission Compatibility

Microsoft has increased the security in each successive release of its terminal server software. These new
policies prevent users from accessing the system folder, *.ini files, the registry, and other resources. Some
programs such as HMI, SCADA, database, and control software need access to these resources to function.
Instead of making all the users administrators, the security can be set to the less strenuous Windows NT 4.0-
style security.

Permission Compatibility E |

Some applications require special access bo system rezources, such as the regizty and
zuztem directories, in order o worl; cormectly.

" Full Security

Select thiz option to prowvide the most zecure environment in which to run applicationz. By
default, Teminal Server Lzerz will have the same permizsions az members of the Uzers
group and thuzs may naot be able to rin some legacy applications.

+ Relaved Security

LR

Select thiz option if you hawve compatibility problems with legacy applications.

& Idnder thiz configuration, all Uszers will have full access to critical registie and
file zuztem locations. This may be necessany in arder ta run many legacy
applicationz.

k. I Cancel

Terminal Services Configuration Console- Permission Compatibility
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Launch the Permission Compatibility window by double-clicking on the Permission Compatibility setting.
Select the Relaxed Security radio button and select the OK button.

28.3.6 Restrict Each User to a Single Session

The Restrict Each User to a Single Session setting prevents duplicate and orphaned sessions by limiting
each user to a single login.

Double-clicking the setting will launch a settings window.

Single session per user ﬂ |

To conzerve zerver regzolrces and simplify reconnecting to
dizconnected sessions, pou can restiict each user to a single
zEzzION

¥ Restict sach uzer ko one session

k. I Cancel

Terminal Services Configuration Console- Single Session Per User

The Restrict each user to one session checkbox is selected by default in Windows 2003.

Note: Keep this setting selected. MultiSession will still work as long as each session is using a different
AppLink program.

28.3.7 License Server Discovery Mode

A new feature in Windows 2003, Service Pack 1 and later, is a setting to point the terminal server to a specific
Terminal Server Licensing Server. This is the License server discovery mode setting in Terminal Services
Configuration. This is easier than hard coding the license server into the registry.
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Terminal Server License Server discovery ﬂ |

— License server dizcovery method

 Autaomatic

¥ Usze these icenze servers:

|1 92.168.1.34 Check namesl

Thiz Terminal Server will atternpt ta locate these licenze servers first. If they are not
lozated, thiz Terminal Server will attempt automatic dizcoveny.

Separate licenze zerver names with commas.

Example: Serverl, Serverd example.com, 192.168.1.1

—Automatically discovered license servers

In DomainAsforkgroup role:; I

In Enterprize role; I

Cancel | ak. I

Terminal Server License Server Discovery Window

Launch the Terminal Server License Server Discovery Window by double-clicking the License server
discovery mode setting in Terminal Services Configuration window.

Entering a valid Microsoft Terminal Server Licensing Server name in the Use these license servers field will
force the terminal server to use the defined server as the license server. This keeps the terminal server from
getting confused when there are multiple license servers.

The Automatically discovered license servers field would be automatically populated with license servers
found by the terminal server and can be used as a reference. The Check names button will check the
validation of the name in the Use these license servers field.

28.4Windows 2008 Server

28.4.1 Adding Terminal Server Role

Windows 2008 Server, like Windows 2003 Server, allows two RDP connections for administrative purposes.
To make the Windows 2008 Server a terminal server where many people can access applications requires
adding the Terminal Services Role.

Open the Server Manager window.
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E.._ Server Manager

File Action View Help

=] E3

S 2% roles

ﬁ Features

= Diagnostics
= jj’l} Configuration

Task Scheduler
Windows Firewall with Adval

’,.6 Services
@ WMI Control
%ﬂ Local Users and Groups

{2 storage

| i H
s Server Manager (2008TSES)

View the health of the roles installed on your server and add or remove
roles and features,

3

| * Roles Summary ﬂ Roles Summary Help

34 Add Roles
i Remove Roles

(~) Roles: 0 of 16 installed

<

{} Last Refresh: 4/12/2010 4:24:54PM  Configure refresh

Server Manager Window

Highlight Roles in the tree and select Add Roles in the right pane. A wizard will launch allowing you to add

Terminal Services as a role.

Highlights of the Role Wizard include:
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Add Roles Wizard E3

Select Server Roles
Before You Begin Select one or more roles to install on this server.
Roles; Description:
E Active Directory Certificate Services Terminal Services provides

technologies that enable users to
access Windows-based programs that

E Active Directory Domain Services
E Active Directory Federation Services

i are installed on a terminal server or to
[ ] Active Directory Lightweight Directory Services access the full Windows desktop. With
Progress [] Active Directory Rights Management Services :Erm.'”all SE”"'E';S: userl:hc.an SREETEE
1 anolicat erminal server from within your
Results L ication Server corporate network or from the
E DHCP Server i

E DNS Server
E Fax Server
[ File Services
[ Metwork Policy and Access Services

[ web server (115)
[] windows Deployment Services

More about server roles

< Previous | Mext = I Instzll Cancel

Role Wizard - Select Server Roles

The Role Wizard lists a dozen roles that are available.
Check the Terminal Services checkbox and any other roles desired.
Select Next to continue.
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Add Roles Wizard E3

Select Role Services
Select the role services to install for Terminal Services:
Server Roles Role services: Description:
Terminal Server enables a server to
. . hostWindows-based programs orthe
L]Ts L|cenlsmg full Windows desktop. Users can
|:| TS Session Broker connect to a terminal server to run
[] T8 Gateway programs, savefiles, and use network
D T5 Web Access resources on that server.
Licensing Made
User Groups
Confirmation
Progress
Results
More about role services
< Previous | Mext = I Install Cancel

Role Wizard —Select Role Services

Terminal Services has several options:
e Terminal Server — the basic terminal services option. Check this option

e TS Licensing — This makes the server a 2008 License Server.
You need a 2008 License Server and 2008 Terminal Services Client Access Licenses
(TS CALSs) to operate.
Select this if this server will be your Terminal Services License Server.

Select Next to continue.
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Add Roles Wizard E

Specify Licensing Mode

Before You Begin The Terminal Services licensing mode determines thetype of Terminal Services client access licenses (TS
Corver R CAlLs) that a license server will issue to clients that connect to this terminal server.
Terminal Services Specify the Terminal Services licensing mode that you want this terminal server to use.
Role Services
" Configure later
Application Compatibili
. Remind me to use the Terminal Services Configuration tool or Group Policy to configure the licensing mode
Authentication Method within the next 120 days.
Licensing Mode " Per Device
User Groups A T5 Per Device CAL must be available for each device that connects to this terminal server.
Confirmation
{* per User
Frogress

A T5 Per User CAL must be available for each user that connects to this terminal server.

Results

{D The licensing mode that you specify must match the TS CALs that are available from your Terminal
Services license server.,

Cancel

< Previous | Mext > I In

Role Wizard — Specify Licensing Mode

Windows 2008 TS CALs, like Windows 2003 TS CALs, are available as Per Device or Per User.
The terminal server should match the mode that the license server is using.

Select Next to continue.
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Add Roles Wizard E

=
E Confirm Installation Selections

Before You Begin

Server Roles

Terminal Services
Role Services
Application Compatibility
Authentication Method
Licensing Mode
User Groups

Confirmation

Progress

Results

To install the following roles, role services, or features, dick Install.

‘1 1warning, 2 informational messages below

'.'jl,i' This server must be restarted after the installation completes.

~) Terminal Services

Terminal Server
You may need to reinstall existing applications.

! IE Enhanced Security Configuration will be turned off,

Authentication method: Do not require Metwork Level Authentication
Licensing mode: Per user
Groups allowed access: Administrators

Print, e-mail, or save this information

< Previous Mext = | Install I Cancel

Role Wizard — Confirm Installation Selections

The Add Roles Wizard will end with a list of the configurations that will be installed.

Select Install to add the role(s). Once the wizard is finished it will assume the role of a terminal server.
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28.4.2 Adding Applications in Windows 2008

Applications on terminal servers need to be installed in the Install Mode. Open the Control Panel and click on
the Install Application on Terminal Server icon to start the installation wizard.

:.l-r-(- |
e
Install
Application an

Terminal
Server

Install Application on Terminal Server Icon

A wizard will run that allows the installation of the application.

The Install Mode can also be entered by typing change user /Zinstall ata command prompt. You

can then run the setup . eXe to install your application.

Type change user /execute when finished installing to leave the Install Mode.

28.4.3 Create Users
Users management is located in the Server Manager console.
E:-.: Server Manager !IEI
File Action Yew Help
o HDIXE = H
R S o e
= _5;‘1- Roles — G
';ﬂ Terminal Services Na!.me — DES?'FMH = e
Eﬁ Features :F_F,_-.ﬂ.dmlnlsh'ab:urs Administrators Mare Actions
i Diagnostics :F!;.:Eadmp Operators Badkup Operato
= _E.EIJL!Z Configuration :F;Certiﬁcate Service DCO... Members of this Remote Desktop Users
Tazk Scheduler ﬂe't:ryph:ugraphic Operators  Members are aL Maore Actions
9 Windows Firewall with Adval gﬂistibuted COM Users Members are all
., Services %Event Log Readers Members of this
-;E’Eﬁ WML Control P Guests Guests have the
= &% Local Users and Groups s _qusrs Built-n group us
| Users & Network Configuration ...  Members in this
__| Groups E:Perﬁ:rmance Log Users Members of this
£ storage & performance Monitor U, Members of this
E'Puwer Lsers Power Users are
gﬁrint Operators Members can ac
Remote Desktop Users Members in this
g-'REplicab:ur Supports file FE[—
Ellsers sers are preve »
1] | L3 KN | r

Server Manager — Local Users and Groups
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Users need to be members of the Remote Desktop Users group to access the terminal server.

28.4.4 Allowing Application Access

Applications installed on a terminal server are not available to remote users unless the Terminal Server
Settings are changed to allow access to the applications. You can either allow access to all applications or
allow access to specific applications in the TS RemoteApp Manager.

284.4.1 Allowing Application Access — All Applications

Applications installed on a terminal server are not available to remote users unless the Terminal Server
Settings are changed to allow access to the applications.

You can change the settings to allow access to all installed applications in the TS RemoteApp Manager.
ESEwer Manager

=]
File Action Miew Help
&= =
:i'_-a Server Manager (2008TSE42) | S TR VY r (2008TSE49) =
= B Rokes koo i U | < :
Bl '3 Terminal Services TS RemoteApp Manager - moteApp Manager (.

TS RemoteApp Ma

a RemoteApp programs are programs that are access [ Add RemoteApp Programs
Terminal Services C ( appear as if they are running on the client’s local o E ) )
&= Terminal Services M i T RemoteApp program available to users, you must ; &l Terminal Server Settings
fﬂ Features | i B 15 Gateway Settings
i Diagnostics Bl Diitsl S )
= Digital Signature Setti
;jﬁ Configuration Overview 'GHtal Signature setings
{5 storage j Export RemoteApp Setti...
| Terminal Server Settings| Change ?E'EI_T: % Import RemoteApp Setti...
L The
(i) Clients will connect to: 2008TSE49 em View ,
1. Users can start listed and unlisted uni -
_ - . Help
programs on initial connection, £ Al
¥
T5 Gateway Settings Change We
(D Clients will use TS5 Gateway settings @ Ar
defined by their domain's Group Policy. el
R
Digital Signature Settings Change -
/0 Mo digital certificate is configured, (Using .@. tlc
a digital certificate may improve security,)
RDP Settings Change Other
@ Clients will not use any custom ROP SEIE.Ct
settings. option
md Cre
[, I
l | K | b

TS RemoteApp Manager

Highlight TS RemoteApp Manager under the Terminal Services branch of the Server Manager tree.

Select the Change link for the Terminal Server Settings to launch the RemoteApp Deployment Settings
page.
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RemoteApp Deployment Settings

Commaon ROP Settings | Custom RDP Settings |
Teminal Server | TS Gateway I Digital Signature I

Clients will use these settings while connecting to this terminal server.

— Connection settings
Server name: [2008TSE43

if the terminal serveris in a fam, enter the DNS name of the

BDF port: 2389

I Require server authentication

If you use server authentication, you may have to provide a fulty qualified DNS
name in the Server name boo.

— Remote desktop access

™ Show a remote deshktop connection to this terminal serverin TS Web Access

— Access to unlisted programs

" Do not allow users to start unlisted programs on inttial connection
{Recommended)

% Allow users to start both listed and unlisted programs on initial connection

oK I Cancel Apply

RemoteApp Deployment Settings

Select the Terminal Server tab of the RemoteApp Deployment Settings page.

Select the Allow users to start both listed and unlisted programs on initial connection radio button in
the Access to unlisted programs section.

This will allow any program to be run by an authorized user.

You can also select and define specific applications that can be run by configuring them in the TS
RemoteApp Manager.
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28.4.4.2

Allowing Application Access — Specific Applications

You can control application access on Windows 2008 Server by only allowing access to specific applications.

.. server Manager

File Action ‘iew Help

[ E3

e ] el 7 1 [e]

ia Server Manager (2008T5E49)
=] 5} Roles
=] ;ﬁ :F‘erminal Services
TS RemoteApp Manage
Terminal Services Confi
&= Terminal Services Mang
ﬁ Features
i Dizgnostics
Bl Hf} configuration
Task Scheduler
B Windows Firewall with Adve
G Services
& WMI Control
= ;-E Local Users and Groups
] Users
1 Groups
fﬂ Storage

TS RemoteApp Manager (2008TSE49)

TS RemoteApp Manager

C

-

RemoteApp programs are programs that are accessed through Terminal Services, and |
appear as if they are running on the cient's local computer. Before you can make a
| RemoteApp program available to users, you must add it to the RemoteApp Programs list.

Actions

TS RemoteApp Manager (2008TSE49) &

Add RemoteApp Programs

Overview

Terminal Server Settings Change

@ Clients will connect to: 2008TSE49

o/ Users can only start listed Remotedpp
programs cn initial connection,
(Recommended)

TS Gateway Settings Change

@ Clients will use TS Gateway settings defined
by their domain's Group Pelicy.

Digital Signature Settings Change

/Ay Mo digital certificate is configured, (Using a
digital certificate may improve security.)
RDP Settings Change

(D Clients will not use any custom RDP
settings,

| @I The RemotelApp Programs list is empty.

| @ A remote deskiop connection for this server

| '@' Meore about using TS Web Access

| B Create Windows Installer Package

| '@' More about distribution cptions

Distribution with TS Web Access

Ay The TS Web Access Computers group is
empty. RemoteApp programs may be
unavailable to users, Refresh | Learn more

is not visible in TS Web Access. Change

Other Distribution Options
Select a Remotelpp program and choose an
option below,

Create .rdp File

RemoteApp Programs

MName | Path

| TS Web Acce... | Arguments

Terminal Server Settings
TS Gateway Settings
Digital Signature Settings
Export RemoteApp Settings
2% ImportRemateApp Settings
View

Help

TS RemoteApp Manager

Highlight TS RemoteApp Manager under the Terminal Services branch of the Server Manager tree.

Select the Add RemoteApp Programs link in the Actions column on the right of the screen to launch the

RemoteApp Wizard.
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RemoteApp Wizard |

Choose programs to add to the RemoteApp Programs list

Select the programs that you want to add to the RemoteApp Programs list. You
can also configure individual RemoteApp properties, such as the icon to display.

[Name | -
14 Calculator
(0% Data Sources {ODEC)
[]&5 Disk Defragmenter
1€, 155 Intiator
g Memory Diagnostics Tool
Y Paint
C18 rFairt Shop Pro 5
D%" Problem Reports and Solutions
(% Remote Desktop Connection
H _i', Securty Configuration Wizard
] :5- Server Manager —_—
C1E& System Corfiguration
[ & System Information
[ Windows Contacts ;I

Select Al Select Mane Properties... | Browse. .. |

RemoteApp Wizard

The RemoteApp Wizard shows a list of applications installed on the Windows 2008 Server.

Select the checkbox for each application that you want available for deployment as a ThinManager Display
Client.

Select Next to complete the wizard. A remote user can run any checked application.

28.4.5 Installing ThinManager

It is a common practice to install ThinManager on a terminal server but ThinManager is independent of
terminal services and doesn’t need to be installed on a terminal server.

Applications on terminal servers need to be installed in the Install Mode. Open the Control Panel and click on
the Install Application on Terminal Server icon to start the installation wizard.

»
Install
Application an
Terminal
Server

Install Application on Terminal Server Icon
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Once the wizard begins navigate to the ThinManager setup.exe program and continue with the wizard. See
Installation of ThinManager for details.

The Install Mode can also be entered by typing change user /Zinstall atacommand prompt. You
can then run the setup . exe to install ThinManager.

Type change user /execute when finished installing to leave the Install Mode.
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28.4.6 Allow Inbound Traffic to Firewall

ThinManager requires communications to the thin clients. This communication is blocked by default in the
firewall and needs to be allowed.

You can either open the firewall to all traffic or open the specific ports needed.

28.4.6.1 Allow All Inbound Traffic

You can configure the firewall by selecting Windows Firewall with Advanced Security in the Server
Manager tree.

E. server Manager o =]

File Acton View Help

= x5 HE

FNERCA G EZENE windows Firewall with Advanced Security Actions

= f';i Roles i
= ':;_“:_| Terminal Services Windows

4 T5 RemoteApp Ma ﬂ Windows Firewall with Advanced Security provides enhanced n | Import...

= T?rm!nal Slerw::.es ( — | & Bport...
73 Licensing Diagr :
= g=g Terminal Services | | Qverview Restor...
- o 2008TSE43 Domain Profile View b
5| Features ~
= Fm Diagnostics & Windows Firewall is on. @ Refresh
Event Viewer (® Inbound connections that do not match a nile are blocked. ER:
Reliability and Perform . _ TP -
o . ) Outbound connections that do not match a rule are allowed. "
gy Device Manager = Help
=1 it Configuration Private Profile
Task Scheduler ~
Windows Firewall with ®'  Windows Firewall is on_
gy Services ® Inbound connections that do net match a nule are blocked.
ﬁ ILI"‘IMI I:c'ntrcll .'ji'. . T ) IS [ PRSP ) NS S [N N ) S, PN———— | J— | i

&/ Local Users and Group: | 4 | I
% Storage

Resources

« | s |
| | I

Windows Firewall with Advanced Security

el

Highlight Windows Firewall with Advanced Security in the Server Manager tree. Right click and select
Properties to launch the Properties window.
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Windows Firewall with Advanced Security

Domain Profile I Private Profile  Public Profile I |Psec Settings |

Specify behavior for when a computer is connected to a public netwaork

]|

location.
— State
i Firewall state: IOn recommended) j
Inbound connections: INIDW j
Quthound connections: INIDW (default) j
— Settings
7| Specify settings that control Windows : |
%— | Firewal behavior. .
[~ Legging
== Specify logging settings for : |
:{ _______ troubleshocting. onlari

Leam maore about these settings

0K, I Cancel Ay

Windows Firewall with Advanced Security Properties

Select the profile tab that matches the type of network you are using, Domain, Private, or Public profile.

Change the Inbound connections to Allow and select OK to accept the change.

This will allow the thin clients to connect to ThinManager through the firewall.

Automation Control Products ThinManager 5.0 Help Manual

Non-ThinManager Components e 566



28.4.6.2 Open Ports in Firewall

You can open specific ports in the Windows 2008 Server firewall instead of allowing all inbound connections if
you prefer.

Open the Local Security Policy by selecting the Start > Administrative Tools > Local Security Policy.
E. Local Security Policy M= B

File  Action Wew Help

& 2wz HE

i Security Settings
5, Account Polides
g, Local Policies There are no items to show in this view,
E [ Windows Firewall with Advanced Security
= 9 Windows Firewall with Advanced Sea
¥ nbound Rules
E£% Outhound Rules
E‘!._,. Connection Security Rules
| Metwork List Manager Polides
| Public Key Polidies
| Software Resfriction Polices
@ IP Security Policies on Local Computer

Mame | Group  *

Local Security Policy

Expand the Windows Firewall with Advanced Security to show the Inbound Rules.

Right click on the Inbound Rules and select New Rule. A wizard will launch that allows configuration of a
new port.

You need to run the wizard twice, once to allow UDP 4900 and once to allow TCP 2031.
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#® New Inbound Rule Wizard E3 |

Rule Type
Select the type of firewall rule to create.

Steps:
& Rule Type What type of nule would you like to create?
@ Protocol and Ports
@ Action " Program
@ Profile Rule that controls connections for a program.
@ Name * Port
Rule that controls connections for a TCP or UDP port.
" Predefined:
BITS Peercaching j
Rule that controls connections for a Windows experience.
" Custom
Custom rule.
Leam more about nile types

<Back || Nea> Cancel

Rule Wizard — Rule Type

Select Port as the rule you are configuring and select Next to continue.
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* New Inbound Rule Wizard E3 |

Protocol and Ports
Specify the protocol and ports that this nule matches.

Steps:

@ Rule Type Does this nule apphy to TCP or UDP?
< Protocol and Ports & ICP

@ Action " UDP

@ Profile

@ MName

Does this nule apply to all local ports or specific local ports 7

Al local ports

* Specific local ports: |2-|}3‘||

Example: 80, 443, 3080

Leam more about protocol and ports

cBack || Nea> Cancel

Rule Wizard — Protocols and Ports

You will need to select the protocol and port for each rule. You will need to run the wizard once for UDP 4900

and once for TCP 2031.

Select the protocol and enter the port as shown in Rule Wizard — Protocols and Ports.

Select Next to continue.
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#® New Inbound Rule Wizard E3 |

Action

Specify the action that is taken when a connection matches the condttions specified in the rule.

Steps:
Rule Type What action should be taken when a connection matches the specified conditions?
Protocol and Ports

' Action * Allow the connection
Profile Allow connections that have been protected with |Psec as well as those that have not.
MName i Allow the connection if it is secure

Allow only connections that have been authenticated and integrity-protected through the use
of IPsec. Connections will be secured using the settings in IPsec properties and rules in the
Connection Securty Rule node.

[ Require the connections to be encypted
Require privacy in addition to integrity and authertication.

= | Ovemide block nies
Useful for tools that must always be available, such as remote administration tools. | you
specify this option, you must also specify an authorzed computer or computer group.

" Block the connection

Leam more about actions

cBack || Nea> Cancel

Rule Wizard — Action

Select Allow the Connection.

Select Next to continue.
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#® New Inbound Rule Wizard E3 |

Profile
Specify the profiles for which this rule applies.

Steps:

Rule Type When does this rule apply?

Protocol and Ports
¢ Action ¥ Domain
Profile Applies when a computer is connected to its corporate domain.
MName v Private
Applies when a computer is connected to a private network location.

¥ Public
Applies when a computer is connected to a public netwark location .

Leam more about

cBack |[ Nea> Cancel

Rule Wizard — Profile

Select the network(s) that the rule will apply to.

Select Next to continue.

A Name page will allow you to name the rule and add a description for management and organizational
purposes.

Select Finish to save and apply the rule.
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E_, Local Security Policy
File  Action Wew Help

&= 25wl
i Security Settings
“a Account Polidies
‘4 Local Polides
Bl [ Windows Firewall with Advanced Security
= @ Windows Firewall with Advanced Sea
%k Inbound Rules
Cutbound Rules
¥ Connection Security Rules
| Metwork List Manager Polices
| Public Key Polides
| Software Restriction Polides
g IP Security Policies on Local Computer

IS =] E3

Name
@Firmware—‘?‘gﬂﬂ
@ThinManager—ch—ZﬂSl

| Group  ~

7 &

Applied Rules
Repeat for UDP 4900 or TCP 2031.

This will allow thin clients to use port 4900 to download the firmware and allow the thin client to use port 2031
to download the configuration but will keep other ports closed on the firewall.
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28.4.7 Local Security Policy — User Access Controls

You may need to go to the Local Security Policy and change the User Account Control: Behavior of the
elevation prompt for administrators in Admin Approval Mode to Elevate without prompting for
ThinManager to run properly.

Open the Local Security Policy by selecting the Start > Administrative Tools > Local Security Policy.

0| User Account Contral: Only elevate executables that are signed and va... Disabled

'z| User Account Control: Only elevate ULAccess applications that are insta... Enabled

| Uzer Account Control: Run all administrators in Admin Approval Mode Disabled

io| User Account Cantral: Switch to the secure desktop when prompting fo... Enabled
o] User Account Contral: Virtualize file and registry write failures to per-us... Enabled -

| User Account Control
'o| User Account Control

E—= Local Security Policy [_ (O]
File Action View Help
e HmIXRE = H
5}__:_.| Security Settings Policy = | Security Setting il
A, Account Polides iz Recovery console: Allow floppy copy and access to all drives and all fol,.,  Disabled
= 3 LC@' Policies inio| Shutdown: Allow system to be shut down without having to log on Disabled
5 Audit Policy 77| Shutdown: Clear virtual memory pagefile Disabled
4 User Rights Assignment 1o System cryptography: Force strong key protection for user keys stored... Mot Defined
- Sebiis | System cryptography: Use FIPS compliant algorithms for encryption, ha... Disabled
~ Windows I.=irewall with .l!'.ljju'..i 10| System objects: Require case insensitivity for non-Windows subsystems  Enabled
~ NEt"_\IDrk List ril"l..anager Polici 1o System objects: Strengthen default permissions of internal system ohje... Enabled
_| Public Key Polices ] . )
| Software Restriction Police: | | System settings: Optional subsystems Paosix
g IP Security Policies on Local | ° | System settings: Use Certificate Rules on Windows Executables for Sof...  Disabled
o) ser Account Control: Admin Approval Mode for the Builtsn Administrat... Disabled
Uszer Account Control: Allow ULAccess applications to prompt for elevati... Dizabled

Uszer Account Control: Behavior of the elevation prompt for administrat. ..
: Behavior of the elevation prompt for standard us...

: Detect application installations and prompt for el...

Elevate without promptin
Prompt for credentials
Enabled

Local Security Policy — User Account Controls

Highlight Local Policies > Security Options in the tree.

Browse to User Account Control: Behavior of the elevation prompt for administrators in Admin
Approval Mode and change the setting to Elevate without prompting.

This may be needed to run ThinManager as a non-administrator.
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28.5Command Prompt

Terminal Services has several commands that aid in managing the terminal server. Some useful ones are:

Command Action
change logon Temporarily disables logons to a Terminal Server
change port Changes COM port mappings for MS-DOS program compatibility
change user /install Puts the server into “Install Mode”
change user /execute Removes the server from “Install Mode”
Ipconfig Displays the IP addresses of the network card
Logoff Logs off a user from a session and deletes the session from the server
net send username “message” Sends a message to a user. username is the NT/2000 user name that the

person or terminal is logged in as. “message” is the text of the message.
Quotation marks are needed for any messages containing a space.

query process Displays information about processes running on a Terminal server
query session Displays information about sessions on a Terminal server

query termserver Displays a list of all Terminal servers on the network

query user Displays information about user sessions on a Terminal server
reset session Resets a session to known initial values

Shadow Monitors another user's session

Tsdiscon Disconnects a client from a terminal server session

Tsshutdn Shuts down the terminal server in an orderly manner

See the Windows online help for additional commands and parameters.

Other useful commands include:

Command Action
gpedit.msc Launches the Group Policy Editor
tscc.msc Launches the Terminal Services Configuration Console
tsadmin Launches the Terminal Services Manager
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28.6Alternative Terminal Keystrokes

Certain keystrokes are not available in a terminal session. Microsoft has provided these alternatives.

Keystroke

Function

ALT+PAGE UP

Switches between programs from left to right.

ALT+PAGE DOWN

Switches between programs from right to left.

ALT+INSERT Cycles through the programs in the order they were started.
ALT+HOME Displays the Start menu.

CTRL+ALT+BREAK Switches the client between a window and full screen.
CTRL+ALT+END Brings up the Windows 2000 Security dialog box.
ALT+DELETE Displays the Windows menu.

CTRL+ALT+Minus (-) symbol on the
numeric keypad

Places a snapshot of the active window, within the client, on the Terminal server
clipboard (provides the same functionality as pressing PrintScrn on a local
computer.)

CTRL+ALT+Plus (+) symbol on the
numeric keypad

Places a snapshot of the entire client window area on the Terminal server
clipboard (provides the same functionality as pressing ALT+PrintScrn on a local
computer.)
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28.7DHCP Server Setup

Dynamic Host Configuration Protocol (DHCP) is a program that assigns IP addresses to devices on a
network. DHCP server can be used to provide IP addresses to thin clients. It can also be configured to point
the thin clients to the ThinManager Servers with Option 66, Boot Server Host Name.

28.7.1.1 Scope Options

The DHCP Server needs Option 066 configured before it will provide the ThinManager Server IP address
that the terminal needs to boot.

Scope Options |

General | Advanced I

Awailable Optiohs | Dezcription ﬂ
O 064 MIS+ Domain Mame The name o

O 065 MIS+ Servers A ligt of IP a
06E Boot Server Hozt Mame TFTP boot :=—
O 067 Bootfile M ame Bootfile Man -
q | o

—Data entry
String walue;

192.168.1.1192.168.1.4

k. I Cancel Apply

Boot Server Host Name

The Boot Server Host Name, Option 066, assigns a ThinManager server to the terminal.

Open the Scope Options dialog box by highlighting the Scope Option folder in the tree pane of the Computer
Management Console under the Services and Application > DHCP folder and selecting Action >
Configure Options.

Scroll through the list window and check the Option 066 check box.
Enter the IP address of the desired ThinManager server in the String Value field.

The DHCP Server can issue the IP address for a Primary ThinManager Server and a Secondary
ThinManager Server by listing the IP addresses of both, separated with a space.
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28.7.1.2 DHCP Properties

The DHCP Server can be configured to check for duplicate IP addresses before issuing a new address. This
is a good feature to use.

Highlight DHCP under Services and Applications in the Computer Management tree and select Action >
Properties, or right-click on DHCP and select Properties. The DHCP Properties window will launch.

bHCP properties K|

Generall DHS  Advanced |

Specify the number of times the DHCP server should attempt conflict
detection for an [P address before the server leazes the address to a client.

Conflict detection attempts: g _:I

Ayt log file path; — |C:w/INDOWS\S pstem32\dhep Browse. . |
Database path; II::"-.WINDDWS\SystemEIZ"-.dhcp Browsze. .. |
Eackup path: II::"-.WINDDWS\SystemSE'\dhcp"mba Browse... |
Change zerver connections bindings: Bindings... |
DS dynamic updates registration credentials: Credentials... |

] I Cancel Apply

DHCP Properties — Advanced Tab

Select the Advanced tab. Replace the zero in the Conflict detection attempts field with an integer. This will
prompt the DHCP Server to check for duplicate IP addresses before assigning an IP address.

Select OK when finished.

28.8Group Policy

Windows has a number of features that can be allowed or prevented with a Group Policy. Group Policy is
configured in the Group Policy Object Editor snap-in to the Microsoft Management Console.

Access the Group Policy Editor by typing gpedit.mSc at a command prompt to launch the Microsoft
Group Policy Editor.
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'fii Group Policy Object Editor

Eile Action Yiew Help

&= BEER| @@

::sf Local Computer Policy ~ | | Setting State |
E@ Caompuker Configuration I:IDesk.tu:up Themes
[:l Software Settings @ Remove Display in Control Panel Mok configured
[:I Wi"":_i'j_""'s Sn?ttings 1 Hide Deskkap tab Mat configured
EH:I .ﬁ.dmln!stratwe Templat: =4 Prevent changing wallpaper Mot configured
% :"'I'HEDWS Compaone =4 Hide Appearance and Themes kab Mok configured
: SR = Hide Settings tab Mak configured
F-[2] Metwork & . )
0] Printers =W Hide Screen Saver kab Mot configured
SCreen S5 g Wk configure
Elﬁ User Canfiguration ! i r Mk |_|_|r||‘|;|ur|:'|:|
-5 Software Settings & Screen Saver executable name Mot configured
(] Windows Settings & Password protect the screen saver Mok configured
E||:I Adrinistrative Termplat = Screen Saver bimeout Mok configured

(£ windows Compane
[C start Menu and Ta
I:l Deskiop

=[] Contral Panel

o [ Add or Remove
-4=5] Display
I:I Prinkers

[ Metwark

EI[:I Swskermn
: [ User Profiles —

[:I Scripks

[ Chrl+Al+Del

|:| Logon -

ﬂ+| 4 Extended , Standard
|

Group Policy Settings

Expanding the tree will show Group Policy settings that can affect the terminal server experience.

Please refer to Microsoft documentation for information on using these features.

28.9Microsoft Licenses

28.9.1 Microsoft Client Access Licenses (CALS)

Thin Clients require a terminal server with Windows 2003 or 2008 Server with Terminal Services enabled
as an operating system.

Each of these operating systems requires a standard Microsoft Client Access License (CAL) for each
connection to the server. These are based on concurrent use; a 5-pack would allow more than five users to
access server resources, but only five users at a time.
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28.9.2 Microsoft Terminal Server Licenses

Terminals, such as thin clients and fat clients, require a license to access terminal services in addition to the
standard Microsoft Client Access License (CAL). This is called the Microsoft Terminal Services Client
Access License (TS CAL) in Windows 2003 and is called the Remote Desktop Services Client Access
License (RDS CAL) in Windows 2008.

Windows 2003 terminal servers require Windows 2003 TS CALs and Windows 2008 terminal servers require
Windows 2008 RDS CALs.

Note: This document will refer to all terminal services CALs as a TS/RDS CALs.

. This licensing is per seat; ten terminals would require ten TS/RDS CALs, even if only two were connected at
atime.

These can be installed as Per Device or Per User.

e The TS/RDS Device CAL licenses one device to connect to any Microsoft Terminal Servers as
any user. This functions like the previous Windows 2000 TS CAL.

e The TS/RDS User CAL licenses one user for any device to connect to any Microsoft Terminal
Servers.

All TS/RDS CALs are installed on a Terminal Services Licensing Server. This acts as a repository for all
TS/RDS CALs. The terminal servers request TS/RDS CAL authentication from the Terminal Services
Licensing Server as terminals attach to terminal servers.

Note: The Terminal Server Licensing Server does not need to be a separate computer. It is a program that
can be installed on any existing server.

The Terminal Services Licensing server is activated through the Internet by connecting to the Microsoft
Certificate Authority and License Clearinghouse.

Windows 2003 and 2008 Servers with Terminal Services enabled will issue 90-day or 120-day temporary
licenses while the Terminal Services Licensing server is being setup and activated. If this period has elapsed,
the terminal will not connect to the terminal server and will display an “Error Number 50" message box.

Windows Server is not normally sold with TS CALs. These need to purchased separately and installed on the
Terminal Services License server.

28.9.3 Microsoft Terminal Server Licensing Activation

In Windows 2003 and 2008, all the TS CALs are installed on a single Terminal Server Licensing Server. This
allows a single site for management and authentication of terminal server connections. A server becomes a
Terminal Server Licensing Server by selection of the option during the installation phase or by selecting
Add/Remove Programs > Add/Remove Windows Components from the Control Panel and selecting the
Terminal Services Licensing.

The licensing of the Microsoft components of a Windows 2003 or 2008 terminal server is a two-step process;
one must first authorize the Terminal Server Licensing Server, then one must activate the licenses. The
license activation will be repeated for each license pack.
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29 ThinManager Troubleshooting
Guide

This is a list of common configuration errors and a guide for fixing them.

Note: When any problem arises, check Downloads at www.thinmanager.com for the latest firmware and any
service packs. The problem you are experiencing may have already been fixed and released in a later version
of firmware and using the latest version will cure the current problem. Try applying the latest firmware, and
then reboot the thin client to see if the problem still exists. The current version (v.2.06.X) is backwards
compatible to earlier versions of ThinManager (2.3.1, 2.4, 2.5, etc.)

29.1Section 1 - From Power on to Terminal Server Login
1) Powering on the Thin Client
A) No Power
e  Check power cable, power supply, and power outlets.
B) No Video
e  Check video cable and monitor.

Warning: Never go into the thin client BIOS and change the Integrated
Peripherals>Display Status from CRT to LCD. This changes the video
output of the motherboard from the VGA port to a socket on the
motherboard used for integrated LCD panels. Changing this from CRT will
prevent any video from being displayed on a monitor.

2) Booting - ACP Network Boot Loader
A) Cannot get IP address using DHCP
e |s the thin client set to DHCP? They are set to DHCP by default, but can be changed.
e |s the Thin Client on the same side of the router as the DHCP server?

e Does the DHCP server have addresses to give out?
B) Cannot get IP address using Static 1P menu

e Certain models (ThinAdapters and older DC-40-100s with black PS/2 ports) cannot use static
IP.

e Static IP hasn't been set. Use the spacebar when the "Select any Key to Configure IP
Settings" is displayed and set the client IP address
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3) Cannot Load Firmware
A) Is Thin Client connecting to ThinManager Server?
i) Using DHCP
e Has Option 066 been set to the ThinManager Server IP Address?
e Isthere alink light on the network port?
e Check router address, IP Addresses, and Subnet Mask

i) Using Static IP

e Has the ThinManager Server IP Address been entered in the IP Configuration Menu?
B) Is the network blocked?

ACP Enabled thin clients that communicate through routers,
gateways, or firewalls may need some ports opened to allow data
flow through these devices. If the thin client communicates
through one of these and it is having trouble, check to see if these
ports are allowed.

The required ports are:
e UDP/4900 - TFTP - Used for the TFTP download of the firmware.

e TCP/2031 - Configuration - Used to pass the configuration from the ThinManager Server
to the thin client.

e TCP/1494 - Citrix - Used by the ICA protocol (if using ICA instead of RDP).
e TCP/3389 - RDP - Used by the RDP protocol (if using RDP in v2.4.1 or later).
e TCP/5900 - Shadowing - Used to shadow terminals.

e TCP/1758 — Multicast — Used for firmware download unless multicast is turned off on the
ThinManager Server Configuration Wizard.

e Ping and DHCP - These need configured as needed.
C) Loads firmware intermittently/slowly

e Check for IP conflicts
e Check cable connections
e Make sure ThinManager Server CPU usage is below 100%

e Check the IGMP settings on the routers. If the IGMP is blocked, the Multicast of firmware
will be interrupted. Unselecting Multicast in the ThinManager Server Configuration wizard
will allow firmware downloads if the IGMP is blocked.

4) Thin Client Loads Firmware but shows blue message screen

A) "Please Define on Server"

e Enter ThinManager and define the terminal.
B) "License Not Available™

e Check your license usage in ThinManager. You are out of an ACP-supplied License
C) "This Terminal Disabled"

e A ThinManager administrator has disabled this terminal. Re-enable it.
D) "Network Error - Check Network Connections"

e Check the network cable. Link light, and network.
E) Was Disabled, but did not go on when Re-enabled.
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e Reboot.
F) Terminal Selection menu is shown, but keyboard does not work

e Check keyboard and reboot
e Use PS/2 splitter if the unit has only one PS/2 port

e Switch the mouse and the keyboard if plugged into a PS/2 splitter.
5) Graphical ACP Logo is shown, but boot process stops

A) Does not attempt to connect to the terminal server

e Check Terminal Configuration Wizard to make sure a terminal server is specified
B) Cannot Connect to Server xxx (0.0.0.0)

e The terminal server doesn't have an IP address configured in the Terminal Server
Configuration Wizard.

e If using DNS, check the terminal server's registration.

e If you are using a Citrix Published Application, you may need to specify the ICA browser.
C) Cannot Connect to Server xxx (w.x.y.z)

e Check the event viewer. If it says "Could not issue client license", you need a Microsoft
Terminal Server Client Access License (MS TS CAL) and/or a Microsoft Terminal Server
Licensing server.

e Check the Subnet Mask in the ACP Boot Loader on the thin client. If it is set to
255.255.255.255 instead of 255.255.255.0, it will fail to connect to the terminal server.
Reboot the thin client and use the spacebar when the "Select any Key to Configure IP
Settings" is displayed. Change the subnet mask in the ACP Boot Loader menu.
D) Error 50 - Disconnected

o Check the event viewer. If it says "Could not issue client license", you need a MS TS Cal
/ MS TS Licensing server.
6) Attempts to connect to terminal server, but dies

e Some servers (Dell and its Dellwall.bmp, for example) load a complex bitmapped
background that can interfere with loading. Find the offending wallpaper file on the
console session and renamed it so that it doesn't load at login

7) Connects to connect to terminal server, but cannot login

e Isthe user a valid user? Is the password correct?

¢ Does the user have permission to connect through Terminal Services (user properties in
the User Manager)

e Iflogging in to a Windows 2003/2008 terminal server, is the user a member of the
Administrators group or Remote Desktop Users group?

e Check the event viewer. If it says "Could not issue client license", you need a Microsoft
TS Cal and or a Microsoft TS Licensing server.
8) Login to Terminal Server prompts for password even though the username and
password are filled in ThinManager

e The password may be entered wrong in ThinManager.

e Windows 2000 Server is set to always prompt for password at login for RDP users.
Select Programs>Administrative Tools>Terminal Services Configuration and double
click on RDP-tcp Properties in the right-hand window. Uncheck the Always Prompt for
Password checkbox on the Login Settings tab.
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29.2Section 2 - Thin Client is Booted, Connected, and
Running a Session on the Terminal Server

9) Disconnects randomly

e Make sure each user is logging on with a unique user name. Windows 2003/2008 will
only allow one session per name by default.

e Check the physical network connection.
e Check for a different computer (e.g. a laptop) with the same IP address.

e Slow down the Monitoring Interval on the Monitoring Connection page of the Terminal
Configuration Wizard by increasing the timeout and retry values.
10) The session in Windows 2003requires frequent logins

e Turn off the Windows screen saver. User accounts in Windows 2003 use a secure screen
saver by default that requires this frequent login.
11) Mouse works but the application is unresponsive

e Application on terminal server is locked up - kill the application and let the thin client
reconnect to terminal server and restart the application
12) Sound doesn't work

e Make sure that you are using a Windows 2003/2008 terminal server

e Make sure that Audio Mapping is allowed on the Client Settings of the RDP-tcp
Properties in the Terminal Server Configuration Console.

e Make sure that you are using a thin client that has sound capability
e Add the Universal Sound Module to that thin client

e Connect a powered speaker to the "Line Out" plug. Line Out isn't amplified so it requires
a powered speaker.

e Properly working thin clients will play sounds at boot.
13) The touch screen doesn't work

e Make sure you are using the right Touch Screen Module for the touch screen controller.
o Make sure that the serial cable is plugged into the correct serial port

o Make sure that the Touch Screen Module is using the correct baud rate.
14) The touch screen mouse doesn't match the touches.

e Calibrate the touch screen by highlighting the unit in the ThinManager tree and select
Tools > Calibrate Touch Screen.
15) Changes to the configuration in ThinManager don't show up on the thin client.

e Reboot the thin client. Changes are only set to a thin client at bootup.
16) The configuration of the primary ThinManager Server and the secondary
ThinManager Server are different.

e Synchronize the configurations by selecting Manage>ThinManager Server List and
selecting Auto-synchronize in the ThinManager Server List Wizard.
17) The terminals in the tree on the primary ThinManager Server show green while
the terminals on the secondary are all red.
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e Add both ThinManager Servers to the ThinManager Server Monitor List in the Terminal
Configuration Wizard (then reboot the terminals and synchronize the ThinManagers as in
Number 15 and Number 16).
18) The client is showing the time of the terminal server in a different time zone and
not the local time.

e Use the Time Zone Redirection Module on the client with the local time zone selected.

o Make sure that the security policy of the terminal server or domain allows it. Look at
Computer Configuration > Administrative Templates> Windows Components >
Terminal Services >Client/Server data redirection >Allow Time Zone Redirection
and set it to Enabled
19) When "Terminal Servers" is highlighted in the ThinManager tree, the Details pane
doesn't show OK for the connections.

A) No login information supplied

e Run the Terminal Server List Wizard and add an administrative user name and password
on the Terminal Server Name page of the Terminal Server List Wizard.
B) User specified does not have permission to connect

e This indicates that the Terminal Server had an invalid username and password added on
the Terminal Server Name page of the Terminal Server List Wizard. Run the Terminal
Server List Wizard and change to an administrative user name and password on the
Terminal Server Name page of the Terminal Server List Wizard.

e Use the domain in the Domain field on the Terminal Server Name page of the Terminal
Server List Wizard.

e If notin a domain, try using the terminal server name in the Domain field on the Terminal
Server Name page of the Terminal Server List Wizard.
C) WTSAPI132.dll connection failed

e This occurs when the terminal server is off or unreachable. Try pinging the terminal
server.

20) The Users, Sessions, and Processes tabs don't show data for a terminal server
A) No login information supplied

e Run the Terminal Server List Wizard and add an administrative user name and password
on the Terminal Server Name page of the Terminal Server List Wizard.
B) User specified does not have permission to connect

e This indicates that the Terminal Server had an invalid username and password added on
the Terminal Server Name page of the Terminal Server List Wizard. Run the Terminal
Server List Wizard and change to an administrative user name and password on the
Terminal Server Name page of the Terminal Server List Wizard.

e Use the domain in the Domain field on the Terminal Server Name page of the Terminal
Server List Wizard.

e If notin a domain, try using the terminal server name in the Domain field on the Terminal
Server Name page of the Terminal Server List Wizard.
21) The Users and Sessions tabs show data for a terminal server, but the Processes
tabs shows no data.

e Shorten the name of the terminal.
Microsoft truncates the terminal names to 15 characters. The Process information won't
display for terminals with a name longer than 15 characters.
22) When shadowing a client the mouse doesn't work in the shadowed session.
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e The user must be logged into the shadowing computer as an administrator or as a
ThinManager Administrator to use interactive shadowing.

e The interactive shadow must be checked in RemoteView on the ThinManager menu.

e Aterminal using the Share Keyboard and Mouse module will only be interactive if the
mouse is active in that session.
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30Glossary of
Terms

Access Groups

TermSecure Access Groups are used to limit
access to a terminal or Display Client unless the
user is also a member of the access group.

ACP

Automation Control Products.

ACP Enabled Thin Client

A terminal that uses ACP technology. Also called
ThinManager Ready

ACP Enabled Thin Client Network

A ThinManager server, a terminal server, and ACP
enabled thin clients connected and configured on
the same network.

ActiveX

A Microsoft technology that allows the sharing of
data between different applications.

Application Group

A managed collection of terminal servers that a
terminal can connect to. Used in ThinManager 3.2
and 3.3. Replaced by Display Client in
ThinManager 4.0.

AppLink

A function that applies the Initial Program to a
Display Client.

BIOS

Basic Input/Output System. A program that the
computer uses to control the keyboard, mouse,
monitor, serial ports, and other devices before the
hard drive is accessed.

CAL

Client Access License. A Microsoft license that is
required to print or access files on a Windows
Server. See also TS CAL.

Client

A machine that requests data, resources, or
services from a server. A software program that
shares data with the server.

Client/Server

A relationship between two computers or
programs where one, the client, requests data,
resources, or services from the other, the server.

COM Port

A serial communication port on a PC.

Console

The administrative session that is run on the
server.

DHCP

Dynamic Host Configuration Protocol. A protocol
for assigning IP addresses and other boot
information to computers on a network.

Disk-On-Chip

Storage device that contains firmware that allows
an ACP Enabled thin client to boot locally. This
may be a disk-on-chip or compact flash,
depending on the make and model of the terminal.
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Display Client

The graphic rendering of the output from a Display
Server. This could be a traditional Terminal Server
session, I[P Camera display, or a Terminal-to-
Terminal Shadow session. Added in ThinManager
4.0.

Display Servers

Devices that provide content that can be displayed
on the client. Examples include the traditional
terminal server and IP cameras. Added in
ThinManager 4.0.

DNS

Domain Name Service. An Internet service that
converts domain names to IP addresses.

Domain

A group of computers that are administered as a
unit, with common rules, policies, and procedures.

Domain Name Service

An Internet service that converts domain names to
IP addresses. Often abbreviated to DNS.

Enforce Primary

A ThinManager feature that allows terminals that
failed over to a backup terminal server to return to
their primary terminal server once the primary
terminal server has returned online.

Failover

The ability of a terminal to switch to a backup
server when the primary server fails.

Fat Client

A computer with a hard drive and operating
system that is acting as a client.

Firmware

The software that runs the ThinManager Ready
thin client.

Gateway

A device that connects two computer networks
that use different protocols.

GUI

Graphical User Interface. The portion of an
operating system or program that provides icons,
symbols, or pictures for options and choices.

HMI

Human-Machine Interface. A software program
that allows an operator to control a manufacturing
process. Also known as MMI, Man-Machine
Interface.

Hot key

A keyboard combination that triggers a function.

ICA

Independent Computing Architecture. A remote
presentation services protocol from Citrix that
allows thin clients to access the terminal server.

ICA Connection

The communication channel between an ICA
server and an ICA terminal.

Initial Program

A function that loads a specific application instead
of the desktop in a terminal server session.

Instant Failover

A ThinManager function that allows a
ThinManager Ready thin client to start sessions on
two terminal servers, with only the session of the
primary terminal server visible. If the primary
terminal server fails, the secondary session is
immediately displayed.

IP

Internet Protocol. A widely used protocol for
network communications.
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IP Address

Four sets of numbers from 0 to 255 that represent
an Internet address.

IP Camera

A video camera that sends its graphic over a
standard Ethernet network.

KeyBlock

A module that prevents certain keyboard
combinations like CTL+ALT+DEL from functioning.

KVM

Keyboard/Video/Mouse. A device that allows
several PCs to be displayed on a single monitor
and controlled by a singe keyboard and mouse.

Load Balancing

A dynamic ability to connect a thin client to a
group of servers and login to the server with the
lightest load. Used by SmartSession.

Load Sharing

A static ability to connect a thin client to one of a
group of servers in a predetermined fashion to
share the load among the servers available.

MAC

Media Access Control Layer. A protocol that
controls access and communication on a network
card.

Module

Modules are software components that can be
added to the firmware to increase the functionality
of the terminal. Modules include touch screen
drivers, sound drivers, and special device drivers.

MultiCast

Multicast provides the ability for an unlimited
number of terminals to boot simultaneously from
the same data stream.

MultiMonitor

The ability for some ThinManager Ready thin
clients to use two or monitors attached to the thin
client.

MultiSession

A function that allows a terminal to connect to
several Display Clients at one time and to switch
between sessions.

OEM

Original Equipment Manufacturer. A company that
manufactures computers.

PLC

Programmable Logic Controller. A device, often
using ladder logic programs, that controls
processes and devices in an industrial plant.

POST

Power On Self Test. A diagnostic test that a
computer runs when it is first turned on to make
sure that the hardware is functioning.

Primary Up Delay

An interval of time given to a server to allow it to
finish loading before terminals will connect to it.

Primary Terminal Server

The first terminal server that a terminal will log
into.

Published Application

An application in a server farm that is shared
equally among the servers.

PXE

Preboot Execution Environment, sometimes
pronounced "pixie," is an environment which
allows a computer to boot over a network.
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Queuing

Queuing extends the functionality of Smart
Session by preventing terminals from connecting
to Terminal Servers that have exceeded their
Smart Session CPU load limit by letting the
terminals connect in an orderly fashion.

RAM

Random Access Memory. The computer's primary
memory space.

Redundancy

The use of duplicate equipment so that if one unit
fails, another one takes its place. ACP uses
Redundancy for duplicate ThinManager Servers
and uses Failover for duplicate terminal servers.

RDP

Remote Desktop Protocol. The client/server
communication protocol used between Windows
servers and Windows clients.

Router

A device that manages data transmission between
two networks.

SCADA

Systems Control And Data Acquisition. A software
program that gathers and displays data, and
allows for operator input, for control of a
manufacturing process.

Secondary Server

Backup terminal servers that a terminal may log
into.

Server

A device, computer, or application that provides
applications, files, or data for use by other
computers

Server Farm

A group of connected servers that share
responsibilities and are usually configured to allow

processing to continue if one or more server
crashes.

Server Ranking

A number that represents the available resources
on a terminal server using SmartSession. Lower
numbers indicate a lighter load.

Shadow

The ability to remotely view the video of a terminal
or PC.

Share Keyboard and Mouse

A module that allows several thin client to share a
keyboard and mouse.

SmartSession

A function that allows a Display Client to be load
balanced so that a ThinManager Ready terminal
will connect to the terminal server in the
Application Group that has the lightest load.

Subnet

A group of TCP/IP addresses that communicate
without going through a router and can be reached
by broadcasts.

TCP/IP

Transmission Control Protocol/Internet Protocol. A
layered application that allows shared applications
and data on PCs.

Terminal

A client device that relies on a server for
operations. ThinManager Ready thin clients are
terminals.

Terminal Server

A server with a multi-user operating system that
processes data for terminals.
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Terminal Server Groups

A managed collection of terminal servers that a
terminal can connect to. Used in ThinManager 2.5
until 3.1. Replaced by Display Client in
ThinManager 4.0.

TermSecure

A function that allows user profiles to be created
and configured with their own Application Groups
and Access Groups. When a TermSecure User
logs in to a terminal using TermSecure, they will
be allowed access to their own Application Groups
and any of the terminal sessions that they are a
member.

Thin Client

A terminal without a hard disk that is used to
access a server.

ThinManager

Thin client configuration and management
software from ACP.

ThinManager Ready
An ACP Enabled thin client.

ThinManager Server

A computer running both the ThinServer service
and the ThinManager interface.

Since ThinManager will run on Windows
workstations, a ThinManager “Server” can be a
workstation.

ThinServer

The Windows service that is the engine for
ThinManager.

Trialware

A free demo version of ThinManager that can be
downloaded from www.thinmanager.com. It can
run for 30 days without a license.

TS CAL

Terminal Server Client Access License. A
Microsoft license that is required for each client
accessing a terminal server.

UniCast

Unicast allows a single terminal to boot from a
data stream.

USB

Universal Serial Bus. A data port that allows
peripherals to connect to a PC.

VCenter Server

VCenter is a virtual machine management tool
from VMWare. It allows IT administrators to control
and manage multiple ESX servers and their virtual
machines in a single console.

Virtual Machine

An isolated and independent install of an operating
system within a host operating system. It allows
one computer to run several virtual computers on
one physical device.

Virtualization

The use of virtual machines.

WinTMC

A terminal server client application that can be
installed on a PC. It can be controlled, configured,
and managed through ThinManager.
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Boot 121

C
CAL 583

3 1 I n d eX Calibrate 105
Calibrate Touch Screen 105
Camera 268, 278
Camera Authentication Page 246
Camera Configuration Wizard 244
Camera Model Options 247
Camera Name Page 245
Camera Overlay Layout Page 268
Cameras 271
Card 516, 517

A Change User 544

Changing a Terminal’s Group 227
Access Groups 90, 470, 471, 473, 475, 481, Citrix 187, 355, 356, 358, 360, 361

484 Citrix 11

acpboot.bin 217 Citrix Device Services 241
Activate Master License 48 Citrix ICA UseAlternateAddress Module 316
ActiveX Configuration 326, 346 Clear Event Log 107, 156
ActiveX Configuration Module 326, 346, 529 Clear History 156
ActiveX Control 529 Client Access License 583
ActiveX Demo 536 Client Communication Protocol 11
Add Group 85, 254 Command Line Options 200

Add Programs 17

Command Prompt 578
Add Remove 17

Communication Indicator 67

Add Remove Programs 544 Compact Flash 319

Add Server 145, 236 Components 11

Add Iel_’minal 85, 177 Computer Management Console 542
Add_ThlnManager Server 85 Configuration Wizards 136

Adding Modules 308 Configure Default 92

Addu_']g Terminals 128 Configure Default Terminal 92
Administrators 452 Confirm at Terminal 320

Allow terminal to be shadowed 453 Create a Master License 41
Application Group Configuration Wizard 88 Create New Terminal 128
Application Link 258 Create New Terminal Mode 128

AppLink 258, 265
Attach Module 310

Auto Login 259 D
Auto-Create 129, 154 Data Gathering 242
Auto-Create Mask 130 Data Gathering Page 242
Auto-Create mode 129 Default 130
Auto-Creation 130 Default Terminal 92
Auto-Login 259 Default Terminal 130
Available Terminal Servers 236 Delete 87

Deleting 83
B Demo Code 57

Detail pane 67
Background 335, 447 Details Pane 76
Backup 93 _ Device Services 241
Backup Configuration 93 DHCP 12, 122, 124, 217, 580

Badge 516, 517
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DHCP Options 123

Disable 72, 103, 105

Disconnect 94

Disk On Chip 319

Disk-On-Chip 320

Display Client 297, 384, 492
Display Client List 253

Display Client Members Page 262
Display Client Name Page 254
Display Client Options 256
Display Client Options Page 258
Display Client Selection Page 191
Display Clients 291

Display Clients 190

DNS Configuration 92, 173
Domain 174, 231

Domain Name Server 173

E

Edit 85

Edit Group 254

Edit Server 236
E-mail 165

Enable 105
Encryption 360
Enforce Primary 258
Event Log 107, 523
Exclusions 221
Experience 205, 335

F

Failover 13, 289, 291
Find 89

Find Next 90

Find Server 236
Firmware 99
Firmware Update 319
Force Update 320
Full Screen 111

Full Security 556

G

Go FullScreen 111

Graph 260

Graphic User Interface 66
Group Configuration 223
Group Configuration Wizard 88
Group Modules 208, 233, 311
Group Options 364

Group Policy 328, 335, 582

Group Selector 512
Group Setting 223

H

Hardware 12

Help 112, 126

Help Topics 112

HID Cards 477, 490

HMI 555

Hotkey 299, 364, 367, 368, 370, 371, 388,
480, 497

Hotkey Configuration Page 198

Hotkeys 353

Hybrid 127

Hybrid IP 127

ICA 11, 187, 355, 356, 358, 360, 361

ICA Browser 361

ICA Modules 315, 316

Icons 68, 301

Initial Program 258, 260

Install 9, 94

Install Mode 543

Install New Firmware 99

Install New TermCap Database 100

Installation 17, 27, 543, 544

Installation ID 50

Installing a Module 306

Instant Failover 259, 261, 293, 296, 301,
368

Instant Failover Module 352

Interactive Shadow 110

IP Address 122, 126, 219

IP Address Range 219

IP Configuration 124, 126

J
Join a Group 179

K

Key Block 316, 466

Key Block Single Key 317
Keyboard 317

Keyboard Configuration 317
Keystrokes 454, 579

L

License 35
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License Activation 36 O
Licensing 94, 583

List Wizards 136

Loading Order 314

Local Printer 321

Local Storage Modules 318

Operating System 11
Option 066 12, 123
Option 067 12, 123
Options 109, 111
Overlay 268, 271, 278

Lock 88 . Overlay Cameras 271
Log In Information Page 200 o ide 192
Login 493 vernde
Login 200
=]
M Pane 66

Password 126, 231, 464, 487

Permission Compatibility 556

Permissions 161, 255, 282, 461, 469, 471,
473, 475

Policy 335

Primary Up Delay 213

Primary Up Delay Multiplier 213

Print 108, 321

Product Code 44

Product Licenses 35

MAC Address 222

Main Menu 513

Manage 90

Manage a Master License 43
Master License 35, 54

Menu Bar 66

Menu Items 85

Microsoft License Server 556
Microsoft Licensing 554, 583

Mirrored 63
Mirrored Redundancy 63 ProxCard 524

i ProxCards 477, 490
oty 88 Published Application 361
Modifying 82 ublished Application

Published Applications 361
PXE Boot 215, 217
PXE Server 216

Module 207, 233

Module List 303

Module Loading Order 314
Module Parameters 311

Module Selection 206 Q
Modules 95, 206, 303, 306, 308 Queuing 264
Modules Properties 210 Quick Start 9

Monitor Retry 213
Monitor Timeout 213

Monitoring Configuration Page 212 R
Mouse Modules 329 RDP 11, 241, 335
Multicast 168 RDP Experience 335
MultiMonitor 15, 16, 35, 377, 447 RDP Modules 335
MultiMonitor 373 RDP Serial Port 337
MultiMonitor Video 203 RDP Settings 549, 552
MultiMonitor WinTMC 447 Reboot 102, 103
MultiSession 14 Reboot Terminals 103
Rebooting 83
N Reconnect 94
Redirect 446
Network 12 Redundancy 61
Network Access 87 Redundant Ethernet 325
New Hardware 128 Relaxed Security 556

New User 542 Remote Desktop Protocol 11, 241

Remote View 110
Remove Module from All Terminals 308
Remove Programs 17
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Remove Server 145

Remove ThinManager Server 87
Rename 88

Renaming 83

Renaming a Terminal 83

Replace or Create New Terminal 129
Replace or Create New Terminal Mode 129
Replacements 154

Reports 108, 429, 431, 433
Requirements 11

Reservations 222

Restart 102

Restart Terminals 102

Restarting 83

Restore 92

Restore Configuration 92

Restrict each user to one session 556
RFID 477, 490, 516, 524

Right Click 113

Right Click Menus 113

Router 126, 220

S

SCADA 555

Scaled to Window 111

Schedule 413, 417, 420, 424, 433

Schedule Reports 433

Scope Options 580

Screen Saver 341

Screen Saver 340

Screen Saver Modules 340

Screened 373

Search Domain 174

Second Network Module 325

Security 87, 460, 464, 465, 555

Select Individual Terminal Servers 185, 186

Selecting Reports 431

Send Key 112

Send Message 106

Serial 337

Server Ranking 259

Session Options 111

SessionTiling 365, 389

Shadow 110, 284, 326

Shadowing 326, 451, 453, 454, 500

Share Keyboard and Mouse 373

Share Keyboard and Mouse 331, 373

Share Keyboard and Mouse Module 331,
373

Show Connected Only 107

Single clicking 84

Single Session Per User 556

SmartSession 242, 243, 258, 259
SmartSession Configuration 243
SmartSession Settings 263
Software Installation 543

Sound Modules 343

Spanned 373

Static IP 124

Status Bar 67, 107

Subnet Mask 126, 220
Synchronization 218
Synchronize 93, 147
Synchronize Configuration 93

T

Tabs 76

TermCap 101, 102

TermCap Database 100

Terminal Capability 101, 102

Terminal Configuration Wizard 177

Terminal Connection License 35

Terminal Connection Type 187

Terminal Group Configuration Wizard 223

Terminal Hardware Page 181

Terminal Interface Options 479, 494

Terminal Interface Options Page 197

Terminal IP Address 126

Terminal Mode Selection 185

Terminal Name Page 178

Terminal Options 183

Terminal Server 11

Terminal Server Capabilities Page 240

Terminal Server Client Access License 583

Terminal Server Display Client Type 257

Terminal Server Group 253

Terminal Server List 235

Terminal Server List Wizard 235

Terminal Server Name Page 239

Terminal Server Selection Page 188

Terminal Server Settings 553

Terminal Server Wizard 238

Terminal Services Configuration Console
547

Terminal Services Display Servers 235

Terminal Shadow 284, 326

Terminal-to-Terminal 326

Terminal-to-Terminal Shadowing 454

TermMon 346, 529

TermSecure 16, 35, 90, 370, 424, 467,
468, 473, 475, 481

TermSecure Access Groups 90

TermSecure Login 508

TermSecure Menu 511
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TermSecure Modules 344

TermSecure User 503

TermSecure User Group 503

TermSecure Users 475, 500

Theme 335

Themes 447

ThinManager 11, 65

ThinManager Administrators 452

ThinManager Installation 17, 27

ThinManager Interactive Shadow Users 452

ThinManager IP Address 126

ThinManager Power Users 452

ThinManager Ready 12

ThinManager Security 464

ThinManager Security Groups 161, 460

ThinManager Server 145

ThinManager Server Configuration Wizard
88

ThinManager Server List 90, 139, 145

ThinManager Server Monitor List 211

ThinManager Shadow Users 452

ThinManager Users 453

ThinServer 12

Time Zone 326

Title Bar 66

Tools 102

Touch Screen 105, 306, 349, 515

Touch Screen Modules 349

Touch Screens 23

Tree 67

Tree pane 66, 67

TS CAL 11, 554, 556, 583

TS CAL Activation 584

U

Unknown Terminals 154
Unlock 89

Upgrades 58

Upgrading 58

USB 329, 347

USB Flash Drive 523

USB Flash Drive Module 318
USB Flash Drives 477, 490, 516
Use Display Clients 185
User Profile 541, 542
Username 231

Users 468

\%

VCenter Server Property Wizard 88
Video 202, 232, 351, 379

Video Resolution 232
Video Resolution Page 202
View 107

Virtualization 391

w

WaveTrend 477, 490, 524
Weight 264

What is New? 2

Windows 2003 87, 335
Windows Groups 461
Windows Login 493
Windows User Groups 159
Windows XP 86

WinTMC 26, 35, 204, 441
WiIinTMC Configuration 441, 444
WiIinTMC Installation 27
WiIinTMC License 58, 449
WiIinTMC Settings 204, 446
Wizards 135

X
XLi Licenses 36
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